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Preface 

The purpose of this manual is to provide you with the information you need to use the 
iCare (BQI) population management application. iCare is a Windows-based, client-
server graphical user interface (GUI) to the IHS Resource and Patient Management 
System (RPMS). iCare retrieves key patient information from various components of 
the RPMS database and brings it together under a single, user-friendly interface. 
iCare is intended to help providers manage the care of their patients. The ability to 
create multiple panels of patients with common characteristics (e.g., age, diagnosis, 
community) allows users to personalize the way they view patient data. 

This manual contains reference information about iCare views, examples of its 
processes, and step-by-step procedures to show you how to perform the activities 
supported by the application. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Table of Contents 
August 2011 

iii 

Table of Contents 

Preface .................................................................................................................ii 
Table of Contents ...............................................................................................iii 
1.0 Introduction...............................................................................................1 

1.1 Background ...................................................................................1 
1.2 iCare Graphical User Interface ......................................................2 
1.3 Who Should Use iCare? ................................................................2 
1.4 Current Features of Version 2.2.....................................................3 
1.5 User Desktop (Client) Requirements .............................................3 

2.0 Orientation ................................................................................................5 
2.1 iCare Windows Overview ...............................................................5 

2.1.1 iCare Main Window .....................................................................5 
2.1.2 About the iCare Panel View Window ...........................................7 
2.1.3 About the iCare Patient Record Window .....................................8 

2.2 Key iCare Concepts .......................................................................8 
2.2.1 Diagnostic Tags ...........................................................................8 
2.2.2 Taxonomies .................................................................................9 
2.2.3 National Performance Measures ...............................................10 

3.0 Getting Started ........................................................................................12 
3.1 Your First Login ...........................................................................12 

3.1.1 User Preferences Wizard...........................................................14 
3.1.2 Completing the User Preferences Wizard .................................21 

3.2 Modifying Your User Preferences ................................................21 
3.2.1 Modifying “My Patients” Definition and Associated Panels ........23 
3.2.2 Flag Setup .................................................................................24 
3.2.3 Comm Alert Setup Tab ..............................................................24 
3.2.4 Startup View ..............................................................................25 
3.2.5 Patient View...............................................................................25 
3.2.6 Layouts Tab ...............................................................................26 
3.2.7 CMET Tab .................................................................................27 

4.0 Using iCare Features ..............................................................................35 
4.1 Working with Columns .................................................................35 

4.1.1 Sorting .......................................................................................35 
4.1.2 Changing Column Width ............................................................35 
4.1.3 Moving Columns ........................................................................36 
4.1.4 Freezing One or More Columns ................................................36 
4.1.5 Filtering ......................................................................................37 

4.2 Selecting Records........................................................................40 
4.3 Menus ..........................................................................................40 

4.3.1 Edit Menu ..................................................................................40 
4.3.2 Window Menu ............................................................................41 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Table of Contents 
August 2011 

iv 

4.3.3 Help Menu .................................................................................41 
4.4 Quick Patient Search ...................................................................42 

4.4.1 Find Patients in Open Panel ......................................................42 
4.4.2 Search Criteria Fields ................................................................43 
4.4.3 Find Patients in RPMS Database ..............................................45 

4.5 Buttons on Right Side of Window ................................................46 
4.5.1 Reset View ................................................................................47 
4.5.2 Refresh ......................................................................................47 
4.5.3 Search .......................................................................................47 
4.5.4 Export to Excel ..........................................................................48 
4.5.5 Print ...........................................................................................50 
4.5.6 Copy to Clipboard ......................................................................50 
4.5.7 Mail Merge .................................................................................50 
4.5.8 Glossary ....................................................................................52 

4.6 Entering Data ...............................................................................52 
4.6.1 Free Text Fields .........................................................................52 
4.6.2 Drop-Down Lists ........................................................................53 
4.6.3 Date Fields ................................................................................53 
4.6.4 Missing Data ..............................................................................54 

4.7 Pop-up Functionality ....................................................................54 
4.8 Add/Remove Functionality ...........................................................56 
4.9 Layout Dialog Functionality ..........................................................57 

4.9.1 Template Group Box .................................................................58 
4.9.2 Display and Available Columns .................................................58 
4.9.3 Columns to Sort .........................................................................59 

4.10 Background Jobs .........................................................................60 
4.11 Table Lookup ...............................................................................61 

4.11.1 Searching for Record .................................................................62 
4.11.2 Clearing Data in Field with Ellipsis Button .................................64 

4.12 iCare Package Manager Functions..............................................64 
4.12.1 iCare User Access Management ...............................................64 
4.12.2 Reassign Panels ........................................................................67 

4.13 Glossary Functions ......................................................................68 
4.13.1 Community Alerts Glossary .......................................................68 
4.13.2 Diagnostic Tag Glossary ...........................................................69 
4.13.3 National Measures Glossary......................................................69 
4.13.4 Reminders Glossary ..................................................................70 
4.13.5 HIV/AIDS / Care Management Glossary ...................................70 
4.13.6 Best Practice Prompts Glossary ................................................71 
4.13.7 Asthma / Care Management Glossary .......................................71 
4.13.8 CMET Glossary .........................................................................72 
4.13.9 Meaningful Use Glossary...........................................................73 

4.14 iCare Taxonomy Editor Function .................................................73 
4.14.1 Add Taxonomy Values ..............................................................74 
4.14.2 Remove Taxonomy Values........................................................75 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Table of Contents 
August 2011 

v 

4.14.3 View Report of All Taxonomies Button ......................................76 
4.15 Creating a Community Taxonomy ...............................................76 
4.16 Edit DPCP Providers ...................................................................79 

4.16.1 Add/Edit New Provider ..............................................................79 
4.16.2 Remove Provider Name ............................................................80 
4.16.3 Save & Close Button .................................................................80 
4.16.4 File Menu on Edit Providers.......................................................80 
4.16.5 Tools Menu on Edit Providers....................................................80 
4.16.6 Help Menu on Edit Providers .....................................................80 

4.17 Graphing Measurement Data ......................................................81 
4.17.1 Chart Data Group Box ...............................................................81 
4.17.2 Chart Options Group Box ..........................................................82 
4.17.3 File Menu for Charting Window .................................................83 

4.18 Select/Clear Functionality ............................................................86 
4.18.1 Search and Select Data for a Field ............................................86 
4.18.2 Clearing Data in Field ................................................................87 

4.19 Default Template for iCare Window Layouts ...............................87 
4.19.1 Template Group Box .................................................................88 
4.19.2 Display Columns ........................................................................89 
4.19.3 Columns to Sort .........................................................................89 

4.20 CMET Worksheet ........................................................................90 
4.20.1 Patient Demographics Group Box .............................................92 
4.20.2 1 - Event Group Box ..................................................................92 
4.20.3 2 - Findings Group Box ..............................................................93 
4.20.4 3 - Follow-ups Group Box ..........................................................96 
4.20.5 4 - Patient Notifications Group Box ............................................98 
4.20.6 Erroneously Tracked Events.................................................... 101 
4.20.7 Menus on CMET Worksheet.................................................... 103 

4.21 Edit Patient Demographic Fields................................................ 104 
4.21.1 Fields on Edit Patient Demographic Fields Dialog ................... 105 
4.21.2 Menus on Edit Patient Demographic Fields Dialog.................. 105 

4.22 CMET Package Manager .......................................................... 105 
4.22.1 Tickler Timeframes Tab ........................................................... 106 
4.22.2 Batch Processing Tab ............................................................. 107 

4.23 Panel Definition Layouts Functionality ....................................... 107 
4.23.1 Template Group Box for Panel Definition Layout..................... 108 
4.23.2 Display and Available Columns for Panel Definition Layout .... 109 
4.23.3 Columns to Sort for Panel Definition Layout ............................ 110 

4.24 Add TIU Note Dialog .................................................................. 111 
4.24.1 Using the Add a Note Button on Patient Record...................... 111 
4.24.2 Using Create Button on Notifications Dialog ............................ 118 
4.24.3 Using Create Button on Batch Processing Window ................. 121 

4.25 Add a Note Dialog...................................................................... 124 

5.0 Creating Patient Panels........................................................................ 126 
5.1 Scenarios and Panel Examples ................................................. 126 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Table of Contents 
August 2011 

vi 

5.2 Steps to Create a Panel ............................................................. 126 
5.3 Population Search Options ........................................................ 129 

5.3.1 No Predefined Population Search ........................................... 129 
5.3.2 My Patients .............................................................................. 131 
5.3.3 Patients Assigned To ............................................................... 133 
5.3.4 Scheduled Appointments ......................................................... 135 
5.3.5 QMan Template ....................................................................... 138 
5.3.6 RPMS Register ........................................................................ 140 
5.3.7 EHR Personal List ................................................................... 141 
5.3.8 Ad Hoc Search ........................................................................ 142 

5.4 Panel Definition Layouts Tab ..................................................... 153 
5.4.1 Edit Patient List Layout ............................................................ 153 
5.4.2 Edit Reminders Layout ............................................................ 154 
5.4.3 Edit Natl Measures Layout....................................................... 155 
5.4.4 Edit Asthma Layout ................................................................. 156 
5.4.5 Edit HIV/AIDS Layout .............................................................. 157 
5.4.6 Edit Events Layout ................................................................... 158 
5.4.7 Edit Tracked Events Layout ..................................................... 159 
5.4.8 Edit Follow-up Events Layout .................................................. 160 

5.5 Sharing Tab ............................................................................... 161 
5.5.1 Fields on Sharing Tab ............................................................. 162 
5.5.2 Grid on Sharing Tab ................................................................ 163 

5.6 Preview Tab ............................................................................... 164 
5.7 Auto Repopulate Options Tab ................................................... 164 

6.0 Panel List............................................................................................... 166 
6.1 Panel List Layout ....................................................................... 166 
6.2 Panel List Toolbar ...................................................................... 167 

6.2.1 New ......................................................................................... 167 
6.2.2 Open ........................................................................................ 168 
6.2.3 Delete ...................................................................................... 168 
6.2.4 Repopulate .............................................................................. 169 
6.2.5 Modify ...................................................................................... 171 
6.2.6 Share ....................................................................................... 173 
6.2.7 Copy ........................................................................................ 173 
6.2.8 Panel Properties ...................................................................... 174 

6.3 Panel List Menus ....................................................................... 175 
6.3.1 File Menu ................................................................................. 175 
6.3.2 Tools Menu .............................................................................. 177 
6.3.3 View Menu ............................................................................... 181 

7.0 Flag List ................................................................................................. 183 
7.1 Flag List Layout ......................................................................... 183 

7.1.1 Flag List Columns .................................................................... 183 
7.1.2 Flag Types ............................................................................... 184 

7.2 Flag List Toolbar ........................................................................ 184 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Table of Contents 
August 2011 

vii 

7.2.1 Show Field ............................................................................... 185 
7.2.2 Hide ......................................................................................... 185 
7.2.3 Show ....................................................................................... 185 
7.2.4 Create a Panel ......................................................................... 185 
7.2.5 Status of Background Jobs ...................................................... 186 

7.3 Flag List Menus ......................................................................... 186 
7.3.1 File Menu ................................................................................. 186 
7.3.2 View Menu ............................................................................... 186 
7.3.3 Tools Menu .............................................................................. 186 

8.0 Community Alerts ................................................................................. 187 
8.1 iCare Community Alerts Pop-up Window ................................... 187 

8.1.1 iCare Community Alerts Pop-up Layout .................................. 188 
8.1.2 iCare Community Alerts Pop-up Toolbar ................................. 188 
8.1.3 Buttons on the iCare Community Alerts Pop-up ...................... 188 

8.2 Community Alerts Tab ............................................................... 188 
8.2.1 Community Alerts Tab Layout ................................................. 189 
8.2.2 Community Alerts Tab Toolbar ................................................ 190 
8.2.3 Community Alerts Tab Menus ................................................. 190 

8.3 Community Alerts Patient View Pop-up ..................................... 191 
8.3.1 Community Alerts Patient View Toolbar .................................. 191 
8.3.2 Menus on the Community Alerts Patient View Pop-up ............ 192 

9.0 Panel View ............................................................................................. 194 
9.1 Panel View Toolbar.................................................................... 194 

9.1.1 Information on Toolbar ............................................................ 195 
9.1.2 Properties ................................................................................ 195 

9.2 Patient List Tab .......................................................................... 195 
9.2.1 Patient List Tab Layout ............................................................ 195 
9.2.2 Patient List Tab Toolbar .......................................................... 198 
9.2.3 Patient List Tab Menu Options ................................................ 204 

9.3 Reminders Tab .......................................................................... 206 
9.3.1 Reminders Tab Layout ............................................................ 206 
9.3.2 Reminders Tab Toolbar ........................................................... 208 
9.3.3 Reminders Tab Menu Options ................................................. 209 

9.4 Rem Aggregated Tab ................................................................ 209 
9.4.1 Rem Aggregated Tab Layout................................................... 210 
9.4.2 Rem Aggregated Tab Toolbar ................................................. 210 
9.4.3 Rem Aggregated Tab Menu Options ....................................... 211 

9.5 Natl Measures Tab .................................................................... 211 
9.5.1 What is National Performance (GPRA)? ................................. 212 
9.5.2 Natl Measures Tab Layout....................................................... 212 
9.5.3 Natl Measures Tab Toolbar ..................................................... 214 
9.5.4 Natl Measures Tab Menu Options ........................................... 215 

9.6 Natl Aggregated Tab .................................................................. 215 
9.6.1 Natl Aggregated Tab Layout .................................................... 215 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Table of Contents 
August 2011 

viii 

9.6.2 Natl Aggregated Tab Toolbar .................................................. 216 
9.6.3 Natl Aggregated Tab Menu Options ........................................ 217 

9.7 CMET Tab ................................................................................. 217 
9.7.1 Events Sub-Tab ....................................................................... 217 
9.7.2 Tracked Events Sub-Tab ......................................................... 220 
9.7.3 Follow-up Events Sub-Tab ...................................................... 223 
9.7.4 CMET Tab Menu Options ........................................................ 225 

9.8 Care Mgmt Tab .......................................................................... 226 
9.8.1 Main Sub-Tab for HIV/AIDS Register ...................................... 226 
9.8.2 Reminders Sub-Tab for HIV/AIDS Register ............................. 233 
9.8.3 Main Sub-Tab for Asthma ........................................................ 235 
9.8.4 Care Mgmt Tab Menus ............................................................ 239 

9.9 Diagnostic Tags Tab .................................................................. 239 
9.9.1 Diagnostic Tags Tab Layout .................................................... 240 
9.9.2 Diagnostic Tags Toolbar .......................................................... 240 
9.9.3 Diagnostic Tags Tab Menu Options ........................................ 246 

9.10 Flags Tab ................................................................................... 246 
9.10.1 Flags Tab Layout ..................................................................... 246 
9.10.2 Flags Tab Toolbar ................................................................... 246 
9.10.3 Flags Tab Menu Options ......................................................... 247 

10.0 Patient Record ...................................................................................... 248 
10.1 Specifying the Default Tab ......................................................... 249 
10.2 Patient Demographic Group Box ............................................... 249 

10.2.1 Community Field ...................................................................... 249 
10.2.2 Allergies Field .......................................................................... 250 
10.2.3 Barriers to Learning Field ........................................................ 250 
10.2.4 Phone Fields............................................................................ 250 
10.2.5 Email Field ............................................................................... 251 
10.2.6 DPCP Field .............................................................................. 251 
10.2.7 Additional Demographics Button ............................................. 251 
10.2.8 Add a Note............................................................................... 253 
10.2.9 View IMM Profile ...................................................................... 253 

10.3 Cover Sheet Tab........................................................................ 254 
10.3.1 Recent Visits Group Box ......................................................... 255 
10.3.2 Scheduled Appointments Group Box ....................................... 255 
10.3.3 Providers Group Box ............................................................... 255 
10.3.4 Insurance Group Box ............................................................... 257 
10.3.5 Panels Group Box ................................................................... 257 
10.3.6 Registers Group Box ............................................................... 258 
10.3.7 Cover Sheet Tab Menus .......................................................... 258 

10.4 Snapshot Tab ............................................................................ 259 
10.4.1 Active Diagnostic Tags Group Box .......................................... 260 
10.4.2 Family History Group Box ........................................................ 262 
10.4.3 Reproductive Factors Group Box ............................................ 263 
10.4.4 Measurements (Last Visit) Group Box ..................................... 266 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Table of Contents 
August 2011 

ix 

10.4.5 Last Routine Events Group Box .............................................. 266 
10.4.6 Open CMETs Group Box ......................................................... 267 
10.4.7 Snapshot Tab Menus .............................................................. 267 

10.5 Flags Tab ................................................................................... 268 
10.5.1 Flags Tab Layout ..................................................................... 268 
10.5.2 Flags Tab Toolbar ................................................................... 268 
10.5.3 Flags Tab Menus ..................................................................... 268 

10.6 Reminders Tab .......................................................................... 269 
10.6.1 Reminders Tab Layout ............................................................ 269 
10.6.2 Reminders Tab Toolbar ........................................................... 270 
10.6.3 Reminders Tab Menus ............................................................ 270 

10.7 BP Prompts Tab ........................................................................ 272 
10.7.1 BP Prompts Layout .................................................................. 272 
10.7.2 BP Prompts Toolbar ................................................................ 272 
10.7.3 BP Prompts Tab Menus .......................................................... 273 

10.8 Natl Measures Tab .................................................................... 273 
10.8.1 Natl Measures Tab Layout....................................................... 274 
10.8.2 Natl Measures Tab Toolbar ..................................................... 274 
10.8.3 Natl Measures Tab Menus....................................................... 275 

10.9 CMET Tab ................................................................................. 275 
10.9.1 Events Sub-Tab ....................................................................... 275 
10.9.2 Tracked Events Sub-Tab ......................................................... 277 
10.9.3 Follow-up Events Sub-Tab ...................................................... 278 
10.9.4 Past Events Sub-Tab ............................................................... 280 
10.9.5 CMET Tab Menus ................................................................... 281 

10.10 Summ/Supp Tab ........................................................................ 281 
10.10.1 Summ/Supp Tab Toolbar ........................................................ 282 
10.10.2 Summ/Supp Tab Menus .......................................................... 282 

10.11 PCC Tab .................................................................................... 283 
10.11.1 PCC Tab Layout ...................................................................... 283 
10.11.2 PCC Tab Toolbar ..................................................................... 284 
10.11.3 PCC Tab Menus ...................................................................... 290 

10.12 Problem List Tab........................................................................ 290 
10.12.1 Patient with No Problems ........................................................ 290 
10.12.2 Patient with Problems .............................................................. 292 
10.12.3 Problem List Tab Layout .......................................................... 292 
10.12.4 Problem List Tab Toolbar ........................................................ 293 
10.12.5 Problem List Tab Menus .......................................................... 297 

10.13 Care Mgmt Tab .......................................................................... 298 
10.13.1 Patient With No Tag ................................................................ 298 
10.13.2 Patient With HIV/AIDS Tag ...................................................... 300 
10.13.3 Main Sub-Tab .......................................................................... 302 
10.13.4 Reminders Sub-Tab ................................................................ 311 
10.13.5 Patient with Asthma Tag .......................................................... 312 
10.13.6 Care Management Tab Menus ................................................ 312 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Table of Contents 
August 2011 

x 

10.14 Referrals Tab ............................................................................. 314 
10.14.1 Referrals Tab Layout ............................................................... 314 
10.14.2 Referrals Tab Toolbar Options ................................................ 315 
10.14.3 Referrals Tab Menus ............................................................... 315 

10.15 DX Tags Tab ............................................................................. 316 
10.15.1 DX Tag Layout ......................................................................... 316 
10.15.2 DX Tags Toolbar ..................................................................... 316 
10.15.3 DX Tags Tab Menus ................................................................ 317 

10.16 Family HX Tab ........................................................................... 318 
10.16.1 Family HX Tab Layout ............................................................. 318 
10.16.2 Family HX Tab Toolbar ............................................................ 319 
10.16.3 Family HX Tab Menus ............................................................. 322 

10.17 Notes Tab .................................................................................. 322 
10.17.1 Notes Tab Layout .................................................................... 323 
10.17.2 Notes Tab Toolbar ................................................................... 324 
10.17.3 Notes Tab Menus .................................................................... 325 

10.18 Suicide Form Tab ...................................................................... 326 
10.18.1 Suicide Form Tab Layout ........................................................ 326 
10.18.2 Suicide Form Tab Toolbar ....................................................... 327 
10.18.3 Suicide Form Tab Menus......................................................... 327 

11.0 CMET ..................................................................................................... 328 
11.1 Events Sub-Tab ......................................................................... 329 

11.1.1 Filters Group Box ..................................................................... 330 
11.1.2 Events Sub-Tab Layout ........................................................... 330 
11.1.3 Buttons on Events Sub-Tab ..................................................... 332 
11.1.4 CMET Batch Mammogram Screening Dialog .......................... 336 
11.1.5 CMET Batch Pap Smear Dialog .............................................. 338 

11.2 Tracked Events Sub-Tab ........................................................... 340 
11.2.1 Filters Group Box (Tracked Events) ........................................ 341 
11.2.2 Tracked Events Sub-Tab Layout ............................................. 341 
11.2.3 Buttons on Tracked Events Sub-Tab ....................................... 343 

11.3 Follow-up Events Sub-Tab ........................................................ 345 
11.3.1 Filters Group Box (Follow-up Events) ...................................... 347 
11.3.2 Follow-up Events Sub-Tab Layout ........................................... 347 
11.3.3 Buttons on Follow-up Events Sub-Tab .................................... 348 

11.4 Menus on the CMET Tab ........................................................... 348 
11.4.1 File Menu ................................................................................. 348 
11.4.2 Tools Menu .............................................................................. 348 
11.4.3 View Menu ............................................................................... 348 

12.0 Notifications .......................................................................................... 349 
12.1 iCare Notifications Window ........................................................ 349 
12.2 iCare Notifications Toolbar Buttons ........................................... 349 

12.2.1 Select All.................................................................................. 350 
12.2.2 Delete ...................................................................................... 350 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Table of Contents 
August 2011 

xi 

12.3 iCare Notifications Menus .......................................................... 350 

13.0 Nat’l Measures ...................................................................................... 351 
13.1 Nat’l Measures Layout ............................................................... 351 
13.2 Nat’l Measures Toolbar .............................................................. 352 

13.2.1 Background Jobs ..................................................................... 352 
13.2.2 Graph It! Button ....................................................................... 352 

13.3 Nat’l Measures Menus ............................................................... 353 
13.3.1 File Menu ................................................................................. 353 
13.3.2 Edit Menu ................................................................................ 354 
13.3.3 Tools Menu .............................................................................. 354 

14.0 Meaningful Use ..................................................................................... 355 
14.1 Meaningful Use Layout .............................................................. 355 

14.1.1 Providers Performance ............................................................ 356 
14.1.2 Hospitals/CAHs Performance .................................................. 356 
14.1.3 Providers CQ (Clinical Quality) ................................................ 357 
14.1.4 Hospitals/CAHs CQ (Clinical Quality) ...................................... 358 

14.2 Meaningful Use Toolbar ............................................................. 360 
14.3 Meaningful Use Menus .............................................................. 360 

14.3.1 File Menu ................................................................................. 360 
14.3.2 Edit Menu ................................................................................ 361 
14.3.3 Tools Menu .............................................................................. 361 

15.0 HIV/AIDS Management Guide .............................................................. 362 
15.1 Introduction ................................................................................ 362 
15.2 Key Functional Features ............................................................ 363 
15.3 Using the HIV/AIDS Glossary .................................................... 363 
15.4 Taxonomy Management ............................................................ 364 

15.4.1 What is a Taxonomy ................................................................ 364 
15.4.2 Taxonomy Nomenclature......................................................... 365 
15.4.3 Software-Defined (Hard-coded) Taxonomies .......................... 365 
15.4.4 Site Populated Taxonomies ..................................................... 366 

15.5 ARV/HAART Definitions ............................................................ 428 
15.6 Medication Categorization for Taxonomy Setup ........................ 428 

Glossary ........................................................................................................... 479 

Acronym List ................................................................................................... 482 

Contact Information ........................................................................................ 483 
 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Introduction 
August 2011 

1 

1.0 Introduction 
iCare is a Windows-based, client-server graphical user interface (GUI) to the IHS 
Resource and Patient Management System (RPMS). iCare retrieves key patient 
information from various components of the RPMS database and brings it together 
under a single, user-friendly interface. iCare is intended to help providers manage the 
care of their patients. The ability to create multiple panels of patients with common 
characteristics (e.g., age, diagnosis, community) allows users to personalize the way 
they view patient data. 

The chapters included in the manual cover the main components of this system: 

Panel List: Content and Navigation (see Sections 2.1.1 and 6.0) 

Patient Panel (List): Content and Navigation (see Sections 2.1.2 and 9.0) 

Community Alerts: Content and Navigation (see Sections 2.1.1.3 and 8.0) 

Creating a New Panel: Step-by-Step Instructions (see Section 5.0) 

Patient Record: Content (see Sections 2.1.3 and 10.0) 

National Performance Measures (GPRA): Viewing and Changes Display (see 
Sections 9.5 and 10.8). 

CMET: Content and Navigation (see Sections 2.1.1.4 and 11.0). 

Site level National Measures (GPRA): Viewing, Layout options and Graphing (see 
Section 13.0). 

Meaningful Use: Provider and Hospital Performance Measures, Provider Clinical 
Quality Measures (see Section 14.0). 

1.1 Background 
Along with the rest of the healthcare industry, IHS has already developed a set of 
chronic condition management (or register) applications, including Diabetes, Asthma, 
and HIV. This type of application provides a way for healthcare providers to manage 
a specific group (register) of patients for a single disease state. Register management 
applications assist healthcare providers to identify high-risk patients, proactively track 
care reminders and health status of individuals or populations, provide more 
standardized and appropriate care by embedding evidence-based guidelines, and 
report outcomes. 
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Many patients, however, have more than one diagnosed disease. For instance, at the 
current time within the Indian Health system, a diabetic, asthmatic woman could be a 
member of four RPMS registers (diabetes, asthma, women’s health, and 
immunizations). This ‘silo’ approach to patient care could potentially result in 
fragmented care, and could increase the risk of inadequate patient care management 
due to misidentification of the true level of risk. 

1.2 iCare Graphical User Interface 
The iCare GUI is intended to allow providers to see a more complete view of patients 
with multiple conditions, while maintaining the integrity of the user-defined disease-
specific registers. 

iCare can help IHS providers by: 

Proactively identifying and managing different groups (populations) of patients who 
share user-defined characteristics. 

Providing an integrated view of a patient’s conditions that would minimize “stove 
piped” care management. 

Providing an intuitive and integrated interface to the diverse patient data elements of 
the RPMS database. 

Facilitating providers a review of clinical quality of care measures for their own 
patients to enable improvement in the quality of healthcare delivery. 

Enabling views of traditional healthcare information from the perspectives of 
community, population, and public health. 

1.3 Who Should Use iCare? 
Any provider who needs to identify a group of patients for long-term management or 
to create a temporary list should think about using iCare. Do you fit any of the 
following scenarios? 

I am a nurse at a facility that assigns a primary care provider to each patient. Every 
day, I want to create a list of scheduled patients for two different doctors in my clinic. 

I want to identify which of my patients are considered obese so I can recommend 
nutrition counseling. 

Because providers at our clinic have performance goals related to annual GPRA 
clinical measures, I want to identify which of my patients are missing key clinical 
data. 
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Our Women’s Health clinic wants to focus on two clinical performance improvement 
initiatives this year. We want to identify the performance problem areas for female 
patients between ages 18 and 50. 

I am one of two part-time case managers for a group of children, and I want to create 
a patient list that we both can use. 

I am a site manager working to ensure our site meets Meaningful Use objectives. 

1.4 Current Features of Version 2.2 
The following describes the current features of Version 2.2. 

Meaningful Use Tab: This tab will display Meaningful Use provider, 
hospitals/critical access hospitals (CAHs) performance and Clinical Quality 
measures. These measures utilize the BJPC v2.0.6 and CRS v11.0.2 releases to 
display measures for up to 100 providers in a user friendly graphic user interface. The 
tabs displayed are: 

1. Provider Performance tab displays performance measures based on the BJPC 
v2.0.6 to enable both providers and site managers to quickly view measures and 
compare with peers. 

2. Hospital/CAHS Performance tab displays summary of hospital and critical access 
hospital measures. 

3. Provider CQ tab displays Clinical Quality measures based on the CRS v11.0.2 
release. 

Miscellaneous Enhancements: Version 2.2 provides the following enhancements: 

1. User Preferences expanded to include choices for Meaningful Use Layouts and 
start up views 

2. Display of Suicide Form tab within the patient view 

Additional Information 

For more information about the RPMS iCare applications please visit the iCare 
website: http://www.ihs.gov/CIO/CA/icare/ 

For user support please contact the RPMS help desk (see last page of this manual). 

1.5 User Desktop (Client) Requirements 
iCare software resides on both your facility’s RPMS server and on the desktop 
computer that you use. In order to use iCare successfully, your computer should have 
the following minimum configuration. 
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Client PC Minimum Version 
Microsoft Windows (Any Windows OS that 
supports .NET 2.0 Framework) 

Windows XP SP2, Windows 2003 Server, Windows 
2000 SP3+, Windows ME, Windows 98/98SE  

Microsoft .NET Framework V2.0 

Suggested Client PC Hardware Processor: Minimum: Pentium III 800MHz; Suggested: 
Pentium 4 2GHz+ 

Memory (RAM): Minimum: 256MB; 
Suggested: 512MB+ 

 

Approximate Disk Space Requirements iCare Application Footprint ~10MB 
.NET 2.0 Framework ~ 100MB (if not already 
installed via Windows Updates) 
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2.0 Orientation 
This section provides an overall look at the design and functions of the main screen 
elements of the iCare interface. 

The core concept of iCare version 2.0 is the patient panel. This panel is a list of 
patients that the user has defined, either manually by selecting individual patients or 
by using automated search definitions (see Section 5.0). 

Appendix C: Keyboard Navigation provides keyboard navigation on the views. This 
includes keyboard short-cuts to access the menus. 

2.1 iCare Windows Overview 
This section reviews the three main windows within iCare. 

The main window will display the namespace and RPMS Server Address. This aids 
those larges sites with multiple servers. The user can quickly review what server and 
namespace are being accessed. 

2.1.1 iCare Main Window 
The iCare Main window contains two lists, which can be displayed on separate tabs 
or viewed on a split screen (see Section 3.1.1.3) as well as a third list, known as 
Community Alerts and a fourth list known as CMET. 

2.1.1.1 About the Panel List 
The Panel List is displayed in columnar format. It contains a list of all the panels that 
have been defined by you or that have been shared with you by another user. See 
Section 6.0 for explanations of column data and the available toolbar icons. 

 
Figure 2-1: Sample Panel List 
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2.1.1.2 About the Flag List 
The Flag List is displayed in columnar format. It displays flags for any patient on any 
of the panels in the Panel List, including shared panels. See Section 7.0 for more 
information. 

 
Figure 2-2: Sample Panel List and Flag List in Split View 

2.1.1.3 About Community Alerts 
The Community Alerts view is displayed in columnar format. It contains alerts 
associated with the patient’s Community of Residence (COR). 

 
Figure 2-3: Sample Community Alerts View 

See Section 8.2 for more information about the buttons and other functionality of this 
view. 

2.1.1.4 About CMET 
The CMET view is displayed in three sub-tabs: Events, Tracked Events, and Follow-
up Events. 
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Figure 2-4: Sample CMET view 

See Section 11.0 for more information. 

2.1.2 About the iCare Panel View Window 
The Panel View displays a list of the patients in a particular panel. See Section 9.0 for 
explanations of column data and the available toolbar buttons. 

 
Figure 2-5: Sample Panel (Patient List) 
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2.1.3 About the iCare Patient Record Window 
The Patient Record window displays information about the selected patient from data 
stored in the RPMS database. See Section 10.0 for detailed information. 

 
Figure 2-6: Sample Patient Record window 

2.2 Key iCare Concepts 
This section discusses diagnostic tags, taxonomies, and national performance 
measures. 

2.2.1 Diagnostic Tags 
iCare provides a diagnostic tagging function that runs as a background process on 
your RPMS server and reviews all patient data. Tagging is a term that refers to 
running a series of logic algorithms on one or multiple patients that identifies (“tags”) 
them with one or more predefined diagnostic categories, listed below. The detailed 
logic for each of these diagnostic tags can be found in Appendix A. These definitions 
are defined nationally and are consistent with definitions used in the Clinical 
Reporting System (CRS) and RPMS disease-specific registers, such as Diabetes 
Management System. 

• Asthma 

• COPD 
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• Cardiovascular Disease (CVD) Known (CVD Kn) 

• CVC At Highest Risk (CVD AHR) 

• CVC At Significant Risk (CVD ASR) 

• CVD At Risk (CVD AR) 

• Diabetes (DM) 

• HIV/AIDS (HIV) 

• Hypertension (HTN) 

• Obese 

• Prediabetes/Metabolic Syndrome w/o DM (PreDM) 

• Current Smokers (Smoker) 
One patient might have multiple diagnostic categories, e.g., diabetes, asthma, and 
known cardiovascular disease (CVD). The overall purpose of the diagnostic “tag” is 
two-fold: (1) to enable iCare to quickly create a panel for a user based on the same 
categories and (2) to enable application of fully integrated healthcare reminders that 
reflect the prevention and treatment priorities for the full spectrum of a patient’s 
disease conditions. (NOTE: integrated reminders will not be available until a future 
phase of iCare.) 

In future versions of iCare, the “tag” will become a more formal concept. Appropriate 
users (providers) will be required to “accept” or “not accept” the iCare proposed tags; 
the accepted tags will be used to provide fully integrated reminders and provide 
access to existing case (register) management functions. It is anticipated that 
“accepted” diagnostic tags will eventually be incorporated into the Health Summary 
and other RPMS logic functions. 

2.2.2 Taxonomies 
RPMS clinical applications, including the Diabetes Management System, the Clinical 
Reporting System, the PCC Health Maintenance Reminders, and iCare contain logic 
(artificial intelligence) statements that compare and calculate various types of patient 
data to arrive at a conclusion. 

For example, in order for a Pap Smear Reminder to appear on the Health Summary, 
RPMS has to calculate the following about the patient: 

• Is the patient a woman? 

• If yes, does she fall into a certain age range? 

• If yes, was a pap smear ever performed? 

• If yes, what is the date of the most recent papa smear? 
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• If the most recent test is over a year ago, a reminder needs to appear 
To produce results with comparable data across every facility, the clinical definition 
of a “pap smear” has been defined nationally. Clinical definitions use RPMS 
taxonomies to contain the various elements of a definition. As much clinical logic as 
possible is based on standard national codes, including ICD, CPT, LOINC, NDC, and 
national IHS standard code sets (e.g., Health Factors, patient education codes, etc.). 
For terminology that is not standardized across each facility, such as lab tests or 
medications, RPMS uses taxonomies that can be populated by each individual facility 
with its own codes. 

For data elements like diagnoses, procedures, or lab tests identified by LOINC codes, 
the taxonomy simply identifies the standard codes that a software program should 
look for. These codes are hard-coded by the programmer into several software-
defined taxonomies that are distributed with the RPMS software that uses those 
taxonomies. These taxonomies can only be updated by the software programmer at 
the direction of a national clinical logic review process. 

Site-populated taxonomies are used to mitigate the variations in terminology for 
other types of data elements that vary from one facility to another, including 
medications and lab tests. This means, for example, that one site’s Pap smear data can 
be compared to another site, even though the same term is not used for the Pap smear 
lab test. Or, one site’s beta-blocker data can be compared to another site, even though 
the same names are not used for beta-blocker drugs. 

For example, one site’s Lab table might contain the term Glucose Test while another 
site’s table might contain the term Glucose for the same test. PCC programs have no 
means for dealing with variations in spelling, spacing, and punctuation. Rather than 
attempting to find all potential spellings of a particular lab test, the application would 
look for a pre-defined taxonomy name that is installed at every facility. The contents 
of the taxonomy are determined by the facility. In this example, the application would 
use the “DM AUDIT GLUCOSE TESTS TAXONOMY.” The individual facility will 
enter all varieties of spelling and punctuation for Glucose Tests used at that particular 
facility. 

2.2.3 National Performance Measures 
Performance assessment measures what an organization does and how well it does it. 
For a healthcare organization, such as the Indian Health Service, this means 
measuring how well we deliver healthcare services to our population, measured by 
documentable improvement in various standard health measures. Standardized 
clinical performance measures provide a systematic approach to health improvement 
for our organization. Results from performance assessment are used internally within 
the IHS, at national and local levels, to support and guide performance improvement 
in those clinical areas that need it. 
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Additionally, the Government Performance and Results Act (GPRA) requires federal 
agencies to report annually to Congress on how the agency measured up against the 
performance targets set in its annual Plan. IHS GPRA measures include measures for 
clinical prevention and treatment, quality of care, infrastructure, and administrative 
efficiency functions. The RPMS Clinical Reporting System (CRS) is the reporting 
tool used by the IHS Office of Planning and Evaluation to collect and report clinical 
performance results annually to the Department of Health and Human Services 
(DHHS) and to Congress. 

2.2.3.1 Clinical Reporting System (CRS) 
The Clinical Reporting System (CRS) is an RPMS software application designed for 
national reporting as well as for local and Area monitoring of clinical GPRA and 
developmental measures. CRS was first released for FY 2002 performance measures 
(as GPRA+) and is based on a design by the Aberdeen Area (GPRA2000). 

Each year, an updated version of CRS software is released to reflect changes in the 
logic descriptions of the different denominators and numerators. Additional 
performance measures might also be added. Local facilities can run reports as often as 
they want to and can also use CRS to transmit data to their Area. The Area Office can 
use CRS to produce an aggregated Area report for either annual GPRA or Area 
Director Performance reports. 

2.2.3.2 Performance Measures Displayed in iCare 
iCare uses exactly the same logic as the Clinical Reporting System to display results 
for national performance measures. Results can be seen for a panel of patients or for 
an individual patient. See Section 9.4.3 for more detailed explanations of the 
available panel view and see Section 10.7. 

2.2.3.3 Reminders Displayed in iCare 
The Reminders view is similar to the National Measures view. The values in the 
individual reminders columns will be the due date of the test/procedure. Active 
reminders are reminders that are “turned on” at the site. See Section 9.3 for more 
information. 

The patient panel has a separate Reminders Aggregate view that displays aggregate 
reminders performance data for the panel population for all national health 
maintenance reminders that are active at the site. See Section 9.4 for more 
information. 
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3.0 Getting Started 
This section describes the process for your first access to the iCare system and how to 
change your user preferences. 

3.1 Your First Login 
Before you begin your first login, make sure the iCare software has been loaded on 
your computer desktop and that the iCare shortcut is available. If the shortcut is not 
there, see your Site Manager. 

You will need the following information from your Site Manager: the IP address and 
the port number of your facility’s RPMS server. 

You will need to complete three activities at your first login: 

• the RPMS server address information 

• the RPMS login information 

• the user preferences wizard 
Follow these steps to complete your first login: 

1. Double-click the iCare shortcut on your Windows desktop to display the RPMS 
Server Address dialog. 

 
Figure 3-1: Sample RPMS Server Address Dialog 

This dialog generally only displays when you first login; iCare will remember 
your server information. 
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RPMS Server Address: Type the number, including punctuation, of the server’s 
IP address. An IP address is typically four groups of two or three numbers, 
separated by a period (.), e.g., 161.223.99.999. Your Site Manager will provide 
this information. 

Server Port: Type the number of the server port. Your Site Manager will provide 
this information. 

Server Namespace: If your site has multiple databases on one server, you will 
additionally need to type the namespace, which is typically a text string, e.g., 
DEVEH. 

2. Click OK. 

If the server address or port is incorrect, an error message will display. 

 
Figure 3-2: Error Message for Incorrect Server Address 

Click Retry and enter the correct information. (Otherwise, click Cancel to leave 
the login process.) 

3. The RPMS Login dialog will display. 

 
Figure 3-3: RPMS Login Information 

Type your RPMS access and verify codes. These are the same access and verify 
codes that you would use to open any RPMS session. 

4. Click OK to continue. (Otherwise, click Cancel to dismiss the RPMS Login 
dialog.) 
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If you typed your access and verify codes incorrectly, the application will display 
the “Unable to connect to RPMS. Not a valid ACCESS CODE/VERIFY CODE pair” error 
message. Click Retry to reenter your access and verify codes. (Otherwise, click 
Cancel to leave the login process.) 

3.1.1 User Preferences Wizard 
The first time you log in to iCare, the application will guide you through a Wizard for 
specifying your initial User Preferences. Once you have finished with this brief IHS 
iCare Preferences Setup Wizard and clicked OK, the application will display its initial 
view. 

Any user preference that you set now can be modified at any time by selecting Tools | 
User Preferences to display the User Preferences window. See Section 3.2 for more 
information. 

 
Figure 3-4: Introduction tab on Wizard 

Follow these steps to complete the wizard: 

1. The Introduction tab provides basic information about your user preferences. 
Click Next. 

2. On the Define My Patients tab you select one or more provider types to identify 
who “belongs” to your panel. See Section 3.1.1.1 for information about using this 
tab. 

Click Next to continue. 

Note: You can click the Back button at any time to return to the 
previous window. Likewise, you can click the Next button 
to move to the next tab in the wizard. 
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3. On the Flag Setup tab, you select the flag types you want displayed and their 
associated time frames. See Section 3.1.1.2 for more information. 

Click Next to continue. 

4. On the Startup View tab, you select the type of screen you want to appear when 
you login to iCare. See Section 3.1.1.3 for descriptions of each of the screen 
option. 

5. Click Finish. 

If you selected a provider type definition in the Define My Patients tab, iCare will 
automatically create a default patient panel (list) titled “My Patients” and will 
display the main Panel List view with the My Patients panel listed. 

 
Figure 3-5: Sample Panel List with Default My Patients Panel 

Otherwise, an empty Panel List view will be displayed. 

3.1.1.1 Define My Patients Tab 
“My Patients” is a way to easily identify a group of patients assigned to you as a 
provider. Selecting a “My Patients” definition when you first log in will cause iCare 
to create a default My Patients panel. 

Select the definition that best describes your patient assignment. NOTE: Many users 
do not have patients assigned to them and will choose “No Provider Selected.” This 
will not negatively affect your ability to fully use the iCare application. 

You can select your own name (the default) or set up a definition for another provider 
(surrogate) by selecting the other name. 
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Figure 3-6: Define My Patient tab on Wizard 

For example, if your site empanels patients (assigns each patient to a specific primary 
care provider), you would use the DPCP (Designated Primary Care Provider) 
provider type to create a core list of patients assigned to you. 

If your site does not use the DPCP designation, you might consider “your” patients to 
be anyone you saw at least twice in the past year as a primary provider. 

1. Check the “No Provider Selected” checkbox if you do NOT want to define 
patients by selecting any provider. If this is the option you use, then the default 
“My Patients” panel will NOT be created. 

The remaining fields will then be grayed out, i.e., not available. This means iCare 
will NOT create the default “My Patient” panel. You can later change the User 
Preferences to a provider and create panels based on “My Patients” definition. 

OR 

2. Select a provider name from the Provider drop-down list. The default name 
displayed will be the user’s name. All RPMS providers are available on the drop-
down list. 

3. Click the appropriate checkboxes to select one or more Provider Types from the 
list. See the Provider Definitions below for more information about the provider 
types. This applies to the name selected in the Provider field. 

4. If you checked either Primary Visit Provider or Primary/Secondary Visit 
Provider, select both a minimum number of visits and a timeframe. 

Below are descriptions of the Provider Types. 
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DPCP (Designated Primary Care Provider): Sites can assign a primary care 
provider to an individual patient through the Patient file or by using the RPMS 
Designated Specialty Provider Management (DSPM) application. Selecting the 
DPCP option will provide a list of patients assigned to you, regardless of when 
their last visits were. 

Specialty Provider: Users are assigned as Specialty Providers to patients as 
defined in the Designated Specialty Provider Management (BDP) application. 
Selecting the Specialty Provider option activates the Specialty Type field. Click 
Edit to access the Add/Remove Specialty Provider Types dialog. 

 
Figure 3-7: Sample Add/Remove 

See Section 4.8 for more information about using this dialog. 

Primary Visit Provider: The provider name documented as the primary provider 
for a specific patient visit. Selecting this Provider Type also requires you to 
indicate the number of visits and a timeframe. For example, you might consider 
“your” patients to be anyone you have seen as a primary provider at least three 
times in the past two years; you would select three visits and two years. The 
default value is twice in the past year. 

Primary/Secondary Visit Provider: The provider name documented as either 
the primary or secondary provider for a specific patient visit. Selecting this 
Provider Type also requires you to indicate the number of visits and a timeframe. 
For example, you might consider “your” patients to be anyone you have seen at 
least three times in the past two years; you would select three visits and two years. 
The default value is twice in the past year. 

Below are descriptions of Minimum Visits and Timeframes. 

Minimum Visits: You can select the minimum number of visits used in 
combination with a time frame to define whether a patient “belongs” to a 
provider, e.g., two visits in the past year. Values are 1 through 9; the default 
value is 2. The Minimum Visits option is used with Provider Types “Primary 
Visit” and “Primary/Secondary Visit” only. 
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Minimum Visit Timeframe: You can select a timeframe to be used in 
combination with the minimum number of visits to define whether a patient 
“belongs” to a provider, e.g., 2 visits in the past year. The Minimum Visit 
Timeframe option is used with Provider Types “Primary Visit Provider” and 
“Primary/Secondary Visit Provider” only. Values are: Last 3 months; Last 6 
months; Last year; Last 2 years. 

3.1.1.2 Flag Setup Tab 
Flags are critical, usually time-sensitive, information points related to a patient that 
might affect diagnosis or care. The default is to display all flag types for the past 30 
days. 

Currently, four flag types are available in iCare: 

• Abnormal Labs 

• ER Visits 

• Unanticipated ER Returns 

• Hospital Admissions 
The user defines which flags, if any, are displayed by selecting or de-selecting from 
the available flag types. The timeframe for the display is calculated from the visit date 
of the flag event. 

Flags are identified in the background job on a routine basis. This screen allows you 
to select which of the flags you would like to see displayed. Electing to "turn off" one 
or more of the flag displays does NOT turn off the background job for the site. 

Changing flag types on the User Preference window will change the flag display for 
all panels. If all flags are de-selected, “none” is the implied value. 
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Figure 3-8: Flag Setup tab on Wizard 

The default Timeframe is 1 month for all flag types. 

Abnormal Labs: This flag type informs the user when a patient has abnormal lab 
values within a user-defined time frame based on the RPMS Lab application and 
Kernel Alerts component. If your site is not running either of these applications, 
you will not see any alerts. 

ER Visits: This flag type informs the user when a patient has an emergency room 
visit within a user-defined time frame. ER visits are defined only as clinic code 30 
Emergency Medicine for any visit and does NOT include clinic code 80 Urgent 
Care. 

Unanticipated ER Returns: This flag type informs the user when a patient has 
an emergency room visit designated as “unanticipated” by the RPMS Emergency 
Room System software within a user-defined time frame. 

Hospital Admissions: This flag type informs the user when a patient has a 
hospital visit within a user-defined time frame. 

Timeframe: for each Flag Type, you can select the number of days after the 
initial flag event that the flag should be displayed, e.g., Abnormal Lab flags 
should display for 30 days. Values are 1 week, 2 weeks, 1 month (30 days), 2 
months (60 days), and 6 months. 

3.1.1.3 Comm Alert Setup 
Use the Comm Alert Setup to specify which community alerts to display. 
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Figure 3-9: Sample Comm Alert Setup tab on the Wizard 

See Section 3.2.3 for more information. 

3.1.1.4 Startup View 
The Startup view determines what window will be displayed when you login to iCare. 
The default selection is the Split view that displays both the Panel List and the Flag 
List. 

 
Figure 3-10: Startup View tab on Wizard 

Panel List: shows the list of panels that you created or that have been shared with 
you by other users. 

Flag List: shows a list of patients who are members of your panel(s) and who have 
one or more of your defined flags. 
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Community Alerts: shows the current community alerts. 

National Measures: shows the IHS national clinical performance measures as 
defined and reported in the RPMS Clinical Reporting System (CRS). 

CMET: shows the CMET tab on the main iCare window. A second field displays 
where you a sub-tab from the drop-down list (required). The default is Events. 

Split View: is a combination of the Panel List and another view, side-by-side. The 
default is Panel List and Flag List. 

 
Figure 3-11: Options for Split View 

If you select Panel List and CMET, a second drop-down list displays (required). On 
this second list, you can select Events, Tracked Events, or Follow-up Events; this 
determines the default sub-tab when you select the CMET tab. The default is Events. 

If you select Panel List and Meaningful Use, a second drop-down displays (required). 
On this second list, you can select Providers or Hospitals/CAHs. The default is 
Providers. 

Panel View: allows you to select a specific panel (from the drop-down list) to be your 
default view. This panel displays on top of the main iCare window. 

3.1.2 Completing the User Preferences Wizard 
Click Finish on the User Preferences wizard to close the dialog and to access the 
iCare application. 

3.2 Modifying Your User Preferences 
You can access and modify your user preferences at any time by selecting Tools | 
User Preferences to display the User Preferences window. 
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Figure 3-12: Sample User Preferences Window for Modifying Preferences 

After the User Preferences window is complete, click OK to save the changes 
(otherwise, click Cancel). 

Note: Changing the “My Patients” definition can affect the 
content of any panel you have created that uses this 
definition. 

When a new version of iCare has been loaded to your server, the application displays 
the New Version of iCare dialog. 

 
Figure 3-13: New Version of iCare dialog 

Use the buttons in the following manner: 

• Click the “No Change” button to keep your current user preferences. 

• Click the “Edit My User Preferences Now” button to access the User Preferences 
window (where you can change your user preferences). 

• Click the “Remind Me Next Time” to have the application remind you the next 
time you access the iCare application. 
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3.2.1 Modifying “My Patients” Definition and Associated Panels 
If you change the definition of “My Patients” on the User Preferences window, you 
also might want to update the content of previous panels that were based on the “My 
Patients” definition. See Section 5.3.2. 

3.2.1.1 Automatic Panel Repopulation 
You can repopulate any of your panels that are based on the “My Patients” definition. 

If only one panel exists based on “My Patients,” the warning message “Immediately 
repopulate the ‘My Patients’ panel in the Background?” will display. 

Click OK to update the list of patients in your My Patients panel to the new “My 
Patients” definition. 

OR 

Click Cancel to maintain the current list with the old definition. 

If more than one panel exists based on “My Patients,” you can select all or some of 
the panels to be updated. 

 
Figure 3-14: Sample Repopulate "My Patients" Panels 

1. Highlight one or more of any panel you want updated from the Available Panels 
on the left. 

2. Click the Add button. The selected panels will move to the Repopulate area on the 
right. 

3. Click OK to repopulate the selected panels. (Otherwise, click Cancel to maintain 
all panels with their previous definitions.) 

3.2.1.2 Manual Panel Repopulation 
You can manually repopulate panels after changing the “My Patients” definition. 
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1. From the Panel List, highlight the panel name. 

2. Click the Repopulate button. The panel has been updated once the “clock” icon to 
the left of the name disappears. The Last Updated date and time will change. 

 
Figure 3-15: Example of Using the Repopulate Button from the Panel List 

If more than one panel exists based on “My Patients,” you can select all or some of 
the panels to be updated. 

3.2.2 Flag Setup 
This tab has the same fields as those on the Flag Setup tab during your first login. See 
Section 3.1.1.2 for more information about this tab. This tab allows you to customize 
the flag that you want displayed. 

3.2.3 Comm Alert Setup Tab 
You use the Comm Alert Setup tab to specify which community alerts to display. 

 
Figure 3-16: Comm Alert Setup Tab on User Preferences Window 

Every diagnosis that triggers a Community Alert is placed into one of three 
categories: Mandatory; Recommended; Optional. This categorization allows for the 
customization of the Community Alert display in iCare. 

The Community Alerts glossary provides a list of diseases that occur in each of these 
categories. To view this glossary, select Help | Community Alerts Glossary. 
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Mandatory Community Alerts are considered to be universally critical and will 
display for all users. They cannot be ‘turned off’.  

Recommended Community Alerts are considered to be universally significant so 
they are included in the default display; however, you can choose to remove them 
from the display. 

Optional Community Alerts are not included in the default display; however, you 
can choose to add them to the display. 

 
Figure 3-17: Recommended Categories 

You can change the On/Off column. If the checkbox contains a check mark, then the 
recommended diagnosis will display on the Community Alert. To change from On to 
Off, select the appropriate check box. 

You can filter any column and resize it. See Section 4.1 for more information. 

When you have finished the Comm Alert Setup tab, click OK. (Otherwise, click 
Cancel to exit the User Preferences window.) 

3.2.4 Startup View 
This tab has the same fields as those on the Flag Setup tab during your first login. See 
Section 3.1.1.3 for more information. This tab allows you to select the view that 
should be presented initially when you open the iCare application. 

3.2.5 Patient View 
You use the Patient View tab to specify the default tab (the tab on top) when you 
view a Patient Record window. For example, you might choose to have the patient 
view open directly to the Snapshot tab as opposed to the Cover Sheet, etc. 

In addition you need to define the default clinic for creating TIU documents and 
adding chart reviews through iCare. 
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Figure 3-18: Patient View Tab on User Preferences window 

Startup Tab: The default tab is the Cover Sheet as the startup tab for the Patient 
Record window. If you want to change to a different tab, select one from the drop-
down list (lists the primary tabs that are on the patient view window). 

View Set: Determine the view size and clicking either the Normal or Maximized 
radio button (the default is Normal). 

Followup Letter Clinic Location: Select a clinic code from the drop-down list for 
TIU documents. 

Telephone Call Clinic Location: Select a clinic code from the drop-down list for 
telephone calls. 

Chart Review Clinic Location: Select a clinic code from the drop-down list for chart 
reviews. 

3.2.6 Layouts Tab 
You use the Layouts tab to determine the default template for the layout of various 
windows in iCare.  
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Figure 3-19: Sample Layout Tab on User Preferences Window 

You can use the defaults for the layouts when creating a panel instead of using the 
system generated default. 

The Layouts tab is not available in the initial Startup Wizard. 

See Section 4.19 for more information about each window displayed when you click 
Edit on the user preferences window. 

3.2.7 CMET Tab 
You use the CMET tab to determine the filters for Events, Tracked, and Follow-up 
Events sub-tabs. 

 
Figure 3-20: Sample CMET Tab on User Preferences window 

After you change the settings on any of the three sub-tabs, click OK to save your 
changes (otherwise, click Cancel to not save). 
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These settings apply to the CMET tab on the following: the main iCare window, the 
Panel View, and the Patient Record window. 

3.2.7.1 Return to System Default Button 
You can return to the system default setting by clicking the Return to System Default 
button. This button is available on all of the sub-tabs. 

3.2.7.2 Collapse Tips Display 
If you check the Collapse Tips Display check box, that means the Tips area of the 
particular sub-tab will be collapsed (you will not be able to view the text of the tips). 
This check box is available on all of the sub-tabs. 

3.2.7.3 Collapse Filters Display 
If you check the Collapse Filters Display check box, that means the Filter group box 
of the particular sub-tab will be collapsed (you will not be able to view the various 
filters). This check box is available on all of the sub-tabs. 

3.2.7.4 Events Sub-Tab 
The Events sub-tab displays all events that have been identified at your site in the 
routine background job. This can be a very large number of events, but you can limit 
this display by applying filters to your view. Filtering in this manner does NOT affect 
the routine background job. 

Use the Events sub-tab to establish the filters for the current events on the Events sub-
tab. 

 
Figure 3-21: Sample Events sub-tab 
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3.2.7.4.1 Category (Events) 
Use the Category field to filter the displayed events to those in one or more 
categories. To populate the Category field, click the Edit button to access the 
Add/Remove Events Category dialog. The default Category for the Events sub-tab is 
Breast, Cervical, Colon, Skeletal. 

 
Figure 3-22: Add/Remove Events Category dialog 

See Section 4.8 for more information about using the add/remove dialog. The 
selections that appear in the Current Selections group box are the selections that 
populate the Category field. 

3.2.7.4.2 Community (Events) 
You use the Community field to filter the displayed events to those in a community 
either by taxonomy or by name. 

 
Figure 3-23: Community filter fields 

Click one of the radio buttons that you want to use as a filter for the events. 

By Name Radio Button 

Use the By Name radio button to define the communities to filter the events. 

Use the field below the radio buttons to filter the communities in the lower field. The 
options are (1) With At Least One Patient or (2) All. 
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Use the Edit button to add one or more names to the lower field. Click the Edit button 
to access the Add/Remove Communities dialog. 

 
Figure 3-24: Sample Add/Remove Communities dialog 

See Section 4.8 for more information about using the add/remove dialog. When this 
dialog is complete, click OK (otherwise click Cancel). If you use OK, this populates 
the lower field with the names of the communities shown in the Current Selections 
group box on the add/remove dialog. 

If the lower field contains more than one community, this activates the Create 
Taxonomy button. To use the Create Taxonomy button, the user must have the iCare 
Editor (BQIZCMED) or iCare Package Manager (BQIZMGR) security key. 

 
Figure 3-25: Sample Community field with several communities 

Use the Create Taxonomy button to save the listed communities as a Community 
taxonomy. Click the Create Taxonomy button to display the Create/Update 
Community Taxonomy dialog. 
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Figure 3-26: Create/Update Community Taxonomy dialog 

Use the Community Taxonomy Name field (required) to specify a taxonomy name 
for the list of communities. Use the Brief Description and Extended Description fields 
(not required) to add other information about the taxonomy. When the dialog is 
complete, click OK (otherwise, click Cancel). 

If the user uses a duplicate taxonomy name to one created by that user, iCare will 
provide a warning that the user might be overwriting the user’s taxonomy. The user 
can overwrite (Yes), save as another name (No), or cancel (to return to the 
Create/Update Community Taxonomy dialog). 

If you use a unique taxonomy name, the application displays the “Confirm save to 
RPMS” information message that asks: The data will be saved to the RPMS server. Do 
you want to continue? Click Yes to save the data to the RPMS server (otherwise click 
No). If you use Yes, the application displays the Community Taxonomy Create 
message stating that the community taxonomy was successfully created and that the 
panel definition will be updated to reflect the use of a taxonomy rather than a list of 
communities. (Click OK to dismiss the message). After you click OK, the list of 
names will be replaced with the name of the taxonomy (and the By Taxonomy radio 
button will be selected). 

By Taxonomy Radio Button 

Use the By Taxonomy radio button to define the taxonomies to filter the displayed 
events. When you click the Edit button, the application displays the Add/Remove 
Community Taxonomies dialog. 
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Figure 3-27: Sample Add/Remove Community Taxonomies dialog 

See Section 4.8 for more information about using the add/remove dialog. When this 
dialog is complete, click OK (otherwise click Cancel). If you use OK, this populates 
the lower field with the names of the taxonomies shown in the Current Selections 
group box on the add/remove dialog. 

3.2.7.4.3 Status (Events) 
Use the Status field to filter the displayed events to those having a particular status. 
To populate the Status field, click the drop-down list and select an option: All, 
Pending, Not Tracked, Superseded, Tracked. The All option uses all of the statuses. 
The system default is Pending. 

3.2.7.4.4 Time Frame (Events) 
Use the Time Frame field to filter the displayed events to those in a particular time 
frame. To populate the Time Frame field, click the drop-down list and select an 
option. The system default is 1 year. 

3.2.7.5 Tracked Events Sub-Tab 
The Tracked Events sub-tab displays all of the events at your site that have been 
designated as “Tracked” by all CMET users. Because this can be a very large number 
of events you can limit this display by applying filters to your view. Filtering in this 
manner does NOT affect the routine background job. 

Use the Tracked Events sub-tab to establish the filters for the current events on the 
Tracked Events sub-tab. 
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Figure 3-28: Sample Tracked Events sub-tab 

3.2.7.5.1 Category (Tracked Events) 
You use the Category field to filter the displayed events to those in one or more 
categories. See Section 3.2.7.4.1 for more information about this field. The default 
Category for the Tracked Events sub-tab is Breast, Cervical, Colon, Skeletal. 

3.2.7.5.2 State (Tracked Events) 
Use the State field to filter the displayed events to those having a particular state. To 
populate the State field, click the drop-down list and select an option: All, Open, 
Closed. The All option uses both open and closed states. The system default is Open. 

3.2.7.5.3 Time Frame (Tracked Events) 
Use the Time Frame field to filter the displayed events to those in a particular time 
frame. To populate the Time Frame field, click the drop-down list and select an 
option. The system default is 1 year. 

3.2.7.5.4 Community (Tracked Events) 
Use the Community field to filter the displayed events to those in a community either 
by taxonomy or by name. See Section 3.2.7.4.2 for more information about this field. 

3.2.7.6 Follow-up Events Sub-Tab 
The Follow-up Events sub-tab displays all of the follow-up events at your site that 
have been generated by all CMET users. Because this can be a very large number of 
events you can limit this display by applying filters to your view. Filtering in this 
manner does NOT affect the routine background job. 

Use the Follow-up Events sub-tab to establish the filters for the current events on the 
Follow-up Events sub-tab. 
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Figure 3-29: Sample Follow-up Events sub-tab 

3.2.7.6.1 Category (Follow-up Events) 
Use the Category field to filter the displayed events to those in one or more 
categories. See Section 3.2.7.4.1for more information about this field. The default 
Category for the Follow-up Events sub-tab is Breast, Cervical, Colon, Skeletal. 

3.2.7.6.2 Time Frame (Follow-up Events) 
Use the Time Frame field to filter the displayed events to those in a particular time 
frame. To populate the Time Frame field, click the drop-down list and select an 
option. The system default is 6 months. 

3.2.7.6.3 Community (Follow-up Events) 
Use the Community field to filter the displayed events to those in a community either 
by taxonomy or by name. See Section 3.2.7.4.2 for more information about this field. 
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4.0 Using iCare Features 
Several iCare features are made available across multiple views and windows within 
the iCare application. Tools or features that are unique to a particular view are 
explained within the section that discusses that view. 

4.1 Working with Columns 
This section reviews how you can customize the view by manipulating the columns in 
a window. 

• Sorting 

• Changing Column Width 

• Moving Columns 

• Making Column First Column (on a panel window only) 

• Filtering 

4.1.1 Sorting 
You can sort a column by clicking on the column’s name. 

This changes the column’s heading to having a sort-by (arrow) image. 

 
Figure 4-1: Column Heading With Arrow Image 

Click the column’s heading again and the arrow changes direction. 

 
Figure 4-2: Column Heading With Arrow in Opposite Direction 

If you click another column’s name, the sort-by image disappears and the most 
recently-selected column contains the sort-by image. 

4.1.2 Changing Column Width 
You can modify the column widths displayed in iCare lists by selecting and dragging 
either of column’s left or right borders. 

To change the default column width, do the following: 

1. Move your pointer over either the left or right edge of the column’s header. The 
arrow will change into an icon. 
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Figure 4-3: Icon for Moving Column’s Edge 

2. Click and drag this icon to the left or right to resize the column’s width in that 
direction; release your mouse when you reach the desired new width. 

3. The other columns will adjust to the new “view” of the columns. 

4.1.3 Moving Columns 
You move a column from one position to another position by the drag-and-drop 
method, using your mouse. As you move from one place to another, a pair of red 
indicator arrows display above and below the column header row at that point. 

 
Figure 4-4: Red Arrow as You Move Column 

Release your mouse when you have the selected column in the new position. 

4.1.4 Freezing One or More Columns 
You can force a column to move to the far left and freeze in place. Then, as you scroll 
across your data, that column stays stationary in the first column position. In the 
views with a flag column, the pinned column moves to the second position and stays 
there as you scroll across your data. 

1. Click the stick pin  icon on the column (that will become the first column). 

2. The column becomes the first column and the stick pin changes ( ). 

3. As you move the horizontal bar across, the first column always displays. 

 
Figure 4-5: Example of First Column Always in View 

4. You can use the stick pin  icon on more than one column. The next selected 
column will position to the right of the previously frozen column(s). Those 
columns will remain stationary (at the beginning of the columns) as you move the 
horizontal bar. 
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5. You can “un-stick” the stick pin by clicking it. 

4.1.5 Filtering 
Filtering is a means by which you can display a sub-set of the current set of data. You 
can use the filters on more than one column. 

Click a column’s Filter  icon to display the options for that column from which to 
choose. The options include each of the values found in that column, as well as (All), 
(Custom), (Blanks), and (NonBlanks). 

 
Figure 4-6: Sample Filter Drop-Down List 

4.1.5.1 Creating a Filter 
Select (Custom) from the drop-down list to display the filter criteria dialog for the 
column. Using the custom filter allows you to filter using multiple criteria for the 
column. 

 
Figure 4-7: Sample Filter Criteria Dialog 

You will create the filter criteria statement on this dialog, using these guidelines. 

The Operator and Operand fields make up the condition for the statement. 
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Click the drop-down list for the Operator field to select the correct operator. These 
operators vary according to the column selected. 

 
Figure 4-8: Sample of Operators 

After selecting the correct operator, click the drop-down list for the Operand field (the 
operand is a value for the column you want to filter). Select the appropriate operand 
or type the value you want to use as a filter (the value does not need to be on the 
drop-down list). 

If you need a second condition, click the “Add a condition” button to add another row 
to the filter criteria statement. After selecting an operator (for the second condition), 
the “And” and “Or” radio buttons become active. 

• AND = Returns TRUE if all its arguments are TRUE; returns FALSE if one 
or more arguments are FALSE. This means that a record will be returned only 
if all the AND statements are true. 

• OR = Returns TRUE if any argument is TRUE; returns FALSE if all 
arguments are FALSE. This means that a record will be returned if any of the 
OR statements are true. 

If you need to remove one of the criteria statements, click the left-most box (of the 
row) to select it and click the “Delete Condition” button. 

When the filter criteria statement is complete, click OK. (Otherwise, click Cancel to 
dismiss the dialog.) 

The rows displayed will be limited to those that match the conditions in your 
statement. 
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The column’s Filter icon changes color ( ); this color change happens even if there 
was no apparent change to the rows displayed, because all records matched the 
specified conditions. 

EXAMPLE: Assume you want the patients born between two dates. You would filter 
based on the values in the DOB column (the Operand). The dialog could look like the 
following: 

 
Figure 4-9: Sample of Filter Dialog 

4.1.5.2 Returning to All Rows 
Generally you use this action after you have filtered the column. Click the Filter icon 
and select [All] from the drop-down list. The Filter icon changes to its original color (

) and all rows are restored to the display. 

TIP: If you wish to filter based on values in more than one column, use the custom 
feature and specify all the conditions at once. If you filter the columns separately, you 
will need to select [All] from the drop-down lists on each filtered column to restore 
all rows. 

4.1.5.3 Other Filter Choices 
If you want to view all the rows where the value is blank for a particular column, 
select (Blank) from that column’s filter drop-down list. 

If you want to view all the rows that are not blank for a column, select (NonBlank) 
from the filter drop-down list. 
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4.2 Selecting Records 
You select records on a window by clicking in the row selector column. If you do not 
click in this particular column, then it might appear that you cannot select more the 
one record. 

Below is any example of where the row selector column is located: 

 
Figure 4-10: Example of Row Selector Column 

• To select adjacent records, click the first record (in the row selector column), 
hold down the Shift key, and then click the last record (in the row selector 
column). 

• To select non-adjacent records, click the first record (in the row selector 
column), hold down the Ctrl key, click the next record (in the row selector 
column), etc. 

• To select all records, use the key combination Ctrl+A on your keyboard (or 
select Edit | Select All). 

• To de-select a row, use the key combination Ctrl+click on the Row Selector 
column. 

4.3 Menus 
Each type of iCare window (iCare Main, Panel View, CMET, and Patient Record) has 
a Menu bar. These windows have the following Menu options in common: File, Edit, 
Tools, Window, and Help. 

The following provides information about the Edit, Window, and Help menus. These 
menus are common to all of the iCare windows. 

4.3.1 Edit Menu 

 
Figure 4-11: Edit Menu 

Select All: Use this option to select all of the records. This is the same as using the 
key combination Ctrl+A on your keyboard. 
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Deselect All: Use this option to deselect all of the records currently selected. 

4.3.2 Window Menu 
The options on the Window menu display the windows that are currently open in the 
iCare application. Click on the name to move to that window. 

 
Figure 4-12: Sample Window Menu Options 

4.3.3 Help Menu 

 
Figure 4-13: Options on Help Menu 

iCare Help: use this option to go to the online help system. 

Best Practice Prompts Glossary: use this option to display information (name, 
default status, denominator, definition of clinical group) about best practice prompts 
for the several clinical groups. 

Care Mgmt Glossaries: expand this option to display the glossaries available for the 
Care Management: Asthma and HIV/AIDS. 

Community Alerts Glossary: use this option to display the information about the 
community alerts: purpose of a community alert, notice that alerts are not linked to an 
individual patient, categories of diagnosis that triggers the alert, how to customize the 
Community Alert display, and list of diseases/conditions and associated codes that 
trigger Community Alerts in iCare. 

Diagnostic Tag Glossary: use this option to display the detailed logic for each 
national performance measure defined in the Clinical Report System. 
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Natl Measures Glossary: use this option to display the detailed logic for each 
national performance measure defined in the Clinical Reporting System. 

Reminders Glossary: use this option to display the Reminder descriptions (from 
RPMS). 

CMET Glossary: use this option to display information about CMET data. 

About iCare: use this option to view the version number of the iCare application. 

4.4 Quick Patient Search 
All iCare views have a Quick Patient Search field located on the upper right side of 
the screen to assist you in quickly finding a patient and displaying the Patient Record. 

 
Figure 4-14: Quick Patient Search Field 

Type the patient’s last name, HRN, SSN, or the Date of Birth. Then click the arrow 
 button. 

Quick Patient Search is context-sensitive to the view the user is in. 

• iCare Main: searches the RPMS database. If it finds more than one 
record, it displays the Quick Patient Search dialog. Otherwise, it opens the 
Patient Record. 

• Panel View: first searches the open panel and highlights any matches. If 
no matches are found, you are asked if you want to search the RPMS 
database. 

• Patient Record: searches the RPMS database. If it finds more than one 
record, it displays the Quick Patient Search dialog. Otherwise, it opens the 
Patient Record. 

If you enter the patient name, HRN, or Date of Birth, iCare first searches the open 
panel then the RPMS patients for any matching results. See Section 4.4.1 for more 
information below. 

If you enter the SSN, iCare searches the RPMS patients for any matching results. See 
Section 4.4.3 for more information. 

4.4.1 Find Patients in Open Panel 
When the system searches for the last name, HRN, or Date of Birth and finds one in 
the open panel, it highlights the first record containing the name in the open panel and 
displays the Quick Patient Search (within Panel) dialog. 
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Figure 4-15: Sample Panel Quick Search Dialog 

The Find What field contains the characters used in the search. You can change 
these characters any time before clicking the Find Next button. 

Check the Match Case checkbox if you want the search to match the case of the 
characters in the Find What field. 

If there is more than one patient that matches your entry in the open panel, click Find 
Next to move to the next patient. 

The fields below the “Show Additional Search Options” checkbox display the 
additional criteria fields you can use in the search. See Section 4.4.2 for more 
information. 

If you uncheck the “Show Additional Search Options” checkbox, the additional 
search criteria fields are removed from the dialog. When you click Find Next, it will 
search all columns. 

You use the Search All RPMS button to search the RPMS database for the patient 
name. 

4.4.2 Search Criteria Fields 
The following information provides information about the fields below the Show 
Additional Search Options checkbox. You can change any of these fields. 

4.4.2.1 Look In Field 
Click the drop-down list for the Look In field on the Quick Patient Search (within the 
Panel) dialog to view the options for that field. The highlighted option determines 
what part of the window to search. 
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Figure 4-16: Sample Drop-Down List Options for Look In Field 

What you have highlighted in the upper part of the list determines the options in the 
lower part of the list. For example, if Look In field contained All columns, then the 
list of the column names would appear in the lower part of the drop-down list. 

4.4.2.2 Match Field 
Click the drop-down list for the Match field on the Quick Patient Search (within 
Panel) dialog to view the options for that field. The highlighted option determines 
what part of the Find What field will be matched in the search. 

 
Figure 4-174-18: Sample Drop-Down List Options for Match Field 

4.4.2.3 Search Field 
Click the drop-down list for the Search field on the Quick Patient Search (within 
Panel) dialog to view the options for that field. The highlighted option determines the 
direction of the search. 

 
Figure 4-19: Sample Drop-Down List Options for Search Field 

4.4.2.4 Completing the Search 
After all fields are populated with the search criteria, click the Find Next button. 

If a match is found, the matching text will be highlighted on the open panel. If you 
want to continue the same search, click the Find Next button again (on the “Quick 
Patient Search (within Panel)” dialog); repeat this process as needed. 

• When you find the patient name that you want to use, highlight it (on the open 
panel) and click Cancel to dismiss the “Quick Patient Search (within Panel)” 
dialog. Then double-click the highlighted record to display the Patient Record. 
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• If a match is not found, the system displays a warning message that asks you 
if you want to search the RPMS database. See Section 4.4.2.6 for more 
information. 

4.4.2.5 Search All RPMS Button 
If you want to search the RPMS database for the patient name, click the Search All 
RPMS button to display the Quick Patient Search dialog. See Section 4.4 for more 
information. 

4.4.2.6 No Patients in Open Panel 
When the system searches for the last name in the open panel and DOES NOT find 
one, it displays the “No matching patients were found within this panel, would you 
like to search all of RPMS?” warning message. 

• Click No to cancel the search process. 

• Click Yes to have the system go to RPMS to find the patient name. See 
Section 4.4.3 for more information. 

4.4.3 Find Patients in RPMS Database 
iCare searches the RPMS patients for any matching results in the following situations: 

• If you entered the SSN on Quick Patient Search field 

• If you use the Quick Patient Search field on the Flag List, Panel List, or 
Patient Record window 

• If the system found no patients in the open panel and you asked the system to 
search all of the RPMS 

If the search finds only one patient name that matches the search in the RPMS 
database, the system opens the Patient Record window. 

If the search finds more than one patient name, it displays the Quick Patient Search 
dialog. See Section 4.4.3.1 for more information. 

If the search finds no patient names, it displays a message. See Section 4.4.3.2 for 
more information. 

4.4.3.1 Quick Patient Search Dialog 
If the system searches the RPMS database and finds more than one record, it displays 
the Quick Patient Search dialog and highlights the first record containing the 
characters in the Quick Patient Search field; these characters are displayed in the 
Search field of the dialog. 
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Figure 4-20: Sample Quick Patient Search dialog 

You can refine your search by entering more or different characters in the Search 
field (if you cannot immediately find the patient’s name). After you have finished 
entering your new search criteria, click Find. This should reduce the number of 
records in the Quick Patient Search dialog. 

When you find the patient’s name, highlight it and click Select to display the Patient 
Record window. (Otherwise, click Cancel to exit the search process.) 

4.4.3.2 No Records Found in RPMS Database 
If no records are retrieved from the search in the RPMS database, the “No matching 
patients were found” message displays. 

Click OK on the message and you return to the Quick Patient Search dialog where 
you can modify your search. See Section 4.4 for more information. 

4.5 Buttons on Right Side of Window 
The buttons on the right side of any iCare window have the same functionality on any 
window. 

 
Figure 4-21: Buttons on Right Side of Window 

These buttons might not be visible; in that case, click the drop-down list  button. 
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The application provides hover help for each button. 

Some window might have the mail merge and glossary button. 

4.5.1 Reset View 

Click the Reset View  button (or select Tools | Reset View) to return the current 
view to the default view. You use this feature when you change the view, such as 
resize the column width. This is the same as using the Ctrl+R key combination. 

4.5.2 Refresh 
Click the Refresh  (or select Tools | Refresh) button to update any RPMS field 
values on the current window with new data from the server. This is the same as 
pressing the F5 key on your keyboard. 

4.5.3 Search 
You can search for data in the current grid by clicking the Search  button (or by 
selecting Tools | Search or by using the Ctrl+F key combination) to display the 
Search dialog. 

 
Figure 4-22: Search Dialog 

If you DO NOT check the “Show Additional Search Options” checkbox, the search 
looks in all columns for a match. 

If you check the “Show Additional Search Options” checkbox, the Search dialog 
changes to show more options for the search. 
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Figure 4-23: Search Dialog with Additional Search Options 

You type in what you want to search for in the “Find What” field. The remaining 
fields determine the criteria for the search. 

If you check the “Match Case” checkbox, that will cause the search to match the case 
of the text that you type into the Find What field. 

The fields Look In, Match, and Search work are described in the section 4.4.2 Search 
Criteria Fields. 

After all fields are populated with the search criteria, click the Find Next button. 
(Otherwise, click Cancel to dismiss the Search dialog.) 

If a match is found, the matching text will be highlighted (in the grid). If you want to 
continue the same search, click the Find Next button again; repeat this process as 
needed. 

If a match is not found, the Datagrid Search Results message displays. Click OK to 
close the message and to return to the Search dialog. 

 
Figure 4-24: Sample Datagrid Search Results 

4.5.4 Export to Excel 
You can export the information in the window to Excel by clicking the Export to 
Excel  button (or by selecting Tools | Export to Excel or by using the Ctrl+E key 
combination). 

The application displays the warning message about the export. 
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Figure 4-25: Warning Message about Exporting the Information 

Click No to dismiss the warning and to exit the export process. 

Click Yes to continue the export process and to display the Save As dialog. 

 
Figure 4-26: Sample Save As Dialog 

Make sure the location where you want to save the file displays in the Save in field. 

Type the name in the File name field. The system will add XLS as the extension to 
the field name (automatically). 

Click Save. (Otherwise, click Cancel to not save.). If you use Save, the Export Panel 
message “Excel export has been created.” displays when the Save command is 
complete; click OK to dismiss the message. 

When you view the Excel document, the application provides a Confidential Patient 
Information header in the document. 
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4.5.5 Print 

You can print the selected rows in the grid by clicking the Print  button (or by 
selecting Tools | Print or by using the Ctrl+P key combination) to display the Print 
Preview dialog. 

 
Figure 4-27: Sample Print Preview Dialog 

Select File | Print or click the Print button (on the Print Preview dialog) to output the 
data. 

If you do not select any rows, the application displays the warning message: You have 
not selected any rows to print. Do you want to proceed and print all rows in this view or cancel 
this print? Click Yes to print all the rows. Click No to cancel the print function. 

4.5.6 Copy to Clipboard 
You can copy the selected rows in the grid to the Windows clipboard by clicking the 
Copy to Clipboard  button (or by selecting Tools | Copy Rows to Clipboard or by 
using the Ctrl+Shift+C key combination). You can paste the contents of the Windows 
clipboard to any Windows application. 

4.5.7 Mail Merge 
The iCare application provides the capability to export patient demographic data in a 
format that can be used by word processing mail merge files. This is a Demographic 
Data Export for Letter Generation function. 
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Follow these steps: 

1. Select the patients that you want to include in the mail merge process. (See 
Section 4.2 for more information about selecting records.) 

2. Click the Mail Merge  button (or select Tools | Mail Merge) to display the Mail 
Merge Export dialog. 

 
Figure 4-28: Sample Mail Merge Export Dialog 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

3. Click the Mail Merge Instructions  button to display the Mail Merge 
Instructions pop-up. Here will be the instructions for completing the mail merge 
process. 

 
Figure 4-29: Mail Merge Instructions Dialog 

Note that you can print the contents by clicking the Print button or by selecting File | 
Print. 

See Section 4.7 for more information about the File menu and the buttons on the pop-
up. 
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4.5.8 Glossary 
Click the Glossary  button (or select the particular glossary from the Help) to 
display the particular Glossary pop-up. The name of the glossary pop-up varies 
according to the part of iCare that you are using. For example, if you are on the 
Reminders tab, the Reminders Glossary pop-up would display. See Section 4.13 for 
more information about the various glossaries. 

4.6 Entering Data 
The following information covers entering data in free text fields, drop-down lists, 
date fields, and missing data. 

4.6.1 Free Text Fields 
Free text fields are those fields that you can type information into; those types of 
fields do not have a drop-down list from which to select an option to populate it. 

An example of the free text field is the Panel Name field (when creating/editing a 
panel definition). 

There is a right-click menu to aid in editing the text. 

 
Figure 4-30: Right-Click Menu to Aid in Editing Text 

These options operate just like those in any Windows application. Here are the 
meanings of the options: 

Undo: allows you to remove the last edit action. 

Cut: removes the selected text from its current position and places it on the clipboard. 

Copy: copies the selected text and places it on the clipboard (the text is NOT 
removed). 

Paste: copies the contents of the clipboard and places it in the field at the current 
cursor position. 

Delete: removes the selected text from its current position. 

Select All: highlights all of the text in the current field. 
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HINT: If you have a long free text field (like the Panel Description field), you could 
type the contents of the field in a word processing application; here you can check the 
spelling and view the entire text string. Then, copy the text string in the word 
processing application and paste it in the iCare free text field. 

4.6.2 Drop-Down Lists 
You can populate a field by selecting an option from the drop-down list for the field. 

4.6.3 Date Fields 
Each date field in iCare has a calendar associated with it OR you can manually enter 
the date using the mm/dd/yyyy format. 

Click the date field’s drop-down list to display the calendar. 

 
Figure 4-31: Sample Calendar for Date Field 

The calendar always indicates the date for today. 

You can select another date by clicking on it; the selected date will display in the 
Date field. 

4.6.3.1 Changing the Month 
You can select from another month’s dates by clicking the appropriate arrow button 
(more than once, if needed). 

If you click on the month label, iCare displays a month from which you can select 
another month. 
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Figure 4-32: List of Months to Select 

4.6.3.2 Changing the Year 
If you click on the year label, iCare displays up and down arrow buttons that you can 
click to change the year. 

 
Figure 4-33: Changing the Year 

4.6.4 Missing Data 
If there is any missing data that is required, you will prompted with a missing data 
icon  next to the field. Below is an example of a field that has missing data. 

 
Figure 4-34: Sample of Field Having Missing Data 

4.7 Pop-up Functionality 
Several places in iCare you will be viewing a pop-up. For example, if you double-
click on any row in the Recent Visits group box on the Cover Sheet of the Patient 
Record window, you will view a pop-up. 
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Figure 4-35: Sample Visit Detail Pop-up 

You can take the following actions on this pop-up: 

• Navigate through the information by using the scroll bar. 

• Click the Find  button to access a search tool to find data in the current 
window. This button works like the Search button. See Section 4.5.3 for more 
information. 

• Click the Font  button to display the Font dialog. 

 
Figure 4-36: Font Dialog 

Here you can change the Font name, style, and size of the text in the pop-up 
(applies to all of the text). In addition, you can add effects like “Strikeout” and 
“Underline” - these perform like those effects indicated in MS Word. 
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Change the Script option if you need to the see the text displayed in another 
language and you have that language pack installed on the machine you are using. 
If the language pack is not installed on your machine, the display does not change 
by selecting another script. 

Click OK to apply your changes to the text in the current pop-up. These changes 
are only effective for the current view of the pop-up. (Otherwise, click Cancel.) 

• Click the Copy  button to copy the selected text to the Windows 
clipboard. 

• Click the Print Preview  button to view the Print Preview dialog. 
You can print the contents of the pop-up from this dialog. See 
Section 4.5.5 for more information about this dialog. 

• Click the Print  button to display a print dialog where you specify the 
printer to output the contents of the pop-up, the page range, and number of 
copies. 

The File menu contains the print actions (like the Print Preview and Print buttons), 
the Page Setup function, the find and copy functions, as well as a Close function 
(dismisses the pop-up). See Section 4.5.5 for more information on the print actions. 
The Find and Copy functions are discussed above. 

4.8 Add/Remove Functionality 
There are several Add/Remove dialogs that you use in iCare. 

 
Figure 4-37: Sample Add/Remove Visit Clinics Dialog 

You use the “Add/Remove” dialog in the following manner: 

You can type a few characters in the Find field to filter the list to those options 
containing those characters. 
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To move a highlighted selection from the Available Selections area to the 
Current Selections area, click the Add button. 

To move a highlighted selection from the Current Selections area to the 
Available Selections area, click the Remove button. 

When the dialog is complete, click OK. This action populates the appropriate field 
with the data in the Current Selections area. (Otherwise, click Cancel). 

4.9 Layout Dialog Functionality 
There are several times in iCare that you will use a layout dialog to determine: (1) the 
columns on a particular window or tab, (2) the sort order of the columns, and (3) the 
direction of the sort. In addition, you can use a customized default template (that you 
define) or you can use the system default template. 

For example, you can determine the columns for the Patient List tab by using the 
Patient List Layout window. 

You can expand or collapse the column levels as needed. 

 
Figure 4-38: Patient List Layout for Selected Panel 

After you have changed the Display Columns and/or Sort Columns, click OK to save 
your changes. 
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Use the Reset button to restore the layout to the most recently saved configuration. 

Use the Cancel button to dismiss the window. 

4.9.1 Template Group Box 

 
Figure 4-39: Template group box 

When you first access the layout dialog, the application displays the System Default 
template. The Template and Customized radio buttons are not selected. 

• If you leave the System Default radio button enabled, then the application 
displays the system default columns. In this case, the Add and Remove 
buttons are not active (and you cannot change anything) on the Patient List 
Layout dialog. You can change the column layout for the default template by 
using the Layouts tab on the User Preferences dialog. See Section 4.19. 

• If you select the Customized radio button, the application lets you change the 
columns (the Add and Remove buttons become active, for example). 
Anything you change on the layout dialog will be used for the Customized 
template. 

• You can name the customized template by selecting the Template radio 
button. This action causes the field with the drop-down list to become active 
(and the Customized and System Default radio buttons are not selected). Once 
you add a name, it is added to the Template name drop-down list. Later, you 
can choose which template you want to use during an iCare session. 

4.9.2 Display and Available Columns 

 
Figure 4-40: Sample Display and Available columns 

You use the Display Columns to determine what columns you want to display for the 
particular window or tab. The listing in the Display Columns area shows the columns 
that will be displayed for your population. The column names in italics are required 
and cannot not be removed. 
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To move a Column name in the Available Columns area to the list in the Display 
Columns area, highlight a column name in the Available Columns area and click 
Add. This moves the column name from the left panel to right panel. 

Likewise, you can remove a column in the Display Columns area and move it to the 
Available Columns area by highlighting the column name (in the Display Columns 
area) and clicking Remove. This moves the column name from the right panel to the 
left panel. 

As noted about the Display Columns area, you cannot remove any column names in 
italics. 

You can determine the order the columns display in the Display Columns area by 
using the Up and Down buttons. Highlight a column name and click the appropriate 
button. You might have to click the button more than once to move it to the desired 
location. 

4.9.3 Columns to Sort 
Sorting a column means you want to arrange the items in the column in alpha-
numeric order. 

 
Figure 4-41: Sample Available Sorts and Sort Columns area 

To move a Column name in the Available Sorts area to the list in the Sort Columns 
area, highlight a column name in the Available Sorts area and click Add. This moves 
the column name from the left panel to right panel. 

Likewise, you can remove a column in the Sort Columns area and move it to the 
Available Sorts area by highlighting the column name (in the Sort Columns area) and 
clicking Remove. This moves the column name from the right panel to the left panel. 

4.9.3.1 Column Sort Order 
You use the Sort Columns area to determine what columns you want to sort for the 
particular window or tab. The column names in italics are required and cannot not be 
removed. 
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You determine which order the columns are sorted in the Sort Columns area by using 
the Up and Down buttons. Highlight a column name and click the appropriate button. 
You might have to click the button more than once to move it to the desired location. 
For example, if you have Gender, Patient Name, and Diagnosis Tags in the right 
column, the Gender sort is applied first then the Patient Name and then the Diagnosis 
Tags is last. 

4.9.3.2 Switch Sort Direction 
The names of columns in the Sort Columns area show “ASC” appended to the name, 
for example Patient Name ASC. You can switch the sort order for a selected column 
by clicking the Switch Sort Direction button. In the example, the name changes 
Patient Name DESC. You can use the “switch sort direction” action on more than one 
column. 

4.10 Background Jobs 
The background jobs information displays in several places in iCare. 

Click the Background Jobs  button (or select File | Background Jobs) to display the 
Background Jobs pop-up. 

 
Figure 4-42: Sample Background Jobs pop-up 

You must dismiss the pop-up in order to use other functions in iCare. 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

The File menu has the following options: 
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Page Setup: This option allows you to set Margin, Paper, Layout characteristics (like 
landscape or portrait orientation), and the Printer to use. 

Print Preview: This option displays the print preview dialog. 

Print: This option outputs the selected rows in the grid. The application displays the 
Print Preview dialog where you can view the output. Select File | Print (on the dialog) 
to output the content. The application provides a header stating Confidential Patient 
Information for all printed panel views. 

If you do not select any rows, the application displays the warning message: You 
have not selected any rows to print. Do you want to proceed and print all rows in this view 
or cancel this print? Click Yes to print all the rows. Click No to cancel the print 
function. 

Close: This option closes the Background Jobs window. 

The Edit menu has one option: Select All (used to select all of the records). 

The Tools menu has options that have the same functions as those of the buttons on 
the right side of the toolbar. 

4.11 Table Lookup 
The ellipsis button next to the field means you can search for a particular record in the 
Table Lookup dialog by clicking the button. In addition, you can clear the 
information in the particular field (on the form). 
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4.11.1 Searching for Record 

 
Figure 4-43: Table Lookup Dialog 

This dialog provides two types of searches: for all items or for a particular item. 

Let’s use an example to demonstrate each type. Assume you are going to search for 
CPT Code. 

4.11.1.1 Using the Show All Button 
If you do not enter anything in the Search field and just click Show All, the 
application will display all CPT codes, as shown below. (The retrieval might take a 
little time.) 
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Figure 4-44: Sample retrieval of all CPT codes 

4.11.1.2 Using the Find Button 
To search for a particular CPT code, type a few characters in the Search field and 
then click Find. The retrieved records will display in the bottom area (if any). 

 
Figure 4-45: Sample retrieval of a particular CPT code 
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4.11.1.3 Completing the Search 
In either case, select a record and click Select. This will close the dialog and populate 
the field (on the form) with the selected record. (To exit the Table Lookup dialog, 
click the Cancel button.) 

4.11.2 Clearing Data in Field with Ellipsis Button 
To clear the data in a field with the ellipsis button (on a form), click the ellipsis button 
to display the Table Lookup dialog. Click Clear (on Table Lookup). This will close 
the Table Lookup dialog and clear the data in the field on the form. (To exit the Table 
Lookup dialog, click the Cancel button.) 

4.12 iCare Package Manager Functions 
When you have the Package Manager security key, you can access the functions by 
selecting Tools | iCare Package Manager on the iCare main window. 

 
Figure 4-46: iCare Package Manager Functions 

4.12.1 iCare User Access Management 
The iCare User Access Management option accesses iCare User Access Management 
dialog. 

When this dialog is complete, click OK to save your changes. (Otherwise, click 
Cancel to not save.) 
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Figure 4-47: Sample iCare User Access Management dialog 

For those with the appropriate permissions, you can assign roles to a particular user, 
scroll to the name on the iCare User Access Maintenance dialog and check the 
appropriate check boxes for the roles. If you want to remove an assigned role, de-
select the particular check box. Note: The BH User column cannot be changed. 

Each of the column headings has hover help. 

4.12.1.1 Existing RPMS Editor Access 
The users displayed on this list (those with the iCare user icon ( ) in first column) 
have been given basic access to the iCare application by your Site (IT) Manager. You 
cannot give Editor or Package Manage access to iCare to a user who doesn’t have 
basic access. See your Site Manager to require basic iCare access for other users. This 
information displays when you click the Help menu. 

4.12.1.2 Users with iCare Access 
This column is a list of RPMS users who have been given access to the iCare 
application by the Site (IT) Manager. 

4.12.1.3 iCare Package Manager 
The iCare Package Manager has all read/write access as defined for other user levels. 
This person can do the following: 

• assign all other access roles in iCare: iCare Package Managers; CMET 
Package Managers; Editors; and Taxonomy Editors. 
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• access Patient Information associated with Community Alerts. 

• has all read/write access as defined for other user levels. 

• reassign existing iCare panels to iCare users. 

Note: Taxonomy Editor Access Management is assigned through 
the Taxonomy Maintenance/ Taxonomy User Access 
Window from the Tools Menu. 

The iCare Package Manager has the highest level of permissions; hence, the iCare 
Package Manager will have access to all items accessible by the CMET Package 
Manager. 

The iCare Package Manager does everything an editor does and also has the ability to 
access the list of patients who have triggered the Community Alerts. This person also 
assigns Editor access to other users. In addition, this person can assign the CMET 
Package Manager role. 

4.12.1.4 CMET Package Manager 
The CMET Package Manager has the ability to establish the CMET site parameters 
related to Tickler Timeframes and Batch Processing. CMET Package Managers have 
all read/write access as defined for other user levels. 

4.12.1.5 Editors 
Editors in iCare will have read/write access to: 1) PCC Historical Data Entry; 2) Care 
Management data; 3) Family History and Reproductive Factors (Snapshot); 4) 
Designated Specialty Provider Management system (DSPM); 5) Problem List; and 6) 
CMET Worksheet. 

The Editor role will give the person the right to edit the care management function 
(e.g., HMS Care Management). It also allows the person to enter Historical Data. 

4.12.1.6 MU Package Manager 
This cell in the column will be checked if the user has Meaningful Use Package 
Manager access. The MU Package Manager can set the Meaningful Use site 
parameters. 

4.12.1.7 BH User 
This cell in the column will be checked if the user has existing BH access. This 
cannot be edited from iCare screens. 
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4.12.2 Reassign Panels 
The Reassign Panels option displays the Reassign Panels dialog. 

 
Figure 4-48: Reassign Panels Dialog 

This dialog allows the iCare Package Manager to reassign panels from one user to 
another user. 

The following are the fields on the dialog: 

Reassign From: select the user. from the drop-down list, whose panels you want to 
reassign. 

Reassign To: select the user, from the drop-down list, to whom the panels are to be 
reassigned. 

Populating the first two fields activates the Select button. Click the Select button to 
display the Add/Remove Panels dialog. 

 
Figure 4-49: Sample Add/Remove Panels dialog 

See Section 4.8 for more information about the Add/Remove dialog. 
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When the Add/Remove dialog is complete, click OK (otherwise, click Cancel). 
After clicking OK, the panels listed in the Current Panels area on the add/remove 
dialog will populate the Panels field on the Reassign dialog. 

After clicking OK, the reassigned panels of the “Reassign From” user are 
removed from that person’s panel view. The reassigned panels will appear in the 
“Reassign “To” user panel view. 

4.13 Glossary Functions 
You can access glossary information by clicking the Glossary  button on the 
current window or by selecting a glossary option on the Help menu. 

4.13.1 Community Alerts Glossary 
The Community Alerts Glossary pop-up provides the following information: 

• Purpose of a community alert 

• Notice that alerts are not linked to an individual patient 

• Categories of diagnosis that triggers the alert 

• How to customize the Community Alert display 

• List of diseases/conditions and associated codes that trigger Community 
Alerts in iCare 

 
Figure 4-50: Community Alerts Glossary 

See Section 4.7 for more information about the buttons and the File menu on the pop-
up. 
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4.13.2 Diagnostic Tag Glossary 
The Diagnostic Tag Glossary pop-up provides the detailed logic for each national 
performance measure defined in the Clinical Reporting System. 

 
Figure 4-51: Diagnostic Tag Glossary 

See Section 4.7 for more information about the buttons and the File menu on the pop-
up. 

4.13.3 National Measures Glossary 
The National Measures Glossary pop-up defines the detailed logic for each of the 
national performance measures defined in the Clinical Reporting System. 

 
Figure 4-52: National Measures Glossary 

See Section 4.7 for more information about the buttons and the File menu on the pop-
up. 
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4.13.4 Reminders Glossary 
The Reminders Glossary pop-up displays the Reminder descriptions (from RPMS). 
The pop-up has descriptions of the logic behind each national health summary 
reminder available for display in iCare. 

 
Figure 4-53: Reminders Glossary 

See Section 4.7 for more information about the buttons and the File menu on the pop-
up. 

4.13.5 HIV/AIDS / Care Management Glossary 
The HIV/AIDS / Care Management Glossary pop-up provides information about the 
HIV/AIDS Diagnostic Tag Definition, HMS Register Specific Data/ Patient Record, 
HMS Panel Layout Options, What is a Taxonomy?, HMS Supplement Logic, HMS 
Reminder Logic, and HIVQUAL Report Synopsis. These are sections that you can 
access individually within the glossary. See Section 15.3 for more information. 

 
Figure 4-54: HIV/AIDS / Care Management Glossary 
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See Section 4.7 for more information about the buttons and the File menu on the pop-
up. 

4.13.6 Best Practice Prompts Glossary 
The Best Practice Prompts Glossary pop-up is accessed from the Best Practice 
Prompts tab of the Patient Record window or by using the Best Practice Prompts 
Glossary option on the Help menu. 

The Glossary text is created by combining the following labels and fields from the 
Treatment Prompts file: Clinical Group (Category field), Prompt Name, Status (e.g. 
On or Off at the site), Description, Currently Defined Criteria field (display label 
ONLY if there is data), and Current Summary types (display label even if NO data). 

Glossary entries are displayed alphabetically by Clinical Group, then by Name 
(Title). 

 
Figure 4-55: Best Practice Prompts Glossary 

See Section 4.7 for more information about the buttons and the File menu on the pop-
up. 

4.13.7 Asthma / Care Management Glossary 
The Asthma / Care Management Glossary pop-up provides information about the 
Asthma Diagnostic Tag Definition, Asthma Specific Data/Patient Record, Asthma 
Panel Layout Options/Panel View, and Asthma Supplement Logic. 
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Figure 4-56: Asthma / Care Management Glossary 

See Section 4.7 for more information about the buttons and the File menu on the pop-
up. 

4.13.8 CMET Glossary 
The CMET Glossary pop-up provides information about the CMET steps, 
configuring the CMET views, Taxonomy/Lab Taxonomy Table, and CMET Events 
and Findings (by category). 

 
Figure 4-57: CMET Glossary 
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See Section 4.7 for more information about the buttons and the File menu on the pop-
up. 

4.13.9 Meaningful Use Glossary 
The Meaningful Use Glossary pop-up displays the different text fields in the 
Meaningful Use tab. The order will be: (1) Measure Short Name, (2) Core or Menu 
Set, (3) Stage 1 Objectives, (4) Stage 1Denominator Definition, (5) Stage 1 
Numerator Description, (6) Stage 1 Logic, and (7) Stage 1 Target. 

 
Figure 4-58: Sample Meaningful Use Glossary 

See Section 4.7 for more information about the buttons and the File menu on the pop-
up. 

4.14 iCare Taxonomy Editor Function 
The iCare Taxonomy Editor holds the security key (BQIZTXED) allowing that 
person to read/edit iCare taxonomies. 

You access the iCare Taxonomy View/Edit dialog by either selecting Tools | 
Taxonomy Maintenance | View/Edit Taxonomy Entries (on the main iCare Tools 
menu) or by double-clicking the Factor cell in the Active Diagnostic Tags group box 
on the Snapshot tab of the patient record window. 
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Figure 4-59: Sample iCare Taxonomy View/Edit dialog 

Note: if you do not hold that security key, you can only view the information on the 
dialog. The following information displays: You do not currently have access rights to 
edit taxonomies. In order to edit taxonomy entries, you will need to have the iCare Taxonomy 
Editor security key (BQIZTXED) added to your RPMS user account. 

When you first access this view/edit dialog, all parts of the tree structure will be 
collapsed. You need to expand one of the tree parts and find the taxonomy you want 
to edit. 

In general, select the taxonomy from the list in the left group box that you want to 
view. This causes the Add and Remove buttons to appear in the right group box of the 
dialog. 

Please note that not all taxonomies will be editable. iCare will display a message on 
the view/edit dialog when this condition exists. Site populated taxonomies can only 
be edited by users with appropriate access. 

The difference between the Apply and OK is: the Apply button is used when you add 
more than one taxonomy value to the iCare Taxonomy View/Edit dialog. 

4.14.1 Add Taxonomy Values 
Click the Add button to create a values for a selected item in the left group box. The 
application displays the Select Taxonomy Item dialog. 
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Figure 4-60: Select Taxonomy Item dialog 

Use the Search field to search for a taxonomy item. Highlight the item you want to 
add and click Select. The application checks to see if it is already there. 

• If it already exists, you receive a warning message about that (click OK to 
dismiss the message); after clicking OK, you return to the iCare Taxonomy 
View/Edit dialog. 

• If it does not exist, it appends the selected item to the bottom of the list. 
After you finish adding taxonomy values, click Apply to “save” your changes. If you 
do NOT click Apply and try to move to another taxonomy or another part of the iCare 
application, the “Save Taxonomy changes?” information message displays, asking if 
you want to apply the changes now. In this case, click Yes to apply the changes 
(otherwise, click No). 

You can repeat adding items to various taxonomies. When you are finished using the 
iCare Taxonomy View/Edit dialog, click OK to save (otherwise, click Cancel). 

4.14.2 Remove Taxonomy Values 
If you want to remove one or more items from the list, highlight them and click 
Remove. The “Confirm taxonomy item remove” message displays. Click Yes to 
remove the items (otherwise, click No). You remain on the iCare Taxonomy 
View/Edit dialog. 
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4.14.3 View Report of All Taxonomies Button 
Click the “View Report of All Taxonomies” button to display the Taxonomy Report 
pop-up. 

 
Figure 4-61: Taxonomy Report 

This pop-up provides information about various Taxonomy Categories (listed in 
alphabetical order). 

See Section 4.7 for more information about the File menu and buttons on the pop-up. 

4.15 Creating a Community Taxonomy 
You access the Community Taxonomy function in the panel definition process, under 
the Ad Hoc search. 

 
Figure 4-62: Sample Community group box 

You create a taxonomy by populating the By Name communities. You can determine 
how many patients will be in the taxonomy by selecting an option on the drop-down 
list for the By Name radio button. 

Click the Edit button to access the Add/Remove Communities dialog. 
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Figure 4-63: Sample Add/Remove Communities dialog 

The goal is to populate the area under the Current Selections label. After you 
populate this area, click OK. This populates the By Name communities area of the 
Community group box on the Ad Hoc search dialog. See Section 4.8 for more 
information about how to use the Add/Remove Communities dialog. 

The communities that appear in the Current Selections area of the Add/Remove 
Communities dialog populates the By Name field on the Community group box. 

 
Figure 4-64: Sample Community group box with By Name field populated 

Click the Create Taxonomy button to display the Create/Update Community 
Taxonomy dialog. 

 
Figure 4-65: Sample Create/Update Community Taxonomy dialog 

Populate the fields on the dialog. The Community Taxonomy Name field is required. 
Then click OK. 
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If the user uses a duplicate taxonomy name to a previous taxonomy created by that 
user, iCare will provide a warning that the user might be overwriting the user’s 
taxonomy. The user can overwrite (Yes), save as another name (No), or cancel (to 
return to the Create/Update Community Taxonomy dialog). 

If the user uses a unique name, the application confirms savings the data to the RPMS 
server. 

 
Figure 4-66: Confirm save to RPMS 

Click Yes to save the data. (Otherwise, click No to not save the data). 

If you use Yes, the application displays the following message: 

 
Figure 4-67: Community Taxonomy Created message 

Click OK. 

The Community group box will change, showing the taxonomy name and what the 
taxonomy includes. 

 
Figure 4-68: Sample Community group box with taxonomy 

The taxonomy creating function is independent of the panel save function, that is, the 
taxonomy will be saved to the server once the user selects the Taxonomy Save 
function. The user has the potential for creating multiple community taxonomies 
within the Panel Definition function and can create a community taxonomy without 
actually creating a panel. 
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The iCare application will observe the underlying business rules for taxonomy 
creation: a user can only edit the user’s created taxonomy. iCare will not allow a 
duplicate taxonomy name if the user is not the owner of the original taxonomy. 

4.16 Edit DPCP Providers 
When you edit the DPCP providers, the application displays the Edit Providers dialog 
(for the current patient). 

 
Figure 4-69: Sample Edit Provider dialog 

The Edit Providers window is divided into two areas: (1) Add/Edit area that has fields 
to add/edit a provider record and (2) Specialty Provider List area that lists the 
providers for the patient. See Section 4.5 for information on how to use the buttons on 
the right side of the Specialty Provider List area. 

4.16.1 Add/Edit New Provider 
Move the cursor to the row of the Provider Category (in the Specialty Provider List 
grid) where you want to add/edit the provider. 

The Provider Category field (in the Add/Edit area) will show the provider category 
that you selected, for example, Cancer. This field is view-only. 
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You can add the provider for the category and clicking the ellipsis button to search 
for the provider name (or initial) on the Table Lookup window. See Section 4.11 for 
more information. 

Select the provider name and click Select; this name populates the Provider Name 
field (in the Add/Edit group box). Then click Apply Changes to move the data to the 
Specialty Provider List group box. 

4.16.2 Remove Provider Name 
You can remove the provider for the category by first selecting the category (in the 
Specialty Provider List grid). Then, click the ellipsis button by the Provider Name 
field (in the Add/Edit area) to access the Table Lookup window. Click Clear. This 
removes the provider name from the Provider Name field. Then click Apply Changes 
to removes the provider name from the Specialty Provider List group box. 

4.16.3 Save & Close Button 

Click the Save & Close  button (or select File | Save & Close) to display the 
“Confirm save to RPMS” information message. Click Yes to save all changed data to 
RPMS (otherwise, click No to not save). The Edit Providers window closes. 

If you saved the data, it will be reflected in the Provider group box on the Cover 
Sheet tab of the Patient Record window. 

4.16.4 File Menu on Edit Providers 
The options on the File menu are: 

Save & Change: this is the same as clicking the Save & Close button. This action 
displays the RPMS information message. Click Yes to save the data to RPMS 
(otherwise, click No to not save). If you use Yes, the data populates the Providers 
group box on the Cover Sheet of the patient record window. 

Close: use this option to close the Edit Providers dialog. 

4.16.5 Tools Menu on Edit Providers 
The options on the Tools menu are: Search, Excel to Export, Print, and Copy Rows to 
Clipboard. These options perform like the button on the right side of the window. See 
Section 4.5 for more information. 

4.16.6 Help Menu on Edit Providers 
The options on the Help menu are: 
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iCare Help: use this option to access the online help information about the Edit 
Providers dialog. This is the same as pressing the F1 key on your keyboard. 

About iCare: use this option view the version of the iCare GUI. 

4.17 Graphing Measurement Data 
You can create a graph of selected measurement data on the patient record window by 

clicking the Graph It  button. The application displays the Charting window, 
showing a graph of the particular measurement type. 

The application creates a line chart of the measurement data. This type of graph 
shows trends over time. 

• The x-axis is the time axis. 

• The y-axis shows the data range that includes the maximum and minimum 
values (this is the default setting). 

 
Figure 4-70: Sample Charting window 

4.17.1 Chart Data Group Box 
The data for the graph are listed in the Chart Options group box. 
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Figure 4-71: Sample Chart Data Group Box 

The data is determined by what you select in the Measurement Type field. 

See Section 4.5 for more information about the buttons in the Chart Data group box. 

4.17.2 Chart Options Group Box 
What you select in the Chart Options group box determines what the graph looks like. 
For example, you can determine the scale units for the x-axis in the X-axis Date 
Range field. 

 
Figure 4-72: Sample Chart Options group box 

Measurement Type: this shows what is being charted. You can change this by 
highlighting another measurement type. 

Selected Rows: use this check box to graph the selected row(s) in the Chart Data 
grid. If you do not use this check box, the application uses all of the measurement 
values. 
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Time Interval: this determines the time interval for the data on the chart. The default 
is what you selected (in the Last field) on the PCC tab of the patient record window. 
You can change this interval by selecting an option from the drop-down list. 

Set Grid to Zero: use this check box to cause the y-axis values to start at zero and go 
to the maximum value of the data. When you do not use this check box, the 
application uses the minimum and maximum values for the y-axis. 

Lines Visible?: use this check box to display the lines that connect the data points. 

Values: use this check box to display the values at each data point. 

Grid Lines: use this check box to display the grid lines on the chart. 

Enable Zooming/Scrolling: use this check box to display zooming/scrolling of the 
grid lines. 

X-axis Data Range: this determines the time units of measure on the x-axis of the 
graph. The options are: Not Set, Days, Weeks, Months, Years. 

Icon: this determines the icon for each data point. The options are: circle, diamond, 
none, plus, square, triangle, upside down triangle, X. The default is None. 

Show Legend: check this check box to show the legend for the graph. The field 
below determines the location of the legend. 

4.17.3 File Menu for Charting Window 
Below are the options on the File menu for the Charting window. 

 
Figure 4-73: Options on File menu for the Charting window 

Use the Close option to chose the charting window. 

4.17.3.1 Chart Option 
The Chart option of the File menu has the following selections: 

Page Setup: this selection allows you to set Margin, Paper, and Layout characteristics 
(like landscape or portrait orientation) for printing. You can select a different printer. 
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Print Preview: this selection displays the Print Preview dialog that displays how the 
output of the chart will look. 

Print: this selection displays the Print dialog where you select the printer to output 
the chart. This is the same as using the Ctrl+P key combination. 

Save Chart for Office: this selection lets you save the chart in a particular graphics 
format, for example JPEG. The application displays the Save Chart for Office dialog. 

 
Figure 4-74: Save Chart for Office dialog for graphics format 

File Name: specify the name of the file for the chart in graphics format. 

Save as type: select the type of graphics format for the chart. The default is 
JPEG. 

After completing the two fields, click Save to save the chart in graphics format 
(otherwise, click Cancel). 

Save Chart for PDF: this selection lets you save the chart in PDF format. The 
application displays the Save Chart for Office dialog. 
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Figure 4-75: Save Chart for Office dialog for PDF format 

File Name: specify the name of the file for the chart in graphics format. 

Save as type: use the default PDF. 

After completing the two fields, click Save to save the chart in graphics format 
(otherwise, click Cancel). 

4.17.3.2 Table Option 
The Table option of the File menu has the following selections: 

Search: this selection searches for data in the Chart Data group box. See 
Section 4.5.3 for more information. 

Excel Export: this selection to export the selected rows in the Chart data group box 
to Excel. See Section 4.5.4 for more information. 

Print: this selection displays the Print Preview dialog of the currently selected rows 
in the Chart Data group box. See Section 4.5.5 for more information. 

Copy Rows to Clipboard: this selection copies the currently selected rows in the 
Chart Data group box to the Windows clipboard. You can paste the contents of the 
Windows clipboard to any Windows application. 
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4.18 Select/Clear Functionality 

 
Figure 4-76: Sample select/clear dialog 

You use the select or clear dialog to do the following: 

• to search and then select a record to populate a field 

• to clear the data in an existing field 

4.18.1 Search and Select Data for a Field 
Type a few characters in the Search field and then click Find. The application will 
display the retrieved record in the lower part of the grid of the dialog. 
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Figure 4-77: Sample of records retrieved 

Highlight the record you want to populate the field and click Select (otherwise, click 
Cancel to stop the search). 

4.18.2 Clearing Data in Field 
If you want to clear data in a field, click the drop-down list for the field. The 
application displays the select/clear dialog. Click Clear. 

4.19 Default Template for iCare Window Layouts 
When you use the Layouts tab on the User Preferences dialog and you click Edit, the 
application displays the Window Default - Window Template dialog. For example if 
you click the Edit button for the Patient List window, the application displays the 
Patient List Default - Patient List Template window. 
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Figure 4-78: Sample Patient List Default - Patient List Template window 

This window is similar to all of the default templates for Patient List, Reminders, Natl 
Measures, Case Mgmt Groups, and CMET. 

After you have changed the Display Columns and/or Sort Columns, click OK to save 
your changes. 

Use the Reset button to restore the layout to the most recently saved configuration. 

Use the Cancel button to dismiss the window. 

4.19.1 Template Group Box 

 
Figure 4-79: Sample Template group box area 

You use the template group box to determine the columns for default template. 

If you want to change the columns, you can do so and then check the “Set as 
default?” check box. This action will re-define the default template. 

If you want to reset to the system default, then click the Reset to System Default 
button. 
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4.19.2 Display Columns 
You use the Display Columns to determine what columns you want to display for the 
customized template. 

 
Figure 4-80: Sample Display Columns area 

You might need to expand an option the in Available columns area by click the + 
button (next to the name). 

The listing to the Display Columns area shows the columns that will be displayed for 
your population. The column names in italics are required and cannot not be 
removed. 

You might need to expand a name in the Available Columns area in order to view the 
names of the columns. 

To move a Column name in the Available Columns area to the list in the Display 
Columns area, highlight a column name in the left panel and click Add. This moves 
the column name from the left panel to right panel. 

Likewise, you can remove a column in the Display Columns area and move it to the 
Available Columns area by highlighting the column name (in the right panel) and 
clicking Remove. This moves the column name from the right panel to the left panel. 

As noted about the Display Columns area, you cannot remove any column names in 
italics. 

You can determine the order the columns display in the Display Columns area by 
using the Up and Down buttons. Highlight a column name and click the appropriate 
button. You might have to click the button more than once to move it to the desired 
location. 

4.19.3 Columns to Sort 
Sorting a column means you want to arrange the items in the column in alpha-
numeric order. 
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Figure 4-81: Sample Sort Columns area 

You might need to expand an option in the Available Sorts area by clicking the + 
button (next to the name). 

To move a Column name in the Available Sorts area to the list in the Sort Columns 
area, highlight a column name in the left panel and click Add. This moves the column 
name to right panel and removes it from the left panel. 

Likewise, you can remove a column in the Sort Columns area and move it to the 
Available Sorts area by highlighting the column name (in the right panel) and 
clicking Remove. This moves the column name from the right panel to the left panel. 

4.19.3.1 Column Sort Order 
You determine which order the columns are sorted in the Sort Columns area by using 
the Up and Down buttons. Highlight a column name and click the appropriate button. 
You might have to click the button more than once to move it to the desired location. 
For example, if you have Gender, Patient Name, and Diagnosis Tags in the right 
column, the Gender sort is applied first then the Patient Name and then the Diagnosis 
Tags is last. 

4.19.3.2 Switch Sort Direction 
If you have column names in the Sort Columns area in alphanumeric order, you can 
reverse the sort order by clicking the Switch Sort Direction button. For example, the 
name Patient Name ASC means the sort direction is ascending. If you select this 
name and click the Switch Sort Direction button, the name of the column will change 
to Patient Name DESC. 

4.20 CMET Worksheet 
Use the Open CMET Worksheet button to access the CMET Worksheet for a selected 
event on the particular sub-tab of the CMET window. You find this button on the 
Tracked Events and Follow-up Events sub-tab on the CMET main, CMET tab on the 
Panel View, and the CMET tab on the Patient Record windows. 
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Use this worksheet to process the Care Management Events that you have chosen to 
track. Enter data related to: Findings, Follow-up and Patient Notification. The Site 
parameters “Due By” default dates set by the CMET Package Manager can also be 
edited in this screen. 

 
Figure 4-82: Sample CMET Worksheet 

When the worksheet is complete, click OK (otherwise, click Cancel). 

• When you use OK, there are two cases. 
Case 1: if all of the steps are not complete, the application updates the data on 
the Tracked Events sub-tab. 

Cases 2: if all of the steps are complete, the application will display the Close 
Event information message that states: The event is eligible for closing as all four 
steps are completed. Do you want to close the event now? Use Yes to close the 
event. Use No to not close the event. 
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If you choose to close the event (by selecting Yes on the Close Event 
message), the application displays the RPMS iCare Reason for Closing dialog. 
Here you select a reason for closing the event and provide a comment 
(required) about the closing. Click OK to save the reason for closing 
(otherwise, click Cancel). 

If you use OK on the Reason for Closing dialog, the application displays the 
“Save to RPMS?” dialog that states: You have data changes pending. Do you want 
to save to RPMS now? Click Yes to save the changes to RPMS. Click No to not 
save the changes. 

• When you use Cancel, there are two cases: 
Case 1: if you did not make any changes on the worksheet, the application 
closes it. 

Case 2: if you did make changes on the worksheet, the application displays the 
“Save to RPMS?” dialog that states: You have data changes pending. Do you want 
to save to RPMS now? Click Yes to save the changes to RPMS. Click No to not 
save the changes. Click Cancel to return to the CMET Worksheet. 

4.20.1 Patient Demographics Group Box 
The Patient Demographics group box shows the patient’s name, HRN, Sex, Age, and 
DOB. 

4.20.2 1 - Event Group Box 
The data in the 1 – Event group box provides information about the event and allows 
you to change the State of the event as well as provide comments about the Event 
and/or State. In addition, you can view the audit history of the event. 

 
Figure 4-83: Sample Event group box 

State: This field defines the State of the event. 

If you populate the State field with Closed, then the Close Reason field becomes 
active where you select an option from the drop-down list that describes why you 
are closing the event. 

When an Event has a State of Closed, the other group boxes (Findings, Follow-up, 
Patient Notifications) will be inactive. 
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Event Comment: Use this free text field to add comments about the Event. 

State Comment: Use this free text field to add comments about the State. 

CMET Audit History: If you click the View label, the application will display the 
CMET Audit History pop-up. 

 
Figure 4-84: Sample CMET Audit History pop-up 

Because multi-users work on the event, the audit history provides of a history of those 
activities. See Section 4.7 for more information about the features of the pop-up 
window. 

State: This is determines the state of the event, either Open or Closed. If “Closed” is 
used, then the Close Reason field becomes active. 

If Closed is used, this causes all of the other group boxes (2 - Findings, 3 - 
Follow-ups, 4 - Patient Notifications) to become inactive. 

Close Reason: This field is active when State = Closed. Select an option on the drop-
down list that gives the reason for closing the event. 

4.20.3 2 - Findings Group Box 
Use the 2 – Findings group box to enter Findings data about the event. 

 
Figure 4-85: Sample Findings group box 

You can minimize this group box by clicking the collapse button in the upper left 
corner. This allows more room for viewing the other group boxes (Follow-ups and 
Patient Notifications). 
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The Findings Due By, Result, and Follow-up Recommended? fields become 
populated when you use the Add button on the grid and save the record. 

Findings Due By: This field displays the date the findings of this event were entered 
into CMET. If this date passes without an entry, a “tickler” (Feather icon) is 
generated. 

Result: This field displays the date of the result. If this field contains an underlined 
date, click on the date to display the detail of the result. For example, below is the 
Radiology Case Number Detail pop-up. 

 
Figure 4-86: Radiology Case Number Detail 

See Section 4.7 for more information about the pop-up window. 

Follow-up Recommended?: This field indicates if follow-up is recommended (yes or 
no). 

4.20.3.1 Add Button 
Use the Add button to create a new Findings record. Click the Add button (or press 
the F2 button on the keyboard) to access the Findings dialog. 
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Figure 4-87: Findings dialog 

The field names followed by an asterisk (*) are required. 

Date: Click the drop-down list and select a date for the finding. 

Finding:. This is the finding associated with the event. Use an option from the drop-
down list to populate this field. 

Interpretation: The application populates this field, based on your selection in the 
Finding field. 

Comment: Type the text of the comments about the Finding, if appropriate, in this 
free text field. 

Follow-up Needed: Use an option from the drop-down list: Yes or No. 

Click OK to save your data on the Findings dialog (otherwise, click Cancel to not 
save). 

After saving the data, the application populates the grid with the record and populates 
the Last Edited (current logon user) and Last Edited By (current date) columns. 

If you saved and had selected Yes for “Follow-up Needed” field (on the Findings 
dialog), this will cause the “Follow-up Recommended?” field on the grid to be 
populated with Yes and the application will automatically display the Follow-Ups 
dialog (where you can enter follow-up data). See Section 4.20.4.1 for more 
information about this dialog. 

4.20.3.2 Delete Button 
The Delete function applies to events that had Findings entered but NOT saved. 

If you select an event that is not eligible for the Delete function, the application 
displays the message: Unable to delete a previously saved entry. Please mark as ‘Entered in 
Error’ instead. Click OK to dismiss the message. 
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Select one or more eligible Findings records you want to delete and click the Delete 
button (or press the Delete button on your keyboard). The application displays the 
Delete Row information message, confirming the deletion. Click Yes to delete the 
selected records. Otherwise, click No to not delete the records. 

4.20.3.3 Error Button 
Use the Error button when Findings records have been saved and you cannot delete 
them and you want to mark them as Entered in Error. 

If you select a record that is not eligible for the Error function, the application 
displays the message: Unable to mark as ‘Entered in Error’ because the entry has not been 
saved in RPMS. Please delete the entry instead. Click OK to dismiss the message. 

Select one or more eligible Findings records and click the Error button. After using 
this function, the application places a strikethrough mark on the text of the record. 

 
Figure 4-88: Sample Entered in Error marking 

After you save and return to the Tracked Events tab, the Result column for the event 
will be blank for the particular event. 

4.20.4 3 - Follow-ups Group Box 
Use the 3 – Follow-ups group box to add follow-up data about the event. 

 
Figure 4-89: Follow-ups group box 

The Follow-ups group box becomes active when the Follow-up Recommended field 
(in the Findings group box) is set to Yes. 

You can minimize this group box by clicking the collapse button in the upper left 
corner. This allows more room for viewing the other group box (Patient 
Notifications). 
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Follow-up Decision Due By: select a date from the drop-down list that indicates 
when the follow-up decision should be made. Populating the field creates a tickler 
(feather icon) for the event. In certain cases, this date is populated by the Tickler 
Timeframe set in the site parameters. You can populate this field with the date you 
want to take action on the event. 

4.20.4.1 Add Button 
Use the Add button to create a new Follow-up record. Click the Add button (or press 
the F2 button on your keyboard) to access the Follow-Ups dialog. 

 
Figure 4-90: Sample Follow-Ups dialog 

The required field are those with the asterisk after the name. 

Event: select an option from the drop-down list that describes the Event for the 
follow-up. 

Date Due: use the drop-down list to display a calendar from which to select the due 
date for the follow-up event. 

Comment: use this free text field to add comments about the follow-up. 

Click OK to save the data on the dialog (otherwise, click Cancel). After saving, the 
follow-up record will display in the 3 - Follow-ups group box on the CMET 
Worksheet. 

4.20.4.2 Delete Button 
The Delete function applies to events that had Follow-ups entered but NOT saved. 

Select one or more eligible Follow-up records you want to delete and then click the 
Delete button (or press the Delete button on your keyboard). The application displays 
the Delete Row information message, confirming the deletion. Click Yes to delete the 
selected records. Click No to not delete the records. 
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4.20.4.3 Error Button 
Use the Error button when Follow-up records have been saved and you cannot delete 
them and you want to mark them as Entered in Error. 

If you select a record that is not eligible for the Error button, the application displays 
the message: Unable to mark as ‘Entered in Error’ because the entry has not been saved in 
RPMS. Please delete the entry instead. Click OK to dismiss the message. 

Select one or more eligible Follow-up records and click the Error button. After using 
this function, the application places a strikethrough mark on the text of the record. 

 
Figure 4-91: Sample of Follow-up record marked as entered in error 

4.20.5 4 - Patient Notifications Group Box 
Use the 4 – Patient Notifications group box to add patient notification data about the 
event. 

 
Figure 4-92: Patient Notifications group box 

The Patient Notifications group box becomes active when the Follow-up 
Recommended field (in the Findings group box) is set to Yes. 

You can minimize this group box by clicking the collapse button in the upper left 
corner. This allows more room for viewing the Follow-ups group box. 

Notification Due By: enter the date to have your patient notified about the results and 
recommendations of the follow-up related to this event. If this date passes without an 
entry, a tickler (feather) icon will be generated. In certain cases, this date is populated 
by the Tickler Timeframe set in the site parameters. 
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4.20.5.1 Add Button 
If you do not have default clinics defined in user preferences, the application displays 
the following message: You must select default clinics in user preferences before 
being able to enter notes. Click OK to dismiss the message. Select Tools | User 
Preferences to access the RPMS iCare – User Preferences dialog. Go to the Patient 
View tab to enter the clinic codes. 

Use the Add button to create a new Patient Notification record. Click the Add button 
(or press the F2 button on your keyboard) to access the Notifications dialog. 

 
Figure 4-93: Sample initial Notifications dialog 

The required fields are those with the asterisk after the name. 

Date: the default date is today’s date. You can change it by clicking the drop-down 
list to access a calendar from which to select another date. 

Method: select an option from the drop-down list that identifies the type of 
notification. 

Create: this button becomes active if you select “Certified Letter” or “Letter” in the 
Method field. You must have an electronic signature on file before you can use this 
function. 

If you have an electronic signature on file, click the Create button to access the Add 
TIU Note dialog. See Section 4.24.2 for more information about this dialog. 

Comment: use this free text field to add any comments about the notification. 

After completing this dialog, click OK to save the data (otherwise, click Cancel). 
After saving, the notification record will display in the 4 - Patient Notifications group 
box on the CMET Worksheet. 
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4.20.5.2 Delete Button 
The Delete function applies to events that had Patient Notifications entered but NOT 
saved. 

Select one or more eligible Patient Notification records you want to delete and click 
the Delete button (or press the Delete button on your keyboard). The application 
displays the Delete Row information message, confirming the deletion. Click Yes to 
delete the selected records. Click No to not delete the records. 

4.20.5.3 Error Button 
Use the Error button when Patient Notification records have been saved and you 
cannot delete them and you want to mark them as Entered in Error. 

If you select a record that is not eligible for the Error function, the application 
displays the message: Unable to mark as ‘Entered in Error’ because the entry has not been 
saved in RPMS. Please delete the entry instead. Click OK to dismiss the message. 

Select one or more eligible Patient Notification records and then click the Error 
button. After using this function, the application places a strikethrough mark on the 
text of the record. 

 
Figure 4-94: Sample Patient Notification record marked as entered in error 

4.20.5.4 Preview 
Use the Preview function to preview the letter associated with the selected Patient 
Notification record. This function only applies to records that are Letters or Certified 
Letters. 

Select the record you want to previous and then click the Preview button. The 
application displays the Letter Preview pop-up. 
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Figure 4-95: Sample Letter Preview pop-up 

See Section 4.7 for more information about the buttons and File menu on the pop-up. 

4.20.5.5 Print Button 
Use the Print button to output a letter in a selected record. After clicking Print, the 
application displays the Print dialog where you specify the printer, page range, 
number of copies, etc.; this dialog works like the one in MS Office. 

4.20.6 Erroneously Tracked Events 
Once an event has been Tracked, it cannot be changed to Not Tracked. The following 
process is used when you erroneously Tracked an event. 

1. Go to the Tracked tab, in any view (Main, Panel, Patient Record) and open a 
CMET worksheet for the event you erroneously tracked. Click the Add button in 
the Findings area to access the Findings dialog. 

 
Figure 4-96: Sample Findings dialog populated 
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Choose the option “ERROR/DISREGARD” in the Findings field. Choose the 
option “No” in the “Follow-Up Needed?” field. We suggest to use today’s date 
for the Date field. Click OK to save and to close the dialog. 

2. Go to the Patient Notifications area of the CMET Worksheet and click the Add 
button. The application displays the Notifications dialog. 

 
Figure 4-97: Sample Notifications dialog populated 

Use the option “NONE” for the Method field. We recommend to add a comment 
in the Comment field and to use today’s date for the Date field. Click OK to save 
and to close the dialog. 

3. The application will display the Close Event information message. 

 
Figure 4-98: Close Event information message 

Click Yes on the message. This closes the message. 

4. The application will display the RPMS iCare – Reason for Closing dialog. 
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Figure 4-99:RPMS iCare – Reason for Closing dialog 

Select the option “Other” for the Reason field. Enter a comment in the Comment 
field. Click OK to save and to close the dialog. 

5. The application will display the Confirm save to RPMS information message. 

 
Figure 4-100: Confirm save to RPMS information message 

Click Yes on the message to save the data to RPMS and to close the message. 

This process causes the particular event to have a State of CLOSED. 

4.20.7 Menus on CMET Worksheet 
The File menu contains the Close option. It operates in the following manner: 

If you have not changed the data on the worksheet, the application closes it. 

If you have changed data on the worksheet, the application displays the “Save to 
RPMS?” dialog that states: You have data changes pending. Do you want to save to 
RPMS now? Click Yes to save the changes to RPMS. Click No to not save the 
changes. Click Cancel to return to the CMET Worksheet. 

The Help menu has two options. 

iCare Help: use this option to access the online help for the CMET Worksheet. This 
is the same as pressing the F1 key on your keyboard. 
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About iCare: use this option to review the information about the iCare version and 
other information. 

4.21 Edit Patient Demographic Fields 
You access this dialog when you edit the phone and Email fields on the Patient 
Record Window and when you edit the Race, Ethnicity, Preferred Language, or Email 
fields on the RPMS iCare – Additional Demographics window. 

 
Figure 4-101: Sample Edit patient demographic fields dialog 

Use this dialog to change the particular phone numbers, the ethnicity, number in 
household, the race of the patient, communication preferences, preferred language, 
and/or email address. 

When you have completed this dialog, click OK to save the data (otherwise, click 
Cancel to not save.) 

If you click OK, the application displays the “Confirm save to RPMS” dialog: The 
data will be saved to the RPMS server. Do you want to continue? Click Yes to continue; 
this action saves the data and dismisses the dialog. Click No to not save the data; this 
action dismisses the dialog. 

If you click Cancel and you have not changed any data, the dialog closes (nothing is 
saved). 

If you click Cancel and you have changed any data, the application displays the “Save 
to RPMS?” information message, asking if you want to save the data to RPMS. Click 
Yes to save, click No to not save, or click Cancel. If you use Yes or No, the action 
dismisses the dialog. If you use Cancel, you return to the dialog. 
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4.21.1 Fields on Edit Patient Demographic Fields Dialog 
The field name followed by an asterisk (*) is required. 

Phone: Populate the phone field with the appropriate number, using 4-60 characters 
in length. This applies to the patient’s Home Phone, Work Phone, and Alternate 
Phone fields. 

Number in Household: Populate with the number of people in the household. 

Ethnicity: Use any option on the drop-down list to define the ethnicity of the patient. 
After populating this field, the Method of Collection field become active. 

Method of Collection: Use any option on the drop-down list to define the method of 
collection for the ethnicity. 

Race: Use any option on the drop-down list to define the patient’s race. 

Communication Preference: Use any option on the drop-down list to define the 
preferred means of communication, for example, email. 

Email: Populate with the patient’s email address. 

Preferred Language: Use any option on the drop-down list to defined the patient’s 
preferred language. 

4.21.2 Menus on Edit Patient Demographic Fields Dialog 
Use File | Close to dismiss this dialog. 

The Help menu has two options. 

iCare Help: use this option to access the online help for the dialog. This is the same 
as pressing the F1 key on your keyboard. 

About iCare: use this option to review the information about the iCare version and 
other information. 

4.22 CMET Package Manager 
You access the CMET Package Manager option on the Tools menu of any main iCare 
window (Panel List, Flag List, Community Alerts, CMET). 

You use the CMET Package Manager option to access the CMET Site Parameters 
option; this option accesses the RPMS iCare – CMET Site Parameters dialog. This 
allows both the iCare and CMET Package Managers t establish the following: 
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• Tickler Timeframes: This is set for the site (not the individual user). 
Consideration for these timeframes are based on typical (or average) lengths of 
time it would take to receive results, to consider the next steps, and to notify 
patient. 

• Batch Processing: This applies to Pap Smears and Mammogram screenings with 
normal results. This allows the package manager to select the timeframe (follow-
up interval) and notification type for Pap Smears and for Mammogram screening. 

4.22.1 Tickler Timeframes Tab 
The Tickler Timeframes tab sets the ticklers (like reminder notices) for Findings, 
Follow-up Decision, and Patient Notification. 

 
Figure 4-102: RPMS iCare – CMET Site Parameters, Tickler Timeframes tab 

Each field has a drop-down list from which to select an option. The default for all 
fields is 1 Week. When a timeframe date is passed and the step has not been entered, 
the Tickler will be displayed. 

After you change one or more settings and click OK, the application populates the 
Last Edited field with the date, and the By field with the person who changed the 
tickler timeframe data. To not save, click Cancel. 

The application provides Ticklers designed to remind the user that a CMET is tracked 
and requires attention. There are three types of Ticklers: 

• Finding Ticklers, based on the event date. The Tickler is initiated from the 
date of the event. 

• Follow-up Decision Ticklers. Ticklers are initiated from the date the Findings 
were entered. 
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• Patient Notification Tickers. Ticklers are initiated from the date the Follow-up 
recommendation is entered. 

Timeframes for each of the three steps is based on the preceding step. For example, a 
Follow-up Decision Tickler is based on the date the Finding was entered. 

4.22.2 Batch Processing Tab 
The Batch Processing tab provides the user with the ability to set the timeframe and 
notification type for the Pap Smear and Mammogram Screening events with normal 
results. In addition, you can set the type of Normal Finding for the Mammogram 
Screening event. 

 
Figure 4-103: RPMS iCare – CMET Site Parameters, Batch Processing 

The Notification Type field defines how the patient will be notified about the Pap 
Smear or Mammogram Screening, for example, by telephone. The default is 
LETTER. 

Each field has a drop-down list from which to select an option. 

After you change one or more settings and click OK, the application populates the 
Last Edited field with the date, and the By field with the person who changed the 
batch processing data. To not save, click Cancel. 

4.23 Panel Definition Layouts Functionality 
The Layouts tab allows you to customize your user template for defining the Patient 
List, Reminders, Natl Measures, Asthma, HIV/AIDS, Events, Tracked Events, and 
Follow-up Events layouts. 
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After you click the “Edit Patient List Layout” button on the Layouts tab of the Panel 
Definition window, the Patient List Layout for the selected patient panel displays. 

 
Figure 4-104: Patient List Layout for Selected Panel 

This layout window works the same for the Reminders, Natl Measures, Asthma, 
HIV/AIDS, Events, Tracked Events, and Follow-up Events layouts. 

After you have changed the Display Columns and/or Sort Columns, click OK to save 
your changes. 

Use the Reset button to restore the layout to the most recently saved configuration. 

Use the Cancel button to dismiss the window. 

4.23.1 Template Group Box for Panel Definition Layout 

 
Figure 4-105: Template group box for Panel Definition 

When you first access the layout dialog, the application displays the System Default 
template. The Template and Customized radio buttons are not selected. 
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• If you leave the System Default radio button selected, then the application 
displays the system default columns. In this case, the Add and Remove 
buttons are not active (and you cannot change anything) on the Patient List 
Layout dialog. You can change the column layout for the default template by 
using the Layouts tab on the User Preferences dialog. See Section 4.19. 

• If you select the Customized radio button, the application lets you change the 
columns (the Add and Remove buttons become active, for example). 
Anything you change on the layout dialog will be used for the Customized 
template. 

• You can name the customized template by selecting the Template radio 
button. This action causes the field with the drop-down list to become active 
(and the Customized and System Default radio buttons are not selected). Once 
you add a name, it is added to the Template name drop-down list. Later, you 
can choose which template you want to use during an iCare session. 

4.23.2 Display and Available Columns for Panel Definition Layout 

 
Figure 4-106: Sample Display and Available columns 

You use the Display Columns to determine what columns you want to display for the 
particular window or tab. The listing in the Display Columns area shows the columns 
that will be displayed for your population. The column names in italics are required 
and cannot not be removed. 

To move a Column name in the Available Columns area to the list in the Display 
Columns area, highlight a column name in the Available Columns area and click 
Add. This moves the column name from the left panel to right panel. 

Likewise, you can remove a column in the Display Columns area and move it to the 
Available Columns area by highlighting the column name (in the Display Columns 
area) and clicking Remove. This moves the column name from the right panel to the 
left panel. 

As noted about the Display Columns area, you cannot remove any column names in 
italics. 
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You can determine the order the columns display in the Display Columns area by 
using the Up and Down buttons. Highlight a column name and click the appropriate 
button. You might have to click the button more than once to move it to the desired 
location. 

4.23.3 Columns to Sort for Panel Definition Layout 
Sorting a column means you want to arrange the items in the column in alpha-
numeric order. 

 
Figure 4-107: Sample Available Sorts and Sort Columns area 

To move a Column name in the Available Sorts area to the list in the Sort Columns 
area, highlight a column name in the Available Sorts area and click Add. This moves 
the column name from the left panel to right panel. 

Likewise, you can remove a column in the Sort Columns area and move it to the 
Available Sorts area by highlighting the column name (in the Sort Columns area) and 
clicking Remove. This moves the column name from the right panel to the left panel. 

4.23.3.1 Column Sort Order for Panel Definition Layout 
You use the Sort Columns area to determine what columns you want to sort for the 
particular window or tab. The column names in italics are required and cannot not be 
removed. 

You determine which order the columns are sorted in the Sort Columns area by using 
the Up and Down buttons. Highlight a column name and click the appropriate button. 
You might have to click the button more than once to move it to the desired location. 
For example, if you have Gender, Patient Name, and Diagnosis Tags in the right 
column, the Gender sort is applied first then the Patient Name and then the Diagnosis 
Tags is last. 
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4.23.3.2 Switch Sort Direction for Panel Definition Layout 
The names of columns in the Sort Columns area show “ASC” appended to the name, 
for example Patient Name ASC. You can switch the sort order for a selected column 
by clicking the Switch Sort Direction button. In the example, the name changes 
Patient Name DESC. You can use the “switch sort direction” action on more than one 
column. 

4.24 Add TIU Note Dialog 
The following information provides information about using the Add TIU Note 
dialog. You can access this dialog from different places in iCare. Below are some 
examples: 

• If you click the Add a Note button on the Patient Record window, the 
application displays the Add a Note dialog. See Section 4.25 for more 
information. If you click the Create button on the Add a Note dialog, the 
application displays the Add TIU Note dialog. See Section 4.24.1. 

• If you are on the Patient Notifications group box on the CMET Worksheet and 
you click the Add button, you access the Notifications dialog. When you click 
the Create button, you access the Add TIU Note dialog. See Section 4.24.2 for 
more information. 

• If you are on the PCC tab of the Patient Record window and you click the Add 
a Note button, the application displays the Add a Note dialog. See 
Section 4.25 for more information. If you click the Create button on the Add a 
Note dialog, the application displays the Add TIU Note dialog. See 
Section 4.24.1. 

• If you are on the CMET Batch Mammogram Screening or CMET Batch Pap 
Smear window, click the Create button to access the Add TIU Note – Batch 
Mode dialog. See Section 4.24.3 for more information. 

4.24.1 Using the Add a Note Button on Patient Record 
When you click the Add Note button on the Patient Record window, the application 
displays the Add a Note dialog. See Section 4.25for more information about the fields 
on this dialog. 

After clicking the Create button on the Add a Note dialog, the application displays the 
Add TIU Note dialog. 
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Figure 4-108: Sample Add TIU Note dialog 

Both fields are required. 

Document Title: select an option from the drop-down list to establish the title of the 
TIU note. 

Subject: use this free text field to enter the subject of the TIU note. This field 
becomes active after populating the Document Title field. 

At this point, you can do one of the following: not use a template or use a template. 

4.24.1.1 Note with No Template 
When you do not want to use a template, and, after you populate the Document Title 
and Subject fields, you can type the text of the TIU note in free text area on the right 
side of the dialog. 

When the text is complete, the following buttons are active: Find, Font, Copy, Save 
Note, Sign Note, Close. See Section 4.24.1.3 for more information. 

Below is an example of what happens after you click the Save Note button. 
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Figure 4-109: Sample Add TIU Note dialog with note information 

4.24.1.2 Note with Template 
After you populate the Document Title and Subject field, check the “Show 
Template?” check box. This action shows the available templates that you can use. 
(You will need to expand the Shared Templates option.) After you find the template 
you want to use, double-click on its name. The application will display the particular 
template. 
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Figure 4-110: Sample Template 

You can complete the template by using the buttons and check boxes on the template. 
What you use on the template determines the text of the TIU note. 

Use the Preview button (on the Template window) to “preview” the note, in its 
current state. 

 
Figure 4-111: Sample Preview of the TIU note 

What appears on the Template Preview pop-up determines what will be in the text of 
your TIU note. See Section 4.7 to review the buttons and File menu on the pop-up. 
After you close (File | Close) the pop-up, you return to the Template window. 
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After you have complete the Template window, click OK (otherwise, click Cancel). 
The OK option returns you to the Add TIU dialog. 

4.24.1.3 Buttons on Add TIU Note Dialog 
Please note the following about the text of the TIU note: 

• Line lengths should be <80 columns (characters), otherwise, the line spacing 
on the finished TIU note will not format correctly. 

• The Find, Font, Copy, Print Preview, and Print buttons on this dialog work 
like those on the pop-up window. See Section 4.7 for more information about 
these buttons. 

• You should adjust the font size before saving the TIU note, if needed. 
Delete Note: use this button to delete the current unsigned note. (This button does not 
apply to signed notes.) 

Save Note: use this button to save the current note. After clicking this button, the note 
is saved and the Delete Note and Edit Note buttons become active. 

Sign Note: use this button to electronically sign the selected unsigned TIU note. After 
clicking the Sign Note button (or selecting File | Sign Note), the application displays 
the Enter Electronic Signature dialog. 

 
Figure 4-112: Enter Electronic Signature dialog 

Enter you electronic signature in the field and then click OK (otherwise, click 
Cancel). After using OK, you return to the Add TIU Note dialog. The text of the 
note shows that the note has been electronically signed. 

 
Figure 4-113: Sample electronic signature noted on text of TIU note 

Edit Note: after you click the Edit Note button, the application displays the text of the 
note. 
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Figure 4-114: Example of text of the note 

After you edit the text of the note, you can use the Save Note button again. 

If you have already signed the TIU note, you cannot change the text; you can only 
view the text. 

Close: use this button to close the Add TIU Note (for patient) dialog. Click the Close 
button (or select File | Close) to close the dialog. 

You return to the Add a Note dialog, with the Preview button next to the Add 
Note field. 
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Figure 4-115: Sample Add a Note dialog with Preview button 

Click the Preview button to display the text of the note.  

 
Figure 4-116: Sample Letter Preview pop-up 

See Section 4.7 for more information about the buttons and File menu on the pop-
up. 

Close the pop-up to return to the Add a Note dialog (with the Preview button on 
it). 

After the Add a Note dialog is complete, click OK (otherwise, click Cancel). 

After clicking OK, the application displays the Enter Electronic Signature dialog. 
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Figure 4-117: Enter Electronic Signature dialog 

Enter you electronic signature in the free text field. After completing the dialog, click 
OK (otherwise, click Cancel). 

• If you click OK and had entered an invalid electronic signature, the 
application displays the Invalid Attempt information message that states: 
Invalid electronic signature. Try again? Click Retry to return to the Enter 
Electronic Signature dialog. Click Cancel and the application displays the 
message: Unable to save with a signed note; click OK to return to the Add a note 
dialog. 

• If you click Cancel, the application displays the message: Unable to save with a 
signed note. Click OK to dismiss the message. 

• If you click OK and had entered a valid electronic signature, the application 
displays the information message: This data will be saved to the RPMS server. Do 
you want to continue? Click Yes to save and to continue. Click No to not save 
and leave the dialog. 

4.24.2 Using Create Button on Notifications Dialog 
If you are on the Patient Notifications group box on the CMET Worksheet, click the 
Add button to access the Notifications dialog. When you click the Create button on 
this dialog, you access the Add TIU Note dialog. 
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Figure 4-118: Add TIU Note dialog 

4.24.2.1 Fields 
Both fields are required. 

Document Title: select an option from the drop-down list to establish the title of the 
TIU note. 

Subject: use this free text field to enter the subject of the TIU note. 

At this point, you can do one of the following: not use a template (see section4.24.1.1 
Note with No Template) or use a template (see Section 4.24.1.2. 

4.24.2.2 Buttons 
The Find, Font, Copy, Print Preview, and Print buttons on this dialog work like those 
on the pop-up window. See Section 4.7 for more information about these buttons. 

You should adjust the Font size before saving, if needed. 

Save Note: use this button to save the current note. 

Delete Note: use this button to delete the current unsigned note. (This button does not 
apply to signed notes.) 
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Edit Note: use this button to edit the text of an unsigned note. 

Close: use this button to close the Add TIU Note dialog. 

After using Close, you return to the Notifications dialog. 

Click OK on the Notifications dialog to save the data (otherwise, click Cancel). If you 
use OK, the data is added to the 4 – Patient Notifications group box of the CMET 
Worksheet. 

If you click OK on the Patient Notifications group box, the application displays the 
Confirm save to RPMS information message that states: This save will be saved to the 
RPMS server. Do you want to continue? Click Yes to save (otherwise, click No). 

If you use the Yes option (on the confirmation message), the application displays the 
Enter Electronic Signature dialog. 

 
Figure 4-119: Enter Electronic Signature dialog 

Enter your electronic signature in the field and then click OK (otherwise, click 
Cancel to not electronically sign the note). 

If you use the OK option, the application displays the Print TIU Notes 
information message. 

 
Figure 4-120: Print TIU Notes information message 

Click Yes to print the TUI note. The application displays the Print Preview dialog. 
You can print the TIU note from this dialog. 

If you use the No option, the application displays the Print TIU Notes warning. 
This gives you a second time to print the TUI note. 
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Figure 4-121: Print TIU Notes information message 

Click Yes to print the TIU note at this time when batch processing. Otherwise, 
you will only be able to reprint this note from the individual patient record. 

If you use Yes, the application displays the Print Preview dialog. You can print 
the TIU note from this dialog. 

If you use yes or no on the Print TIU Notes warning, the application displays the 
Close Event information message that asks: All steps for this Event are completed. Do 
you want to Close the Event? Use Yes to close the event. Use No to not close the 
event. Use Cancel to return to the CMET worksheet. 

If you use Yes, the application displays the RPMS iCare – Reason for Closing 
dialog where you give the reason for closing and add comments, if needed. Click 
OK to save (otherwise, click Cancel). 

If you use save, the application displays the Confirm save to RPMS information 
message that asks: The data will be saved to the RPMS server. Do you want to continue? 
Click Yes to save. Click No to not save. 

4.24.3 Using Create Button on Batch Processing Window 
If you are on the CMET Batch Mammogram Screening or CMET Batch Pap Smear 
window, click the Create button to access the Add TIU Note – Batch Mode dialog. 
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Figure 4-122: Sample TIU Note – Batch Mode dialog 

4.24.3.1 Fields 
Both fields are required. 

Document Title: select an option from the drop-down list to establish the title of the 
TIU note. 

Subject: use this free text field to enter the subject of the TIU note. 

At this point, you can do one of the following: not use a template (see 
Section 4.24.1.1) or use a template (see Section 4.24.1.2. 

4.24.3.2 Buttons 
The Find, Font, Copy, Print Preview, and Print buttons on this dialog work like those 
on the pop-up window. See Section 4.7 for more information about these buttons. 

You should adjust the Font size before savings the note. Using this process will save 
the note in an appropriate font size for output (later). 

Save Note: use this button to save the current note. 

Delete Note: use this button to delete the current unsigned note. (This button does not 
apply to signed notes.) 
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Edit Note: use this button to edit the text of an unsigned note. 

Close: use this button to close the Add TIU Note – Batch Mode dialog. 

After you click the Close button, the application closes the Add TIU Note – Batch 
Mode dialog. 

Then the application displays the Enter Electronic Signature dialog. 

 
Figure 4-123: Enter Electronic Signature dialog 

Enter your electronic signature in the field and then click OK (otherwise, click 
Cancel). 

4.24.3.3 Printing the TIU Note 
When you use OK (on the Enter Electronic Signature dialog), the application displays 
the Print TIU Notes information message. 

 
Figure 4-124: Print TIU Notes information message 

Click Yes to print the TUI note. The application displays the Print Preview dialog. 
You can print the TIU note from this dialog. 

Click No to not print the TUI note. The application displays the Print TIU Notes 
information message. This gives you a second time to print the TUI note. 
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Figure 4-125: Print TIU Notes information message 

Click Yes to print the TIU note at this time when batch processing. Otherwise, 
you will only be able to reprint this note from the individual patient record. 

If you use Yes, the application displays the Print Preview dialog. You can print 
the TIU from this dialog. 

4.25 Add a Note Dialog 
The following information provides information about using the Add a Note dialog. 
You can access this dialog from different places in iCare. Below are some examples: 

• If you click the Add a Note button on the Patient Record window, the 
application displays the Add a Note dialog. 

• If you are on the PCC tab of the Patient Record window and you click the Add 
Chart Review, you access the Add New Chart Review Visit dialog. If you 
click the Create button, you access the Add a Note dialog. 

 
Figure 4-126: Sample Add a Note dialog 

The application automatically populates the Provider field with the current logon user 
and the Narrative field. 
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All of the fields are required. 

Clinic: select an option from the drop-down list that defines the clinic for the note. 
The options are Chart Review (or record modification), Follow-Up Letter, or 
Telephone Call. After populating the Clinic field, the application automatically 
populates the Category field. 

Add Note: click the Create button to access the Add TIU Note dialog. See 
Section 4.24 for more information about this dialog. 

The File menu (on the Add a Note dialog) has one option: Close. This closes the 
dialog (same action as clicking the Cancel button). 

The Help menu (on the dialog) has two options: (1) iCare help for this dialog (same 
as pressing the F1 key) and (2) About iCare (displays information about the 
application, such as the version being used). 
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5.0 Creating Patient Panels 
A patient panel is a group of patients that needs to be managed collectively. Some 
users will have only one patient panel while others will have many. 

You can create and use a panel for a day, a month, permanently. iCare provides you 
with many pre-defined search options to populate your panels, or you can add 
individually selected patients. 

The key categories of a pre-defined population search include: 

• Your “My Patients” definition, with additional filters such as visit date range, 
sex, age, community, and diagnosis. 

• Surrogate Provider - a provider different from yourself 

• By scheduled appointments, defined by date range and/or clinics 

• From an existing QMan search template 

• From a Register 

• By any combination of patient data including age, sex, visit date range, 
primary visit provider, community, or pre-defined diagnosis 

5.1 Scenarios and Panel Examples 
• I am a nurse at a facility that assigns a primary care provider to each patient. 

Every day, I want to create a list of scheduled patients for two different 
doctors in my clinic. 

• I want to identify which of my patients are considered obese so I can 
recommend nutrition counseling. 

• Because providers at our clinic have performance goals related to annual 
GPRA clinical measures, I want to identify which of my patients are missing 
key clinical data. 

• Our Women’s Health clinic wants to focus on two clinical performance 
improvement initiatives this year. We want to identify the performance 
problem areas for female patients between ages 18 and 50. 

• I am one of two part-time case managers for a group of children, and I want to 
create a patient list that we both can use. 

5.2 Steps to Create a Panel 
To create a panel, follow the steps below. Detailed information about each option is 
presented in the following sections. 
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1. From the Panel List window, do any of the following: 

• Click the New  button 

• Select the New option on the right-click menu 

• Select File | Panel | New 
The Panel Definition window will display where you can define the search criteria 
to be used to populate the list of patient members for the new panel. 

 
Figure 5-1: Initial Panel Definition Window 

2. Type the unique name of the new panel in the required Panel Name field, limited 
to 120 characters (required field). 

If you enter a duplicate name, iCare displays the “Panel Name is not unique, please 
choose another name” warning message when you try to move to another tab. Click 
OK on the message and enter a new name. (Otherwise, click Cancel.) 

3. Type a description of your panel (limited to 250 characters). This is not a required 
field but is strongly recommended. 

4. Select one of the Population Search Options radio buttons. 
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• No Predefined Population Search: a blank panel will be created and you can 
add patients individually. See Section 5.3.1 for more information. This panel 
will not have an search logic associated with it and therefore all panel patient 
members will be added manually. 

• My Patients: the panel will be based on the “My Patients” definition set in 
your User Preferences. See Section 5.3.2 for more information. 

• Patients Assigned to: the panel will be based on a “My Patients” definition 
for another provider. See Section 5.3.3 for more information. 

• Scheduled Appointments: the panel will be based on the RPMS Scheduling 
application. You will select an appointment date range and appointment 
locations. See Section 5.3.4 for more information. 

• Qman Template: the panel will be based on an existing QMan template. See 
Section 5.3.5 for more information. 

• RPMS Register: the panel will be based on any existing Register that was 
created with case management software, including the Diabetes Management 
System (BDM), the Case Management System (ACM), the Asthma Register 
System (BAT), or the HIV Management System (BKM). See Section 5.3.6 for 
more information. This option searches for patients that are members of 
various register applications on the RPMS server. 

• EHR Personal List: the panel will be based on a selected personal list from 
the RPMS-EHR application. See Section 5.3.7 for more information. 

• Ad Hoc Search: the panel will be based on one or more data items. See 
Section 5.3.8 for more information. 

5. To preview the list of patients created from your population search logic, click the 
Preview tab. This will provide you with the opportunity to change logic as needed 
before saving the panel (on the Definition tab). See Section 5.6 for more 
information. 

If you are ready to save your panel, skip to Step 9. Otherwise, you can perform the 
following actions (in Steps 6 through 8) before you save your panel. 

6. To change the screen layout of your panel, click the Layouts tab. See Section 5.4 
for more information. 

7. To share the panel with others, click the Sharing tab. See Section 5.5 for more 
information. 

8. To have your panel repopulated automatically (add or delete patients based on 
your panel logic), click the Auto Repopulate Options tab. See Section 5.7 for 
more information. 

9. Click OK to save and close the panel or Cancel to discard the incomplete panel. 
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If you click OK and it takes time to populate the panel, the “Background 
populate?” information message will display, asking you if you want to populate 
in the background. Click Yes to populate in the background. Click No to populate 
in the foreground. 

If you used OK to save, your new patient panel will display on your Panel List 
window. 

If you have forgotten to enter a panel name or complete any of the search options, the 
warning message “Complete the required information in the highlighted field(s)” will 
display. See Section 4.6.4 for more information on missing data fields. 

If you decide to NOT create the Patient Panel, click Cancel on the Panel Definition 
window to display a warning message, asking if you want to save the changes to the 
panel. 

• Click Yes to save the changes to the panel. You will be warned about any 
missing information, if any. 

• Click No to exit the Panel Definition window. 

• Click Cancel to return to the current panel where you can continue to 
create the panel. 

5.3 Population Search Options 
To create a patient panel, you must select one of the Population Search Options radio 
buttons on the Panel Definition window. The following sections provide details about 
each of the Search Options. 

5.3.1 No Predefined Population Search 
The default option “No Predefined Population Search - Add Patients Manually” 
creates an empty panel. You add the patients to the panel using a search tool. On the 
Definition tab, do the following: 

1. Enter a panel name and description. 

2. Click the “No Predefined Population Search” radio button from the Population 
Search Options list. 

3. Click OK to create the panel. An empty panel is created and the Select Patients 
dialog is displayed. 
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Figure 5-2: Empty New Panel with Select Patients Dialog 

If you click Close (and do not search for any patients), the new panel will contain 
no patients. 

4. To add patients to the new panel, type the last name, HRN, SSN, or DOB of the 
individual patient you want to add to your panel in the Search box. Then click 
Find. There are two conditions: (a) one or more matches are found or (b) no 
matches are found. 

5. If one or more matches are found, they will be displayed. 
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Figure 5-3: Sample Populated Select Patients Dialog 

Highlight the patients and click Add. (See Section 4.2 for more information about 
selecting patients). This adds the selected patients to the new panel. The Search 
field will be cleared of data. 

6. If no matches are found, the warning message “No matching patients were found” 
will display. Click OK to dismiss the message. You return to the Select Patients 
dialog. Try another search criteria. 

7. Search for additional patients by continuing to type the last name, HRN, SSN, or 
DOB in the Search box. Continue to highlight and add patients. 

8. Click Close when you have added all of your patients. The Select Patients dialog 
will close and your panel will be displayed. (Otherwise, click Close; the panel 
will display with no patients in it.) 

5.3.2 My Patients 
If you select My Patient, you must have “My Patients” defined in the User 
Preferences (see Section 3.1.1.1). This search logic applies to any panel created using 
the “My Patients” option. On the Definition tab, do the following: 

1. Type a name and definition for your panel. 

2. Click the My Patients radio button. If you have “My Patients” defined, the Panel 
Definition will display, as below: 
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Figure 5-4: My Patient Definition 

If you do NOT have “My Patient” defined, you will have to Cancel the Panel 
Definition and set a definition for “My Patients” from the Tools | User 
Preferences menu. See Section 3.1.1.1 for more information. 

3. Check the Apply Additional Filters check box to display additional data that can 
be used to refine the search. 

These are the same fields that display when you select the Ad Hoc Search radio 
button. See Section 5.3.8 for detailed information. 

4. Click OK on the Panel Definition dialog. The application displays the 
“Background populate?” information message, asking if you want to background 
process. Click Yes to populate the panel in the background. Otherwise, click No 
to populate in the foreground. 

Example: You want the panel to contain female patients ages 45 to 47 for whom you 
are either the Designated Primary Care Provider or the Primary Visit Provider for at 
least three years in the past two years. 

 
Figure 5-5: Sample Panel Definition with Sex and Age Filters 
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In this example, here are the steps to follow: 

1. Make sure your “My Patients” definition has the following selections: the DPCP 
type and Primary Visit Provider type with 3 visits in the past 2 years. You can 
check this by holding your mouse over “Current Definition” phrase. If you need 
to modify “My Patient” definition, access it under Tools | User Preferences. 

2. On the Panel Definition window, select My Patients and check the Apply 
Additional Filters checkbox. 

3. Select Sex option Female. 

4. Select Age “in range (inclusive)” and enter 45 and 47 for the age range. 

Note: You can also create this same search logic by using the 
Patients Assigned To search option and selecting your 
name and provider definition. 

5.3.3 Patients Assigned To 
The Patients Assigned to option is similar to the “My Patients” definition but does not 
become a permanent User Preference. You will select your name or another 
provider’s name and then select one or more provider types that best define patients 
that are “assigned” to the provider selected. See Section 3.1.1.1 for a more detailed 
explanation of each provider name and timeframe option. 

 
Figure 5-6: Sample Patients Assigned to Options 

This is a good option to use if you want to use a different definition for yourself for 
“your patients.” For example, if your User Preference designates “your” patients as 
Designated Primary Care Provider (DPCP) only, you might want to use both DPCP 
and primary visit provider. 

This is also a good option for nurses or case managers who are responsible for 
working with two or three individual physicians. You can quickly create individual 
panels for each physician based on the physician’s specific role. 
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1. Type a name and definition for your panel. 

2. Click the Patients Assigned to radio button. Additional data options are displayed. 

3. Click the drop-down list for the Provider field (required) and select a name (a 
provider or surrogate provider). To search for a name, type the last name of the 
provider and the appropriate names will be displayed. Highlight the name. NOTE: 
you must have entered a name for your panel before the drop-down list becomes 
available. 

4. After you populate the Provider field, you need to indicate what type of provider 
the selected name is. The choices are: 

DPCP (Designated Primary Care Provider): any patient who’s documented DPCP 
is the selected provider/surrogate. You use this option if the selected provider is 
using the Designated Specialty Provider Management (DSPM) option, in the 
RPMS application. 

If the selected provider is NOT running DSPM, then you use the last two options, 
the Primary Visit Provider or the Primary/Secondary Visit Provider. 

Specialty Provider: Users are assigned as Specialty Providers to patients as 
defined in the Designated Specialty Provider Management (BDP) application. 

 
Figure 5-7: Specialty Provider radio button 

After you select the Specialty Provider radio button, the Specialty Type field 
becomes active. Click the Edit button to display the Add/Remove Specialty 
Provider Types dialog. 

 
Figure 5-8: Add/Remove Specialty Provider Types dialog 
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See Section 4.8 to review how to use the add/remove dialog. After you click 
OK on the dialog, the selections in the Current Selections group box will 
populate the Specialty Type field. (Otherwise, click Cancel to not change the 
Specialty Type field.) 

Primary Visit Provider: any patient whose Primary Visit Provider is the 
selected provider/surrogate for a user-defined number of visits within a user-
defined timeframe, e.g., a patient where the selected provider/surrogate was 
the Primary Visit Provider for at least two times in the past six months. The 
defaults for the user-defined values are two visits within the past year. 

Primary/Secondary Visit Provider: any patient whose Primary/Secondary 
Visit Provider is the selected provider/surrogate for a user-defined number of 
visits within a user-defined timeframe. The defaults for the user-defined 
values are two visits within the past year. 

Minimum Visits: you can select the minimum number of visits used in 
combination with a time frame to define whether a patient “belongs” to a 
provider, e.g., two (2) visits in the past year. Values are 1 through 9; you must 
select the value from the drop-down list. The Minimum Visits option is used 
with Provider Types “Primary Visit” and “Primary/Secondary Visit” only. 

Minimum Visit Timeframe: you can select a timeframe to be used in 
combination with the minimum number of visits to define whether a patient 
“belongs” to a provider, e.g., 2 visits in the past year. Values are: 3 months, 6 
months, 1 year, 2 years; you must select the value from the drop-down list. 
The Minimum Visit Timeframe option is used with Provider Types “Primary 
Visit Provider” and “Primary/Secondary Visit Provider” only. 

5. If you checked the Primary Visit Provider or Primary/Secondary Visit Provider, 
select both a minimum number of visits and a timeframe (required). 

6. Select the “Apply Additional Filters?” check box to display additional data that 
can be used to refine the search. 

These are the same fields that display when you select the Ad Hoc Search radio 
button. See Section 5.3.8 for detailed information. 

5.3.4 Scheduled Appointments 
You use the Scheduled Appointments search option to find the patients with 
scheduled appointments in a specified date range or time frame for your new panel. 

This is a good option to use if you are a nurse in a clinic that empanels patients 
(assigns a primary care provider to each patient), and you manage the patients for 
multiple physicians. 
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1. Type a name and definition for your panel. 

2. Click the Scheduled Appts radio button. 

3. You use the Appointment Range group box to set either a date range or a time 
frame. You must select one of the radio buttons. 

 
Figure 5-9: Sample Scheduled Appointments Selection Options 

By Date 

Click the By Date radio button where you enter the date range for the 
scheduled appointments. See Section 4.6.3 for more information. If you want 
one day only, both the beginning and end dates must be the same. The default 
is [none]. 

By Timeframe 

If you select this option, the panel should be set to automatically Auto 
Repopulate at first login (see Section 5.7 for more information). 

Click the Timeframe radio button to select time frame associated with the date 
range (cannot be blank). Valid choices are on the drop-down list: 

Today 
Tomorrow 

This Week (to include today) 
Next Week (beginning one week from today) 

Next 30 Days (to include today) 
Yesterday 

Last Week (beginning yesterday) 
Last 2 weeks (beginning yesterday) 

Last 30 (beginning yesterday) 
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4. You use the Appointment Locations group box to select the appointment locations 
by which to search. 

 
Figure 5-10: Appointment Locations group box 

You must select one of the radio buttons (By Scheduling Clinic or Visit Clinic). 

After selecting By Scheduling Clinic or By Visit Clinic and clicking Edit, you 
move to the “Add/Remove” dialog. 

 
Figure 5-11: Sample Add/Remove Scheduling Clinics Dialog 

You control the list of available clinics by selecting an option from the Available 
Selections field, either Active Only or All. 

To review how the other parts of the dialog works, see Section 4.8. 

When the Add/Remove dialog is complete, click OK. This action populates the 
By Scheduled Clinic/By Visit Clinic field on the Panel Definition window. 
(Otherwise, click Cancel). iCare searches for the patients in the clinics in the By 
Scheduled Clinic/By Visit Clinic field. 

The intent of the Appointment Status field is to define a panel once and have it 
auto populate every day without having to manually change the date range. If you 
use this option, the panel should be set to Auto Repopulate (see Section 5.7 for 
more information). 

The Appointment Status field is populated by clicking the Edit button to display 
the Add/Remove Appointment Statuses.  
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Figure 5-12: Add/Remove Appt Types 

See Section 4.8 for more information about the Add/Remove dialog. 

When the Add/Remove dialog is complete, click OK. This action populates the 
Appointment Status field on the Panel Definition window. (Otherwise, click 
Cancel). The search will be OR (not AND). 

5. Select the “Apply Additional Filters?” check box to display additional data that 
can be used to refine the search. 

These are the same fields that display when you select the Ad Hoc Search radio 
button. See Section 5.3.8 for detailed information. 

5.3.5 QMan Template 
You use the QMan Template option to populate your panel with the patients 
identified in a specified QMan search template. 

This is a good option to use if you or another RPMS user has already spent time 
creating QMan searches that you would like to reuse. For the expert user, QMan can 
produce highly complex searches. 

1. Type in a name and definition for your panel. 

2. Click the QMan Template radio button. 

3. Click the Template Name drop-down list to display a list of available templates 
arranged in alphabetical order. 
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Figure 5-13: Sample QMan Template List 

4. You can search for a template by typing a few characters in the QMan Template 
field; the list will scroll to the first instance of the name containing those 
characters. 

OR 

Use the scroll bar to browse through the list. 

5. Highlight the template name. 

Please note the following about the Template Type: 

The ‘P’ in the Template Type column means the it is a patient centric QMan 
search 

The ‘V’ in the Template Type column means the it is a visit centric QMan search. 

6. If you need additional filters, check the “Apply Additional Filters?” check box; 
additional filter fields display at the bottom of the window (they are the same 
fields that display when you select Ad Hoc Search). See Section 5.3.8 for more 
information. 

User Tip: You can only select one QMan template for each panel. 
To create a panel containing multiple templates, create one 
panel for each template, and then copy all patients out of 
each panel into one combined panel. Duplicate patients will 
not be included. 

Please note that if the QMan template is removed from the database and you try to 
modify that panel (using the template), the Template Name field will empty. In this 
case, close the Panel Definition window and create a new panel and copy the patients 
to the new panel. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Creating Patient Panels 
August 2011 

140 

5.3.6 RPMS Register 
You use the RPMS Register option to populate your panel with patients who are 
already on a Register for any existing RPMS case management system. Examples of 
case management systems are Diabetes Management System (BDM), Case 
Management (ACM), the Asthma Register System (BAT), and the HIV Management 
System (BKM). Currently, only the Case Management System has multiple Registers. 

Note: Any Register created within the Diabetes Management 
System that is NOT the “official” IHS Diabetes Register 
can be located by selecting the Case Management System 
option, and then scrolling to the named diabetes sub 
registers. 

1. Type the name and definition for your panel. 

2. Click the RPMS Register radio button. 

3. Click the Register Name drop-down list to display the list of RPMS registers in 
alphabetical order. 

 
Figure 5-14: Sample RPMS Register List 

4. Begin by typing the name of the Register and the list will scroll to the first 
occurrence of the typed letters. Highlight your selection. 

The Case Management System option requires secondary data. 

 
Figure 5-15: Case Management Selection Options 

You must select a sub-register from the drop-down list. 

The default Status is ACTIVE. The Status field displays for the Asthma, Diabetes, 
HIV Management System, and Pre-Diabetes registers. 
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To change the Status, click Edit to display the Add/Remove Register Statuses 
dialog. 

 
Figure 5-16: Add/Remove Register Statuses Dialog 

See Section 4.8 for more information about the Add/Remove dialog. 

When the dialog is complete, click OK. This action populates the Status field on 
the RPMS Register Parameters group box. (Otherwise, click Cancel). 

5. If you need additional filters, check the “Apply Additional Filters?” check box; 
additional filter fields display at the bottom of the window (they are the same 
fields that display when you select the “Ad Hoc Search” radio button). See 
Section 5.3.8 for more information. 

5.3.7 EHR Personal List 
You use the EHR Personal List option to use an existing defined personal list from 
the RPMS-EHR application. 

After you select this option and there is no existing personal list, the application 
displays the Warning: No Selections Available message that reads: There is no EHR 
Personal Lists for selection. Click OK to dismiss the message. 

If there are personal lists available, follow these steps: 

1. Type a name and definition for your panel. 

2. Click the Edit button associated with the Personal List field. The application 
displays the Add/Remove EHR Personal Lists dialog. You can use one or more 
selections. See Section 4.8 for more information. When this dialog is complete, 
click OK (otherwise, click Cancel). Your selections populate the Personal List 
field. 
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3. If you need additional filters, check the “Apply Additional Filters?” check box; 
additional filter fields display at the bottom of the window (they are the same 
fields that display when you select the “Ad Hoc Search” radio button). See 
Section 5.3.8 for more information. 

5.3.8 Ad Hoc Search 
You use the Ad Hoc Search option to combine one or more common search criteria, 
such as age, gender, community, or visit date range, to define the patient population 
that you want. 

1. Type a name and definition for your panel. 

2. When you click the Ad Hoc Search radio button, the Definition tab displays with 
all of the filter collapsed, as shown below: 

 
Figure 5-17: Sample Ad Hoc filters 

The information after the name of the filter shows any filters defined on it. For 
example, in the above screen capture, Patient (Category) is defined as one of the 
filters. 

After completing the filter options, click OK to use the filter options in creating a new 
patient panel. 

3. Expand the Patient area to display the criteria that you can select. 
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Figure 5-18: Ad Hoc Search Selections 

4. The Ad Hoc Search allows you to use one or more filter options to define the 
patient population that you want. The following sections discuss the filter options: 
Patient, Visit, Other. 

5.3.8.1 Patient Group Box 
You can enter a filter by using the field in the Patient group box. You can 
expand/collapse the Patient group box by clicking the button in the upper, left corner. 

 
Figure 5-19: Patient Criteria group box 
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Age: You can enter a filter by age by using a criteria statement and age. Click the 
drop-down to select the criteria statement. 

• Less than, e.g., a panel of children could be defined as ages less than 19. 
• Less than or equal to, e.g., the same panel of children in the previous example 

could be defined as ages less than or equal to 18. 
• Equal to, e.g., create a panel of patients aged 50 to identify those who should have 

a colorectal exam. 
• Greater than or equal to, e.g., a panel of adults could be defined as ages greater 

than or equal to age 19. 
• Greater than, e.g., the same panel of adults in the previous example could be 

defined as ages greater than age 18. 
• In range (inclusive), e.g., create a panel of women ages 45 through 60 with this 

option. 
• Out of range (exclusive), e.g., 20-25, exclusive means ages 21, 22, 23, 24. 

There will be a date range for Age if you select: (1) in range (inclusive) or (2) out 
of range (exclusive). For example: 20-25, inclusive means 20, 21, 22, 23, 24, 25 
whereas 20-25, exclusive means 21, 22, 23, 24. 

Type the age to be used in the search in the middle field (limited to 3 characters). 

The drop-down list for the last field for the Age criteria defines the units of measure 
for the age: YRS (for years), MOS (for months), DYS (for days). 

Beneficiary: You use the Beneficiary field to search for either AI/AN or non-AI/AN 
Classification/Beneficiary patient categories. This is similar to the CRS reports where 
users can select a patient population based on the Classification/Beneficiary 
categories in Patient Reg. Click the Edit button to display the Add/Remove 
Beneficiaries dialog. NOTE: a blank (selection) will include all patients. 

 
Figure 5-20: Add/Remove Beneficiaries Dialog 

See Section 4.8 for more information about the Add/Remove dialog. 
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When the Add/Remove dialog is complete, click OK. This action populates the 
Beneficiary field in the Patient group box. (Otherwise, click Cancel). 

Category: Use this group box to restrict your search to one of the following: Living, 
Deceased, Both. 

 
Figure 5-21: Sample Category group box 

If you use Deceased or Both, you can select a Date of Death date range. By selecting 
either of these categories, this activates the Date of Death fields. If you do not use a 
date of death date range, the application searches for all deceased patients. 

Community: Use this group box to restrict your search to patients defined in a 
community either by taxonomy or by name. This option used the Active patients in 
the database for each associated Community of Residence. Active is defined as a 
patient with at least one active HRN on the server, regardless of the division that the 
user is logged in to. 

 
Figure 5-22: Community Group Box 

Define Community by Taxonomy 

To define the community by taxonomy, click the By Taxonomy radio button. 
Then select the Edit button to display the Add/Remove Community Taxonomies 
dialog. 

 
Figure 5-23: Sample Add/Remove Community Taxonomies 
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See Section 4.8 for more information about the Add/Remove dialog. Note that 
you can select multiple community taxonomies. 

Click OK when the Add/Remove dialog is complete. This populates the field by 
the Edit button as well as the Selected Taxonomy Includes field. 

As you select a community taxonomy in the field by the Edit button, the 
communities for that taxonomy will display in the Selected Taxonomy Includes 
field. 

Define Community by Name 

To define the community by name, click the By Name radio button. You select an 
option from the drop-down list for the By Name field; your selection determines 
the number of patients in the community (or least one or all); With At Least One 
Patient is the default. 

Use the Edit button to determine which community to use in the search. Click 
Edit to display the Add/Remove Communities. 

 
Figure 5-24: Add/Remove Communities 

You control the list of available communities by selecting an option from the 
Available Selections field, either With At Least One Patient or All. 

To review how to use the other parts of the dialog, See Section 4.8 for more 
information about the Add/Remove dialog. 

Click OK when the Add/Remove dialog is complete. This populates the field by 
the Edit button. 

If you select more than one community, this activates the Create Taxonomy 
button. 
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Figure 5-25: Sample more than one community selected 

The user must have the iCare Editor (BQIZCMED) or iCare Package Manager 
(BQIZMGR) security key in order to use the Create Taxonomy button. 

Clicking the Create Taxonomy allows you to save those communities as a 
Community taxonomy. This action will change the panel definition from a list of 
communities to the new Community taxonomy name. See Section 4.15 for more 
information. Users are allowed to edit the Community Taxonomies that they 
created. 

Diagnostic Tag: Use this group box to restrict your search to patients with one or 
more of the predefined diagnostic tags. See Section 2.2.1 for a detailed explanation of 
how iCare creates proposed diagnosis tags. You need to expand the Diagnostic Tag 
selection to display the entire Diagnostic Tag group box 

 
Figure 5-26: Diagnostic Tag Group Box 

Click the Edit button. There are two conditions that could be present: (1) taxonomies 
that do not have any entries or (2) all taxonomies have entries. If there are any 
taxonomies that do not have any entries, the iCare Taxonomy Check warning 
message displays, giving you information about the entries. This message makes you 
aware that some definitions are missing and might affect the accuracy of the 
diagnostic tags. (Click OK to dismiss the message). 

The Add/Remove Diagnostic Tags dialog displays. 
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Figure 5-27: Add/Remove Diagnostic Tags Dialog 

See Section 4.8 for more information about the Add/Remove dialog. 

After completing the Add/Remove dialog and clicking OK, the Diagnostic Tag 
group box becomes populated. 

 
Figure 5-28: Diagnostic Tab Group Box Populated 

The default tag selection will be Proposed and Accepted, as shown in the above 
example. You can change the tag selection for any record by selecting or de-
selecting any checkbox. 

You can click the “use AND?” check box when there are multiple tags selected. 
The “And” option searches for patients who have ALL of the user-defined tags. 

5.3.8.2 Allergies Group Box 
Use the Allergies group box to filter by allergies. 

 
Figure 5-29: Allergies group box 

Click the Edit button to access the Add/Remove Allergies dialog. 
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Figure 5-30: Add/Remove Allergies dialog 

See Section 4.8 for more information about the Add/Remove dialog. 

When the Add/Remove Allergies dialog is complete, click OK (otherwise, click 
Cancel). After clicking OK, the allergies field becomes populated. 

 
Figure 5-31: Populated Allergies field 

You can click the “use AND?” check box when there are multiple allergies 
selected. The “And” option searches for patients who have ALL of the allergies. 

5.3.8.3 Visit Group Box 
You can expand/collapse the Visit group box by clicking the button in the upper, left 
corner. 

 
Figure 5-32: Visit Group Box 

You can enter a filter by using the fields in the Visit group box for either BY DATE 
or BY TIMEFRAME (not both). After selecting either feature, this activates the Visit 
Detail group box. 
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By Date 
Enter a filter by Visit Date by entering the beginning and ending dates. See 
Section 4.6.3 for more information. If you want one day only, both the beginning and 
ending dates must be the same. The intent of this feature is to define a panel once and 
have it auto populate every day without having to manually change the Date range. 

After clicking OK (on the Panel Definition window), the application displays the 
following warning message: 

 
Figure 5-33: Warning message about preserving existing manually added/removed patients 

Click Yes to preserve the manually added and removed patients. 

Click No to totally refresh the patient list. 

After responding to the warning message, the application displays the 
“Background populate?” information message: Populating the panel may take some 
time and will run in the background. Do you want to continue to populate the panel? Click 
OK to continue and populate the panel (otherwise, click Cancel). 

By Timeframe 
Use this feature to define a panel once and have it auto populate every day without 
having to manually change the date range. After clicking the By Timeframe radio 
button, select an option from the drop-down list: 

Last Week (beginning yesterday 
Last 2 Weeks (beginning yesterday) 
Last Month 
Last 6 Months 
Last Year 
Ever 

After you click OK (on the Panel Definition window), the application displays the 
RPMS iCare message: This panel definition includes a Timeframe filter. It is 
recommended that this panel be set to Auto Repopulate. Do you agree? Click Yes to 
agree and the next prompt displays. Click No to not agree and the next prompt 
displays. Click Cancel to return to the Visit group box. 
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After using Yes or No, the application displays the “Background populate?” 
information message: Populating the panel may take some time and will run in the 
background. Do you want to continue to populate the panel? Click OK to continue and 
populate the panel (otherwise, click Cancel). 

If you use YES about setting the panel to Auto Repopulate, you can change the 
Auto Repopulate option. See Section 5.7 to view the information this tab on the 
Panel Definition window. 

Visit Detail Group Box 
After populating either radio button in the Visit Range group box, the application 
activates the Visit Detail group box. 

 
Figure 5-34: Sample Visit Detail group box 

This group box allows you to create a panel based on both number of visits and/or 
to a specific provider or clinic. 

Use the Add button to create a panel based on a specific provider and/or clinic. 
After clicking Add, the application displays the Visit Details dialog. 

 
Figure 5-35: Visit Details dialog 

# of Visits*: You can specify the additional filter for the number of visits within 
the date range. The modifier options are the same as those of age (less than, less 
than or equal to, equal to, greater than, greater than or equal to, in range, out of 
range). The purpose of the additional field is to allow you to create panels of 
patients who have had so many visits within a user-defined timeframe. The 
default value is 1. Use any value 1 - 99. 

Visit Clinic: To add a visit clinic, click the drop-down list and select an option. 
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Visit Provider: To add a visit clinic, click the drop-down list and select an option. 

Use AND?: check this checkbox to have ALL of the visit details used in the 
search. 

When the Visit Details dialog is complete, click OK (otherwise, click Cancel). 
After clicking Yes, the application updates the Visit Detail group box. 

Select a row in the grid and click Edit to access the Visit Details dialog. Here you 
can change any data on the dialog. 

Select a row in the grid and click Delete. 

5.3.8.4 Other Group Box 
You can enter a filter for panels in the Other group box. This restricts your search to 
those patients who are members of a panel (you can select one or more panels). 

 
Figure 5-36: Other Group Box 

To search by Panels, click the Edit button to display the Add/Remove Panels dialog. 

 
Figure 5-37: Add/Remove Panels Dialog 

See Section 4.8 for more information about the Add/Remove dialog. 

When the Add/Remove dialog is complete, click OK. This populates the Panel 
field in the Other group box. 
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5.4 Panel Definition Layouts Tab 
The Layouts tab allows you to customize your user template for defining the Patient 
List, Reminders, Natl Measures, Asthma, HIV/AIDS, Events, Tracked Events, and 
Follow-up Events layouts for Patient Panels. In addition, you can specify to use the 
system default layout for any of them. 

 
Figure 5-38: Layouts tab for Patient Panels 

All of the customized layouts have the same functionality in that you add and remove 
the columns to be displayed, add or remove the columns to be sorted, determine the 
sort order of the columns. 

5.4.1 Edit Patient List Layout 
After you click the “Edit Patient List Layout” button on the Panel Definition window, 
the Patient List Layout for the current patient panel displays. 
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Figure 5-39: Patient List Layout for Selected Panel 

See Section 4.23 for information on how to use this layout dialog. 

5.4.2 Edit Reminders Layout 
After you click the “Edit Reminders Layout” button on the Panel Definition window, 
the Reminders Layout for the current patient panel displays. 
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Figure 5-40: Reminders Layout for Patient Panels 

See Section 4.23 for information on how to use this layout dialog. 

5.4.3 Edit Natl Measures Layout 
After you click the “Edit Natl Measures Layout” button on the Panel Definition 
window, the Natl Performance Layout for the current patient panel displays. 
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Figure 5-41: National Measures Layout 

See Section 4.23 for information on how to use this layout dialog. 

5.4.4 Edit Asthma Layout 
After you click the “Edit Asthma Layout” button on the Panel Definition window, the 
Asthma Layout for the current patient panel displays. 
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Figure 5-42: Asthma Layout 

See Section 4.23 for information on how to use this layout dialog. 

5.4.5 Edit HIV/AIDS Layout 
After you click the “Edit HIV/AIDS Layout” button on the Panel Definition window, 
the HIV/AIDS Layout for the current patient panel displays. 
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Figure 5-43: HIV/AIDS Layout 

See Section 4.23 for information on how to use this layout dialog. 

5.4.6 Edit Events Layout 
After you click the “Edit Events Layout” button on the Panel Definition window, the 
Events Layout window for the current patient panel displays. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Creating Patient Panels 
August 2011 

159 

 
Figure 5-44: Events Layout window 

See Section 4.23 for information on how to use this layout dialog. 

5.4.7 Edit Tracked Events Layout 
After you click the “Edit Tracked Events Layout” button on the Panel Definition 
window, the Tracked Events Layout window for the current patient panel displays. 
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Figure 5-45: Tracked Events Layout window 

See Section 4.23 for information on how to use this layout dialog. 

5.4.8 Edit Follow-up Events Layout 
After you click the “Edit Follow-up Events Layout” button on the Panel Definition 
window, the Follow-up Events Layout window for the current patient panel displays. 
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Figure 5-46: Follow-up Events Layout window 

See Section 4.23 for information on how to use this layout dialog. 

5.5 Sharing Tab 
If you want to share your panel with other RPMS users, click the Sharing tab on the 
Panel Definition window. You can select one or more users who can share your panel 
and can assign access rights to each user. 

When you share a panel, the shared user will receive a notification about the shared 
panel. If you do not see a panel that is shared with you, select View | Refresh on the 
iCare main window. 

This tab will not be available if the Share button is inactive on the Panel List view for 
the patient list. 
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Figure 5-47: Sharing Tab 

See Section 4.5 to review how to use the buttons on the right side of the Sharing tab 
window. 

Note: You can share a panel at any time by opening the panel and 
clicking the Share button. 

5.5.1 Fields on Sharing Tab 
The following information describes the fields on the Sharing tab. 

Shared with: Your selection from the drop-down list is the person with whom you 
want to share your panel. 

Shared Access: The radio buttons become active after you populate the “Shared 
with” field. 

 
Figure 5-48: Sample Shared With and Access Rights 

• Read Only: use this radio button to allow the person sharing your panel to 
only view your panel. The shared user can change the layout of a panel. 

• Read/Write: use this radio button to allow the person sharing your panel to 
view and change your panel (for example, add or delete patients). 
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• Inactive: use this radio button to assign the person sharing your panel inactive 
access rights. 

Temporary: Select the Temporary check box to display a date range for the 
temporary status of the shared user. The access rights will only apply during the 
specified data range and will automatically expire once the specified date range has 
passed. 

 
Figure 5-49: Sample Temporary Status 

You must select a date range when using the Temporary status. See Section 4.6.3 for 
more information about entering dates. The default is today’s date. 

Shared Layouts?: Check this checkbox if you want to share the layouts of one or 
more of three panel views: Patient List, Reminders, and/or National Measures. The 
shared user will see the same layout modifications made by the creator. 

• This causes the Shared Layouts cell (in the grid) to contain Y. 

• The shared user will continue to be able to make modifications to the layouts 
of that shared panel. These modifications will not affect the creator’s layouts. 

5.5.2 Grid on Sharing Tab 
The grid shows a history of the users (that have not been removed/deleted) with 
whom you have shared the current panel. 

 
Figure 5-50: Sample Lower Grid 

Add: click this button to add the information in the Shared with, Shared Access, 
Temporary, and Shared Layouts fields to the grid. 

 
Figure 5-51: Shared User Information in Lower Grid 

Apply: click this button to change the Shared Access and/or Temporary status of a 
selected user in the grid. You can change the shared access rights; for example, 
change the access rights from Read Only to Read/Write. Then click the Apply button 
to reflect the changes in the grid. 
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Remove: highlight one or more names in the grid and click this button to remove the 
name(s) from the grid. It might be more useful to inactivate the user instead of 
removing the user. After clicking the Remove button, the “Delete Row” information 
message displays, asking if you want to delete the selected names. Click Yes to delete 
(otherwise, click No). 

5.6 Preview Tab 
Click the Preview tab to show the patients retrieved from the characteristics for the 
patient population indicated on the Definition tab. The Preview tab does not require 
any edits or changes. Changing the column order, sort order, and filters are not 
preserved; instead use the Layout tab for column and sort order. Filters should be 
applied in the panel view in order to save the filter criteria. 

5.7 Auto Repopulate Options Tab 
Use the Auto Repopulate Options if you want the contents of your panel to be 
dynamic, i.e., automatically refreshed. This is a good option to use if you have 
defined panels by ages or by visit dates; patients will be automatically added or 
deleted based on the search logic. 

Note: You can manually repopulate a panel at any time by 
selecting the panel from the Panel List and clicking the 
Repopulate button. 
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Figure 5-52: Auto Repopulate Options Tab 

The only group box that is active on this tab is the Repopulate Settings. (This option 
is not active if the panel definition was based on No Predefined Population Search.) 

 
Figure 5-53: Repopulate Settings Group Box 

1. Check the Auto Repopulate check box to specify that you want the panel to 
automatically refresh the patient list based on the panel’s defined search criteria. 

2. You must then select when you want your panel to be re-populated, either During 
Nightly Job or First Login Each Day. 

Note: A large panel (over 1,000 records) might take a lot of time 
to repopulate. It is recommended that you use the During 
Nightly Job option for the larger panels. 
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6.0 Panel List 
The Panel List shows a list of your current panels, including the default panel, the 
panels created by the user, and the panels shared with you by other users. 

 
Figure 6-1: Sample Panel List View 

The Startup View tab on User Preferences determines the view that will display when 
you first login to iCare. See Section 3.1.1.3 for more information. 

To view the Panel List window, do one of the following: 

• If you are in Split View, the Panel List will be in the left frame. 

• If you are not in Split View, you need to click the Panel List tab. 

• If you are in another window, select the iCare Main option from the 
Window menu. 

6.1 Panel List Layout 
The Panel List has the following data columns: 

Flag: the Flag Indicator  icon displays in the first column if one or more patients in 
any of the panels have any flags. 

Panel Name: user-defined name of the panel (required). 

Panel Description: user-defined description of the panel. 

# of Pts: the number of patients in the panel. 

Last Updated: the date and time the contents of the panel was last updated by a 
manual (user) repopulate, by an auto-repopulate, or the panel created date, if the panel 
has never been repopulated. 

Last Updated By: the name of user who either created or last repopulated the panel. 

Owner: the name of the user who created (“owns”) the panel. 
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Shared With: this column has different icons representing whether a panel has been 
shared by you with other user or shared with you by a user. 

You can view how your patient panel is shared by hovering your mouse over the last 
column of the panel. 

 
Figure 6-2: Sample Shared With Information 

The icons in the Shared With column have the following meanings: 

The  icon means you have Read/Write access to the panel. 

The  icon means you created the panel and have shared it with other users. 

The  icon means you have read-only access to the panel. 

You can sort and/or filter any column, re-arrange the order of the columns, etc. See 
Section 4.1 for more information. 

6.2 Panel List Toolbar 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

The toolbar buttons and menu options determine what actions you can take on this 
window. 

6.2.1 New 
You use the New function to create a new panel. You can create a patient panel in one 
of the following ways: 

• Clicking the New  button 

• Selecting the New option on the right-click menu 

• Selecting File | Panel | New 

• Pressing the key combination of Ctrl+N 
Any of the above actions displays a blank Panel Definition window where you can 
create a new panel. See Section 5.0 for more information about this window. 
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6.2.2 Open 
You use the Open function to show the patients in one or more selected panels. 
Highlight the panels by holding down the Ctrl key and then use the Open function. 

You can open selected panels by doing one of the following: 

• Clicking the Open  button 

• Selecting File | Panel | Open 

• Selecting the Open option on the right-click menu 

• Double-clicking on the panel 

• Pressing the Ctrl+O key combination 

• Selecting File | Recent Panels and selecting the panel name (the list is 
limited to the last five panels that you have viewed) 

A Panel View window displays for each of the selected panels, showing the patients 
for the panel. See Section 9.0 for more information about this window. 

More than one user can open a shared panel simultaneously. The second and 
subsequent users to open the same panel will have “read only” access to the panel 
content. If the first user closes the panel, the second user will be notified that the 
panel is now available for “edit” access, unless the user only has been provided with 
Shared Read Only access by the panel creator. 

6.2.3 Delete 
You can delete the selected panels that are no longer useful. There are two conditions 
for the delete function: (1) when you delete a panel you created and (2) when you 
delete a panel that was shared with you. 

6.2.3.1 Delete Panel You Created 
You can delete a panel that you created. Highlight one or more panels by holding 
down the Ctrl key and then use the Delete function. 

You can delete the selected panels by doing one of the following: 

• Clicking the Delete  button 

• Selecting File | Panel | Delete 

• Selecting the Delete option on the right-click menu 

• Pressing the Delete key on your keyboard 
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The “Confirm panel delete” dialog displays, asking if you want to delete the selected 
panel. Click Yes to delete the panel. Its name will no longer appear in the Panel List 
view. (Otherwise, click No to not delete the panel). 

Shared users with shared access to the deleted panel will receive notification that you 
(the person who deleted the panel) are no longer sharing the panel. See Section 12.0 
for more information about this window. 

 
Figure 6-3: Sample iCare Notification for Deleting a Shared Panel 

If you are in the Delete Process and you clicked Yes and the selected panel is open in 
another window, the following message will display: 

 
Figure 6-4: Warning Message About Panel Open in Another Window 

Click OK to dismiss the warning and you return to the Panel List window. In 
order to delete the panel, you need to close it and then use the Delete process. 

6.2.3.2 Delete Panel Shared with You 
If you delete a panel that was shared with you, you will no longer see the panel on 
your list, i.e., the shared access is deleted but the panel remains for the panel creator 
and other shared users. 

6.2.4 Repopulate 
You use the Repopulate function on the Panel List when the patients in a selected 
panel need to be updated with new data (for example, some patients have moved). 
Repopulate reruns the panel definition against the cached data (from the nightly job) 
where it adds patients who meet the criteria and removes the patients that no longer 
meet the criteria. 

You can repopulate the highlighted panel by doing one of the following: 
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• Clicking the Repopulate  button 

• Selecting File | Panel | Repopulate 

• Selecting the Repopulate option on the right-click menu 

• Setting the Auto Repopulate Options under the panel modifications (use 
the Modify button) 

The “Repopulate Panel” warning message displays asking if you want to update the 
patient list for the panel. Click Yes to repopulate the patient list. (Otherwise, click No 
to not process and to return to the Panel List.) This message does not appear for Auto 
Repopulate. 

The repopulate process (cannot be undone) will run as a background operation. 

The “clock” icon will appear to the left of the panel name while the process takes 
place; the date and time of the Last Updated column will be updated. 

 
Figure 6-5: Example of Panel List During Repopulate Process 

6.2.4.1 Other Warning Message 
If you manually edited (added or removed) patients in the panel, the Maintain Manual 
Changes warning message will display. 

 
Figure 6-6: Maintain Manual Changes Warning Message 

Click Cancel to exit the Repopulate function for the selected panel. 

Click No if you want the patient list totally refreshed. In this case, any added 
patient names will be lost as well as any deleted patient names will be added back 
to the panel. 
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Click Yes if you want to preserve the manually added and removed patients. The 
“Background populate?” information message displays asking if you want to 
repopulate in the background. Click Yes if you want the repopulation to execute 
in the background. Otherwise, click No to repopulate in the foreground. 

This process does not run for panels that are manually populated. If you try to run the 
repopulate process in this situation, the application displays a warning message that 
states: Panel is manually selected and cannot be repopulated. Please open the panel 
and add or remove patients as necessary. Click OK to dismiss the message. 

6.2.4.2 Panel Open in Another Window 
If you are in the Repopulate Process and you clicked Yes and the selected panel is 
open in another window, the following message will display: 

 
Figure 6-7: Warning Message about panel open in another window 

Click OK to dismiss the warning and you exit the repopulate process. 

6.2.4.3 Repopulate Not Active 
You will not be able to repopulate a panel if your shared access is read-only. The 
following repopulate options are: 

• The Repopulate button will be inactive 

• The Repopulate option on the right-click menu will be inactive 

• The Repopulate option on File | Panel will be inactive 

6.2.5 Modify 
You use the Modify function to change the panel definition for a selected panel. 

You can modify a highlighted panel by doing one of the following: 

• Clicking the Modify  button 

• Selecting File | Panel | Modify 

• Selecting the Modify option on the right-click menu 
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If the selected panel is already open, a message about the panel being already open 
displays. 

 
Figure 6-8: Panel Already Open Message 

Click OK and you move to the panel described in the message. You will modify 
the panel from this window. 

When you select the Modify process, the Panel Definition window displays, showing 
the population criteria. 

 
Figure 6-9: Sample Panel Definition Window to Modify 

Below is an overview of the tabs on this window: 

Definition: allows you to specify the panel’s name and description as well as what 
criteria to use to populate the panel. See Section 5.3. 

Layouts: allows you to select the columns for your panel. See Section 5.4. 

Sharing: allows you to share your panel with RPMS users. See Section 5.5 for more 
information. 
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Preview: allows you to view the patients retrieved for the panel. This tab requires no 
edits. 

Auto Repopulate Options: allows you to have your panel automatically refreshed. 
See Section 5.7 for more information. 

6.2.6 Share 
You use the Share function to define users who can share your panel. 

You can share a highlighted panel by doing one of the following: 

• Clicking the Share  button 

• Selecting File | Panel | Share 

• Selecting the Share option on the right-click menu 
The Panel Definition window opens to the Sharing tab. See Section 5.5 for more 
information about sharing a panel. 

You will not be able to share a panel if your Share access is read-only. In this case, 
the following Share options are: 

• The Share button will be inactive 

• The Share option on File | Panel will be inactive 

• The Share option on the right-click menu will be inactive 

6.2.7 Copy 
You use the Copy function to create a new panel by copying one of your existing 
panels and saving it with a new name. What is copied is the patient population and 
the panel definition along with any added or deleted patients. 

You can copy a highlighted panel by doing one of the following: 

• Clicking the Copy  button 

• Selecting File | Panel | Copy 

• Selecting the Copy option on the right-click menu 

The Copy Panel dialog displays. 
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Figure 6-10: Sample Copy Panel Dialog 

The default name displays in the Panel Name field. You can edit the name. 

The Panel Name field contains a right-click menu for editing the text. See 
Section 4.6.1 for more information about this menu. 

The Copy Layouts check box determines if the layouts of the columns are in the copy 
process. The default is checked. 

Click OK to have the “new” panel added to the Panel List view. (Otherwise, click 
Cancel to exit the copy process.) 

Once copied, you can modify the panel in any way, such as changing the panel 
definition, adding and deleting the patient names, etc. 

If the entered name is a duplicate name, the “Panel Name is unique, please choose 
another name” warning message displays. Click OK to dismiss the message and you 
return to the Copy Panel dialog. 

6.2.8 Panel Properties 
You can view the properties of a highlighted panel by selecting File | Panel | 
Properties (or by selecting the Properties option on the right-click menu). The Panel 
Properties pop-up displays. Click OK to dismiss the pop-up. 
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Figure 6-11: Sample Panel Properties Pop-up 

• The General tab provides information about the panel name, when the panel 
was created and who created it, the panel description, and any filters used to 
create the panel. 

• The Update History tab provides information about the auto repopulate status, 
when the panel definition was last modified and who modified it, when the 
patient list was last populated and who modified it, and when the patient list 
was manually updated. 

• The Shared/Access tab provides information about the shared users for the 
current panel and their access rights. 

• The Flag Setup tab provides information about the timeframes for the flag 
types (defined in User Preferences). 

6.3 Panel List Menus 
The File, Tools, and View menus for the panel list window are reviewed below. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

6.3.1 File Menu 
Below are the options on the File menu. 
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Figure 6-12: File Menu Options 

Panel: The sub-menus contain the actions that you can take on this window. For 
example, the Open option will display the patients in the selected panel. 

See Section 3.1 for more information about the Change RPMS Server and the Change 
RPMS Login options. 

Change RPMS Server: This option allows you to change the server information on 
the RPMS Server Address dialog. 

Change RPMS Login: This option allows you to change your access and verify 
codes to the iCare application on the RPMS Login dialog. 

Change RPMS Division: This option allows you to change the RPMS Division on 
the Select Division dialog. This option applies to a site that uses more than one RPMS 
database. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Panel List 
August 2011 

177 

 
Figure 6-13: Sample Select Division Dialog 

Recent Panels: This sub-menu shows your recent panels. If you select one, you can 
view the patients in the selected panel in a new window. The list of panels is the last 
five panels that you have viewed. 

Page Setup: This option allows you to set Margin, Paper, Layout characteristics (like 
landscape or portrait orientation), and the Printer to use. These settings are used when 
you use the Print option. 

Print Preview: This option displays the print preview dialog. 

Print: This option sends the selected rows in the grid to the printer using the settings 
in Page Setup. Note that only the selected tab (Panel List or Flag List) will be printed. 

Background Jobs: This option displays the Background Jobs pop-up. This pop-up 
displays, for example, the start and end dates for the nightly and weekly background 
jobs. See Section 4.10 for more information. 

Exit iCare: The option allows you to leave the iCare application. You will be 
reminded to save any changed panels (if needed). 

6.3.2 Tools Menu 
Below are the options on the Tools menu. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Panel List 
August 2011 

178 

 
Figure 6-14: Tools menu options 

Quick Patient Search: This option allows you to search for a patient name. This is 
the same as using the F8 key on your keyboard. See Section 4.4 for more information. 

The Reset View, Search, Refresh, Excel Export, Print, and Copy Rows to 
Clipboard options work like the buttons on the right side of the window. See 
Section 4.5 for more information. 

User Preferences: This options opens the User Preferences window. See Section 3.2 
for more information. 

View iCare Notifications: This option opens the iCare Notifications pop-up. See 
Section 12.1 for more information. 

iCare Package Manager: This option is active for those users with Package Manager 
security key. See Section 4.12 for more information. 

Taxonomy Maintenance: This option is used by those users who can maintain 
taxonomies. Also, you use this option to view the taxonomy elements. This option has 
the following two features: 

View/Edit Taxonomy Entries: this feature displays the iCare Taxonomy View/Edit 
dialog. See Section 4.14 for more information. This option will have “Edit” in its 
label only if you can edit the taxonomy. 

Taxonomy User Access: this feature is active for those user with the proper security 
key. Selecting this option displays the iCare Taxonomy User Access Management 
window. 
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Figure 6-15: iCare Taxonomy User Access Management for Taxonomy Editor 

Editing site populated taxonomies can affect many existing processes in RPMS. 
Be certain of your edits prior to clicking OK. 

Taxonomy Editors can add and delete members from any Site Populated 
Taxonomies related to either laboratory tests or medications. 

Existing RPMS Editor Access is available to any RPMS user with Manager level 
Keys to at least one of the following case management applications: CRS (BGP), 
Diabetes Management (BDM), HIV Management System (BKM), and/or 
Women’s Health (BW). 

This window displays the users who have been given basic access to the iCare 
application by your Site (IT) Manager. You cannot give Editor or Package 
Manager access to iCare who does not have basic access. See your Site Manager 
to request basic iCare access for other users. This information is available when 
you click the Help menu. 

The Site Manager can select or de-select the Taxonomy Editor role for a user on 
the list. The taxonomy editor role allows the user to view/edit the iCare 
taxonomies. Click OK to save the changes (otherwise, click Cancel). 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Panel List 
August 2011 

180 

Note: Editing site populated taxonomies can affect many existing 
processes in RPMS. For this reason, Taxonomy Editor 
access should be carefully assigned to a limited number and 
only after discussion with the CRS (GPRA) coordinator at 
your site. 

CMET Package Manager: this option is used by those who have package manager 
security requirements and those who will determine the CMET site parameters. This 
option accesses the RPMS iCare – CMET Site Parameters dialog. See Section 4.22 
for more information. 

Web Links: This option provides links to Web sites for related clinical guidelines. 

MU Package Manager: this role is assigned by the iCare Package Manager. The 
Meaningful Use (MUP Package Manger will entitle users to see the identity of all 
providers and their related data on MU Tab/Eligible Providers sub-tab. This manager 
can set the Site Parameters related to Provider Types and the display of User’s title. 
Selecting this option accesses the Meaningful Use Site Parameters dialog. 

 
Figure 6-16: Sample Meaningful Use Site Parameters dialog 

Default Timeframe: this field has two options: 90 Days or 1 Year. The default is 90 
Days. After changing to 1 year, that timeframe stays in effect whenever the user logs 
onto iCare. 

Show Types?: check this checkbox to display the Type to the right of the Provider’s 
name (on the Meaningful Use display). This is pulled from the User Class field in 
RPMS. 

User Types: this field lists the user classes that will be used in the Background Jobs 
and for display on the MU Providers sub-tab. The default will be to display all 
providers who have been assigned the ORES key. The default for this field are the 
following roles: Physician, Physician Assistant, Nurse Practitioner. A minimum of 
one role must be selected. 
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Click Edit to access the Add/Remove User Classes dialog. Use this dialog to 
add/remove user classes. 

 
Figure 6-17: Sample Add/Remove User Classes dialog 

See Section 4.8 for more information about the add/remove dialog. 

After the Add/Remove User Classes dialog is complete, click OK (otherwise, 
click Cancel). 

After clicking OK, the application updates the User Types field on the 
Meaningful Use Site Parameters dialog. 

After the Meaningful Use Site Parameters dialog is complete, click Save (otherwise, 
click Cancel). 

6.3.3 View Menu 
The View menu on the iCare Main window provides a way to change between the 
Split View and tab view. If the Split View option is selected, a Refresh option is also 
displayed. 

 
Figure 6-18: Sample View Menu 

Split View: When this option is checked, that means that the current view is the split 
view. You can change to the Panel List view or the Flag List view by removing the 
checkmark; this is a temporary setting. When you exit iCare and reopen iCare, the 
settings set under User Preferences for the default screen are used. 

Refresh: Use this option to refresh the current window (usually after a panel is shared 
with you while you are in iCare). This is the same using the F5 key on your keyboard. 
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7.0 Flag List 
The Flag List displays specific data about the flags for any patients on any of the 
panels on the panel list, including shared panels. This is referred to as the Master Flag 
List. 

 
Figure 7-1: Sample Flag List window 

If you are in Split View, the Flag List will be in the right frame. If you are not in Split 
View, you need to click the Flag List tab. If you are in another window, select iCare 
Main from the Window menu. 

7.1 Flag List Layout 
The default display has the flag listed alphabetically by flag date (most recent first), 
by patient name, and then by flag type. No duplicate values are displayed in the first 
column. This means if a particular date has more than one flag, the date will be 
displayed only on the first row. 

The iCare application will display an initial list of flags at first login only for the 
timeframe that is defined in the User Preferences. See Section 3.1.1.2 for more 
information. Likewise, you can change the flag view to display modified flag types 
and/or timeframes if you change the User Preferences. After changing the flag 
settings in User Preferences, refresh the flag view. 

7.1.1 Flag List Columns 
The following table provides information about the columns. 

Column Meaning 
Flag Date The date the flag became active, e.g., the date of the hospital 

admission. 
Patient Name This is a required field and will link to the patient’s Patient Record if 

you double-click on it. See Section 10.0 for more information. 
HRN Patient’s Health Record Number. 
Sex Either F (for Female) or M (for Male) 
Age Patient’s age. 
DOB Patient’s Date of Birth. 
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Column Meaning 
Flag Type This can be Abnormal Lab Values, ER Visit, Unanticipated ER 

Return Visit, Hospital Visit. See Section 7.1.2 for more information. 
Flag Description A brief description of the event that caused the trigger. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this 

field to empanel patients. 
 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

7.1.2 Flag Types 
The Flag Type column contains various flag types, as defined in the following table: 

Flag Type Meaning 
Abnormal Lab Values Alert This flag type informs the user when a patient has 

abnormal lab values within a user-defined 
timeframe, based on the Kernel Alerts component. 
The Abnormal Lab Values alerts, generated from 
the RPMS Laboratory application, reside in the 
Kernel Alerts component. If the ALV alert is closed 
by the provider in Kernel Alerts, it will no longer 
display in iCare, regardless of the Flag Display 
Timeframe selected by the user in the User 
Preferences. 

ER Visit This flag type informs the user when a patient has 
an emergency room visit within a user-defined 
timeframe. This flag is generated directly by iCare. 
ER visits (clinic code 30) is the trigger for this flag. 

Unanticipated ER Return Visit This flag type informs the user when a patient has 
an emergency room visit designated as 
“unanticipated” within a user-defined timeframe. 
This flag is generated directly by iCare. ER visits 
(clinic code 30) with Visit Type “Unscheduled 
Revisit” is the trigger for this flag. 

Hospital Admission This flag type informs the user when a patient has 
a hospital visit within a user-defined timeframe. 
This flag is generated directly by iCare. Any visit 
with service category H where the discharge date 
is not the same day as the admission date is the 
trigger for this flag. 

7.2 Flag List Toolbar 
The text above the grid shows the flag set-up information and how current the data is. 

 
Figure 7-2: Sample Flag Setup Information 
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See Section 4.5 to review how to use the buttons on the right side of the Flag List 
window. 

7.2.1 Show Field 
What flags are displayed on this window is determined by the option selected on the 
Show field. Your choices are: 

• Active Flags: Active is defined as a flag that has not expired and has not been 
hidden by the users. 

• Hidden Flags: Those flags that you specified to be hidden, using the Hide 
button. 

• All Flags: All flags, hidden as well as active. 

7.2.2 Hide 
You can hide a highlighted row in the Flag List grid by doing any of the following: 

• Clicking the Hide  button 

• Selecting File | Flags | Hide 

• Selecting the Hide option on the right-click menu 

• Pressing the F3 key on your keyboard 
You can view the hidden flags by selecting the Hidden Flags option on the Show 
field. 

7.2.3 Show 
If you need to cause a hidden flag to re-appear in the current view, select it from the 
list on the Hidden Flags option (from Show field) and do any of the following: 

• Click the Show  button 

• Select File | Flags | Show 

• Select the Show option on the right-click menu 

• Press the F4 key on your keyboard 

7.2.4 Create a Panel 
Select one or more patients in the grid that you want to use as a new panel. Then, 
click the Create a Panel button. This process is the same as the Create a Panel on the 
CMET tab. See Section 11.1.3.5 for more information. 
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7.2.5 Status of Background Jobs 
You can check the status of the background jobs on the RPMS iCare - Background 
Jobs window. See Section 4.10 for more information. 

To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs  button 

• Select File | Background Jobs 

7.3 Flag List Menus 
See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

7.3.1 File Menu 
The File menu for the Flag List window has the same options as the iCare Main File 
Menu, except for one option. The Flags option that has the following selections: 

Hide: this hides a highlighted row in the Flag List grid. 

Show: this causes a hidden flag to re-appear in the current view. 

Refresh: this updates any RPMS field values on this view with new data from the 
server. 

7.3.2 View Menu 
The View menu on the Flag List window provides a way to change between the Split 
View and tab view. When the Split View option is checked, that means that the 
current view is the split view. You can change to the Panel List view or the Flag List 
view by removing the checkmark; this is a temporary setting. When you exit iCare 
and reopen iCare, the settings set under User Preferences for the default screen are 
used. 

7.3.3 Tools Menu 
The options on the Tools menu for the Flag List window is the same as those on the 
Tools Menu on the Panel List window. See Section 6.3.2 for more information. 
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8.0 Community Alerts 
Community Alerts inform providers that there has been an occurrence of either a 
communicable disease listed in the CDC’s Nationally Infectious Notifiable Diseases 
or suicidal behavior in a specific community. The intention is to provide information 
as soon as it is known to providers so that early intervention is possible. The alert is 
anonymous and does not display the name of the patient that triggered the alert; only 
the name of the community where patient resides when the incident occurred 
displays. 

• The CDC Nationally Notifiable Infectious Diseases (NND)alert is defined as: 
Any primary care visit within the past 30 days with any Purpose of Visit 
(POV) identified in the CDC NND table. The CDC NND logic will review 
primary care visits only. 

• The Suicidal Behavior alert is defined as: Any AMH or PCC visit within the 
past 30 days with Suicide Ideation, Attempt, Completion or Not Categorized. 

Only one (1) alert per patient per 30 day period should be displayed. 

The triggers for a Community Alert are placed into one of three categories: 
Mandatory, Recommended, Optional. You can determine which Recommended and 
Optional alerts that you want to display on the alert (all mandatory ones will display). 
The default display will be the Mandatory and Recommended diagnosis groups. See 
Section 3.2.3 for more information. 

For this version, the logic will only display each alert for 30 days from the visit 
occurrence date. 

The Community Alerts display at the following different times: 

• as a splash screen after you logon into iCare 

• as a tab (Community Alerts) on the iCare main window 

• on the Patient Record screen in the demographic information group box 

8.1 iCare Community Alerts Pop-up Window 
Community alerts will display on the Splash Screen. You can close (dismiss) the 
splash screen but cannot turn it OFF. 
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Figure 8-1: Sample iCare Community Alerts Window 

Community Alerts are related to the individual patient’s Community of Residence 
(COR). You must dismiss the alert in order to use the other features of the 
application. 

8.1.1 iCare Community Alerts Pop-up Layout 
You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

8.1.2 iCare Community Alerts Pop-up Toolbar 
The information on the pop-up is effective as of the date range shown in the toolbar. 

8.1.3 Buttons on the iCare Community Alerts Pop-up 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

8.2 Community Alerts Tab 
The Community Alerts tab on the iCare main window displays the alerts by the 
communities listed (in the Community Column). 
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Figure 8-2: Sample Community Alerts tab on iCare main window 

8.2.1 Community Alerts Tab Layout 
You can sort/filter the columns and perform other column functions. See Section 4.1 
for more information. 

The default sort order is: Community, Type, Diagnosis Category, and Most Recent 
Occurrence. 

The Community Alerts information has the following data columns: 

Community: The community where the alert type occurs. 

Type: The following describes the alert types: (1) CDC Nationally Notifiable 
Infections Diseases (NND) and (2) Suicidal Behavior: Ideation, Attempt and 
Completion. For this version, the logic will only display each alert for 30 days from 
the visit occurrence date. 

• The CDC Nationally Notifiable Infectious Diseases (NND) alert is defined as: 
Any primary care visit within the past 30 days with any POV identified in the 
CDC NND table. Only one (1) alert per patient per 30 day period will be 
displayed. The CDC NND logic will review primary care visits only. Primary 
care clinics are defined in CRS (BGP) in the BGP CONTROL FILE, Field 
1201 CLINIC CODES FOR 2ND VISIT (90241.0112). Any primary care visit 
within the RPMS database will be reviewed, regardless of the facility location. 

• The Suicidal Behavior alert is defined as: Any AMH or PCC visit within the 
past 30 days with Suicide Ideation, Attempt, Completion or Not Categorized 
(see definitions below). Only one (1) alert per patient per 30 day period should 
be displayed. Both AMH (Behavioral Health) and PCC Visit files will be 
reviewed for visit data. First identify any AMH visits with BH visit codes 39, 
40 or 41. Next, identify any additional PCC visits in the timeframe that were 
not documented in AMH with diagnosis or Ecode defined below. 

• AMH Ideation: BH Visit Code 39. 
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• AMH Attempt: BH 40 

• AMH Completion: BH 41 

• PCC Ideation: V62.84 

• PCC Not Categorized: Ecodes E950-E959 
Diagnosis: The diagnosis category for the alert. 

Cases Past 30 Days: The number of cases in the past 30 days. 

Cases Yesterday: The number of cases yesterday. 

Most Recent Occurrence: The date for the most recent occurrence. 

8.2.2 Community Alerts Tab Toolbar 
See Section 4.5 to review how to use the buttons on the right side of the window. 

8.2.2.1 Web Link 

Click the Web Link  button (or select File | Community Alerts | Web Link) to 
go to the Center for Disease Control and Prevention (CDC) Web site. 

8.2.2.2 View Detail 

Click the View Detail  button (or select File | Community Alerts | View 
Detail) to view the details about the community alert. See Section 8.3 for more 
information. 

8.2.2.3 Background Jobs 
Click the Background Jobs  button (or select File | Background Jobs) to display the 
Background Jobs pop-up. See Section 4.10 for more information. 

8.2.3 Community Alerts Tab Menus 
The File menu has options like those on the Panel List window (see Section 6.3.1). 
The difference is that instead of the Panel option, the Community Alerts tab has the 
Community Alerts option. The Community Alerts option has the following 
selections: 

Web Link: use this option to go to the CDC NND Web site. 

View Detail: use this option to view the details about the community alert. 
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Refresh: use this option to re-display the pop-up by retrieving the most up-to-date 
information from the server. 

The Tools menu has options like those on the Panel List window (see Section 6.3.2). 
This Tools menu on the Community Alerts tab has this extra option: 

Glossary: use this option to display Community Alerts pop-up. See Section 4.13.1 for 
more information about this pop-up. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

8.3 Community Alerts Patient View Pop-up 
The purpose of this feature is to allow for monitoring of appropriate care and 
follow-up for the patient. 

The Package Manager can double-click any record on the Community Alerts tab to 
display the Community Alerts Patient View pop-up. The pop-up shows the patients in 
the community alert. 

 
Figure 8-3: Sample Community Alerts Detail pop-up 

If you are not a Package Manager, the message: You do not have the correct security 
access to see the Community Alerts Patient detail view. Please check with the iCare 
Package Manager to request access. displays. 

You must close the pop-up in order to do further work in iCare. 

8.3.1 Community Alerts Patient View Toolbar 
See Section 4.5 for information about the buttons on the right side of the pop-up. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Community Alerts 
August 2011 

192 

8.3.1.1 Create Panel Button 
You use the Create Panel button to create a panel from the selected patient names 
listed on the pop-up. 

Follow these steps to create a panel: 

1. Select the patient names that you want on the panel. See Section 4.2 for more 
information about selecting the patient names. 

2. Click the Create Panel  button to display the Create Panel dialog. 

 
Figure 8-4: Sample Create Panel Dialog 

The application provides a name for the new panel that you can change by 
manually typing the name. This is a free text field that has a right-click menu to 
aid in editing the “new” name. See Section 4.6.1 for more information. 

3. Click OK to create the panel with the selected patients. The application displays 
the Panel create successfully! message; click OK to dismiss the message. If you do 
not want to create the panel, click Cancel on the Create Panel dialog. 

After you click OK and exit the pop-up, your new panel will be listed on the 
Panel List window (otherwise, click Cancel to not save). This new panel uses the 
“No Predefined Population Search - Add Patients manually” population search 
option. You can share this panel with other RPMS users. 

8.3.1.2 Web Link Button 

Click the Web Link  button to go the CDC Web page. 

8.3.2 Menus on the Community Alerts Patient View Pop-up 
The following provides information about the options on the menus. 

8.3.2.1 File Menu 
The File menu has the following options: 

Community Alerts: This option has two choices: Create Panel and Web Link. These 
choices work like the buttons on the toolbar. 
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Page Setup: This option allows you to set Margin, Paper, Layout characteristics (like 
landscape or portrait orientation), and the Printer to use. 

Print Preview: This option displays the print preview dialog. 

Print This option sends the page to the printer using the settings in Page Setup. Note 
that only the selected tab (Panel List or Flag List) will be printed. 

Close: This option dismisses the pop-up. 

8.3.2.2 Edit Menu 
The Edit menu has the Select All option. You use this option to select all of the 
patient names in the grid on the pop-up. This is the same as using the key 
combination Ctrl+A. 

8.3.2.3 Tools Menu 
The options on the Tools operate like the buttons on the right side of the window. See 
Section 4.5 to review how to use the buttons on the right side of the pop-up. 

8.3.2.4 Help Menu 
The Help menu has the Glossary option. Select this option to display the Community 
Alerts glossary. See Section 4.13.1 for more information. 
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9.0 Panel View 
You can view the patients in a selected panel on the Panel List window either by 
using the Open function or by double-clicking a record. Either action opens the Panel 
View window. 

 
Figure 9-1: Sample Panel View 

NOTE: the Repopulate button will not display on the Panel View if the patients in the 
panel were added manually (that is, the panel has no predefined logic). 

The application displays the loading progress (in percentage) in the status bar when 
the panel contains a large number of patients. This feature applies to the Patient List 
(when you first access the Panel View window), Reminders, Natl Measures, CMET, 
Care Management, and Diagnostic Tags tabs. 

 
Figure 9-2: Loading Progress Information 

You can cancel the load by clicking Cancel; the application displays the “Cancel 
display of data?” dialog confirming that you want to cancel the loading process. 
Click Yes to cancel the load (otherwise, click No). 

iCare will provide the ability for more than one user to open the same shared panel 
simultaneously. The second and subsequent users to open the same panel will have 
“read only” access to the panel content, similar to Word or Excel functionality. If the 
first user closes the panel, the second user will be notified that the panel is now 
available for “edit” access, unless the user only has been provided with Shared Read 
Only access by the panel creator. 

9.1 Panel View Toolbar 
Below find information about the toolbar and the Properties button. 
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9.1.1 Information on Toolbar 
The following data are displayed in the panel information area located between the 
menu bar and the Panel View tabs: 

• Panel Name and Panel Description: both data are user-defined. 

• Owner Name (only displayed if you are not the creator of the panel): Name of 
the user who created the panel and shared it with you. 

• Total Patients: Number of patients in the panel. 

• Patient List Last Updated: Date and time the Patient List was last repopulated, 
either manually or auto-repopulated. 

• By: Name of user who last repopulated the Patient List. 

Note: If the panel has been shared with others who have 
read/write access, the displayed Owner and By fields might 
contain different names. 

9.1.2 Properties 
Click the Properties button located above the tabs in the Panel Information area (or 
select File | Panel Properties) to view the properties about the current panel. Click OK 
to dismiss the window. See Section 6.2.8 for more information. 

9.2 Patient List Tab 
The Patient List tab of the Panel View window shows the patients in the panel. The 
default grid will displays the standard demographic columns (Name, HRN, Sex, Age, 
DOB) in addition to the Diagnostic Tag-related data and the condition-specific 
(register) fields. 

 
Figure 9-3: Sample Patient List tab 

9.2.1 Patient List Tab Layout 
The system default template for the Patient List window is determined in User 
Preferences. See Section 3.2.6 for more information. 
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You can customize your Patient List template for defining the layout (on the Panel 
Definition Layouts tab of the Panel Definition window). See Section 5.4.1 for more 
information. This is the same as using the Layout function on the Patient List 
window. 

You can determine which template is being used by reviewing what is in the status 
bar, in Current Layout. For example, it could read Current Layout: System Default. 

The status bar shows information about the rows in the panel. Visible rows will be a 
smaller number than Total Rows if a filter has been applied. 

 
Figure 9-4: Sample Row Information 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

You use the Layout function to determine what columns display on the Patient List 
tab. See Section 9.2.2.10 for more information. 

The following table provides information about the default columns on the Patient 
List tab. 

Column Information 
Flag  indicator Displays when a patient has a flag. This column is always the first column and 

can only be removed by turning all flags “off” in the User Preferences (see 
Section 3.1.1.2). 

 The feather indicator in this column means that there is an open CMET with 
an overdue step. Go to the CMET Tracked Events sub-tab to review this 
condition. 

Patient Name Required field that will link to the Patient Record if you double-click on it. 
HRN Patient’s health record number. The HRN will display as the HRN number 

followed by the facility code. 
Sex F (for female) or M (for male). 
Age Patient’s age. 
DOB Patient’s Date of Birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to 

empanel patients. 
Community Patient’s community of residence. 
Active DX Tags One or more predefined diagnosis definitions (“tags”) that iCare has proposed 

for the patient that has a Proposed or Active status. See Section 2.2.1 for 
more information. 

 
If a Community cell contains the Community Alert  icon, you can view the 
Community Alert text by hovering your mouse over the icon.. The icon does not 
affect the sorting of the Community column. 
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9.2.1.1 Diagnostic Tags 
iCare provides a diagnosis tagging function that runs as a background process on your 
RPMS server and reviews all patient data. Tagging is a term that refers to running a 
series of logic algorithms on one or multiple patients that identifies (“tags”) them 
with one or more predefined diagnosis categories, listed below. 

• Asthma 

• COPD 

• Cardiovascular Disease (CVD) Known (CVD Kn) 

• CVC At Highest Risk (CVD AHR) 

• CVC At Significant Risk (CVD ASR) 

• CVD At Risk (CVD AR) 

• Diabetes (DM) 

• HIV/AIDS (HIV) 

• Hypertension (HTN) 

• Obese 

• Prediabetes/Metabolic Syndrome w/o DM (PreDM) 

• Current Smokers (Smoker) 
iCare will classify tags into one of five statuses: proposed (pending) (P), accepted 
(A), not accepted (NA), No longer valid (NLV), and Superseded (S). In the Active 
DX Tags column on any Panel View, the status value should be concatenated with the 
tag name, e.g., Asthma (A); CVD AHR (P); DM (A). 

The detailed logic for each of these diagnosis tags can be found in section 13.0 
Appendix A: iCare Predefined Diagnosis Definitions. These definitions are defined 
nationally and are consistent with definitions used in the Clinical Reporting System 
(CRS) and RPMS disease-specific registers, such as Diabetes Management System. 

9.2.1.2 Patient Classified as Sensitive 
You can identify a “sensitive patient” in the Patient Name column when the name is 
preceded by the  symbol. 

When you double-click the sensitive patient record, and if one of the following 
conditions exists: 

• if the patient is Sensitive and the user is not a DG SENSITIVITY key holder 
OR 
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• if the patient is an employee and the user is not a DG SENSITIVITY 
OFFICER key holder 

Then, the application will display a warning message. 

 
Figure 9-5: Sample Sensitive Patient Warning Message 

Click Yes to open the patient record. Otherwise, click No. 

9.2.2 Patient List Tab Toolbar 
See Section 4.5 for more information about the buttons on the right side of the 
toolbar. 

9.2.2.1 Add Patients 

Note: You can add a patient to the current panel by using the Add 
function or by copying a patient from another panel and 
pasting the patient into the current panel. 

Only the panel creator or the shared user with Read/Write access can add patient 
names to the current panel. This is a manual add function. You can add a patient 
name even if the panel was originally created from a pre-defined search definition. 
The panel stores the original definition as well as any patients added. This is 
important during the repopulate action. 

You can add a patient to the Panel View by doing one of the following: 

• Clicking the Add  button 

• Selecting Patients | Add Patient(s) 

• Selecting the Add Patient(s) option on the right-click menu 
The Select Patients dialog displays. 
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Figure 9-6: Select Patients Dialog 

Use any of the following to search for the patient in the Search field: 

• a few characters of the patient’s last name 

• the patient’s HRN 

• the patient’s SSN 

• the patient’s Date of Birth 
Then click Find. The retrieved records will display in the lower panel of the Select 
Patients dialog. You can refine your search (if needed) by using the Search field 
again. 

More than one row at time can be added by selecting multiple rows using Ctrl and 
Shift keys while highlighting the row. See Section 4.2 for more information. 

When you have highlighted the correct patient(s), click Add. This action adds the 
patient(s) to the Patient List tab on the Panel View window. (Otherwise, click Close 
to not add any patient). 

9.2.2.2 Open 
You use the Open function to move to another window to view the patient record 
(patient data information stored in the RPMS database). 

Highlight the patient name and open the patient record by doing one of the following: 
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• Clicking the Open  button 

• Selecting Patients | Open Patient(s) 

• Selecting the Open Patient(s) option on the right-click menu 

• Double-clicking on the row 

• Using the key combination Ctrl+O 
This action opens your default tab of the Patient Record window. See Section 10.0 for 
more information about this window. 

By highlighting more than one row, multiple patient records open in individual 
windows. 

9.2.2.3 Remove 
You use the Remove function to delete one or more patients from the Patient List tab 
on the Panel View window. The removed patients are NOT deleted from the RPMS 
database but are only removed from your panel display. Only the panel creator or the 
shared user with Read/Write access can remove patients from the Patient List tab. 

The panel stores the original definition as well as any patients removed or added. This 
is important during the repopulate action. 

You can remove the highlighted patients by doing one of the following: 

• Clicking the Remove  button 

• Selecting Patients | Remove Patient(s) 

• Selecting the Remove Patient(s) option on the right-click menu 

• Pressing the Delete key on your keyboard 
After using the Delete function, the “Confirm patient remove” dialog displays, asking 
if you want to delete the selected patients. Click Yes to remove the selected patients. 
Otherwise, click No. 

9.2.2.4 Repopulate 
You use the Repopulate function when you want iCare to rebuild the contents of the 
panel. Repopulate reruns the panel definition against the cached data (from the 
nightly job) and will add patients who meet the criteria and remove the patients that 
no longer meet the criteria. Only the panel creator or the shared user with Read/Write 
access can repopulate the panel. 

NOTE: the Repopulate button will not display on the Panel View if the patients in the 
panel were added manually (that is, the panel has no predefined logic). 
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You can repopulate a panel by doing one of the following: 

• Clicking the Repopulate  button 

• Selecting Patients | Repopulate 

• Selecting the Repopulate option on the right-click menu 
A warning message displays asking if you want to update the patient list. 

 
Figure 9-7: Warning Message About Updating Patient List 

Click Yes to repopulate the panel. Otherwise, click No. 

If you manually edited (added or removed) patients in the panel, the Maintain Manual 
Changes warning message displays. 

 
Figure 9-8: Maintain Manual Changes warning message 

Click Cancel to cancel the repopulate process. 

Click Yes to repopulate the panel and to keep the manually added or removed 
patients. 

Click No if you want the patient list totally refreshed. In this case, the patient list 
will be totally refreshed and any added patient names will be lost as well as any 
deleted patient names will be added back to the panel. 

If you use Yes or No and the current panel contains many patients, iCare displays 
the “Background populate” information message. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Panel View 
August 2011 

202 

 
Figure 9-9: Background populate information message 

Click Yes to run the repopulate process in the background. Otherwise, click No to 
repopulate in the foreground. 

9.2.2.5 Copy 
You use the Copy function to copy the selected patient’s information to the iCare 
clipboard. Then you can go to another panel view (for a different patient panel) and 
paste the patient’s information. 

You can copy the selected patient’s information by doing one of the following: 

• Clicking the Copy  button 

• Selecting Patients | Copy Patient(s) 

• Selecting the Copy Patient(s) option on the right-click menu 

• Using the keyboard combination Ctrl+C 
You need to move to another patient panel and use the Paste function. 

You use the Select All function to select all the patients on the current Panel View 
window. Once the patients are selected, you could copy-paste them into another 
panel, for example. 

You can select all the patients by doing one of the following: 

• Selecting Edit | Select All 

• Using the keyboard combination Ctrl+A 
If you need to deselect the patients, select the Deselect All option on the Edit menu. 

9.2.2.6 Cut 
You use the Cut function to copy the selected patient’s information to the iCare 
clipboard and to remove the selected patient from the current Panel View. Then you 
can go to another panel view (for a different patient panel) and paste the patient’s 
information. Only the panel creator or the shared user with Read/Write access can cut 
patient data from the Panel View. This function is useful for moving patients from 
one panel to another. 
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You can cut the selected patient’s information by doing one of the following: 

• Clicking the Cut  button 

• Selecting Patients | Cut Patient(s) 

• Selecting the Cut Patient(s) option on the right-click menu 

• Using the keyboard combination Ctrl+X 
You need to move to another patient panel and use the Paste function. 

9.2.2.7 Paste 
You use the Paste function to place the contents of the iCare clipboard (containing 
patient data) into the current Panel View (this cannot be duplicate patient data). If 
there are duplicate patients in the paste operation, the system displays a message 
about this condition. Only the panel creator or the shared user with Read/Write access 
can paste patient data on the Panel View. 

Patients that are pasted into a panel are considered “manually added.” This means that 
they are considered to be members of the panel that were manually selected to be on 
the patient list, and therefore are considered outside of the patient list that exists due 
to the panel’s search logic. 

You can paste the contents of the clipboard by doing one of the following: 

• Clicking the Paste  button 

• Selecting Patients | Paste Patient(s) 

• Selecting the Paste Patient(s) option on the right-click menu 

• Using the keyboard combination Ctrl+V 

The patients on the clipboard are added to the current Panel View. (If there are no 
patients on the iCare clipboard, a warning message will display.) 

If there is a duplicate patient to be pasted, the Duplicate patient message displays that 
states: One or more of the patients being pasted already exist on the panel. If you 
choose to continue those patient will be skipped to avoid duplicate patients within the 
panel Would you like to continue pasting the other patient? Click OK to continue 
pasting the other patients (otherwise, click Cancel to discontinue the paste operation). 

9.2.2.8 Modify 
You use the Modify function to modify the patient panel definition information. Only 
the panel creator or the shared user with Read/Write access can modify the patient 
panel definition. 
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You can modify the current panel by doing one of the following: 

• Clicking the Modify  button 

• Selecting File | Modify 
The Panel Definition window for the panel displays. See Section 5.3 for more 
information about completing/modifying this window. 

9.2.2.9 Share 
You use the Share function to define users who can share the current panel. Only the 
panel creator or the shared user with Read/Write access can share patient data. 

You can share the patient panel by doing one of the following: 

• Clicking the Share  button 

• Selecting File | Share 
The Panel Definition window opens to the Sharing tab of the Panel Definition 
window. See Section 5.5 for more information about sharing the panel. 

9.2.2.10 Layout 
You use the Layout function to select which data columns to show, the order of the 
columns chosen for display, and the initial sort order of the patients in the list. This 
layout information is stored with the panel if the you decide to save the panel 
changes. Users with read-only access can change the layout of a panel. 

You can select the view layout function by doing one of the following: 

• Clicking the Layout  button 

• Selecting File | Layout 
The Patient List Layout window opens, showing the current layout for the panel. See 
Section 4.9 for information on how to use this layout dialog. 

9.2.3 Patient List Tab Menu Options 
See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

The options on the Patients menu operate like the action buttons on the toolbar. See 
Section 9.2.2 for more information. 
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9.2.3.1 File Menu 
The options on the File menu of the Patient List tab are: 

New: This option displays the Panel Definition window where you can define a new 
patient panel. See Section 5.0 for more information about this window. 

Modify, Share, Layout: These options work like the buttons on the toolbar. See 
Section 9.2.2 for more information. 

Save: This option saves the changes you made to the current Panel View window. 

Page Setup: This option allows you to set Margin, Paper, and Layout characteristics 
(like landscape or portrait orientation) for printing. 

Print: This option outputs the selected rows in the grid. The application displays the 
Print dialog where you select the Page Range, Number of Copies, the printer, etc. The 
application provides a header stating Confidential Patient Information for all printed 
panel views. 

If you do not select any rows (when using the Print or Print Preview option), the 
application displays the warning message: You have not selected any rows to print. Do 
you want to proceed and print all rows in this view or cancel this print? Click Yes to print 
all the rows. Click No to cancel the print function. 

Print Preview: This option displays the Print Preview dialog for the selected rows in 
the grid. 

Panel Properties: This option displays the Panel Properties window. This view-only 
window provides information about the panel properties. See Section 9.1.2 for more 
information. 

Background Jobs: This option displays the Background Jobs pop-up. See 
Section 4.10 for more information. 

Close: This option closes the current Panel View window. If there are changes that 
need to be saved, you will be notified about this condition. 

9.2.3.2 Tools Menu 
The options on the Tools menu are: 

Quick Patient Search: This option opens the Quick Patient Search (within Panel) 
dialog. See Section 4.4.1 for more information about this functionality. 

Mail Merge, Reset View, Refresh, Search, Excel Export, Print, Copy Rows to 
Clipboard: These options work like the buttons on the right side of the window. See 
Section 4.5 for more information. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Panel View 
August 2011 

206 

User Preferences: This option opens the User Preferences window. See Section 3.2 
for more information. 

Web Links: This option provides links to Web sites for related clinical guidelines. 

9.3 Reminders Tab 
The Reminders tab displays the national reminders that are pulled from the same data 
as the Health Summary report reminders in RPMS (such as lab test, immunization, 
etc.). 

 
Figure 9-10: Sample Reminders tab 

The Reminders Glossary contains information about each of the Reminders. To view 
this glossary, select Help | Reminders Glossary. 

9.3.1 Reminders Tab Layout 
The system default template for the Reminders window is determined in User 
Preferences. See Section 3.2.6 for more information. 

You can customize your Reminders template for defining the layout (on the Panel 
Definition Layouts tab of the Panel Definition window). See Section 5.4.2 for more 
information. This is the same as using the Layout function on the Reminder window. 

You can determine which template is being used by reviewing what is in the status 
bar, in Current Layout. For example, it could read Current Layout: System Default. 

The default view displays the fields in the following order: 

Column Information 
Flag  indicator Displays when a patient has a flag. This column is always the first column and 

can only be removed by turning all flags “off” in the User Preferences (see 
Section 3.1.1.2). 

 The feather indicator in this column means that there is an open CMET with 
an overdue step. Go to the CMET Tracked Events sub-tab to review this 
condition. 

Patient Name Required field that will link to the Patient Record if you double-click on it. 
HRN Patient’s health record number. The HRN will display as the HRN number 

followed by the facility code. 
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Column Information 
Sex F (for female) or M (for male). 
Age Patient’s age. 
DOB Patient’s Date of Birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to 

empanel patients. 
Community Patient’s community of residence. 
Active DX Tags One or more predefined diagnosis definitions (“tags”) that iCare has proposed 

for the patient that has a Proposed or Active status. See Section 2.2.1 for 
more information. 

Individual Columns There are individual columns for each Reminder. 
 

If a Community cell contains the Community Alert  icon, you can view the 
Community Alert text by hovering your mouse over the icon. The icon does not affect 
sorting of the column. 

Double-click any row on the Reminders view to display the Reminders tab of the 
Patient Record window. 

The default sort order is alphabetical by Patient Name. 

You can double-click on any record on the Reminders tab to open the Reminders tab 
of the Patient Record window. See Section 10.6 for more information. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

9.3.1.1 Due/Overdue Dates 
A date (or “N/A”) will be displayed under each of the particular reminder’s column 
(for example, Height). If the test or procedure is currently due or overdue, an icon 
will be displayed next to the date, as shown below. 

 
Figure 9-11: Sample Overdue Date for Pelvic Exam Reminder 

The icon is not displayed for dates that are not yet due (in the future). 

9.3.1.2 Tooltip for Test/Procedure 
You can hover your mouse over a test/procedure column heading to view information 
about it. The information is pulled from the Reminders application. 
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9.3.2 Reminders Tab Toolbar 
The reminder logic is calculated with Flags/Tags/Performance data runs and cached 
for display. The reminder logic is updated nightly by a system job. The toolbar shows 
the date for which the data is effective. 

See Section 4.5 for more information about the buttons on the right side of the 
toolbar. 

9.3.2.1 Copy Patient(s) 
This action copies the patients information to the iCare clipboard. 

Select one or more patients (see Section 4.2 for more information about selecting 
patients) and then do one of the following: 

• Click the Copy Patient(s)  button 

• Select Reminders | Copy Patient(s) 

• Use the keyboard combination Ctrl+C 
You must go to another panel view (for a different patient panel) and paste the 
patient’s information. 

9.3.2.2 Layout 
You use this function to select which reminder columns to display as well as the order 
and sorting that should be used. 

To change the layout, do one of the following: 

• Click the Layout  button 

• Select Reminders | Layout 
The Reminders Layout screen of the Panel Definition will display for the current 
panel. Here you can select the Reminders columns you want to display on your panel. 
See Section 5.4.2 for more information. 

You can display the EHR Clinical Reminders by selecting Reminders | EHR Clinical 
Reminders and add them to the Display Columns. See Section 5.4.2 for more 
information. 

9.3.2.3 Status of Background Jobs 
You can check the status of the background jobs; this displays the RPMS iCare - 
Background Jobs window. See Section 4.10 for more information. 
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To check on the status of the background jobs, do one of the following: 

• Click the background jobs  button 

• Select File | Background Jobs 

9.3.3 Reminders Tab Menu Options 
The File menu on the Reminders tab is the same as the one on the Patient List tab. 
See Section 9.2.3.1 for more information. 

The options on the Reminders menu perform the same actions as the Copy Patient(s) 
and Layout buttons on the toolbar. See Section 9.3.2 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

The options on the Tools menu are: 

Quick Patient Search: This option opens the Quick Patient Search (within Panel) 
dialog. See for more information about this functionality. 

Mail Merge, Glossary, Reset View, Refresh, Search, Excel Export, Print, Copy 
Rows to Clipboard: These options work like the buttons on the right side of the 
window. See Section 4.5 for more information. 

User Preferences: This option opens the User Preferences window. 

Web Links: This option provides links to Web sites for related clinical guidelines. 

9.4 Rem Aggregated Tab 
The Reminders Aggregated tab displays the percentages and counts of patients within 
a panel that have or have not met reminder criteria. Active reminders are reminders 
that are “turned on” at a site. Reminders will be calculated at the time the view is 
opened. 

 
Figure 9-12: Sample Rem Aggregated tab 
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9.4.1 Rem Aggregated Tab Layout 
The default view displays the fields on the Reminders Aggregated tab in the 
following order: 

Column Meaning 
Source The name of the source for the reminder, The following reminders 

will be organized into Source: Asthma Reminders, CMET 
Reminders, EHR Clinical Reminders, Health Summary Reminders, 
HIV/AIDS Reminders. 

Category The name of the category for the particular source. 
Reminder Name The name of the reminder. 
# Patients Eligible The total number of patients in this panel who need individual 

reminders. 
# Patients Current “Current” is defined as any due date in the future (not including 

today). 
% Current The total percentage of patients in this panel who are current for an 

individual reminder, that is, [# Patient Current] divided by [#Patients 
Eligible]. Because of the one month “grace” period for the overdue 
definition, the total percentage of Current and Overdue cannot equal 
100%. 

# Patients Overdue “Overdue” is defined as the due date equal or is before [today - 30 
days]. This means the reminder is NOT counted as overdue for 
purposes of performance until at least a month. The total of the 
Patients Current and the Patients Overdue cannot equal the total 
Patients Eligible because of the one month “grace” period for the 
overdue definition. 

% Overdue The total percentage of patients in this panel who are overdue for an 
individual reminder. That is, [Patients Overdue] divided by [Patients 
Eligible]. Because of the one month grace period, the total 
percentage of Patients Current and Patients Overdue might not 
equal 100%. 

 
There is hover help for each cell in the Reminders Name column 

The National Measures glossary provides information about the measures. To view 
this glossary, select Help | National Measures Glossary. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. However, you cannot change the layout by adding 
or deleting columns. 

9.4.2 Rem Aggregated Tab Toolbar 
The toolbar displays the date/time the data is effective. 

See Section 4.5 for more information about the buttons on the right side of the 
toolbar. 
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You can check the status of the background jobs; this displays the RPMS iCare - 
Background Jobs window. See Section 4.10 for more information. 

To check on the status of the background jobs, do one of the following: 

• Click the background jobs  button 

• Select File | Background Jobs 

9.4.3 Rem Aggregated Tab Menu Options 
The options on the File menu for the Reminders Aggregated tab is the same as those 
on the Patient List tab. See Section 9.2.3.1 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

The options on the Tools menu are: 

Quick Patient Search: This option opens the Quick Patient Search (within Panel) 
dialog. See Section 4.4 for more information about this functionality. This is the same 
as pressing the F8 key on your keyboard. 

Glossary: This option displays the Reminders Glossary pop-up. The information 
provides Reminder descriptions (from RPMS). The pop-up has descriptions of the 
logic behind each national health summary reminder available for display in iCare. 
You can display, print, and save the Glossary text. See Section 4.13.4 for more 
information about this glossary. This is the same as clicking the Glossary  button. 

Mail Merge, Glossary, Reset View, Refresh, Search, Excel Export, Print, Copy 
Rows to Clipboard: These options work like the buttons on the right side of the 
window. See Section 4.5 for more information. 

User Preferences: This option opens the User Preferences window. See Section 3.2 
for more information. 

Web Links: This option provides links to Web sites for related clinical guidelines. 

9.5 Natl Measures Tab 
The Natl Measures tab displays IHS national clinical performance measure as defined 
and reported in the RPMS Clinical Reporting System (CRS). iCare uses CRS 
performance logic to display whether “your” patients are meeting annual performance 
goals. 
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Figure 9-13: Sample National Measures tab 

9.5.1 What is National Performance (GPRA)? 
The Government Performance and Results Act (GPRA) requires federal agencies to 
report annually to Congress on how the agency measured up against the performance 
targets set in its annual Plan. See Appendix B or the CRS User Manual for additional 
information about the IHS quarterly and annual performance reporting process. 

Most performance measures have a denominator and a numerator defined. 

• The denominator is the total population being reviewed 

• The numerator is the number of patients from the denominator who meet the 
definition of the measure. 

Some measures are just a count, such as Sealants and Topical Fluorides. 

Measure example: GPRA Measure Cancer Screening: Pap Smear Rates: Maintain 
the proportion of female patients ages 21 through 64 without a documented history of 
hysterectomy who have had a Pap screen within the past three years at the previous 
year’s level (60.0%). 

The denominator is the total population that is being reviewed for a specific measure. 
For the Pap Smear measure, the denominator is all female patients ages 21 through 64 
at the beginning of the Report period. The numerator is the number of patients in the 
denominator who meet specific criteria. For Pap Smear, the numerator is the number 
of patients in the denominator who had either a Pap smear, defined by certain codes, 
documented in RPMS any time in the three years prior to the end of the report period 
or a refusal of a Pap smear in the past year. 

If you are not familiar with your facility’s policies and practices related to national 
performance reporting, you might want to talk with your site GPRA coordinator. 

9.5.2 Natl Measures Tab Layout 
The system default template for the Natl Measures window is determined in User 
Preferences. See Section 3.2.6 for more information. 
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You can customize your Natl Measures template for defining the layout (on the Panel 
Definition Layouts tab of the Panel Definition window). See Section 5.4.3 for more 
information. This is the same as using the Layout function on the Natl Measures 
window. Additional data columns are available, including non-GPRA national 
performance measures. Use the Layout toolbar button to sort, add, or delete columns. 

You can determine which template is being used by reviewing what is in the status 
bar, in Current Layout. For example, it could read Current Layout: System Default. 

The default columns are described below. 

Column Information 
Flag  indicator Displays when a patient has a flag. This column is always the first column and 

can only be removed by turning all flags “off” in the User Preferences (see 
Section 3.1.1.2). 

 The feather indicator in this column means that there is an open CMET with 
an overdue step. Go to the CMET Tracked Events sub-tab to review this 
condition. 

Patient Name Required field that will link to the Patient Record if you double-click on it. 
HRN Patient’s health record number. The HRN will display as the HRN number 

followed by the facility code. 
Sex F (for female) or M (for male). 
Age Patient’s age. 
DOB Patient’s Date of Birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to 

empanel patients. 
Community Patient’s community of residence. 
Active DX Tags One or more predefined diagnosis definitions (“tags”) that iCare has proposed 

for the patient that has a Proposed or Active status. See Section 2.2.1 for 
more information. 

Individual Columns The value of the performance met. 
 

If you double-click any record, the patient record window opens to the Natl Measures 
tab. See Section 10.8 for more information. 

If a Community cell contains the Community Alert  icon, you can view the 
Community Alert text by hovering your mouse over the icon. The icon does not affect 
sorting of the column. 

There is hover help for each performance column that displays the GPRA definition. 

You can find information about all of the measures in the National Measures 
Glossary. To view this glossary, select Help | Natl Measures Glossary. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 
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9.5.3 Natl Measures Tab Toolbar 
The toolbar shows the date/time for which the data is effective. 

See Section 4.5 for more information about the buttons on the right side of the 
toolbar. 

9.5.3.1 Copy Patient(s) 
This action copies the patients information to the iCare clipboard. This is useful for 
selecting patients that need additional follow-up based on the measure information 
displayed. 

Select one or more patients (see Section 4.2 for more information about selecting 
patients) and then do one of the following: 

• Click the Copy Patient(s)  button 

• Select National Measures | Copy Patient(s) 

• Use the keyboard combination Ctrl+C 
You must go to another panel view (for a different patient panel) and paste the 
patient’s information. 

9.5.3.2 Layout 
You use this function to select which performance measures to display as well as the 
order and sorting that should be used. 

To change the layout, do one of the following: 

• Click the Layout  button 

• Select National Measures | Layout 
The Natl Measures Layout screen for the current panel will display. Here you can 
select the National Measures columns you want to display on your panel as well as 
the sort order. See Section 5.4.3 for more information. 

If you choose to add the “CRS Pop” column to the National Measures tab, it will 
display the value(s) describing the population category defined by CRS. The CRS 
Population categories include: UP (User Population), AC (Active Clinical), AD 
(Active Diabetic), etc. The population is a text string from the Denominator column 
of the CRS Patient List report that will be calculated for each patient within the 
weekly performance measures background process. 
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9.5.3.3 Status of Background Jobs 
You can check the status of the background jobs; this displays the RPMS iCare - 
Background Jobs window. See Section 4.10 for more information. 

To check on the status of the background jobs, do one of the following: 

• Click the background jobs  button 

• Select File | Background Jobs 

9.5.4 Natl Measures Tab Menu Options 
The options on the File and Tool menus for the Natl Measures tab is the same as 
those on the Patient List tab. See Section 9.2.3. 

The options on the Natl Measures menu operate like the action buttons on the toolbar. 
See Section 9.5.3 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

9.6 Natl Aggregated Tab 
The National Aggregated tab information is based on the format of the Summary 
Page from the CRS National GPRA report. It displays a summarized overview of the 
national performance measure data for patients in the panel being viewed. 

 
Figure 9-14: Sample Natl Aggregated Tab 

This window displays aggregated performance for this panel expressed in percentages 
and compared to the predefined Agency-level values from the previous year and 2010 
performance goals. 

9.6.1 Natl Aggregated Tab Layout 
The following data are displayed on the Natl Aggregated tab. 
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Category: the name of the category associated with the measure. 

Clinical Group: the name of the clinical performance group. 

Measure Name: the measure title derived from the Summary Report (iCare pulls from 
the first column of the CRS Summary Report). The hover help displays a description of 
the performance logic for each cell in the column. 

# Patients in Denominator: the total number of patients in this panel who meet the 
denominator definition. 

# Patients in Numerator: the total number of patients in this panel who meet the 
numerator definition. 

% Met: the percentage of the panel who meet the measure, derived by dividing the 
denominator total by numerator total. 

year Goal: the value will be the same as the one that displays in the “GPRA” column 
on the Summary Page from the CRS National GPRA report. The “year” is the most 
recent year with final goals recorded. 

IHS Current National Performance: the value will be the same as the one that 
displays in the “Nat’l” column on the Summary Page from the CRS National GPRA 
report. 

Healthy People 2020 Goal: the value shows the 2020 goals detailed in CRS. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

9.6.2 Natl Aggregated Tab Toolbar 
The toolbar shows the date/time for which the data is current. 

See Section 4.5 for more information about the buttons on the right side of the 
toolbar. 

You can check the status of the background jobs; this displays the RPMS iCare - 
Background Jobs window. See Section 4.10for more information. 

To check on the status of the background jobs, do one of the following: 

• Click the background jobs  button 

• Select File | Background Jobs 
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9.6.3 Natl Aggregated Tab Menu Options 
The options on the File menu for the Natl Aggregated tab are the same as those on the 
Patient List tab. See Section 9.2.3.1 for more information. 

The options on the Tools menu for the Natl Aggregated tab are the same as those on 
the Reminders Aggregated tab. See Section 9.4.3 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

9.7 CMET Tab 
The CMET tab on the Panel View displays data related to the Events, Tracked 
Events, and Follow-up Events for the panel of patients. 

 
Figure 9-15: Sample CMET Tab window 

9.7.1 Events Sub-Tab 
The Events sub-tab provides data that was last retrieved on the date displayed on this 
Events window. 
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Figure 9-16: Sample Events sub-tab 

The Events sub-tab is divided into three general area: Tips information, Events 
toolbar, and Events data. 

The Tips information provides an overview of the Events sub-tab. You can collapse 
this area in order to have more room for viewing the Events data. 

Note: You can establish the default “collapse” status for the Tips 
area on this sub-tab. To do that, select Tools | User 
Preferences | CMET tab | Events sub-tab. The Tips check 
box on this sub-tab will establish the “collapse” status. 

9.7.1.1 Events Sub-Tab Layout 
The system default template for the Events sub-tab is determined in User Preferences. 
See Section 3.2.6 for more information. 

You can customize your Event template for defining the layout (on the Panel 
Definition Layouts tab of the Panel Definition window). See Section 5.4.6 for more 
information. This is the same as using the Layout function on the Events sub-tab 
window. 

You can determine which template is being used by reviewing what is in the status 
bar, in Current Layout. For example, it could read Current Layout: System Default. 

The following table provides information about the default columns. 

Column Meaning 
Category The category of the event: Breast, Cervical, Colon, Skeletal 
Patient Name Required field that will link to the Events sub-tab of the CMET tab on the Patient 

Record if you double-click on it. 
HRN Patient’s Health Record Number. 
Sex F (for female) or M (for male) 
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Column Meaning 
Age Patient’s age today. 
DOB Patient’s date of birth 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to empanel 

patients. 
Community Patient’s community of residence. 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for this patient, 

based on the tagging function. 
Event Name Name of the event. 
Event Date The date associated with the event. 
Result The date of the result of the event. This cell also has hover help, such as V 

Radiology. 
Status The status of the event. 
Status Comments Text of the any comments about the status. 
Last Modified 
Date/Time 

The date and time the record was last modified. 

Last Modified By The name of the person who last modified the record. Initial job means it is the 
initial record. 

 
If a Community cell contains the Community Alert  icon, you can view the 
Community Alert text by hovering your mouse over the icon. The icon does not affect 
the sorting of the Community column. 

Double-click the underlined Event Date to access the Visit Detail pop-up. 

Double-click the underlined Result Date to access a particular detail pop-up, for 
example, Women’s Health Detail. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

9.7.1.2 Events Sub-Tab Toolbar 
The toolbar shows the date/time the data is effective. 

See Section 4.5 to review how the buttons on the right side of the window operate. 

9.7.1.2.1 Copy Patient(s) 
This action copies the patients information to the iCare clipboard. 

Select one or more patients (see Section 4.2 for more information about selecting 
patients) and then do one of the following: 

• Click the Copy Patient(s)  button 

• Select CMET | Events | Copy Patient(s) 

• Use the keyboard combination Ctrl+C 
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You must go to another panel view (for a different patient panel) and paste the 
patient’s information. 

9.7.1.2.2 Layout 
You use the Layout function to determine the columns on the Events sub-tab for the 
current panel. This is the same dialog that displays during the panel definition 
process. See Section 5.4.6 for more information. 

You can select the layout function by doing one of the following: 

• Clicking the Layout  button 

• Selecting File | Layout 

• Selecting CMET | Events | Layout 

9.7.1.2.3 Track 
Use the Track button to change the status of a Not Tracked or Pending event to 
Tracked. See Section 11.1.3.1 for more information. 

9.7.1.2.4 Don’t Track 
Use the Don’t Track button to change the status of a Pending event to Not Tracked. 
See Section 11.1.3.2 for more information. 

9.7.1.2.5 Pend 
Use the Pend button to change the status of Not Tracked event to Pending. See 
Section 11.1.3.3 for more information. 

9.7.1.2.6 Batch Process 
Use the Batch Process button to batch process selected records. See Section 11.1.3.4 
for more information. 

9.7.1.2.7 Status of Background Jobs 
Click the Status of Background Jobs button to check the status of the background 
jobs; this displays the RPMS iCare - Background Jobs window. See Section 4.10 for 
more information. 

9.7.2 Tracked Events Sub-Tab 
The CMET events that are identified as “Tracked” for the current panel will display 
on the Tracked Events sub-tab. 
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Figure 9-17: Sample Tracked Events sub-tab 

The Tracked Events sub-tab is divided into three general area: Tips information, 
Tracked Events toolbar, and Tracked Events data. 

The Tips information provides an overview of the Tracked Events sub-tab. You can 
collapse this area in order to have more room for viewing the Tracked Events data. 

Note: You can establish the default “collapse” status for the Tips 
area on this sub-tab. To do that, select Tools | User 
Preferences | CMET tab | Tracked Events sub-tab. The Tips 
check box on this sub-tab will establish the “collapse” 
status. 

9.7.2.1 Tracked Events Sub-Tab Layout 
You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

The system default template for the Tracked Events sub-tab is determined in User 
Preferences. See Section 3.2.6 for more information. 

You can customize your Tracked Events template for defining the layout (on the 
Panel Definition Layouts tab of the Panel Definition window). See Section 5.4.7 for 
more information. This is the same as using the Layout function on the Tracked 
Events sub-tab window. 

You can determine which template is being used by reviewing what is in the status 
bar, in Current Layout. For example, it could read Current Layout: System Default. 

The following table provides information about the columns. 

Column Meaning 
Category The category of the tracked event: Breast, Cervical, Colon. Skeletal. 
Patient Name Required field that will link to the Tracked Events sub-tab of the CMET tab on the 

Patient Record if you double-click on it. 
HRN Patient’s Health Record Number. 
Sex F (for female) or M (for male) 
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Column Meaning 
Age Patient’s age today. 
DOB Patient’s date of birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to 

empanel patients. 
Community Patient’s community of residence. 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for this patient, 

based on the tagging function. 
1 - Event Name of the event. 
Event Date The date associated with the event. 
Preceding Event Contains the date of the preceding event. Double-click on this underlined date to 

open the Tracked Events of the CMET tab on the Patient Record. The chain of 
events in the same category is revealed. In addition, there is hover help when 
you move your mouse over the date (for example, PAP SMEAR 139). 

Results The date of the result of the event. Hover help will describe where the result 
came from (V-RADIOLOGY, V-LAB). 

2 - Finding(s) Icons that indicate if the event has any findings. 
Interpretation The interpretation of the Finding. 
3 - Follow-up(s) Icon that indicates if the event has follow-up data. 
4 - Patient 
Notification(s) 

Icon that indicates if the event has any patient notification data. 

State The state of the tracked event (Open or Closed). 
 

When the 2 - Finding(s) cell contains the following: 

• the “feather”  icon to indicate that the element is overdue; hover your 
mouse over the icon to view the Due Date (the tickler). 

• the check  icon to indicate that the step is complete; hover your mouse of 
the icon to view the Finding Due date and the Finding Value. 

• is blank to indicate that the element is not complete but is not overdue. 

When the 3 - Follow-up(s) cell contains the check  icon, this means the step is 
complete; hover your mouse of the icon to view the Follow-up Date and the Follow-
up type. If it is blank, this indicates that element is not complete but is not overdue. 

When the 4 - Patient Notification(s) cell contains the check  icon, this means the 
step is complete; hover your mouse of the icon to view the Notification Date and the 
Notification method. If it is blank, this indicates that element is not complete but is 
not overdue. 

The Results column will display the date (Linked) if results have been mined during 
the nightly job. The data link will be the most recent result. Hover help will describe 
where the result came from, for example, v-lab. 
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9.7.2.2 Tracked Events Sub-Tab Toolbar 
The toolbar shows the date/time for which the data is effective. 

You use the Layout function to determine the columns on the Tracked Events sub-tab 
for the current panel. This is the same dialog that displays during the panel definition 
process. See Section 5.4.7 for more information. 

You can select the layout function by doing one of the following: 

• Clicking the Layout  button 

• Selecting File | Layout 

• Selecting CMET | Tracked Events | Layout 
The Copy Patient(s) button works like the one on the Events sub-tab. See 
Section 9.7.1.2.1 for more information. 

The Reopen, Close, Batch Process, Open CMET Worksheet, Status of Background 
Jobs buttons work like those on the CMET tab window of the main iCare window. 
See Sections 11.2.3.1, 11.2.3.2, 11.2.3.3, 11.2.3.4, and 11.2.3.6 for more information. 

Note: Multiple selections from the Panel View are not permitted 
when using the Close function. 

See Section 4.5 to review how the buttons on the right side of the window operate. 

9.7.3 Follow-up Events Sub-Tab 
The Follow-up Events sub-tab contains what you want to do for follow-up. 

 
Figure 9-18: Sample Follow-up Events sub-tab 

The Follow-up Event Name and Date are pulled from Step 3 of the CMET process. 
This is the provider’s recommendation for follow-up. The date is the date due for the 
follow-up. 
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The Follow-up Events sub-tab is divided into three general area: Tips information, 
Follow-up Events toolbar, and Follow-up Events data. 

The Tips information provides an overview of the Follow-up Events sub-tab. You can 
collapse this area in order to have more room for viewing the Follow-up Events data. 

Note: You can establish the default “collapse” status for the Tips 
area on this sub-tab. To do that, select Tools | User 
Preferences | CMET tab | Follow-up Events sub-tab. The 
Tips check box on this sub-tab will establish the “collapse” 
status. 

9.7.3.1 Follow-up Events Sub-Tab Layout 
The data on the Follow-up Events sub-tab is effective as of the date on the window. 

The system default template for the Follow-up Events sub-tab is established in User 
Preferences. See Section 3.2.6 for more information. 

You can customize your Follow-up Events template for defining the layout (on the 
Panel Definition Layouts tab of the Panel Definition window). See Section 5.4.8 for 
more information. This is the same as using the Layout function on the Follow-up 
Events sub-tab window. 

You can determine which template is being used by reviewing what is in the status 
bar, in Current Layout. For example, it could read Current Layout: System Default. 

The following table provides information about the columns. 

Column Meaning 
Category The category for the Follow-up Event: Breast, Cervical, Colon, Skeletal. 
Follow-up Event 
Name 

The name of the event. 

Follow-up Event 
Date 

The follow-up date for the event. 

Preceding Event Contains the date of the preceding event. Double-click on this underlined date to 
open the Follow-up Events of the CMET tab on the Patient Record. The chain of 
events in the same category is revealed. 

Patient Name Required field that will link to the Follow-up Events sub-tab of the CMET tab on the 
Patient Record if you double-click on it. 

HRN Patient’s Health Record Number. 
Sex F (for female) or M (for male) 
Age Patient’s age today. 
DOB Patient’s date of birth (required) 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field to empanel 

patients. 
Community Patient’s community of residence. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Panel View 
August 2011 

225 

Column Meaning 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for this patient, 

based on the tagging function. 
 

If a Community cell contains the Community Alert  icon, you can view the 
Community Alert text by hovering your mouse over the icon. The icon does not affect 
the sorting of the Community column. 

9.7.3.2 Follow-up Events Tab Toolbar 
You use the Layout function to determine the columns on the Follow-up Events sub-
tab for the current panel. This is the same dialog that displays during the panel 
definition process. See Section 5.4.8 for more information. 

You can select the layout function by doing one of the following: 

• Clicking the Layout  button 

• Selecting File | Layout 

• Selecting CMET | Events | Layout 
The Copy Patient(s) button work like those on the Events sub-tab. See 
Section 9.7.1.2.1 for more information. 

The Open CMET Worksheet and Background Jobs button works like those on the 
Events sub-tab of the main iCare CMET window. See Sections 11.2.3.4 and 11.2.3.6 
for more information. 

See Section 4.5 to review how the buttons on the right side of the window operate. 

9.7.4 CMET Tab Menu Options 
See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

9.7.4.1 File Menu 
The options on the File Menu for the CMET tab are similar to those on the File Menu 
for the Patient List tab. See Section 9.2.3.1 for more information. 

9.7.4.2 Tools Menu 
The options on the Tools menu for the CMET tab are the same as the options on the 
Tools menu for the Patient List tab. See Section 9.2.3.2 for more information. 
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9.7.4.3 CMET Menu 
The options on the CMET menu operate like the action buttons on the various sub-
tabs. 

9.8 Care Mgmt Tab 
The Care Mgmt tab displays data related to asthma or HIV/AIDS for the patients in 
the panel. 

When you first access this tab, the display will be empty. You must select an option 
in the “Please Select a Group” field in order to display any data. 

 
Figure 9-19: Sample Care Mgmt tab 

iCare provides you with existing Register capabilities for iCare panels for specific 
underlying case management applications. 

This tab displays information from the register (shown in the Care Mgmt Group field) 
for the patients in the panel. You must select an option for this field in order to view 
the data. 

The underlying RPMS application for the HIV/AIDS Register option is BKM. 

9.8.1 Main Sub-Tab for HIV/AIDS Register 
When you select the HIV/AIDS option in the Please Select a Group field, the Main 
sub-tab displays the HMS management system register information. 
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Figure 9-20: Sample Main Sub-Tab View for HIV/AIDS register 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

9.8.1.1 Main Sub-Tab for HIV/AIDS Register Layout 
The system default template for the HIV/AIDS window is determined in the User 
Preferences dialog under the HIV/AIDS group. See Section 3.2.6 for more 
information. 

You can customize your HIV/AIDS template for defining the layout (on the Panel 
Definition Layouts tab of the Panel Definition window). See Section 5.4.5 for more 
information. This is the same as using the Layout function on the Care Mgmt 
window. 

You can determine which template is being used by reviewing what is in the status 
bar, in Current Layout. For example, it could read Current Layout: System Default. 

The following table provides information about the default columns. 

Column Meaning 
Flag  indicator Displays when a patient has a flag. This column is always the first 

column and can only be removed by turning all flags “off” in the User 
Preferences (see Section 3.1.1.2). 

 The feather indicator in this column means that there is an open CMET 
with an overdue step. Go to the CMET Tracked Events sub-tab to review 
this condition. 

Patient Name Required field that will link to the Patient Record if you double-click on it. 
HRN Patient’s Health Record Number. 
Sex F (for female) or M (for male). 
DOB Patient’s date of birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this field 

to empanel patients. 
Community Patient’s community of residence. 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for this 

patient, based on the tagging function. 
Register Status The status of this patient on the HMS Register. Values are can Active, 

Deceased, Inactive, or Transient. 
Remaining Columns The HIV/AIDS register-specific data. 
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If a Community cell contains the Community Alert  icon, you can view the 
Community Alert text by hovering your mouse over the icon. 

There is hover help for the columns displaying HMS register-specific data. For 
example, there is view the help by hovering your mouse over the HIV Provider 
column heading. 

The Community Alerts glossary provides a list of diseases that occur in mandatory 
alerts. To view this glossary, select Help | Community Alerts Glossary. 

You can sort/filter the columns and perform other column functions. See Section 4.1 
for more information. 

9.8.1.2 Main Sub-Tab for HIV/AIDS Register Toolbar 
See Section 4.5 for more information about the buttons on the right side of the 
toolbar. 

9.8.1.2.1 Copy Patient(s) 
This action copies the patients information to the iCare clipboard. 

Select one or more patients (see Section 4.2 for more information about selecting 
patients) and then do one of the following: 

• Click the Copy Patient(s)  button 

• Select Care Mgmt | Main | Copy Patient(s) 

• Use the keyboard combination Ctrl+C 
You must go to another panel view (for a different patient panel) and paste the 
patient’s information. 

9.8.1.2.2 Layout 
Click the Layout button (or select Care Mgmt | Main | Layout) to display the Register 
Main Layout dialog, where you can determine the columns in the Main sub-tab. This 
dialog is the same as the one used in the panel definition process. See Section 5.4.5 
for more information. 

A similar dialog displays when you are using the Asthma register. See Section 5.4.4 
for more information. 

You can find information about the layout on the Asthma / Care Management 
Glossary (under section III Asthma Panel Layout Options / Panel View). To view this 
glossary, select Help | Care Mgmt Glossaries | Asthma / Care Management Glossary. 
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9.8.1.2.3 Change Status 
You use the Accept, Not Accept, and Proposed buttons to change the Status on an 
existing record (or select Care Mgmt | Main to select a status to change). 

Select the patient record whose status you want to change and click the appropriate 
“change status” button to display the Update Diagnostic Tag dialog. 

 
Figure 9-21: Sample Update Diagnostic Tag dialog 

All fields are required on this dialog. 

The radio buttons available for the Status Change Reason changes according to what 
you select in the New Status field. 

The “Not Accept” function cannot be performed on multiple patients or multiple tags. 

See Section 9.9.2.2 for more information about the fields and “View Tag Activity” 
button on this dialog. 
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9.8.1.2.4 Add Tag 

Select a patient to which you want to add a tag and then click the Add Tag  
button (or select Care Mgmt \ Main | Add Tag) to display the Add Diagnostic Tag 
dialog. This is a manual add that allows a provider to manually assign one or more of 
the diagnosis tags to patients that did not meet the tag’s criteria for being proposed 
automatically. (See Section 4.2 for more information about selecting patients.) See 
Section 9.9.2.2.1 for more information). 

9.8.1.2.5 Update 

You can batch update register data for selected patients by clicking the Update  
button (or select Care Mgmt | Main | Update). (See Section 4.2 for more information 
about selecting patients.) The Batch Update Data dialog will display. 

 
Figure 9-22: Sample Batch Update Data Dialog 

After you choose an option from the Select drop-down list, a second field displays. 
When the second field has an ellipsis button, click it to search for the name on a 
lookup dialog; see Section 4.11 for more information. 

Click OK to save your information. (Otherwise, click Cancel). After the update is 
complete, the “HMS Register data has been saved successfully to RPMS” message 
displays; click OK to dismiss this message. 

After clicking OK, you need to refresh the screen in order to see the changes. 
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9.8.1.2.6 Reports Button 

Select one or more patients and click the drop-down list on Reports  button to 
view the Quality of Care report (or select Care Mgmt | Main | Reports). (See 
Section 4.2 for more information about selecting patients.) The reports define their 
scope based on the patients that are members of a given panel. 

Quality of Care Report 

 
Figure 9-23: Quality of Care dialog 

If you selected more than one patient on the panel, the Report Population field will 
display “Selected Patient(s) (n selected)” where n is the number of patients selected. 

You populate the fields on the Quality of Care dialog by selecting any option on the 
drop-down list. Then, click OK (otherwise, click Cancel). 

iCare will provide the ability to display, print, and export the existing BKM Quality 
of Care Report from the Panel Register view. 

This report includes all patients who have at least one HIV/AIDS POV or Active 
Problem List or HMS Initial HIV Dx Date or HMS Initial AIDS Dx Date at least 182 
days (6 months) prior to Report End Date. 

Below is an example of the first part of the report: 
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Figure 9-24: Sample Report, Page 1 

The following shows a page of the report, near the bottom, describes the criteria of 
the selected denominator for the report. 
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Figure 9-25: Page of Report near bottom 

The final page of the report displays all of the patients in the selected denominator 
(those patients on the report). 

See Section 4.7 about the buttons and File menu on this window. 

9.8.2 Reminders Sub-Tab for HIV/AIDS Register 
The Reminders sub-tab view displays the disease/register-specific reminders for the 
patient. 
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Figure 9-26: Sample Reminders sub-tab 

If you are using the Asthma option on the Care Mgmt Group field, there is NO 
Reminders sub-tab. 

9.8.2.1 Reminders Sub-Tab for HIV/AIDS Register Layout 
Below are the default fields on the Reminders sub-tab for the HIV/AIDS Register: 

Column Meaning 
Flag  indicator Displays when a patient has a flag. This column is always the 

first column and can only be removed by turning all flags “off” 
in the User Preferences (see Section 3.1.1.2). 

 The feather indicator in this column means that there is an 
open CMET with an overdue step. Go to the CMET Tracked 
Events sub-tab to review this condition. 

Patient Name Required field that will link to the Patient Record if you 
double-click on it. 

HRN Patient’s Health Record Number. 
DOB Patient’s date of birth. 
Remaining Columns The reminders for the HIV/AIDS register-specific data. 

 
A date (or “N/A”) will be displayed under each of the Reminders columns. If the test 
or procedure is currently due or overdue, an icon will be displayed next to the date, as 
shown below. The icon is not displayed for dates that are not yet due (in the future). 

 
Figure 9-27: Sample Overdue Date for Chlamydia Reminder 

9.8.2.2 Reminders Sub-Tab for HIV/AIDS Register Toolbar Options 
The toolbar shows the date/time for which the data is effective. 

The fields on the view are based on what is selected in the Care Management Group 
field (of the Care Management tab). 
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You can display a tooltip about a reminder by hovering your mouse over the column 
heading. 

Click the Copy Patient(s)  button (or select Care Mgmt | Main | Copy 
Patient(s)) to copy the selected patients information to the iCare clipboard. You must 
go to another panel view (for a different patient panel) and paste the patient’s 
information. 

You can sort/filter the columns and perform other column functions. See Section 4.1 
for more information. 

See Section 4.5 for more information about the buttons on the right side of the 
toolbar. 

9.8.3 Main Sub-Tab for Asthma 
Only the Main sub-tab displays for the Asthma option for the “Please Select a Group” 
field. 

 
Figure 9-28: Sample Main sub-tab for Asthma 

The system default template for the Asthma window is determined in User 
Preferences. See Section 3.2.6 for more information. 

You can customize your Asthma template for defining the layout (on the Panel 
Definition Layouts tab of the Panel Definition window). See Section 5.4.4 for more 
information. This is the same as using the Layout function on the Care Mgmt 
window. 

You can determine which template is being used by reviewing what is in the status 
bar, in Current Layout. For example, it could read Current Layout: System Default. 

9.8.3.1 Main Sub-Tab for Asthma Layout 
The data on the Main sub-tab enables users to view asthma-related data in the context 
of the population. 

The following table provides information about the default fields. 
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Column Meaning 
Flag  indicator Displays when a patient has a flag. This column is always the 

first column and can only be removed by turning all flags “off” in 
the User Preferences (see Section 3.1.1.2). 

 The feather indicator in this column means that there is an open 
CMET with an overdue step. Go to the CMET Tracked Events 
sub-tab to review this condition. 

Asthma If this patient has an Active Asthma Diagnostic Tag (Proposed or 
Accepted), are ALL of the following key elements documented: 
Asthma Severity value ever; Asthma Control and Peak Flow or 
FEV1 measurement and Asthma Action Plan and Flu Shot in 
past year; and current Controller medication prescription if 
Severity is Persistent (2, 3 or 4)? 
Display: 
Y - Yes, the patient has documentation regarding of each of the 
quality of care elements. 
N - No, the patient does not have documentation of each of the 
quality of Care elements. 
N/A - Not Applicable, the patient does not have an active Asthma 
Diagnostic Tag. 

Patient Name Required field that will link to the Care Management window, 
Asthma group when you double-click on it. 

HRN Patient’s Health Record Number. 
Sex F (for female) or M (for male). 
DOB Patient’s date of birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use 

this field to empanel patients. 
Community Patient’s community of residence. 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed 

for this patient, based on the tagging function. 
 

The following table provides information about the asthma-related fields. 

Column Meaning 
Asthma Severity 
(default field) 

The most recent Severity, documented in Problem List 
Classification field.  
Display: Can be one of the following: 
1 - Intermittent 
2 - Mild Persistent 
3 - Moderate Persistent 
4 - Severe Persistent 

Asthma Diagnostic Tag 
Status 
(default field) 

The most recent Diagnostic Tag status for Asthma only, if 
any. Open this patient’s record to DX Tag tab to view a 
complete history of all diagnostic tags. This field is editable 
in both the Panel View and the Patient Record. 

Last Asthma Visit Date 
(default field) 

The date of the most recent Asthma visit, defined as a face-
to-face visit with ANY of the following asthma-related data 
elements documented: Severity, Control, Symptom Free 
Days, Work/School Missed, and/or Patient Education. Click 
the date to link directly to the related Visit Record. 
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Column Meaning 
Best Peak Flow (BPF) 
value 
(default field) 

The most recent BPF value from PCC V-Measurements file. 
BPF is the highest Peak Expiratory Flow (PEF) the patient 
was able to achieve over a 2- to 3-week period of using the 
peak flow meter while asthma is under control. 

Peak Flow (PF) value 
(default field) 

The most recent PF value from the PCC V-Measurements 
file, obtained from a peak flow meter during a visit. If 
multiple PFs were documented on the same date, the value 
displayed is the highest. 

Asthma Control value 
(default field) 

The most recent control value from the PCC V-
Measurements file. 

Forced Expiratory Volume/ 
Forced Vital Capacity 
(FEV1/FVC) values 
(default field) 

The most recent FEV1/FVC ratio value from the PCC V-
Measurements file obtained from spirometry measurements 
during a visit. 

Last Action Plan Date 
(default field) 

The date of the most recent Action Plan provided to this 
patient. Action Plans are available from the PCC Patient 
Wellness Handout menus or from the iCare Patient Record: 
Summ/Supp tab. 

Last Flu Shot Date (default 
field) 

The date of the most recent Influenza immunization. 
Double-click the underlined date to access the Visit Detail 
pop-up. 

DPCP 
(default field) 

Designated Primary Care Provider (DPCP): Name of this 
patient’s DPCP, if any. 

Asthma Family History If this patient has at least one Family History (FHX) entry for 
asthma, the detailed asthma FHX data will display if your 
cursor hovers over the cell. Open this patient's record FHX 
tab to view, add, or edit any Family History. 

Asthma Triggers 
(concatenated) 

A concatenated list of the most recent of ANY Asthma 
Triggers documented ever in Health Factors for this patient. 

Asthma Triggers 
(individual) 

The date of the most recent visit documented in Health 
Factors with the selected Asthma Trigger. The Asthma 
Triggers available for display are: Air Pollutants; Animal; 
Change in Weather; Cockroaches; Dust Mites; Exercise; 
Menses; Mold; Other Trigger; Pollen; Strong Emotional 
Expression; Tobacco Smoke; Viral Infection. 

Last ER/UC Visit Date The date of the most recent visit to the Emergency Room 
(ER) or Urgent Care (UC) (clinic codes 80 or 30) with 
Asthma as the primary POV. Click the date to link directly to 
the related Visit Record. 

Last Asthma Hospital Visit 
Date 

The date of the most recent hospitalization (service category 
H) with Asthma as the primary POV. Click the date to link 
directly to the related Visit Record. 

Last Tobacco Health Factor The most recently documented Tobacco Health Factor(s). 
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Column Meaning 
On Controller Med Is the patient is on Controller Meds as defined by 

taxonomies: [BATASTHMACONTROLLER MEDS]; [BAT 
ASTHMA CONTROLLER NDC]; [BAT ASTHMA INHALED 
STEROIDS]; [BAT ASTHMA INHLD STEROIDS NDC]; 
[BAT ASTHMA LEUKOTRIENE MEDS]; [BAT ASTHMA 
LEUKOTRIENE NDC]? 
Display Yes, No, or N/A if the patient does not have an 
active Asthma diagnostic tag. 
Open this patient's record to PCC/ Medications tab to view 
specific asthma related medication list. 

On Inhaled Steroids Is the patient on Inhaled Steroids as defined by taxonomies: 
[BAT ASTHMA INHALED STEROIDS]; [BAT ASTHMA 
INHLD STEROIDS NDC]? 
Display Yes, No or N/A (if the patient does not have an 
active Asthma diagnostic tag). 
Open this patient's record to PCC/ Medications tab to view 
specific asthma-related medication list. 

On Reliever Meds Is the patient on Reliever Meds as defined by taxonomies: 
[BAT ASTHMA SHRT ACT RELV NDC]; [BAT ASTHMA 
SHRT ACT RELV MEDS]; [BAT ASTHMA SHRT ACT 
INHLR NDC]; [BAT ASTHMA SHRT ACT INHLR MEDS]; 
[BGP RA GLUCOCORTIOCOIDS]; [BGP RA 
GLUCOCORTIOCOIDS CLASS]? 
Display Yes, No, or N/A (if the patient does not have an 
active Asthma diagnostic tag). 
Open this patient's record to PCC/ Medications tab to view 
specific asthma-related medication list. 

Symptom Free Days The most recently entered value in the Symptom Free Days 
field in PCC v-Measurements file. Available values are 0 - 
14 days. The visit date will display if your cursor hovers over 
the cell. 

Work/School Days Missed The most recently entered value in the Work/School Missed 
field in the PCC v-Measurements file. Available values are 0 
- 14 days. The visit date will display if your cursor hovers 
over the cell. 

 
If a Community cell contains the Community Alert  icon, you can view the 
Community Alert text by hovering your mouse over the icon. 

There is hover help for the columns displaying Asthma register-specific data. For 
example, there is view the help by hovering your mouse over the Asthma Severity 
column heading. 

Double-click any underlined date to access the Visit Detail pop-up for the visit. 

You can sort/filter the columns and perform other column functions. See Section 4.1 
for more information. 
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9.8.3.2 Main Sub-Tab for Asthma Toolbar 
The toolbar displays the date/time for which the asthma-related data is effective. 

See Section 4.5 for more information about the buttons on the right side of the 
toolbar. 

The Reports button is inactive on the Asthma toolbar. The Update button is not 
available on the Asthma toolbar. See Section 9.8.1.2 for more information about the 
other buttons on the Main sub-tab for the Asthma toolbar. 

Use the Glossary button to access the Asthma/Care Management Glossary. See 
Section 4.13.7 for more information. 

9.8.4 Care Mgmt Tab Menus 
The options on the File menu for the Care Management Tab are the same as those on 
the Patient List Tab. See Section 9.2.3.1 for more information. 

The options on the Tools menu for the Care Management Tab are the same as those 
on the Diagnostic Tags tab. See Section 9.9.3 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

9.9 Diagnostic Tags Tab 
The Diagnostic Tags tab provides a comprehensive view of all tag history for a 
patient (regardless of the tag status), provides auto-accept and auto-reject capabilities, 
allows the user to accept a proposed tags for multiple patients, allows the user to 
reject proposed tags, and allows the user to update of tag status. 

 
Figure 9-29: Sample Diagnostic Tags Tab 

Tags that are identified through iCare’s execution of the pre-defined tag criteria will 
start with an initial tag status of PROPOSED. From there you have several options 
including “Accepting” a tag or “Not Accepting” the validity of a tag for any patient. 
These statuses are editable from within this tab. 
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9.9.1 Diagnostic Tags Tab Layout 
The following table provides information about the columns. 

Column Meaning 
Patient Name Required field that will link to the Patient Record if you double-

click on it. 
HRN Patient’s Health Record Number. 
DOB Patient’s Date of Birth. 
Age Patient’s age. 
Tag Name The name of the tag for the patient. 
Status ACCEPTED: means the patient is a member of specified formal 

case management registers with status of Active, Decease, 
Transient, Non IHS, Lost to Follow Up, or Noncompliant. 
PROPOSED: means the patient has Status Un-reviewed or 
Inactive in the register. 
NO LONGER VALID: means the RPMS data no longer 
supports the tag. 

Status Change Reason The reason the status changed can be: System Generated 
(system), RPMS Data No Longer Supports Tab (system), 
Patient Data Does Not Support Acceptance (user), Manually 
Designated (user), Other (user - with required comment field), 
on Existing RPMS Register (system). 

Status Comment The text of any comments entered about the status change 
(used with the Other status change reason). 

Last Updated The date the content of the panel was last updated by a manual 
(user) repopulate, by an auto-repopulate, or the panel created 
date, if the panel has never been repopulated. 

Last Updated By The name of the user who either created or last repopulated 
the panel (in certain cases, it will contain SYSTEM UPDATE). 

 
The is hover help for the Tag Name cell that shows the name of the tag. 

Double-click any record to go the Diagnostic Tags tab of the Patient Record window. 
See Section 10.15 for more information. 

You can find information about all of the tags in the Diagnostic Tag Glossary (select 
Help | Diagnostic Tag Glossary). 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

9.9.2 Diagnostic Tags Toolbar 
The toolbar show the date/time for which the data is effective. 

iCare will classify tags into one of five statuses: proposed (pending) (P), accepted 
(A), not accepted (NA), No longer valid (NLV) and Superseded (S). Those tags with 
a classification of NA will not display. 
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See Section 4.5 for more information about the buttons on the right side of the 
toolbar. 

9.9.2.1 Copy Patient(s) 
This action copies the patients information to the clipboard. 

Select one or more patients (see Section 4.2 for more information about selecting 
patients) and then do one of the following: 

• Click the Copy Patient(s)  button 

• Select Diagnostic Tags | Copy Patient(s) 

• Use the keyboard combination Ctrl+C 
You must go to another panel view (for a different patient panel) and paste the 
patient’s information. 

9.9.2.2 Add Tag 

Select a patient to which you want to add a tag and then click the Add Tag  
button (or select Diagnostic Tags | Add Tag) to display the Add Diagnostic Tag 
dialog. This is a manual add that allows a provider to manually assign one or more of 
the diagnosis tags to patients that did not meet the tag’s criteria for being proposed 
automatically. (See Section 4.2 for more information about selecting patients.) 
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Figure 9-30: Add Diagnostic Tag dialog 

This dialog shows information about the patient named in the Patient Name field (the 
one you selected). 

When you have completed the dialog, click OK to add the information to the 
Diagnostic Tags tab on the Panel View. (Otherwise, click Cancel.) 

9.9.2.2.1 Tag Activity 
You can view existing tag activity about the patient by clicking the View Tag 
Activity button. The Diagnostic Tag Activity pop-up displays. See Section 9.9.2.4 for 
more information about this pop-up. 

9.9.2.2.2 Fields on Add Diagnosis Tag Dialog 
All fields are required. 

Patient Name: the name of the patient to which to add tag information (application 
populated). 

Diagnostic Tag: the name of diagnostic tag to add for the patient. Select an option 
from the drop-down list to populate this field. 

New Status: the status of the tag being added. 
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ACCEPTED: this option allows you to “Accept” a proposed tag to provide an 
affirmation of its validity for a given patient. 

NOT ACCEPT: this option allows you to disapprove or “Not Accept” a 
diagnostic tag that has been proposed for a patient. 

PROPOSED: this option allows you to change the status of a diagnosis tag back 
to “Proposed” so that further review can take place. 

Reason: click the appropriate reason for adding the tag. 

• Patient Data Supports Acceptance - use this when the patient data does 
support the tag. 

• Manually Designated - use this when you want to manually change the tag 
status. 

• Other - use this when the other reasons do not fit. 
Status Comment: here you type the reason for the change. This feature provides a 
rich audit history for reasons for providers’ decisions to accept or not accept proposed 
tag assignments. 

9.9.2.3 Change Status 
You use the Accept, Not Accept, and Proposed buttons (or select these options on the 
Diagnostic Tags menu) to change the Status for a selected record. 

Select the patient record whose status you want to change and click the appropriate 
“change status” button to display the Update Diagnostic Tag dialog. 
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Figure 9-31: Sample Update Diagnostic Tag dialog 

All fields are required on this dialog. 

The “Not Accept” status cannot be performed on multiple patients or multiple tags. 

See Section 9.9.2.2 for more information about the fields and “View Tag Activity” 
button on this dialog. 

After the dialog is complete, click OK to change the status (otherwise, click Cancel). 

9.9.2.4 Activity 
You can view existing tag activity about the selected patient by clicking the Activity 

 button (or by selecting Diagnostic Tags | Activity) on the Panel View toolbar. 
The RPMS iCare - Diagnostic Tag Activity pop-up displays. This is a view-only pop-
up. Multiple people can enter the tags, so this pop-up shows all of the activity. 
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Figure 9-32: Sample Diagnostic Tag Activity Pop-up 

See Section 4.5 for more information about the buttons on the right side of the 
toolbar. 

Click the Glossary  button to display the Diagnostic Tag Glossary. See 
Section 4.13.2 for more information. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

You can view various tags by selecting from the drop-down list for the Tag field. 

If you check the “Display Factor Details” check box, the following columns will 
display: Factor, Date, Item, Value. This allows you to view additional details about 
the tags. The default view is unchecked. 

You must dismiss the pop-up. 

9.9.2.5 Status of Background Jobs 
You can check the status of the background jobs; this displays the RPMS iCare - 
Background Jobs window. See Section 4.10 for more information. 

To check on the status of the background jobs, do one of the following: 

• Click the background jobs  button 

• Select File | Background Jobs 
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9.9.3 Diagnostic Tags Tab Menu Options 
The options on the File menu for the Diagnostic Tags tab are the same as those on the 
Patient List tab. See Section 9.2.3.2 for more information. 

The options on the Tools menus for the Diagnostic Tags tab are the same as those on 
the Reminders tab. See Section 9.3.3 for more information. 

The Diagnostic Tags menu have options that operate like the action buttons on the 
toolbar. See Section 9.9.2 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

9.10 Flags Tab 
The Flags tab of the Panel View displays the flags for the patients in the open panel. 

 
Figure 9-33: Sample Flags tab 

The Flags tab displays the flag type shown in the Show field. 

You can change the default flag display by changing the flag settings under User 
Preferences. See Section 3.1.1.2 for more information. 

Double-click any record on this tab to go to the Flags tab of the Patient Record 
window. See Section 10.5 for more information. 

9.10.1 Flags Tab Layout 
The Flags Tab layout on the Panel View has the same default columns as those on the 
Flag List window. See Section 7.1.1 for more information. 

9.10.2 Flags Tab Toolbar 
The Flags tab toolbar on the Panel View is the same as the toolbar on the Flag List 
window. See Section 7.2 for more information. 

The toolbar shows the date for which the data is effective. 
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9.10.3 Flags Tab Menu Options 
See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

The options on File and Tools menus are the same those on the Patient List tab. See 
Section 9.2.3 for more information. 

The Flags menu is only available when the Flags tab is selected. The Hide and Show 
options work like the Hide and Show action buttons. The Refresh option refreshes the 
flags display, to show the most recent changes. 
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10.0 Patient Record 
The patient record window has several tabs and other information that shows patient 
data information stored in the RPMS database. This window provides a wide range of 
clinical data, with a focus on providing quick access to needed data. 

 
Figure 10-1: Sample Patient Record window 

The patient record window can be accessed either by opening a patient record on a 
panel or by a direct search for a patient name. 

The Suicide Form tab might not display. This tab displays for those with special keys. 

The Quick Patient Search field allows you to search for a particular patient (even one 
that is not on any of your panels). After a successful search, the data for the indicated 
patient will display on the Patient Record window. See Section 4.4 for more 
information. 
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As a general rule, when you double-click any date that is underlined (in the Date 
column), the Visit File dialog will display. 

10.1 Specifying the Default Tab 
You can set the default tab for the Patient Record window by defining it on the 
Patient View tab of the User Preferences window (select Tools | User Preferences). 
This means that when you access the Patient Record window, the default tab will be 
on top. See Section 3.2.5 for more information. 

If you do NOT specify a default tab, the default tab will be Cover Sheet. 

10.2 Patient Demographic Group Box 
The top group box shows the patient demographic information. This information 
remains visible from any tab on the Patient Record window. 

 
Figure 10-2: Sample Patient demographics group box 

10.2.1 Community Field 
The Community field shows any alerts about the community in which the patient 
resides. If the community alert icon  is displayed, you can click it to display the 
“Community Alerts for” pop-up. 

 
Figure 10-3: Sample Community Alerts for Community pop-up 

See Section 8.2.1 for more information about the columns on this pop-up. 
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10.2.1.1 Menus on Community Alerts for Community Pop-up 
The File menu contains the following options: 

Page Setup: This option allows you to set Margin, Paper, Layout characteristics (like 
landscape or portrait orientation), and the Printer to use. 

Print Preview: This option displays the print preview dialog. 

Print: This option sends the page to the printer using the settings in Page Setup. Note 
that only the selected tab (Panel List or Flag List) will be printed. 

Close: The option closes the pop-up. 

The Edit menu contains the Select All and Deselect options. The Select All option 
will select all of the records in the grid. 

The Tools menu contains the Search, Excel Export, Copy Rows to Clipboard work 
like the buttons on the right side of the window. See Section 4.5 for more 
information. 

10.2.1.2 Buttons on Community Alerts for Community Pop-up 
See Section 4.5to review how to use the buttons on the right side of the toolbar. 

10.2.2 Allergies Field 
The Allergies field pulls data (about the patient) directly from the Adverse Reaction 
Tracking application. Each reaction shows a tooltip (Causative Agent, Reaction, Date 
of Onset, Historical or Observed). You can do the following with the selected rows in 
the grid: Export to Excel, Print, Copy; see Section 4.5 for more information. 

10.2.3 Barriers to Learning Field 
The Barriers to Learning field lists the current values for any health factor categorized 
as Barriers to Learning, e.g., Blind. 

10.2.4 Phone Fields 
The user with appropriate iCare Editor access can edit any of the available phone 
number fields (Home Alternate, Work) on the Demographic header area. 

Click the “pencil”  button next to the phone number to display the Edit patient 
demographic fields dialog. See Section 4.21 for more information. 
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10.2.5 Email Field 
You can edit the Email field by clicking the “pencil”  button next to the phone 
number to display the Edit patient demographic fields dialog. See Section 4.21 for 
more information. 

10.2.6 DPCP Field 
You can edit the DPCP providers by clicking the “pencil”  button next to the 
DPCP field. The application displays the Edit Providers dialog (for the current 
patient). 

 
Figure 10-4: Sample Edit Provider dialog 

Use the Edit Providers dialog to add, edit, or remove providers. See Section 4.16 for 
more information about this dialog. 

10.2.7 Additional Demographics Button 
You can view more information about the patient’s demographics by clicking the 
Additional Demographics button on the Patient Record window. The Additional 
Demographics pop-up will display. Click OK to dismiss this pop-up. 
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10.2.7.1 Demographic Detail Tab 
Below is the information on the Demographic Detail tab. 

 
Figure 10-5: Sample Additional Demographics Pop-up 

You can change the Race Ethnicity, Preferred Language, and/or Email field by 
clicking the “pencil”  button next to the field. This action displays the “Edit patient 
demographic fields” dialog. See Section 4.21 for more information. 

10.2.7.2 Household Tab 
You can view additional household information by clicking the Household tab. These 
data values are from the RPMS Patient Registration application (and are view only). 
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Figure 10-6: Sample Information on Household tab 

You can change the Number in Household by clicking the “pencil”  button to 
access the Edit patient demographic fields dialog. See Section 4.21 for more 
information. 

10.2.8 Add a Note 
After clicking the Add a Note button and if you do not have default clinics defined in 
user preferences, the application displays the following message: You must select 
default clinics in user preferences before being able to enter notes. Click OK to 
dismiss the message. Select Tools | User Preferences to access the RPMS iCare – 
User Preferences dialog. Go to the Patient View tab to enter the clinic codes. 

Use the Add a Note button to add a TIU note for the current patient. This involves a 
two-step process: 

1. Click the Add a Note button to access the Add a Note dialog. You complete the 
fields on this dialog. See Section 4.25 for more information. 

2. Click the Create button on the Add a Note dialog to access the Add TIU Note 
dialog. See Section 4.24.1 for more information. 

10.2.9 View IMM Profile 
Use the IMM Profile button to view the Immunization Profile pop-up window. 
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Figure 10-7: Sample Immunization Profile pop-up 

This pop-up provides information about the patient’s immunization history, including 
contraindicated vaccines, the mother’s HBsAg status, the immunizations that are due, 
the immunizations that will be due, and the vaccine series that are complete or no 
longer relevant. See Section 4.7 for more information about the pop-up window. 

10.3 Cover Sheet Tab 
The Cover Sheet tab includes several categories of data, such as Providers, Recent 
Visits, etc. 

 
Figure 10-8: Sample Cover Sheet tab 

The icon next to each group box name is the expand-collapse symbol. These symbols 
work like they do in any Windows application. 
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• Click the Expand  symbol to expand group box. 

• Click the Collapse  symbol to collapse a group box. 
See Section 4.5 to review how to use the buttons on the right side of each group box. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

10.3.1 Recent Visits Group Box 
The Recent Visits group box displays the visits in order of most recent visit first, 
within the selected timeframe. You can determine the time range for the visit display 
by selecting an option from the drop-down list: 1 month, 3 months, 6 months, 1 year, 
2 years, Ever (the default is 1 month). 

Hover your mouse over a record to view key visit information (such as diagnosis, 
provider, etc.) about the visit. 

Double-click any row of the Recent Visits group box to display the Visit Detail pop-
up. See Section 4.7 for more information about the buttons and the File menu on the 
pop-up. 

10.3.2 Scheduled Appointments Group Box 
The Scheduled Appointments group box displays the patient’s scheduled 
appointments in order of closest upcoming appointment first, within the selected 
timeframe. You can determine the time interval for the appointments display by 
selecting an option from the drop-down list: 2 weeks, 1 month, 3 months (the default 
is 1 month). 

10.3.3 Providers Group Box 
The Providers group box displays the provider roles designated in the RPMS 
Designated Specialty Provider Management System if provider names have been 
assigned. If your facility is actively using this application, you will see a list of 
providers and case managers for the current patient. 

 
Figure 10-9: Sample Providers Group Box 
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10.3.3.1 Link to Last Visit Date 
The Last Visit date is linked to the RPMS visit record. Double-click any record to 
view the Visit Detail pop-up. See Section 4.7 for more information about pop-ups. 

10.3.3.2 Edit Button 
You can add and edit provider entries. This feature requires either the iCare Editor 
(BQIZCMED) or iCare Package Manager (BQIZMGR) security key. Choices for new 
entries will be limited to the existing BDP Category Name list. The user will NOT be 
able to enter a new BPD Category Name; this function will continue to be performed 
by an assigned manager within the BDP interface. All additions and changes, 
including the user name and date the record is edited via the iCare interface will be 
recorded in BDP (Designated Specialty Provider). 

Click the Edit  button to display the Edit Providers window. 

 
Figure 10-10: Sample Edit Providers Window 

Use this window to add, edit, or remove providers. You can dismiss the Edit 
Providers window by selecting File | Close. 

See Section 4.16 for more information about this window. 
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10.3.4 Insurance Group Box 
The Insurance group box displays all insurances defined as “active” in Patient 
Registration and the effective date. There can be multiple active insurances. 

 
Figure 10-11: Sample Insurance Group Box 

10.3.5 Panels Group Box 
The Panels group box displays the names of all iCare panels available to the user of 
which this patient is a member. 

 
Figure 10-12: Sample Panels Group Box 

10.3.5.1 Tooltip for Panel Description 
Hover your mouse over a record to display a description of the panel. 

10.3.5.2 Add to Panel Button 
If you want to add the patient to another panel, click the Add to Panel button to 
display the Add/Remove Panels dialog. 
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Figure 10-13: Sample Add/Remove Panels Dialog 

The Available Panels group box contains the panels of which the patient is NOT a 
member. The Current Panels group box contains the panels of which the patient IS a 
member. 

See Section 4.8 for more information about the Add/Remove dialog. 

Please note that if you select a panel in the Current Panels group box and click 
Remove, and if the selected panel is open, the application displays the message that is 
panel is currently opened in this session and to please try again after you have 
finished editing the panel or removing the patient from the Panel View. (Click OK to 
dismiss the message.) 

Click OK to add the patient to the panels listed in the Current Panel group box 
(otherwise, click Cancel.). When you use OK, the Panels group box will contain the 
panels listed in the Current Panels group box of the Add/Remove Panels dialog. In 
addition, the patient’s name will be added to the “other” panels (on the Panel View 
window). 

10.3.6 Registers Group Box 
The Registers group box displays the Register names of which the patient is a 
member. Register names that the user does not have security access will be displayed 
as grayed out. The data shows the patient’s register status (in the Status column). 

Hover your mouse over a record to display a tooltip about the status (Status, Status 
Date, Category). 

10.3.7 Cover Sheet Tab Menus 
See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 
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10.3.7.1 File Menu 
The options on the File menu for the Cover Sheet tab are: 

New: this option displays the Panel Definition dialog where you create a new panel 
definition. See Section 5.0 for more information about this window. This is the same 
as pressing the Ctrl+N key combination. 

Page Setup: this option is active when you select one or more rows in the grid. This 
option allows you to set Margin, Paper, and Layout characteristics (like landscape or 
portrait orientation) for printing. You can select a different printer. 

Print Preview: this option is active when you select one or more rows in a grid. This 
option displays the Print Preview dialog for the selected rows in the grid. 

Print: this option is active when you select one or more rows in a grid. It uses the 
most recently selected rows (because there are more than one grid on the tab). This 
option displays the Print Preview dialog for the selected rows in the grid. This is the 
same as pressing the Ctrl+P key combination. Select File | Print on the dialog to 
output the data in the rows. 

Background Jobs: this option displays a pop-up showing background jobs 
information. See Section 4.10 for more information. 

Close: this option dismisses the current open patient record window. 

10.3.7.2 Tools Menu 
The options on the Tools menu for the Cover Sheet tab are: 

Quick Patient Search: this option executes a patient search. See Section 4.4 for more 
information about this functionality. 

User Preferences: this option takes you to the User Preferences window where you 
can change your user preferences. See Section 3.2 for more information about the 
tabs on this window. 

Web Links: this option shows several categories (such as Asthma) that have Web 
links. When you select a Web link, the Internet browser for the particular category 
opens. 

10.4 Snapshot Tab 
The Snapshot tab has sections of information that are linked to the underlying RPMS 
visit record. This tab shows several types of data with a more clinical focus that are 
useful for case management review. The intention is to highlight more urgent 
information on this screen when considering various patient conditions. 
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Figure 10-14: Sample Snapshot tab 

The underlined visit date listed within any of the sections of the Snapshot view will 
be a link to the underlying RPMS visit record. You can open the visit related to the 
various sections by double-clicking the underlined date. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

See Section 4.5 to review how to use the buttons on the right side of the group boxes. 

10.4.1 Active Diagnostic Tags Group Box 
The Active Diagnostic Tags group box displays a list of Predefined Diagnosis 
definitions (“tags”) that iCare has proposed for this patient, based on the tagging 
function. 

 
Figure 10-15: Sample Active Diagnostic Tags Group Box 
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The Diagnostic Tag could have been identified by a visit or by a problem. Double-
clicking on any underlined value will display the detail for whichever matched the 
criteria for the diagnostic tags (Problem Detail or Visit Detail). 

10.4.1.1 Details Button 
Select a record and then click the Details button to move to the DX Tags tab (on the 
Patient Record window) for the particular tag. Here you view the status, date, item, 
value, and factor about the selected tag. 

10.4.1.2 Tooltip for Active Diagnostic Tags Tab 
Hover your mouse over a value in the Tag Name column to display the definition of 
the tag. 

Hover your mouse over a value in the Status column to display status information 
(Last Updated, Updated By, Status Change Reason, Status Comment). 

Hover your mouse over a value in the Factor column to display factor information 
(Compliance Value, Last Updated). 

10.4.1.3 iCare Taxonomy View/Edit 
Double-click any Factor cell in the Active Diagnostic Tags group box to display the 
iCare Taxonomy View/Edit dialog. 
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Figure 10-16: Sample iCare Taxonomy View/Edit dialog 

If you do not have access rights to edit taxonomies, this dialog will display that 
information. 

If you have edit privileges (iCare Taxonomy Editor with security key BQIZTXED), 
you can add/remove values. See Section 4.14 for more information. 

Click OK to save any changed data (otherwise, click Cancel). 

Click the “View Report of All Taxonomies” button to access the RPMS iCare - 
Taxonomy Report pop-up. On this pop-up, you can view information about each 
taxonomy category. For example you can view the high and low values for each 
taxonomy category. See Section 4.7 for more information about how to use a pop-up 
window. 

10.4.2 Family History Group Box 
The Family History group box displays an overview of the family history information 
that is relevant to case management. This data is pulled directly from the IHS 
Dictionaries/Patient: Family History file (9000014). 
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Figure 10-17: Sample Family History Group Box 

The default display will be sorted by Sort Order and then by Relationship. 

Hover your mouse over any record to view a tooltip (Diagnosis Code, Date Noted). 

Click the Details button to move to the Family HX tab of the Patient Record window. 

10.4.3 Reproductive Factors Group Box 
The Reproductive Factors group box displays the current patient’s reproductive 
history (from the AUPN IHS Dictionaries/ Patient Reproductive Factors file). This 
applies to female patients only. 

 
Figure 10-18: Sample Reproductive Factors Group Box 

10.4.3.1 Fields on Reproductive Factors Group Box 
The fields shows the latest values of the current patient’s reproductive factors. New 
reproductive factors can be entered by using the Edit button. 
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10.4.3.2 Edit Reproductive Factors 
Click the Edit button on the Reproductive Factors group box to display the Edit 
Reproductive Factors dialog (where you can add new data). 

 
Figure 10-19: Sample Edit Reproductive Factors dialog 

10.4.3.2.1 Buttons on Dialog 
After completing the data, click OK to save the data. These values populate the fields 
on the Reproductive Factors group box on the Snapshot tab of the patient record 
window. 

Otherwise, click Cancel. The application displays the “Save to RPMS?” dialog 
asking: Do you want to save to RPMS now? Click Yes to save any data to RPMS. 
Click No to not save any data to RPMS. Click Cancel to return to the Edit 
Reproductive Factors dialog. 

10.4.3.2.2 Fields on Dialog 
Last Menstrual Period: populate with the date of the patient’s last menstrual period 
(required field). 
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Current Contraception Method: populate with the type of contraception currently 
employed. Click the drop-down list to access the list of values. 

Current Contraception Begun: populate with the date the current contraception 
method started. 

Estimated Due Date: populate with the date that shows the patient’s estimated 
delivery date (EDD). Click the drop-down list to access the calendar. 

EDD Method: enter the method used to estimate the Estimated Due Date (if known). 
Options are Clinical Parameters, Dates, Sonogram, Unknown Method. 

Total Number of Pregnancies: populate with the value that shows the number of 
times this patient has been pregnant. 

Full Term Births: populate with the value that shows the number of full term births 
for the patient. 

Premature Births: populate with the value that shows the number of premature 
births for the patient. 

Abortions, Spontaneous: populate with the value shows the number of spontaneous 
abortions for the patient. 

Abortions, Induced: populate with the value that shows the number of induced 
abortions for the patient. 

Ectopic Pregnancies: populate with the value that shows the number of gestations 
elsewhere than in the uterus (such as in a fallopian tube or in the peritoneal cavity). 

Living Children: populate with the value that shows number of living children of the 
patient. 

Multiple Births: populate with the value that shows the number of multiple births for 
the patient. 

10.4.3.2.3 Menus on Dialog 
The File menu contains the Close option. This automatically closes the dialog. 

The Help menu contains the following options: 

iCare Help: use this option to access the online help for the dialog. This is the same 
as pressing the F1 key on your keyboard. 

About iCare: use this option to review the information about the iCare version and 
other information. 
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10.4.4 Measurements (Last Visit) Group Box 
The Measurements (Last Visit) group box displays two sets of data: (1) the patient’s 
most recent Height and Weight data and (2) all measurement data documented at the 
patient’s last visit. This will include a calculated BMI only if the height and weight 
measurements meet the standard CRS definition. This information comes from PCC, 
the V Measurement file. 

 
Figure 10-20: Sample Last Measurements group box 

There will always be height and weight values. After height and weight, the 
measurements are displayed in alphabetical order by Measurement Name. 

Double-click any record in this group box to display the Visit Detail pop-up. See 
Section 4.7 for more information. 

10.4.5 Last Routine Events Group Box 
The Last Routine Events group box displays a list of the most recent routine 
screenings, based on Health Summary Reminders logic, that are tailored to the 
specific patient based on age, sex, etc. This information comes from PCC. 

 
Figure 10-21: Sample Last Routine Events Group Box 

Double-click any record in this group box (with a date) to display the Visit Detail 
pop-up. See Section 4.7 for more information about the buttons and the File menu on 
the pop-up. 
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10.4.6 Open CMETs Group Box 
The Open CMETs group box shows the latest Tracked, Open CMET data for the 
patient. 

 
Figure 10-22: Sample Open CMETs group box 

Select a record and then click the Details button to move to the event on the Tracked 
Events sub-tab on the CMET tab of the Patient Record window. 

Double-click any underlined event date to display the Visit Detail pop-up. See 
Section 4.7 for more information about the buttons and the File menu on the pop-up 

There are the following icons in the 2 - Finding(s), 3 - Follow-up(s), and 4 - Patient 
Notification(s) cells: 

• A check mark  icon indicates that the step is complete. The Finding Date 
In the Finding(s) cell, the hover help shows the Finding Date and Finding 
Value. In the Follow-up(s) cell, the hover help shows the Follow-up Date and 
Follow-up Value. In the Notifications cell, the hover help shows the 
Notification Date and the type of Notification. 

• A tickler  icon indicates that the element is overdue. The element Due 
Date is prior to Today’s date (shown in hover help). 

• The cell is blank if it is not completed but is not overdue. 
If there are multiple elements for any of the steps (for example, 2 Follow-up(s)), there 
will a check mark if all of the multiples are completed. 

10.4.7 Snapshot Tab Menus 
The options on the File menu of the Snapshot tab are the same as those on the Cover 
Sheet tab. See Section 10.3.7.1 for more information. 

The options on the Tools menu of the Snapshot tab are the same as those on the 
Cover Sheet tab. See Section 10.3.7.2 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 
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10.5 Flags Tab 
The Flags tab displays a list of the patient’s “flags” identified by the iCare 
application. 

 
Figure 10-23: Sample Flags tab 

10.5.1 Flags Tab Layout 
The Flags Tab layout on the Patient Record has the same default columns as those on 
the Flag List window. See Section 7.1.1 for more information. 

10.5.2 Flags Tab Toolbar 
The Flags tab toolbar on the Patient Record is the same as the toolbar on the Flag List 
window. See Section 7.2 for more information. 

10.5.3 Flags Tab Menus 
The options on the File menu of the Flags tab are the same as those on the Cover 
Sheet tab. See Section 10.3.7.1 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

10.5.3.1 Flags Menu 
The options on the Flags menu are Refresh, Hide, Show. The Hide and Show options 
work like the action buttons on the left side of the Flags toolbar. See Section 7.2 for 
more information. The Refresh option works like the Refresh button on the right side 
of the window. See Section 4.5.2 for more information. 

10.5.3.2 Tools Menu 
The options on the Tools menu for the Flags tab are: 

Quick Patient Search: this option executes a patient search. See Section 4.4 for more 
information about this functionality. This is the same as pressing the F8 key on your 
keyboard. 
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Reset View, Refresh, Search, Excel Export, Print, Copy Rows to Clipboard: these 
options operate like the buttons on the right side of the window. See Section 4.5 for 
more information about these functions. 

User Preferences: this option takes you to the User Preferences window where you 
can change your user preferences. See Section 3.2 for more information about the 
tabs on this window. 

Web Links: this option shows several categories (such as Asthma) that have Web 
links. When you select a Web link, the Internet browser for the particular category 
opens. 

10.6 Reminders Tab 
The Reminders tab lists the national reminders that are pulled from the same data as 
the Health Summary report reminders in RPMS (such as lab test, immunization, etc.).  

 
Figure 10-24: Sample Reminders tab 

You can control what displays on this tab by selecting any one or more of the options 
in the Show field. After selecting (or de-selecting) any option in the Show field, the 
display will automatically update. 

The default sort order is by due date, with the most overdue first, then sorted by 
Category, Clinical Group, and Reminder Name. 

10.6.1 Reminders Tab Layout 
Below is an overview of the columns. 

Source: the “source” of the reminder logic. Examples are: Health Summary (i.e., 
Health Maintenance Reminders), HMS (HIV Management System), DMS (Diabetes 
Management System), EHR, etc. When the Source is “Care Management” and 
“HIV,” the denominator for the HMS reminders will be any patient with a proposed 
or accepted tag for HIV. Note: the register status is NOT considered for the 
denominator definition. 

Category: the name of the clinical performance group, for example, Breast. 
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Reminder Name: the name of the clinical procedure that needs to be done. You can 
view a tooltip by hovering your mouse over any Reminder Name cell. 

Due Date: the date the reminder procedure is due. This column will display the 
warning indicator ( ) if any of the patient’s reminders are overdue. This date is 
derived from the Health Summary Reminders Next Due text. 

Next Due: the actual text from the Reminders Next Due display on the Health 
Summary. 

Last Date Performed: the date that the reminder procedure was most recently 
completed. 

Preceding CMET Event: this is populated with the tracked Event that initiated this 
follow-up. If the displayed reminder is not a CMET Reminder, this cell will contain 
N/A. 

Date of Preceding CMET Event: the date of the preceding CMET Event. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

You can review information about the fields by reviewing the Reminders glossary. 
Select Help | Reminders Glossary for more information. 

10.6.2 Reminders Tab Toolbar 
The Patient Reminders data is current as of the date shown on the toolbar. The 
reminders are calculated on-the-fly. 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

10.6.2.1 Recalc 

Click the Recalc  button (or select Reminders | Recalc) to get the latest data 
from the server and to run the algorithm. 

10.6.2.2 Background Jobs 
Click the Background Jobs  button to display the Background Jobs pop-up. See 
Section 4.10 for more information. 

10.6.3 Reminders Tab Menus 
See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 
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The Reminder menu has the Recalc and Refresh options; these perform like the 
buttons on the toolbar. 

10.6.3.1 File Menu 
The options on the File menu of the Reminders tab are: 

New: this option displays the Panel Definition dialog where you create a new panel 
definition. See Section 5.0 for more information about this window. This is the same 
as pressing the Ctrl+N key combination. 

Page Setup: this option allows you to set Margin, Paper, and Layout characteristics 
(like landscape or portrait orientation) for printing. You can select a different printer. 

Print Preview: this option displays the Print Preview dialog for the selected rows in 
the grid. 

Print: This option outputs the selected rows in the grid. The application displays the 
Print dialog where you select the Page Range, Number of Copies, and the Printer. 

If you do not select any rows, the application displays the warning message: You 
have not selected any rows to print. Do you want to proceed and print all rows in this view 
or cancel this print? Click Yes to print all the rows. Click No to cancel the print 
function. 

Background Jobs: this option displays a pop-up showing background jobs 
information. See Section 4.10 for more information. 

Close: this option dismisses the current open patient record window. 

10.6.3.2 Tools Menu 
The options on Tools menu for the Reminders tab are: 

Quick Patient Search: this option executes a patient search. See Section 4.4 for more 
information about this functionality. This is the same as pressing the F9 key on your 
keyboard. 

Glossary: this option opens the Reminders glossary where you can review 
information about the fields on this tab. 

Reset View, Refresh, Search, Excel Export, Print, Copy Rows to Clipboard: these 
options operate like the buttons on the right side of the window. See Section 4.5 for 
more information. 
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User Preferences: this option takes you to the User Preferences window where you 
can change your user preferences. See Section 3.2 for more information about the 
tabs on this window. 

Web Links: this option shows several categories (such as Asthma) that have Web 
links. When you select a Web link, the Internet browser for the particular category 
opens. 

10.7 BP Prompts Tab 
The Best Practice (BP) Prompts tab displays a list of suggested treatments based on 
pre-determined prompt logic (including new CVD and existing Asthma reminders). 
CVD Treatment prompts are callable by the Health Summary or other RPMS 
applications. The best practice prompts can be turned off via the PCC Health 
Summary functions. 

 
Figure 10-25: Sample BP Prompts tab 

10.7.1 BP Prompts Layout 
The data columns on the Best Practice Prompts tab are described below. 

Clinical Group: the name of the clinical group. 

Prompt Name: the name of the best practice prompt. 

Guidance: the text that defines the diagnosis. 

A tooltip displays by hovering your mouse over the Prompt Name cell. The text is 
pulled from the Tooltip field in the Treatment Prompt file. 

10.7.2 BP Prompts Toolbar 
The field with the drop-down list determines what data within each clinical group will 
be displayed: either the TOP 5 or ALL. The default is TOP 5. 

The time/date for the last data update is shown in the toolbar. 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 
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10.7.2.1 Recalc 

Click the Recalc  button (or select Best Practice Prompts | Recalc) to get the 
latest data from the server and to run the algorithm. 

10.7.2.2 Background Jobs 
Click the Background Jobs  button (or select File | Background Jobs) to display the 
Background Jobs pop-up. See Section 4.10 for more information. 

10.7.3 BP Prompts Tab Menus 
The options on the File menu of the Best Practice Prompts tab are the same as those 
on the Cover Sheet tab. See Section 10.3.7.1 for more information. 

The options on the Tools Menu on the Best Practice Prompts tab are the same as 
those on the Reminders tab. See Section 10.6.3.2 for more information. 

The Best Practice Prompts menu has one option: Recalc. This performs like the 
button on the toolbar. 

For information about the Edit, Window, and Help menus, see Section 4.3 for more 
information. 

10.8 Natl Measures Tab 
The Natl Measures tab displays the patient’s GPRA performance status (based on the 
CRS national summary report). 

 
Figure 10-26: Sample National Measures tab 

This detailed list shows all national CRS measures broken down by clinical group 
along with the current patient’s status with respect to the measure. 
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The toolbar on this tab displays the date that iCare most recently processed the 
National Measures logic on your facility’s RPMS database. The default setting for the 
National Measures’ logic “run” is weekly (your Site Manager can select a different 
time frame). 

10.8.1 Natl Measures Tab Layout 
The data columns on the Natl Measure tab are described below. 

Category: the name of the category, Developmental, National GPRA, Non-National, 
or Other National. 

Clinical Group: the name of the clinical performance group. 

Measure Name: the measure title derived from the Summary Report. A description 
of the performance logic (tooltip) will display when you hover the mouse over the 
name. 

Performance Status: displays the current status (as of the date listed on the toolbar) 
of this patient’s performance to the specific measure. 

The National Measures tab on the Patient Record is based on CRS logic and the data 
for each measure is primarily Yes, No or N/A. 

• The font is green if the value is Yes and the measure is traditional in the sense 
that meeting the measure is positive OR if the value is No and the measure is 
such that not meeting the measure is positive. 

• The font is red if the value is No and the measure is traditional in the sense 
that not meeting the measure is negative OR if the value is Yes and the 
measure is such that meeting the measure is negative. 

Adherence Value: displays the visit date and clinical procedure that meets the 
performance numerator definition. 

You can find information about all of the measures in the National Measures 
Glossary. Select Help | Natl Measures Glossary for more information. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

10.8.2 Natl Measures Tab Toolbar 
The time/date for the last data update in shown in the toolbar. 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 
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10.8.2.1 Recalc 

Click the Recalc  button to get the latest data from the server and to run the 
algorithm. 

10.8.2.2 Background Jobs 
Click the Background Jobs  button to display the Background Jobs pop-up. See 
Section 4.10 for more information. 

10.8.3 Natl Measures Tab Menus 
The options on the File menu of the Natl Measures tab are the same as those on the 
Reminders tab. See Section 10.6.3.1 for more information. 

The options on the Tools Menu on the Natl Measures tab are the same as those on the 
Reminders tab. See Section 10.6.3.2 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

10.9 CMET Tab 
The CMET tab displays the CMET data associated with the current patient. 

 
Figure 10-27: Sample CMET tab 

The CMET tab on the patient record window has the information displayed in four 
sub-tabs: Events, Tracked Events, Follow-up Events, and Past Events. 

10.9.1 Events Sub-Tab 
The patient’s events display on the Events sub-tab. 
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Figure 10-28: Sample Events sub-tab 

The Events sub-tab is divided into three general areas: Tips information, Events 
toolbar, and Events data. 

The Tips information provides an overview of the Events sub-tab. You can collapse 
this area in order to have more room to view the Events data. 

Note: You can establish the default “collapse” status for the Tips 
area on this sub-tab. To do that, select Tools | User 
Preferences | CMET tab | Events sub-tab. The Tips check 
box on this sub-tab will establish the “collapse” status. 

10.9.1.1 Events Sub-Tab Layout 
The default sort of the columns is: Category, Date of Event (newest listed first), 
Patient Name (alphabetical). 

Below are the fields: 

Category: the category of the event. 

Event Name: the name of the event. 

Event Date: the date of the event. Double click any underlined date to view the Visit 
Detail pop-up. See Section 4.7 for more information about the buttons and the File 
menu on this pop-up. 

Result: the date of the result. Double-click the underlined date to access a particular 
detail pop-up, for example, Women’s Health Detail. This cell also has hover help, 
such as V Radiology. 

Status: the status of the event: all, not tracked, pending, superseded, tracked. 

Status Comment: any comments about the status. 

Last Modified Date: the date the record was last modified. 
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Last Modified By: the person who last modified the record. The Initial job name 
means that this was a initial event. 

10.9.1.2 Events Sub-Tab Toolbar 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

The action buttons (Track, Don’t Track, Pend) function like those on the main iCare 
CMET window. See Section 11.1.3 for more information. 

10.9.2 Tracked Events Sub-Tab 
The patient’s tracked Events display on the Tracked Events sub-tab. 

 
Figure 10-29: Sample Tracked Events sub-tab 

The Tracked Events sub-tab is divided into three general areas: Tips information, 
Tracked Events toolbar, and Tracked Events data. 

The Tips information provides an overview of the Tracked Events sub-tab. You can 
collapse this area in order to have more room to view the Tracked Events data. 

Note: You can establish the default “collapse” status for the Tips 
area on this sub-tab. To do that, select Tools | User 
Preferences | CMET tab | Tracked Events sub-tab. The Tips 
check box on this sub-tab will establish the “collapse” 
status. 

10.9.2.1 Tracked Events Sub-Tab Layout 
Below are the fields: 

Category: the category of the tracked event. 

1 - Event: the name of the tracked event. 

Event Date: the date of the tracked event. Double-click the underlined date to access 
the Visit Detail pop-up. See Section 4.7 for more information about the buttons and 
the File menu on this pop-up. 
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Result: the date of the result. Double-click the underlined date to access a particular 
detail pop-up, for example, Women’s Health Detail. Hover help will describe where 
the result came from (V-RADIOLOGY, V-LAB). 

2 – Finding(s): the field will display a tickler or be empty. See Section 11.2.2 for 
more information. 

Finding Date: the Finding Date of the tracked event. 

Interpretation: the interpretation of the selection in the Result field. There is hover 
help for this field, e.g., CMET, that refers to where the interpretation was obtained. 

3 - Follow-up(s): the field will display a tickler or be empty. See Section 11.2.2 for 
more information. 

Follow-Up Date: the follow-up date of the tracked event 

4 - Patient Notification(s): the field will display a tickler or be empty. See 
Section 11.2.2 for more information. 

Patient Notification Date: the notification date of the tracked event. 

State: the state of the tracked event: all, closed, open. 

Last Modified Date: the date the record was last modified. 

Last Modified By: the person who modified the record. 

Double-click any record to access the CMET Worksheet. See Section 4.20 for more 
information. 

10.9.2.2 Tracked Events Sub-Tab Toolbar 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

The action buttons (Reopen, Close, Open CMET Worksheet, Status of Background 
Jobs) function like those on the main iCare CMET window. See Section 11.2.3 for 
more information. 

10.9.3 Follow-up Events Sub-Tab 
The Follow-up Events sub-tab displays the patient’s follow-up events. 
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Figure 10-30: Sample Follow-up Events sub-tab 

The Follow-up Events sub-tab is divided into three general areas: Tips information, 
Follow-up Events toolbar, and Follow-up Events data. 

The Tips information provides an overview of the Follow-up Events sub-tab. You can 
collapse this area in order to have more room to view the Follow-up Events data. 

Note: You can establish the default “collapse” status for the Tips 
area on this sub-tab. To do that, select Tools | User 
Preferences | CMET tab | Follow-up Events sub-tab. The 
Tips check box on this sub-tab will establish the “collapse” 
status. 

10.9.3.1 Follow-up Events Sub-Tab Layout 
Below are the fields: 

Category: the category of the follow-up event. 

Follow-up Event Name: the name of the follow-up event. 

Follow-up Event Date: the date of the follow-up event. 

Preceding Event: the date of the preceding event. There is hover help when you 
move your mouse over the date (for example, PAP SMEAR). 

Double-click any record to access the CMET Worksheet. See Section 4.20 for more 
information. 

10.9.3.2 Follow-up Events Sub-Tab Toolbar 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

Select a record in the grid and then click the Open CMET Worksheet button to access 
the CMET Worksheet. See Section 4.20 for more information. 

Click the Background Jobs  button (or select File | Background Jobs) to display the 
Background Jobs pop-up. See Section 4.10 for more information. 
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10.9.4 Past Events Sub-Tab 
The Past Events sub-tab displays the patient’s past CMET events. Past events come 
from the data mining. 

 
Figure 10-31: Sample Past Events sub-tab 

The Past Events sub-tab is divided into three general areas: Tips information, Past 
Events toolbar, and Past Events data. 

The Tips information provides an overview of the Past Events sub-tab. You can 
collapse this area in order to have more to view the Past Events data. 

The Past Events toolbar and Past Events data are described below. 

10.9.4.1 Past Events Sub-Tab Layout 
Below are the fields: 

Category: the name of the category for the past event. 

Event Name: the name of the past event. 

Event Date: the date of the past event. 

Result: the date of the result of the past event. Double-click a record with an 
underlined date to access a particular detail pop-up, for example, Women’s Health 
Detail. 

Interpretation: the interpretation of the selection in the Result field. There is hover 
help for this field, e.g., CMET, that refers to where the interpretation was obtained. 

10.9.4.2 Past Events Sub-Tab Toolbar 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs  button 
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• Select File | Background Jobs 
This displays the RPMS iCare - Background Jobs window. See Section 4.10 for more 
information. 

10.9.5 CMET Tab Menus 
The options on the File menu are the same as those on the File menu for the Cover 
Sheet. See Section 10.3.7.1 for more information. 

The options on the Tools menu are the same as those on the Tools menu for the Flags 
tab. See Section 10.5.3.2 for more information. 

The CMET menu varies, according to the sub-tab. Most of the CMET menus reflect 
the buttons on the toolbar for that sub-tab. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

10.10 Summ/Supp Tab 
The Summ/Supp tab displays a selected type of report (shown in the Type field): Face 
Sheet, Health Summary, Patient Wellness Summary, Supplement. These reports are 
from RPMS. 

When you first access this tab, it will be blank. You must select an option from the 
drop-down list for the Type field. 

You can display and print existing condition-specific (i.e., register specific) 
Supplements. 

 
Figure 10-32: Sample Summ/Supp tab 

See Appendix H for more information about the different types of Supplements. 
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When you use the Asthma Patient Care Summary (from the Supplement option), you 
can review the Asthma Supplement Logic (section IV) in the Asthma Glossary. This 
section of the glossary gives the structure of the report and the definitions of the 
fields. (Select Help | Care Mgmt Glossaries | Asthma Glossary for more information.) 

10.10.1 Summ/Supp Tab Toolbar 
The Type field determines the summary/supplement reports to be displayed: 

• Asthma Action Plan 

• Face Sheet 

• Health Summary – has secondary selection, with Adult Regular as the default 

• Patient Wellness Handout – has a secondary selection 

• Supplement. – has a secondary selection 

• Women’s Health Profile - Brief 
Refresh button: it is not intuitive to the users that when they select a second HS type, 
and then return to the initial HS, they have to use Refresh in order to display updated 
data, e.g., after entering PCC data. 

Find button: allows you to search for a specific text string within the report text. This 
is especially useful for finding information within long reports. 

Print Preview button: displays a preview of page layout prior to printing the report 
on a printer. 

Print button: outputs the report. The application displays the Print dialog where you 
select the Printer, page range, and number of copies. 

10.10.2 Summ/Supp Tab Menus 
See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

10.10.2.1 Tools Menu 
The options on the Tools menu for the Summ/Supp tab are: 

Quick Patient Search: this option executes a patient search. See Section 4.4 for more 
information about this functionality. This is the same as pressing the F8 key on your 
keyboard. 
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Refresh: this option when you select a second HS type, and then return to the initial 
HS, you have to Refresh in order to display updated data, e.g., after entering PCC 
data. This is the same as pressing the F5 key on your keyboard or clicking the Refresh 
button. 

Find: this option finds data in the current window. The application displays the 
Search dialog. See Section 4.5.3 for more information. This is same as clicking the 
Find button. 

User Preferences: this option takes you to the User Preferences window where you 
can change your user preferences. See Section 3.2 for more information about the 
tabs on this window. 

Web Links: this option shows several categories (such as Asthma) that have Web 
links. When you select a Web link, the Internet browser for the particular category 
opens. 

10.10.2.2 File Menu 
The options on the File menu of the Summ/Supp tab are the same as those on the 
Cover Sheet tab. See Section 10.3.7.1 for more information. 

10.11 PCC Tab 
The PCC tab displays various types of PPC data associated with the patient. This data 
comes the V Lab file from PCC. 

 
Figure 10-33: Sample PCC tab 

The PCC data that displays is determined by the selection in the Type field on the 
toolbar. The time interval is controlled by what is selected in the Last drop-down list. 

10.11.1 PCC Tab Layout 
No duplicate values are displayed; e.g., if a patient has multiple immunizations on the 
same day, the date should be displayed only on the first line. 

The display can show any of the following PCC data types (shown in the Type field): 

The CPT data has these data elements: Date, CPT Code, Modifier 1, Modifier 2, 
Quantity. 
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The Elder Care data has these data elements: Date, Toileting, Bathing, Dressing, 
Transfers, Feeding, Continence, Finances, Cooking, Shopping, Housework/Chores, 
Medications, Transportation, Functional Status Change, Is Patient a Caregiver?. 

The Exams data comes from PCC V Exam files. Data Elements: Date, Exam, Result, 
Encounter Provider, Comments. 

The Health Factors data comes from PCC V Health Factor files. Data Elements: 
Date, Health Factor Category, Health Factor, Level/Severity, Quantity, Provider, 
Comments. 

The Immunizations data comes from PCC V IMM files. Data Elements.: Date 
(visit), Immunization, Series, Reaction, Encounter Provider. 

The Lab data comes from the PCC V Lab file. Data Elements: Date, Parent Panel, 
Panel, Test, Result, Normal/Abnormal, Range, Ordering Physician, Units. When 
entering historical data, you are limited to lab tests only (you are not allowed entry of 
lab panels because panels have no result since they are comprised of multiple 
individual tests with associated results). You can filter Lab data by “Related to” 
(currently HIV register-related). 

The Measurement data comes from PCC V Measurements files. Data Elements: 
Date, Measurement, Value, Percentile, Qualifiers. 

The Medication data comes from PCC V Medications file. Data Elements: Date, 
Medication (name), Instructions, Quantity, Days, Ordering Physician. You can filter 
Medication data by “Related to” (1) Asthma (Controllers or Relievers) or (2) 
HIV/AIDS. 

The Patient Education data comes from PCC V Patient Ed files. Data Elements: 
Date, Disease/Topic, Level of Understanding, Time Spent, Provider, Goal Status, 
Comments. 

The Procedures data comes from PCC V Procedures files. Data Elements: Date, 
Operation/Procedure, Provider Narrative. 

The Radiology data comes from PCC V Radiology file. Data Elements: Date, 
Procedure, Impression, Result. 

The Skin Test data comes from PCC V Skin Test files. Data Elements: Date, Skin 
Test, Results, Reading. 

10.11.2 PCC Tab Toolbar 
The default date range for all data is one year; you can select different predefined date 
ranges (3 months; 6 months; 1 year; 2 years; ever). The default display is in reverse 
order of date with most recent first. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Patient Record 
August 2011 

285 

When Type = Medication, you can display the HIV Management System (HMS) 
register data by selecting the checkbox next to the HIV/AIDS (for the Related To 
field). The Relate To field also displays for Medications and Lab (from the Type 
field). There are other register data that you can select for other data types. 

When Type = Measurement, the Graph It! button displays on the toolbar. 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

10.11.2.1 Add Event 
You use the Add Event feature to record historical PCC data for the current patient. 
This feature requires either the iCare Editor (BQIZCMED) or iCare Package Manager 
(BQIZMGR) security key. 

The Add Event feature is available for each option in the Type field. 

In PCC, this data is categorized with a Service Category of “Historical Event” and 
does not enter the normal facility visit billing cycle. Historical data might need to be 
entered to complete the patient record in the following circumstances: 

• The facility uses an off-site reference lab and is not using the RPMS 
Reference Lab application to send and receive lab data electronically directly 
into RPMS. 

• A test or procedure was documented in the patient’s chart but was not entered 
into RPMS. 

• The patient was traveling and received care at another facility that should be 
documented in their home facility. 

• The patient received an immunization or similar public health procedure at an 
off-site community event. 

Click the Add Event  button (or select PCC | Add Event) to display the Add 
PCC Event dialog. 
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Figure 10-34: Sample Add PCC Event 

You can dismiss the Add PCC Event window by selecting File | Close. 

When you click a ellipsis button by a field, the Table Lookup dialog displays. See 
Section 4.11 for more information about this dialog. 

The Add PCC Event window has two areas: (1) Add/Edit Event Info contains fields 
to adding or editing PCC data and (2) Pending Events displays the records that are 
pending events that you can remove, add new ones, and save to PCC. 

Any field followed by an asterisk (*) is required. 

10.11.2.1.1 Add/Edit Event Info Group Box 
The default Patient Name is the name of the open Patient Record. 

The default location is the service unit associated with the current user. You can 
change this by clicking the ellipsis button to search for a location name. If the 
Location field is populated with OTHER, then the Outside Location and Outside 
Provider Name fields become active; here you type in each free text field to populate 
it. 

10.11.2.1.2 Pending Events Group Box 
You can add new records, remove existing records, or save existing records to PCC in 
this group box. 
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See Section 4.5 to review how to use the buttons on the right side of the toolbar of the 
Pending Events area. These same functions can be found on the Tools menu of the 
Add PCC Event window. 

If you double-click a record in Pending events group box, the Visit Detail pop-up will 
display. See Section 4.7 for more information about the buttons and the File menu on 
the pop-up. 

Add New 

Click the Add New  button (or select File | Add New) to clear the fields in the 
Add/Edit Event Info group box where you can define a new PCC type record. 

You need to populate the appropriate fields for the selected PCC Type. When all 
fields are complete, click Add. This action adds a new record to the Pending Events 
area. 

Edit a Record 

Double-click a record in the Pending Events area to cause the existing record data to 
populate the fields in the Add/Edit Event Info group box. 

You can change the fields, as needed. When all fields are complete, click the Apply 
Changes button. This changes the record in the Pending Events group box. 

Remove 

You can remove the highlighted records in the Pending Events group box by clicking 

the Remove  button (or selecting File | Remove). The “Confirm remove” 
window display, confirming the deletion. Click Yes to remove the records. 
(Otherwise, click No.) 

Save to PCC 

You need to save your changes/additions to PCC (that are listed in the Pending 

Events group box). Click the Save to PCC  button (or select File | Save to 
PCC) to displays the “Confirm save to PCC?” information message, confirming that 
you want to save the PCC data to the patient’s PCC visit file. Click Yes to save the 
information to PCC. (Otherwise, click No to not save to PCC.). In either case, the 
record is removed from the Pending Events group box. 
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After you exit the information message, the application displays the Add Chart 
Review? information message that asks: Do you wish to add a Chart Review at 
this time? Click OK to add a Chart Review record (other wise, click Cancel to not 
add one). If you use OK, the application displays the Add Chart Review dialog. 
See Section 10.11.2.2 for more information about this dialog. 

Please note that for each type of added event, you will be need to save. When you try 
to enter a new type, iCare asks if you want to save the existing records to PCC. 

• Click Yes to save to PCC. This action removes the record from the Pending 
Events group box. 

• Click No to not save. This action removes the record from the Pending Events 
group box. 

• Click Cancel to return to the Add PCC Event dialog. 

10.11.2.2 Add a Note 
The Add a Note feature is available for each option in the Type field. Use this feature 
to add a note for the patient, such as a chart review, follow-up letter, or telephone call. 

Note: The Add a Note button is active ONLY if you have your 
electronic signature on file. 

Click the Add a Note  button (or select PCC | Add a Note) to access the Add a 
Note dialog. Use this dialog to add a new chart review, follow-up letter, or telephone 
call note for the patient. 

 
Figure 10-35: Sample Add a Note dialog 
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See Section 4.25 for more information. 

10.11.2.3 Related To 
When you have Type = Medication, the toolbar changes to show the Related To field. 

 
Figure 10-36: Sample PCC Toolbar for Medication type 

When you check any of the check boxes under the Asthma tree, the display will 
change, showing the (checked) medications. 

Controllers are defined as the following medication name taxonomies: BAT 
ASTHMA CONTROLLER MEDS; BAT ASTHMA INHALED STEROIDS; 
BAT ASTHMA LEUKOTRIENE MEDS 

OR the following NDC values: BAT ASTHMA CONTROLLER NDC; BAT 
ASTHMA INHLD STEROIDS NDC; BAT ASTHMA LEUKOTRIENE NDC 

Relievers are defined as the following medication names: BAT ASTHMA SHRT 
ACT RELV MEDS; BAT ASTHMA SHRT ACT INHLR MEDS; BGP RA 
GLUCOCORTIOCOIDS 

OR the following NDC codes: BAT ASTHMA SHRT ACT RELV NDC; BAT 
ASTHMA SHRT ACT INHLR NDC 

OR the following VA Class codes: BGP RA GLUCOCORTIOCOIDS CLASS 

When Type = Lab, the toolbar changes where you can indicate if you want to show 
labs related to HIV/AIDS. 

10.11.2.4 Graph It Button 

The Graph It  button only appears when Type = Measurement. This feature 
allows you to display, print, and save a graph of particular measurements data. 

When the current patient has measurement data, click the Graph It  button (or 
select PCC | Graph It). The application displays the Charting window, showing a 
graph of the various measurement types. 
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Figure 10-37: Sample Charting window 

See Section 4.17 for more information about the Charting window. 

10.11.3 PCC Tab Menus 
The options on the File menu of the PCC tab are the same as those on the Reminders 
tab. See Section 10.6.3.1 for more information. 

The options on Tools Menu on the PCC tab are the same as those on the Flags tab. 
See Section 10.5.3.2 for more information. 

The options on the PCC menu operate like the action buttons on the toolbar. See 
Section 10.11.2 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

10.12 Problem List Tab 
There are two conditions for this tab: (1) a patient with no problems and (2) a patient 
with one or more problems. The toolbar to each condition will be different. 

10.12.1 Patient with No Problems 
The Problem List tab for a patient with no problems is shown below. 
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Figure 10-38: Problem List tab for patient with no problems 

The “No Active Problems” button only displays for a patient with no problems. 

Use the “No Active Problems” button to indicate when there were no active 
problems. Click the No Active Problems button to access the No Active Problems 
dialog. 

 
Figure 10-39: No Active Problems dialog 

Both fields are required. 

Date Provider documented “No Active Problems”: either manually populate this 
field with the date or click the drop-down list and pick a date from the calendar. 

Provider who documented “No Active Problems”: click the ellipsis button to 
access the Table Lookup dialog. Here you search for a name and select one from the 
retrieved records to populate the field. 

After the dialog is complete, click OK (otherwise, click Cancel). 

After clicking OK, the application displays the Confirm save to RPMS information 
message that asks: This data will be saved to the RPMS server. Do you want to 
continue? Click Yes to save the data to the RPMS server. Click No to not save the 
data. 

After click Yes, the Problem List tab will change, showing a message that there is no 
active problems. 
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Figure 10-40: Sample Problem List tab showing message about no active problems 

You can add a problem, as described below. 

10.12.2 Patient with Problems 
The Problem List tab shows the patient’s current problem list. The Problem List data 
comes from the PCC Problem List. 

 
Figure 10-41: Sample Problem List tab 

You can add, edit, review, and delete problem list items, including notes, on this tab. 

The default Problem List display shows the Active Problems first, then the Inactive 
ones. 

10.12.3 Problem List Tab Layout 
The data columns are described below: 

Problem ID: the identification label assigned to the problem. 

Status: status of the problem, Active, Inactive, or Deleted. 

Provider Narrative: the narrative entered for the ICD code for the problem. 

Date of Onset: the date the symptoms started. 

DX Code: the ICD code for the problem. 

Problem Notes: any notes entered about the problem (like a Comment field). 
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Classification: this shows any staging associated with the problem (for example, in 
Asthma Severity). 

Date Last Modified: the date the problem was last modified. 

User Last Modified: the name of the person who last modified the record. 

Facility: the name facility where the login user (who entered the problem) resides. 

Class: this will be blank or will contain Personal History. 

The default display (sort) order will be by Status (Active first), then by Problem ID. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

10.12.4 Problem List Tab Toolbar 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

10.12.4.1 Add New Problem 

You can add a problem by clicking the Add Problem  button (or by selecting 
Problem List | Add Problem). The Add New Problem window will display. This 
feature requires either the iCare Editor (BQIZCMED) or iCare Package Manager 
(BQIZMGR) security key. 
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Figure 10-42: Add New Problem dialog 

• You use the Add/Edit area for the adding/editing problem information. 

• You use the lower area for the notes associated with the problem as well as 
the date the problem list was updated and the provider who updated the list. 

• The required fields are those followed by an asterisk (*) 

10.12.4.1.1 Fields on Dialog 
DX Code: the ICD code for the problem. Click the ellipsis button to search for the 
ICD code. See Section 4.11 for more information. 

Provider Narrative: This is a free text field used to describe the problem. 

Classification: This field will observe the server-side business rules and only be 
available for entry when an asthma ICD code is entered. Users will select a value for 
this field from a predefined list. 

Date of Onset: Enter the date the symptoms started, if known. Click the drop-down 
list to display a calendar. See Section 4.6.3 for more information about selecting a 
date from the calendar. 

Status: The status of the problem, either Active or Inactive. The default is Active for 
a new problem. 
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Class: This indicates if this problem is documented for historical purpose (Personal 
History is the only option). 

Problem Notes: Use this area to add/delete notes about the problem. 

To add a note, click the Add  button. iCare will populate the Note Number 
with a number that identifies the note. You type the text of the note in the free text 
field (Note Narrative). 

To delete one or more selected notes, click the Delete button. iCare will display the 
Delete Rows information message asking if you want to delete the selected rows. 
Click Yes to delete (otherwise, click No). After clicking Yes, the notes are removed 
from the Problem Notes area. 

Date Problem List Updated: Click the drop-down list to access a calendar where 
you select the date the problem list was updated. 

Provider Who Updated Problem List: Click the ellipsis button to access the Table 
Lookup where you search for the name of the provider who updated the problem list. 

When you have completed the information about the new problem, click OK. After 
you click OK, the application displays the Confirm save to RPMS information 
message: This data will be saved to the RPMS server. Do you want to continue? Click Yes 
to save (otherwise, click No). If you use Yes, the problem is added to the Problem 
List tab of the Patient Record window. 

The application does the following to the Problem List window: 

• assigns a problem ID and adds the data to the various fields 

• adds the name of the facility (of the user who entered the problem) 

• uses today’s date as the Date Last Modified 

• uses the name of the current login user for the User Last Modified. 

10.12.4.1.2 Menus on Dialog 
Use File | Close to close the dialog. 

The Help menu has the following options: 

iCare Help: use this option to access the online help for the dialog. This is the same 
as pressing the F1 key on your keyboard. 

About iCare: use this option to review the information about the iCare version and 
other information. 
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10.12.4.2 Edit Problem List 

You can change a highlighted record by clicking the Edit Problem  button (or 
by double-clicking the record or by selecting Problem List | Edit Problem). The Edit 
Problem List dialog will display. 

This edit dialog operates like the Add Problem List dialog. See Section 10.12.4.1 for 
more information about the fields. 

10.12.4.3 Delete Problem 
You can delete one or more highlighted problems on the Problem List tab by clicking 

the Delete Problem  button (or by selecting Problem List | Delete Problem). 

iCare displays the Delete Problem List dialog. 

 
Figure 10-43: Delete Problem List dialog 

Both fields are required. 

Date Problem List Updated: either manually populate this field with the date or 
click the drop-down list and pick a date from the calendar 

Provider Who Updated Problem List: click the ellipsis button to access the Table 
Lookup dialog. Here you search for a name and select one from the retrieved records 
to populate the field. 

After the dialog is complete, click OK (otherwise, click Cancel). 

After clicking OK, the application displays the Confirm save to RPMS information 
message that asks: This data will be saved to the RPMS server. Do you want to 
continue? Click Yes to save the data to the RPMS server. Click No to not save the 
data. 

After clicking Yes, the “deleted” record will move to the bottom of the list of 
problems and its status will be DELETED. 
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10.12.4.4 Problem List Reviewed 
Use the Problem List Reviewed button to update two fields of the selected Problem 
List record: (1) Date Problem List Reviewed and (2) Provider Who Reviewed 
Problem List, and to save the data to PCC. 

Select the record to change and then click the Problem List Reviewed button. The 
application will display the Problem List Reviewed dialog. 

 
Figure 10-44: Problem List Reviewed dialog 

Both fields are required. 

Date Problem List Reviewed: select a date by clicking the drop-down list to access a 
calendar. 

Provider Who Reviewed Problem List: click the ellipsis button to access the Table 
Lookup dialog where you search for a provider name. This is the provider who 
reviewed the problem list. See Section 4.11 for more information about using the 
Table Lookup dialog. 

When the dialog is complete, click OK (otherwise, click Cancel). After clicking OK, 
the application displays the Save to RPMS? information message that asks: You have 
data changes pending. Do you want to save to RPMS now? Click Yes to save the 
data to RPMS. Click No to not save the data to RPMS. 

If the data was incomplete and you clicked OK, the information message would have 
one more button Cancel: Click Cancel to return to the Problem List Reviewed dialog. 

10.12.5 Problem List Tab Menus 
The options on the File menu of the Problem List tab are the same as those on the 
Reminders tab. See Section 10.6.3.1 for more information. 

The options on the Problem List menu perform like the action buttons (Add, Edit, 
Delete) on the toolbar. See Section 10.12.4 for more information. 

The options on Tools Menu on the Problem List tab are the same as those on the 
Flags tab. See Section 10.5.3.2 for more information. 
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See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

10.13 Care Mgmt Tab 
The Care Management tab displays any related care management data for the current 
patient. You must select an option from the “Please Select a Group” field in order to 
display data. There are two conditions: (1) if the patient does not have any related 
care management data and (2) if the patient does have related care management data. 

10.13.1 Patient With No Tag 

 
Figure 10-45: Sample Care Management Tab for Patient with No Tag 

The Care Management toolbar displays information that the patient does not have an 
associated HIV/AIDS/Diabetes/ Asthma tag. 

• If you want to manually add the patient to a register, use the Enter Data 
button. 

• If you want to add an associated tag, use the Add Tag button. 

10.13.1.1 Enter Data 

Click the Enter Data  button to add the patient to a register. 

The fields will display in the Main sub-tab. This feature requires either the iCare 
Editor (BQIZCMED) or iCare Package Manager (BQIZMGR) security key. See 
Section 10.13.3 for more information. 

10.13.1.2 Add Tag 

Click the Add Tag  button (or select Care Mgmt | Add Tag) to add a diagnostic 
tag. The Add Diagnostic Tag dialog will display. This is a manual add. 
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Figure 10-46: Sample Add Diagnostic Tag dialog 

This is a manual add that allows a provider to manually assign one or more of the 
diagnosis tags to patients that did not meet the tag’s criteria for being proposed 
automatically. 

Note: If you are adding the Asthma diagnostic tag, the Diagnostic 
Tag field will be Asthma. 

10.13.1.2.1 Fields 
You can edit the following fields: 

New Status: the status of the tag being changed. 

ACCEPTED: this option allows you to “Accept” a proposed tag to provide an 
affirmation of its validity for a given patient. 
NOT ACCEPT: this option allows you to disapprove or “Not Accept” a 
diagnostic tag that has been proposed for a patient. 
PROPOSED: this option allows you to change the status of a diagnosis tag back 
to “Proposed” so that further review can take place. 

Reason: click the appropriate radio button for the reason to change the tag. 
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• Patient Data Supports Acceptance - use this when the patient data does not 
support the tag. 

• Manually Designated - use this when you manually designate the tag. 

• Other - use this when the other reasons do not fit. You must populate the 
Status Comment field to provide the text of the reason. 

Status Comment: here you type the reason for the change (when the reason is 
“Other”). This feature provides a rich audit history for reasons for providers’ 
decisions to accept or not accept proposed tag assignments. 

Click OK to save your changes. (Otherwise, click Cancel). If you save, you need to 
refresh the screen; the message besides the Care Management Group field will reflect 
the change. 

10.13.1.2.2 View Tag Activity Button 
Click the View Tag Activity button to display the RPMS iCare – Diagnostic Tag 
Activity window. See Section 9.9.2.4 for more information about this pop-up. 

10.13.2 Patient With HIV/AIDS Tag 

 
Figure 10-47: Sample Care Management Tab for Patient with HIV/AIDS Tag 

The data will display on the Main sub-tab. 

10.13.2.1 Accept Button 
When the Accept button is active in the toolbar of the Care Management tab, you can 
change the status of the tag (displayed in the toolbar). The button will be active, for 
example, when the status of the tag is Proposed. 
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Click the Accept button to display the Update Diagnosis Tag dialog. 

10.13.2.2 Using the Update Diagnostic Tag Dialog 
The Update Diagnostic Tag dialog displays the patient name, diagnostic tag, and 
current status. 

 
Figure 10-48: Sample Update Diagnosis Tag Dialog 

You can view existing tag activity about the patient by clicking the View Tag 
Activity button. The Diagnostic Tag Activity pop-up displays. See Section 9.9.2.4 for 
more information about this pop-up. 

You can edit the following fields: 

New Status: the status of the tag being changed. 

ACCEPTED: this option allows you to “Accept” a proposed tag to provide an 
affirmation of its validity for a given patient. 

NOT ACCEPT: this option allows you to disapprove or “Not Accept” a 
diagnostic tag that has been proposed for a patient. 

PROPOSED: this option allows you to change the status of a diagnosis tag back 
to “Proposed” so that further review can take place. 
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Reason: click the appropriate radio button for the reason to change the tag. 

• Patient Data Supports Acceptance - use this when the patient data does not 
support the tag. 

• Manually Designated - use this when you manually designate the tag. 

• Other - use this when the other reasons do not fit. You must populate the 
Other field to provide the text of the reason. 

Other: here you type the reason for the change (when using the reason “Other”). This 
feature provides a rich audit history for reasons for providers’ decisions to accept or 
not accept proposed tag assignments. 

Click OK to save your changes. (Otherwise, click Cancel). If you save, you need to 
refresh the screen; the message besides the Care Management Group field will reflect 
the change. 

10.13.3 Main Sub-Tab 
You use the Main sub-tab of Care Management window to add/edit patient register 
information. 

 
Figure 10-49: Sample Care Management Tab After Clicking Enter Data 

You need to expand any category (listed below the toolbar buttons) that you want to 
change. After completing your changes, use the Save button to save your changes. 

Many of the drop-down lists (for fields) contain a “blank” option that you use when 
you want the particular field to have no data. Usually the “blank” option is the first 
one on the drop-down list. 

10.13.3.1 General 
Expand the General category to display the following fields on the General group 
box: 
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Figure 10-50: Fields for the General Group Box 

All fields with an asterisk (*) are required. 

Register Status: enter the status of the patient on this register from the drop-down 
list: Active, Deceased, Inactive, Transient. 

Register Status Comments: enter comments about the register status selection in this 
free text field (limited to 50 characters). 

HMS Diagnosis Category: select a specific HIV-related diagnostic category from the 
drop-down list: AIDS, HIV, At Risk - Exposed Source Unknown, At Risk - Infant 
Exposed, At Risk - Non-occupational Exposure, At Risk - Occupational Exposure. 

Diagnosis Comments: enter comments about the HMS Diagnosis Category selection 
in this free text field (limited to 50 characters). 

Initial HIV DX Date: enter the date when this patient was first diagnosed with HIV. 
You can enter a month and year only; in this case the entry will be stored in BKM as 
MM-01-YYYY. This field is active only when you have populated the HMS 
Diagnosis Category field with HIV. 

Note: A proposed date might be displayed, based on the earliest 
RPMS data that meets the HIV/AIDS tag definition. You 
must enter the actual date even if you want to “accept” the 
proposed date. 

Initial AIDS DX Date: enter the date when this patient was first diagnosed with 
AIDS. You can enter a month and year only; in this case the entry will be stored in 
BKM as MM-01-YYYY. This field is active only when you have populated the HMS 
Diagnosis Category field with AIDS. 
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Note: A proposed date might be displayed, based on the AIDS 
logic defined above in the HMS Diagnosis Category field. 
You must enter the actual date even if you want to “accept” 
the proposed date. 

CDC Cause (Etiology): select a cause (etiology) of the patient’s DX from the drop-
down list. The Centers for Disease Control has categorized the ways in which an 
individual is exposed to HIV. 

Etiology Comments: enter comments about the CDC Cause selection in this free text 
field (limited to 50 characters). (This field is active only when the CDC Cause 
(Etiology) field is populated.) A comment should always be entered if you select 
“OTH - Other" in the CDC Cause field. 

CDC Clinical Classification: this field is active when the HMS Diagnosis Category 
contains AIDS or HIV. Select the clinical classification from the drop-down list. 

The current CDC classification system combines three categories of the CD4 count 
with three symptom categories. The use of both the CD4 cell count and clinical 
categories provides shorthand for where the patient stands in the course of the 
HIV/AIDS continuum. While there are guidelines in place, assign the classification 
only after clinical evaluation. The decision of which category to assign is always 
made by a clinical person. The CDC proposed that the clinical classification system 
be used to “guide clinical and therapeutic actions in the management of HIV infected 
adolescents and adults.” 

The HIV Provider, HIV Case Manager, and Where Followed fields are populated by 
using the Table Lookup dialog. For more information about using the Table Lookup 
dialog after clicking the ellipsis button by a field, see Section 4.11. 

HIV Provider: click the ellipsis button to search for a HIV provider name at your 
facility. If this patient is cared for at an outside facility, enter the provider in the 
“Outside Provider” field. This information is pulled from the RPMS Designated 
Specialty Provider Management (DSPM) application, if available, and displayed here. 

HIV Case Manager: click the ellipsis button to search for a case manager name at 
your facility. This information is pulled from the RPMS Designated Specialty 
Provider Management (DSPM) application, if available, and displayed here. 

Where Followed: click the ellipsis button to search for name of a facility that 
primarily follows the patient’s care related to HIV/AIDS. If this is not your facility, 
select OTHER from the list; you can identify the specific facility in the outside 
location field and the provider in the Outside Provider field. 

Outside Location: manually enter the name of the facility or outside physician’s 
office where the patient is followed. This is free text limited to 50 character. 
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Outside Provider: manually enter the name of the patient’s HIV provider at the 
outside location. This is free text limited to 50 characters. 

10.13.3.2 Partner Notification 
This notification type is to document the notification of a patient’s partner of a 
potential exposure to HIV. The public health recommendation to notify the patient’s 
partner is a practice that is encouraged in all I/T/U facilities. 

Expand the Partner Notification category to display the following fields on the 
Partner Notification group box: 

 
Figure 10-51: Fields for Partner Notification Group Box 

Partner Notification Status: Enter if this patient’s partner has been notified by 
selecting by the drop-down list: N/A, No, Remind Me Later, Unknown, Yes. 

Partner Notification Date: This field is active when the Partner Notification Status 
contains Yes. Enter a date that the partner was notified; you can select from a 
calendar by using the drop-down list. 

10.13.3.3 Antiretroviral (ARV) Status 
Expand the ARV category to display the following fields on the Antiretroviral ARV 
(Status) group box: 
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Figure 10-52: Fields on the ARV group box 

Use this group box to enter ARV (Anti-Retro Viral Medications) data for ARV 
appropriate, ARV adherence, and ARV Stability. The medications are used to treat 
HIV/AIDS patients by reducing viral load and improving immunological function. 
See Section 15.5 for more information. 

Because the ARV status might change over time, HMS maintains a history of ARV 
Appropriate and Compliance statuses for the patient. The entire ARV history will be 
displayed on this screen with the most recent status listed first; this feature allows the 
provider to easily view the continuum of assessment. 

For ARV Appropriate, click the Add  button to add data. Each of the fields 
will have either a drop-down list from which to select or become a free text field 
where you enter information. Data can be entered at any time and can be done so 
retrospectively. 

Date: Enter the date the patient was assessed for suitability for ARV (required). Click 
the drop-down list to select from a calendar. 

Status: Click the drop-down list and select one of the options: Yes Appropriate, No 
Not Appropriate, Unknown, Not Applicable. 

Comment: Type a comment, if appropriate, in this free text field, using up to 50 
characters. 

Last Edited By: The name of the person who last edited the record (system 
populated). 
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Last Edited Date: The date the record was last edited (system populated). 

After you click Save, iCare confirms that you want to add the record. After clicking 
Yes, iCare populates the Last Edited By field (name of user who populated the 
record) and today’s date in the Last Edited Date. 

For ARV Appropriate, you can delete selected records by clicking the Delete 
 button to display the Delete Rows information message. Click Yes to 

remove the records. Otherwise, click No to retain the records. 

For ARV Adherent, click the Add  button, each of the fields will have either a 
drop-down list from which to select or become a free text field where you enter 
information. 

Date: Enter the date the patient was assessed for adherence to the prescribed ARV 
regimen (required). Click the drop-down list to select from a calendar. 

Adherent: Click the drop-down list and select one of the options: Adherent, Non- 
Adherent, Unknown, Not Applicable. 

Comment: Type a comment, if appropriate, in this free text field, using up to 50 
characters. 

Last Edited By: The name of the person who last edited the record (system 
populated). 

Last Edited Date: The date the record was last edited (system populated). 

After you click Save, iCare confirms that you want to add the record. After clicking 
Yes, iCare populates the Last Edited By field (name of user who populated the 
record) and today’s date in the Last Edited Date. 

For ARV Adherent, you can delete selected records by clicking the Delete  
button to display the Delete Rows information message. Click Yes to remove the 
records. Otherwise, click No to retain the records. 

For ARV Stability, click the Add  button, each of the fields will have either a 
drop-down list from which to select or become a free text field where you enter 
information. 

Date: Enter the date the patient was assessed for ARV Stability. Click the drop-down 
list to select from a calendar. 

Stability: Click the drop-down list and select one of the options: Stable, Unstable, 
End Stage, Other. 
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ARV Regimen: Click the drop-down list and select one of the options: Changed, 
Unchanged. 

Comments: Add any comments regarding the ARV Stability data in the free text 
field. 

Last Edited By: The name of the person who last edited the record (system 
populated). 

Last Edited Date: The date the record was last edited (system populated). 

After you click Save, iCare confirms that you want to add the record. After clicking 
Yes, iCare populates the Last Edited By field (name of user who populated the 
record) and today’s date in the Last Edited Date. 

For ARV Stability, you can delete selected records by clicking the Delete  
button to display the Delete Rows information message. Click Yes to remove the 
records. Otherwise, click No to retain the records. 

10.13.3.4 State Notification 
This notification type involves the requirement to notify the appropriate state Health 
Department of new AIDS diagnoses; most states also required notification of HIV 
diagnoses as well. 

Expand the State Notification category to display the following fields on the State 
Notification group box: 

 
Figure 10-53: Fields on State Notification Group Box 

If the HMS Diagnosis is HIV or AIDS, then the fields in this group box are active. 

State HIV Report Status: Select the State HIV Report Status from the drop-down 
list: N/A, No, Remind Me Later, Unknown, Yes. This answers the question: Has the 
state health department been notified about this patient’s HIV status? 

State HIV Report Date: This field is active if the State HIV Report Status field 
contains Yes. You can select from a calendar by using the drop-down list. This is the 
date the State HIV status report was submitted to the state health department. 
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State HIV Acknowledgment Status: Select the State HIV Acknowledgment status 
from the drop-down list: No, Unknown, Yes. This answers the question: Has your 
facility received an acknowledgement from the state health department? 

State HIV Acknowledgment Date: This field is active if the State HIV 
Acknowledgment Status field contains Yes. You can select from a calendar by using 
the drop-down list. This is the date the state acknowledged receipt of HIV report, if 
any. 

State AIDS Report Status: Select the State AIDS Report Status from the drop-down 
list: N/A, No, Remind Me Later, Unknown, Yes. This answers the question: Has the 
state health department been notified about this patient’s AIDS status? 

State AIDS Report Date: This field is active if the State AIDS Report Status field 
contains Yes. You can select from a calendar by using the drop-down list. This is the 
date the AIDS status report was submitted to the state health department. 

State AIDS Acknowledgment Status: Select the State AIDS Acknowledgment 
status from the drop-down list: No, Unknown, Yes. This answers the question: Has 
your facility received acknowledgement from the state’s health department? NOTE: 
Most sites report that they do not receive this acknowledgment. 

State AIDS Acknowledgment Date: This field is active if the State AIDS 
Acknowledgment Status field contains Yes. You can select from a calendar by using 
the drop-down list. This is the date the state acknowledged receipt of AIDS report 

10.13.3.5 Save Button 
You use the Save button to save the care management information (entered or 
changed) in RPMS. Click the Save button to display the “Confirm save to Care 
Mgmt” information message where you are asked if you want to save the patient’s 
care management record in RPMS. Click Yes to save (otherwise, click No.) 

Below is one example of what happens after you click Yes. What displays after you 
click Yes depends upon if there is a tag status or not. 

After clicking Yes, you will receive a message asking about changing the tag status. 

 
Figure 10-54: Message About Changing Status 

If you click Yes, you go to the Update Diagnostic Tag dialog. 
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If you click No, the system displays the message “HMS Register data has been saved 
successfully to RPMS” and you need to click OK to dismiss the message. 

If you click Cancel, the system asks if you want to cancel the entire Save process. If 
you click Yes, you exit the save process. If you click No, you return to the message 
about changing the status. 

10.13.3.6 Reports 

The Main sub-tab provides reports. Click the drop-down list for the Reports  
button to select the type of report you want to view. Some options display another 
dialog where you further define the report; click OK when complete. The report 
displays in a pop-up window. Below is a sample Health Summary pop-up report 
using the All Reminders report parameter. 

 
Figure 10-55: Sample Health Summary Pop-up Report 

See Section 4.7 for more information about the pop-up. 

The following table provides an overview of what the reports are: 

Report Selection What You View 
Asthma Action Plan Asthma Action Plan report. 
Face Sheet Ambulatory Care Record Brief report. 
Health Summary You first select a summary type to view. For example, if 

you select Lab, you will view the DMS Lab Report 
Summary. 

Patient Wellness Handout You first select the report parameter that determine the 
Wellness Handout type. You view the selected patient 
wellness handout type report. 

Supplement You first select a supplement type to view. For 
example, if you select Diabetic Care Summary, you will 
view the Diabetic Patient Care Summary. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Patient Record 
August 2011 

311 

Report Selection What You View 
Women’s Health Profile - Brief Women’s Health Patient Profile that lists the date, 

procedure, results/diagnosis, and status (for female 
patients only). 

State Surveillance Adult HIV/AIDS Confidential Case Report to State 
(State Surveillance report in BKM) about the patient. 

HMS Patient Care Supplement HMS Patient Care Supplement report. 
State Surveillance (Blank) Adult HIV/AIDS Confidential Case Report to State 

about the patient. This option gets as much data from 
RPMS that is available. This allows the providers to 
review this report and manually correct any incorrect or 
missing data. Then the report is to be sent to the 
appropriate state agency. 

10.13.3.7 Glossary Button 
Click the Glossary button to access the HIV/AIDS / Care Management Glossary pop-
up. The glossary provides information about the HIV/AIDS Diagnostic Tag 
Definition, HMS Register Specific Data/ Patient Record, HMS Panel Layout Options, 
What is a Taxonomy?, HMS Supplement Logic, HMS Reminder Logic, and 
HIVQUAL Report Synopsis. These are sections that you can access individually 
within the glossary. See Section 15.3 for more information. 

See Section 4.7 for more information about the buttons and the File menu on the pop-
up. 

10.13.4 Reminders Sub-Tab 

 
Figure 10-56: Sample Reminders Sub-Tab on Care Management 

This display is like the one shown on the Reminders sub-tab of the patient record. See 
Section 10.6 for more information. 

If the patient does not have any HIV reminders, iCare displays the message: No 
Reminders Returned. (Click OK to dismiss the message.) 
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10.13.5 Patient with Asthma Tag 

 
Figure 10-57: Sample Patient with Asthma tag 

The Main sub-tab displays the existing Asthma Patient Care Summary (Supplement) 
report. See Section 4.7 for more information about the pop-up. The Asthma Care 
Management view does not include the Reminders sub-tab because there are no 
asthma-specific reminders. 

10.13.6 Care Management Tab Menus 
See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

The options on the File menu of the Care Management tab (both Main and Reminders 
sub-tabs) are the same as those on the Cover Sheet tab. See Section 10.3.7.1 for more 
information. 

10.13.6.1 Tools Menu for Main Sub-Tab 
The options on the Tools menu for the Main sub-tab of Care Management are the 
same as those for Cover Sheet tab. See Section 10.3.7.2 for more information. 

10.13.6.2 Tools Menu for Reminders Sub-Tab 
The options on the tools menu for the Reminders sub-tab are the same as those for the 
Flags tab. See Section 10.5.3.2 for more information. 

10.13.6.3 Care Mgmt Menu 
The options on the Care Management window (both Main and Reminders sub-tabs) 
are shown below. 
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Both Main and Reminders sub-tabs have the following options on the Care Mgmt 
Menu: 

Add Tag: This option works like the Add Tag button. See Section 10.13.1.2 for more 
information. 

Accept Tag: This option works like the Accept button. See Section 10.13.2.1 for 
more information. 

HIV/AIDS Management Guide: This option displays the iCare Population 
Management GUI window. See Section 15.0 for more information. 

10.13.6.3.1 Main Sub-Tab 
The Main sub-tab for the HIV/AIDS (Group): 

 
Figure 10-58: Care Mgmt menu options for HIV/AIDS 

Save: this option does the same things as the Save button on the Main sub-tab. 

Reports: this option lists the available report on the Main sub-tab. See 
Section 10.13.3.6 for more information. 

HIV/AIDS Management Guide: this option accesses information about HIV/AIDS 
management. See Section 15.0 for more information. 

The following option displays if you are on the Main sub-tab for Asthma group: 

Refresh: this option refreshes the Reminders sub-tab by retrieving the most up-to-
date information from the server. This is same as pressing the F5 key. 

10.13.6.3.2 Reminders Sub-Tab 
The Reminders option for the HIV/AIDS (Group): 
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Figure 10-59: Care Management Menu for the Reminders sub-tab 

Add Tag: this option works like on the action button on the Care Mgmt window. See 
Section 10.13.1.2 for more information. 

The following options display if you are the Reminders sub-tab: 

Recalc: this option gets the latest data from the server and to run the algorithm. 

Refresh: this option refreshes the Reminders sub-tab by retrieving the most up-to-
date information from the server. This is same as pressing the F5 key. 

HIV/AIDS Management Guide: this option accesses information about HIV/AIDS 
management. See Section 15.0 for more information. 

10.14 Referrals Tab 
The Referrals tab displays the referrals for the selected patient in the time range 
shown in the “Last” field. This data comes from the Referral Care Information 
System (RCIS). 

 
Figure 10-60: Sample Referrals tab 

The default display is in reverse order of date, with the most recent first. 

10.14.1 Referrals Tab Layout 
The data comes from the RCIS (Referred Care Information System). You can review 
the user manual at the following URL: 
http://www.ihs.gov/Cio/RPMS/index.cfm?module=home&option=documentschoice 

Select Referred Care Information System from the drop-down list. On the next page, 
select the User Manual. 

http://www.ihs.gov/Cio/RPMS/index.cfm?module=home&option=documentschoice
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You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

The following table provides information about the fields. 

Field Meaning 
Initiated Date The date that the referral was initiated. 
Referral Provider The provider who requested the referral for the patient. 
Purpose of Referral This is a narrative that describes the purpose of the referral. 
Outside Vender This is the name of the Outside vendor, such as outside providers, 

clinics, hospitals, labs etc. This information comes from the RCIS 
application. 

Expected Begin 
Date 

This applies to outpatient visits that is the expected begin date of 
service. 

Actual Appt Date The date that the appointment for the referral was scheduled for 
this patient. 

RCIS Status The RCIS status of the referral. 
Referral Type The type of referral that was made. This can be any of the 

following: 
IHS - a referral to another IHS facility 
CHS - a referral to an outside facility that will be paid for with CHS 
funds 
In-house - a referral to another clinical area within the facility 
Other - any other type of referral that will be paid with funds other 
than CHS (such as Medicaid or private insurance) 

Patient Type This is either inpatient or outpatient. 

10.14.2 Referrals Tab Toolbar Options 
The Last field determines the date range for the data. The default is one year. You can 
select a different predefined date range. 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

10.14.3 Referrals Tab Menus 
The options on the File menu of the Referrals tab are the same as those on the 
Reminders tab. See Section 10.6.3.1 for more information. 

The options on Tools Menu on the Referrals tab are the same as those on the Flags 
tab. See Section 10.5.3.2 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 
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10.15 DX Tags Tab 
The DX Tags tab displays the diagnostic tags information for the current patient. 
Diagnostic Tags are Predefined Diagnosis definitions (“tags”) that iCare has proposed 
for this patient, based on the tagging function. The display includes the relevant 
qualifying criteria data. 

 
Figure 10-61: Sample DX Tags tab 

Providers can review tags that were automatically assigned by the system, and then 
decide whether or not the provider wants to accept the tags as valid for the patient. 

This tab displays the “Active” tags for the patient, i.e., those tags having the Proposed 
or Accepted status. 

10.15.1 DX Tag Layout 
The data columns are described below. 

Column Meaning 
Tag Name The diagnostic tab name. You can view the tooltip by hovering your 

mouse over this column (shows the definition of the tag). 
Status The status of the tag. You can view the tooltip by hovering your mouse 

over this column. 
Date The date associated with the tag. 
Item This is where the tag was found (Visit or Problem). 
Value The value for the tag. The text that precedes the value determines what 

that value represent. For example: Problem: 250.00. 
Factor  This is defined through the Taxonomy listed or other (like BMI). 

 
Double-click any underlined date to access the Visit Detail pop-up. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

10.15.2 DX Tags Toolbar 
The patient diagnostic tags are current as of the date shown on the toolbar. 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 
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10.15.2.1 Recalc 

Click the Recalc  button (or select Diagnostic Tags | Recalc) to update any 
values from a logic algorithm by recalculating the logic with new data from the 
server. 

10.15.2.2 Change the Tag Status 
You can change the tag status by clicking the Accept, Not Accept, or Propose button 
(or selecting the options on the Diagnostic Tags menu). This causes the Update 
Diagnostic Tag dialog to display where you can change that tag status, select the 
reason for the change, and populate the Other (free text) field. See Section 10.13.2.1 
for more information about this dialog. 

When you are finished with this dialog, click OK to accept the changes. (Otherwise, 
click No.). You can view your changes in the grid of records on the DX Tags tab. 

10.15.2.3 Add Tag 

Click the Add Tag  button (or select Diagnostic Tag | Add Tag) to add a tag to 
the current patient. The Add Diagnostic Tag dialog will display. This is a manual add 
that allows a provider to manually assign one or more of the diagnosis tags to patients 
that did not meet the tag’s criteria for being proposed automatically. See 
Section 10.13.1.2 for more information about this dialog. 

10.15.2.4 Activity 
You can view existing tag activity about the patient by doing one of the following: 

• Click the Activity  button 

• Select Diagnostic Tags | Activity 
The RPMS iCare - Diagnostic Tag Activity pop-up displays. This is a view-only pop-
up. Multiple people can enter the tags, so this pop-up shows all of the activity. See 
Section 9.9.2.4 for more information about this pop-up. 

10.15.2.5 Background Jobs 
Click the Background Jobs  button to display the Background Jobs pop-up. See 
Section 4.10 for more information. 

10.15.3 DX Tags Tab Menus 
The options on the Diagnostic Tags menu operate like the action buttons on the 
toolbar. See Section 10.15.2 for more information. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Patient Record 
August 2011 

318 

The options on File menu on the DX Tags tab are the same as those on the Reminders 
tab. See Section 10.6.3.1 for more information. 

The options on Tools Menu on the DX Tags tab are the same as those on the 
Reminders tab. See Section 10.6.3.2 for more information. 

See Section 4.3 for information about the Edit, Window, and Help menus. 

10.16 Family HX Tab 
The Family HX tab displays any family history information about the patient. 

 
Figure 10-62: Sample Family HX tab 

This information comes from the Family History of the PCC patient record. 

10.16.1 Family HX Tab Layout 
You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

The following table provides a description of the fields. 

Column Meaning 
Relative This is the family history relationship, such as Brother. 
Relative Modifier This is the relative description, if any. 
Diagnosis Code This is the family history ICD code that best describes the 

diagnosis of the relative. 
Diagnosis Narrative This is the provider narrative that the provider entered. 
Age of Onset This is the age of onset of the condition. This can be In Infancy, 

Before Age 20, specific age range (such as 30-39), Age 
Unknown. 

Status This is the status of the relative: Living, Deceased, Unknown, 
Patient Refused To Answer. 

Age at Death If the status is Deceased, this is age of death of the relative. 
Cause of Death If the status is Deceased, this is the cause of death of the 

relative. 
Multiple Birth This determines is there was a multiple birth: Yes, No, Unknown. 
Provider This is the provider for this record. 
Last Date Modified This displays the date the record was modified (system 

populated). 
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10.16.2 Family HX Tab Toolbar 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

10.16.2.1 Add New Family History Record 
Click the Add Family HX button (or select Family HX | Add Family HX) to add a 
family history record for the current patient. The application displays the Add New 
Family History Record dialog. 

 
Figure 10-63: Sample Add New Family History Record dialog 

This dialog contains two areas: Add/Edit and Conditions. 

10.16.2.1.1 Add/Edit Area 
To add a new family history record, complete the fields in the Add/Edit area of the 
dialog. The field followed by an asterisk (*) is required. 

The following table provides information about the fields. 

Field Meaning 
Relative Select an option from the drop-down list that indicates the patient’s 

relative. 
Relative 
Modifier 

Populate this free text field with text the describes the relative. 
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Field Meaning 
Status Select an option from the drop-down list. This describes the status of 

the relative. 
Age at Death This field become active if you populate the Status field with Deceased. 

Use one of the options from the drop-down list. 
Cause of Death This field become active if you populate the Status field with Deceased. 

Use this free text field to describe the cause of death, if known. 
Multiple Birth 
Status 

Select an option from the drop-down list. 

Multiple Birth 
Type 

This field becomes active if you populate the Multiple Birth status with 
YES. Select an option that describe the type of multiple birth. 

10.16.2.1.2 Conditions Area 
To add family conditions, click the Add button in the Conditions area. This highlights 
a row in the Conditions grid. Each field has a drop-down list that you use to populate 
it. 

The following table provides information about the fields. 

Field Meaning 
Diagnosis Code Click the drop-down list to access the Select DX Code (Condition) 

dialog. Use this dialog to populate or clear the DX Code (Condition) 
field. See Section 4.18 for more information about this dialog. 

Diagnosis Narrative Use this free text field to enter the diagnosis narrative. 
Provider Click the drop-down list to access the Select Provider dialog. Use 

this dialog to populate or clear the Provider field. See Section 4.18 
for more information. 

Age at Onset Click the drop-down list and select an option. 
 

After all fields are populated, do one of the following: 

• Click OK to display the Confirm save to RPMS information message that asks 
if you want to save the data to the RPMS server. Click Yes to save (otherwise, 
click No). to save the data. 

• Click Cancel to not save and exit the Add/Edit process. 
To delete a condition record, highlight it and click Delete. The application displays 
the Delete Rows information message asking if you want to delete the selected rows. 
Click Yes to delete the rows (otherwise, click No to not delete). 

The File menu has one option that closes the dialog. 

The Help menu has an option that accesses the online help information for this dialog. 
In addition, it has another option that displays the version of the iCare GUI. 
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10.16.2.2 Edit Existing Family History Record Dialog 
Use the Edit Family HX button (or select Family HX | Edit Family HX) to change the 
selected record’s family history. The application displays the Edit Existing Family 
History Record dialog. 

 
Figure 10-64: Sample Edit Existing Family History Record dialog 

The fields on this dialog are the same as those on the Add New Family History 
Record dialog. See Section 10.16.2.1 for more information. 

10.16.2.3 Delete Family HX 
Use the Delete Family HX button (or select Family HX | Delete Family HX) to delete 
the selected record’s family history. The application displays the Delete Conditions 
Confirmation: Are you sure you want to delete this family history condition? Click OK to 
remove the record (otherwise, click Cancel to not remove it). 

10.16.2.4 Reassign Condition 
Use the Reassign Condition button (or select Family HX | Reassign Condition) to 
either select an exiting relative or to add a new one for the patient. The application 
displays the Reassign Conditions dialog. 
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Figure 10-65: Sample Reassign Condition dialog 

If you select an existing relative, click OK and the application displays a message that 
the selected family history condition records were reassigned. This action creates a 
new record with the “copied” information of the selected existing relative (the relative 
cell will be blank). 

If you select “Add NEW Relative” option, the application displays the Add New 
Family History Relative to Reassign Conditions dialog. This dialog has the same 
fields as the Edit Family HX dialog. See Section 10.16.2.2 for more information. 

10.16.3 Family HX Tab Menus 
The options on the Family HX menu operate like the action buttons on the toolbar. 
See Section 10.16.2 for more information. 

The options on the File menu of the Family HX tab are the same as those on the 
Reminders tab. See Section 10.6.3.1 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

The options on the Tools menu of the Family HX tab are the same as those on the 
Flags tab. See Section 10.5.3.2 for more information. 

10.17 Notes Tab 
The Notes tab displays the existing TIU notes for the current patient. 
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Figure 10-66: Sample Notes tab 

10.17.1 Notes Tab Layout 
The sort order is only by date, most recent date first. 

The following table provides information about the fields. 

Field Meaning 
Class The class of the note. 
Title The title of the note. 
Subject The subject of the note. 
Date of Note The date/time the note was written 
Author The person who wrote the note. 
Status The status of the note. 

 
If you double-click a record in the grid, the application displays a pop-up window 
showing information about the particular note. 

 
Figure 10-67: Sample Note pop-up 

See Section 4.7 for more information about the buttons and the File menu on this pop-
up. 
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10.17.2 Notes Tab Toolbar 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

You can determine the time range for the notes by selecting an option from the Time 
Frame drop-down list: 1 month, 3 months, 6 months, 1 year, 2 years, Ever (the default 
is 1 month). 

10.17.2.1 View Multiple Notes 
Use the View Multiple Notes button to select one or more notes from the grid and to 
display them together rather than having to open them one at a time. After clicking 
the View Multiple Notes button (or selecting Notes | View Multiple Notes), the 
application displays the Multiple Notes pop-up. 

 
Figure 10-68: Sample Multiple Notes pop-up 

This pop-up will contain notes with TIU headers and footers. 

See Section 4.7 for more information about the buttons and the File menu on this pop-
up. 

10.17.2.2 Print Notes 
Use the Print Notes button to print selected notes without TIU headers and footers. 
Highlight one or more selected notes from the grid and the click Print Notes (or select 
Notes | Print Notes). The application displays the notes in the Print Preview dialog. 
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Figure 10-69: Sample Print Preview dialog 

Each note (when using more than one note) will start on a new page. 

You can print the contents on the Print Preview dialog by selecting File | Print. 

The output will contain the date and time it was printed. 

10.17.3 Notes Tab Menus 
The options on the Notes menu operates like the View Multiple Notes and Print Notes 
buttons. 

The options on the File menu of the Notes tab are the same as those on the Reminders 
tab. See Section 10.6.3.1 for more information. 

See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

The options on the Tools menu of the Notes tab are the same as those on the Flags 
tab. See Section 10.5.3.2 for more information. 
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10.18 Suicide Form Tab 
The Suicide Form tab only displays for users who been assigned specific Behavioral 
Health (BH) permission keys. These keys are assigned through BH only, not through 
iCare User Access Management. 

 
Figure 10-70: Sample Suicide Form tab 

This tab displays the existing Suicide Reporting Forms (SRF) for the patient. When 
all of the fields are populated, this means the SRF is complete. 

Double-click any record in the grid to access the Suicide Form Detail. This pop-up 
provides information about the Suicide Form. 

 
Figure 10-71: Sample Suicide Form Detail pop-up 

Besides the patient demographic information, this pop-up displays data in the fields 
on the SRF. 

See Section 4.7 for more information about how to use the pop-up window. 

10.18.1 Suicide Form Tab Layout 
You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

The following provides a description of the fields. 
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Date of Act: The date of the suicide act. 

Suicidal Behavior: This is the type of suicidal activity for the suicide act. 

Method: The method used in the suicide act. 

User Created: The name of the provider who created the record. 

User Last Modified: The name of the provider who last modified the record. 

Date Last Modified: The date the record was last modified. 

10.18.2 Suicide Form Tab Toolbar 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

10.18.3 Suicide Form Tab Menus 
See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

The options on the File menu of the Suicide Form tab are the same as those on the 
Cover Sheet tab. See Section 10.3.7.1 for more information. 

The options on the Tools menu of the Suicide Form tab are: 

Quick Patient Search: This option allows you to search for a patient name. This is 
the same as using the F8 key on your keyboard. See Section 4.4 for more information. 

The Reset View, Refresh, Search, Excel Export, Print, Copy Rows to Clipboard 
options work like the buttons on the right side of the window. See Section 4.5 for 
more information. 

User Preferences: This options opens the User Preferences window. See Section 3.2 
for more information. 

Web Links: This option provides links to Web sites for related clinical guidelines. 
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11.0 CMET 
The Care Management Event Tracking (CMET) tab on the iCare main window 
provides information on Events, Tracked Events, and Follow-up Events. 

 
Figure 11-1: Sample CMET tab 

The data on the various sub-tabs are for those patients with an active HRN (Health 
Record Number). 

The CMET tab displays the statuses of particular tests/procedures/exams on the 
various sub-tabs. The term “event” refers to what needs to be completed, for example, 
Breast Exam. 

• These events are listed by category: Breast, Cervical, Colon, Skeletal. 

• The events apply to female and male patients. 
If two users are working on the same CMET record, the changes that are saved first 
will be applied. A message to the second user is provided: This record has just been 
updated. Do you want to refresh the entire list? Click Yes to refresh (otherwise, click No). 

Consider the following information: 
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When using the Startup View tab of User Preferences, you select the startup view you 
would like to see when opening iCare. If you select the CMET radio button, there will 
be a secondary field. Use this secondary field to define the default sub-tab, for 
example, Tracked Events. If you select the Split View radio button and select the 
Panel List and CMT option, use the secondary field to define the default sub-tab. This 
means, for example, when you open iCare, the view will be in split view and the 
Tracked Events sub-tab on the CMT tab will be on top. 

11.1 Events Sub-Tab 
The Events sub-tab displays all events that have been identified at your site in the 
routine background job. This can be a very large number of events, but you can limit 
this display by applying filters to your view. Filtering in this manner does not affect 
the routine background job. 

 
Figure 11-2: Sample Events sub-tab 

The information on this sub-tab is divided into three general areas: Tips information, 
Events data, and Filter area. 

The Tips information provides an overview of the sub-tab. You can collapse this 
information in order to have more room for viewing the Events data. 

The Filters area provides filters for applying filter criteria to the events data. You can 
collapse this area in order to have more room for viewing the events data. 
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Note: You can establish the default “collapse” status for the Tips 
and Filters areas on this sub-tab. To do that, select Tools | 
User Preferences | CMET tab | Events sub-tab. The check 
boxes on this sub-tab will establish the “collapse” status. 

The default filters are established on the CMET tab (Events sub-tab) of user 
preferences. These filters are: Category, Status, Time Frame, and Community. See 
Section 3.2.7.4 for more information. 

You can (also) filter the columns on the Events sub-tab. See Section 4.1.5 for more 
information. This is a temporary filter and will be lost once you exit the application. 

The initial Data Mining will return the most recent occurrence of every event found 
with an established timeframe. These events are displayed on the Events sub-tab. 

• The iCare and CMET package managers can establish the timeframe (referred 
to as the Tickler Timeframe). 

• See Section 4.22.1 for more information about the timeframes. 

11.1.1 Filters Group Box 
You can use the filter features shown in the Filters group box. This means you can 
filter the events by using one or more of the following: Category, Status, Time Frame, 
Community. Then, you must use the Get Events button to re-display the events. See 
Section 3.2.7.4 for more information about using the filters. 

Get Events: If you change the filters in the Filters group box, click the Get Events 
button to update the display. 

Save: After you have changed the filters using the filter features in the Filters group 
box and you want these to be the default filters, click the Save button. This means 
those filters will be in effect when you use iCare in another session. This action 
changes the filters in User Preferences (on the CMET tab). 

Restore to User Pref: If you used the CMET filter features in the Filters group box 
and you want to return to the last-saved CMET filters in User Preferences, click the 
“Restore to User Pref” button. 

11.1.2 Events Sub-Tab Layout 
The data on the Events sub-tab is effective as of the date/time on the toolbar. 

You can sort/filter the columns and perform other functions on the columns on this 
layout. See Section 4.1 for more information. 
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Figure 11-3: Sample Columns on Events sub-tab 

The following table provides information about the columns on the Events sub-tab. 

Column Name Meaning 
Category The name of the category for the event: Breast, Cervical, Colon, 

Skeletal. 
Patient Name Required field and will link to the Events sub-tab of the CMET tab on 

the Patient Record if you double-click on it. 
HRN Patient’s Health Record Number. 
Sex F (for female) or M (for male) 
Age Patient’s age today. 
DOB Patient’s date of birth. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this 

field to empanel patients. 
Community Patient’s community of residence. 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for 

this patient, based on the tagging function (Proposed or Accepted). 
Event Name The name of the event. Events are procedures, exams, or tests that 

have been documented in RPMS. Events are predefined.. 
Event Date The date associated with the event. 
Result The date of the result of the event. This cell also has hover help, 

such as V Radiology. 
Status The status of the event: Pending, Superseded, Tracked, or Not 

Tracked. 
Status Comments Text of the any comments about the status. 
Last Modified 
Date/Time 

The date the event was last modified 

Last Modified By The name of the person who last modified the event (in some cases 
it will read: Initial job). 

 
The default sort order is: Category, Date of Event (newest listed first), Patient Name 
(in alphabetical order). 

If a Community cell contains the Community Alert  icon, you can view the 
Community Alert text by hovering your mouse over the icon. The icon does not affect 
the sorting of the Community column. 

You can view the CMET - Visit Detail pop-up for any underlined date in the Event 
Date column by double-clicking the date. 

You can view a particular detail pop-up for any underlined date in the Result column, 
for example, CMET – Women’s Health Detail. 
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If there exists an older event with a status of Pending and a new event comes in, the 
application changes the status of the older event to Superseded. You cannot track this 
type of event. 

The system default template for this sub-tab is established in User Preferences, using 
the Layouts tab and the Events field. 

11.1.3 Buttons on Events Sub-Tab 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

Please consider the following: 

When you change the status of an event, that event will not display on the sub-tab. 
The event is still there. In order to view it, change the Status field in the Filters group 
box. For example, if you changed the status of an event to Tracked, you would 
change the Status to Tracked (or All) and then click Get Events. 

11.1.3.1 Track 
The Track function requires the iCare Editor (BQIZCMED) security key. Select one 
or more events with a status of Not Tracked or Pending and then click the Track 
button (or select Track on the right-click menu). 

Once an event has been Tracked, it cannot be changed to Not Tracked. If the 
particular event was changed to Tracked and that is not correct, you need to go to the 
Tracked tab, then access the CMET worksheet for the event you tracked in error. 

If you select events that are not eligible for the Tracked function, the application 
displays the message: Events having a status of Tracked can’t be changed to Tracked. 
Click OK to dismiss the message. 

If you select only one eligible event, the application displays the RPMS iCare - Track 
- Findings Due Date dialog. 

 
Figure 11-4: Sample RPMS iCare - Track - Findings Due Date dialog 
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If you selected more than one eligible event, the application displays the RPMS iCare 
- Track - Findings Due Date dialog (for multiple events). 

 
Figure 11-5: Sample RPMS iCare - Track - Findings Due Date dialog for multiple events 

In either case, do the following: 

• Make sure that the correct date is in the Findings Due Date field (required). If 
you need to change it, click the drop-down list to access a calendar (where 
you can select another date). The date cannot be earlier than the current date. 

• Type the text of the reason for changing the status to TRACKED in the free 
text field (not required). 

• Click Save to save the information (otherwise, click Cancel to not save). 
When you use Save, this changes the status of the events to Tracked. These 
events will display on the Tracked events sub-tab of the main window as well 
as on the Tracked Events sub-tab of the Patient Record window. 

If you use the “Save and Enter Findings” button for a single event, the application 
displays the CMET Worksheet (where you can add Findings to the event, for 
example). See Section 4.20 for more information. After saving the worksheet, you 
return to the Events sub-tab. 

11.1.3.2 Don’t Track 
Use the Don’t Track function to change the status of a Pending event to Not Tracked. 
Select the events and click Don’t Track (or select Don’t Track on the right-click 
menu). 

If you select Tracked events, they are not eligible for the Not Tracked function. In 
this case, the application displays the message: Once an event has been Tracked, it 
cannot be changed to Not Tracked. See the User Manual guidance on how to manage an 
event that was tracked. Click OK to dismiss the message. If the selected Tracked event 
was erroneously tracked in error, see Section 4.20.6 for more information. 

If you selected eligible events, the application displays the RPMS iCare – Don’t 
Track Event dialog. 
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Figure 11-6: Sample RPMS iCare – Don’t Track Event dialog 

Type a reason for the change in the free text field (not required). Click OK to save 
(otherwise, click Cancel to not save). If you use OK, this changes the Status of the 
events to Don’t Track. 

11.1.3.3 Pend 
Use the Pend function to change the status of a Not Tracked event to Pending. Select 
the events and then click the Pend button (or select Pend on the right-click menu). 

If you select events that are not eligible for the Pend function, the application displays 
the message: Only events with status of Not Tracked can change to Pending. Click OK to 
dismiss the message. 

If you selected eligible events, the application displays the RPMS iCare – Pend Event 
dialog. 

 
Figure 11-7: Sample RPMS iCare – Pend Event dialog 

Type a reason for the change in the free text field (not required). Click OK to save 
(otherwise, click Cancel to not save). If you use OK, this changes the Status of the 
events to Pending. 

11.1.3.4 Batch Process 
The Batch Process only applies to screening mammograms and pap smears with 
normal results. This process can be applied to multiple events. Although it can be 
applied to one event, its purpose is to be applied to multiple events. 
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The CMET Package Manager sets the parameters for batch processing for the entire 
site. The Batch Process function requires the iCare Editor (BQIZCMED) security 
key. 

The Batch Process works only on events that are Pending. 

• If you selected a mammogram screening or pap smear event that is not Pending, 
the application displays the Invalid selection message: Please select only PENDING 
Events in order to process these as a batch. Click OK to dismiss the message. 

• If you have selected a event that is not a mammogram screening or pap smear, the 
application displays the Invalid Selection message: The event type selected is not 
eligible for batch processing. Please reselect. Click OK to dismiss the message. 

Select either the mammogram screening events or the pap smear events that you want 
to batch process. Then, click the Batch Process button (or select Batch Process on the 
right-click menu) to batch process the selected events and to change the Status/State 
to Closed. (The selected events must be of the same type of event, either all 
mammogram screenings or all pap smears.) 

• If you selected the mammogram screening events that are eligible for this process, 
the application displays the CMET Batch Mammogram Screening dialog. See 
Section 11.1.4 for more information. 

• If you selected the pap smear events that are eligible for this process, the 
application displays the CMET Batch Pap Smear dialog. See Section 11.1.5 for 
more information. 

11.1.3.5 Create a Panel 
Use the Create Panel function to create a panel from selected events. The patients 
associated with the events become the patients in the new panel. Select the events and 
then click the Create Panel button (or select Create Panel on the right-click menu) to 
access the Create Panel dialog. 

 
Figure 11-8: Create Panel dialog 

You can change the name of the new panel in the New Panel Name free text field. 
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Click OK to create the panel (otherwise, click Cancel). After the create process 
finishes, the application displays a message: Panel created successfully! Click OK to 
dismiss the message. The new panel is listed on the Panel List window. It uses the 
“No Predefined Population Search - Add Patients manually” population search 
option. 

11.1.3.6 Status of Background Jobs 
To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs  button 

• Select File | Background Jobs 
This displays the RPMS iCare - Background Jobs window. See Section 4.10 for more 
information. 

11.1.4 CMET Batch Mammogram Screening Dialog 
The batch process for mammogram screenings changes the events to have a Status of 
Tracked, the Event State of Closed, and the Close Reason of Event Complete. 

 
Figure 11-9: Sample CMET Batch Mammogram Screening dialog 
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After completing the dialog, click OK to save the data on the dialog. (Otherwise, 
click Cancel to not save.) 

11.1.4.1 Fields on Dialog 
The required fields have the asterisk (*) following the name. 

Status: This is the status of the event (view only). 

Event Finding: This indicates the event finding. The drop-down list contains the 
options to populate/change this field. 

Finding Interpretation: This field provides the interpretation of the finding (view 
only). 

Follow-up Event: This is the follow-up event (view only). 

Follow-up In: This is the timeframe for the follow-up. The drop-down list contains 
the options to populate/change this field. 

Notification Type: This is the type of patient notification for the event. Select an 
option from the drop-down list. The options on the drop-down list are defined by the 
application (sites cannot add values). 

Create: the Create button is active when the Notification Type is Letter or Certified 
Letter. This function requires that you have an electronic signature on file. Click the 
Create button to access the Add New TIU Note - Batch Mode dialog. See 
Section 4.24.3 for more information. 

Notification Date: This is the date for the patient notification. The drop-down list 
contains a calendar from which to select a date. 

Event State: This shows the state of the event (view only). 

Close Reason: This is the reason why the status is closed (view only). 

Comment: Use this free text field to enter any comments pertaining to the 
mammogram screenings. 

11.1.4.2 Selected Events Group Box 
The Selected Events group box contains the selected patients for batch processing 
(these are the events you selected for the process). This is read-only information. 
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Figure 11-10: Sample Selected Events group box 

11.1.5 CMET Batch Pap Smear Dialog 
The batch process for pap smears changes the events to have a Status of Tracked, the 
Event State of Closed, and the Close Reason of Event Complete. 

 
Figure 11-11: Sample Batch Pap Smear dialog 

After completing the dialog, click OK to save the data. (Otherwise, click Cancel to 
not save.) 

11.1.5.1 Fields on Dialog 
The fields with the asterisk (*) following the name are required. 

Status: This field displays the status of the event (view only). 
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Event Finding: This indicates the event finding. Select an option from the drop-down 
list. 

Finding Interpretation: This provides the interpretation of the finding (view only). 

Follow-up Event: This displays the follow-up event (view only). 

Follow-up In: This is the timeframe for the follow-up. The drop-down list contains 
the options to populate/change this field. 

Notification Type: This is the type of patient notification for the event. Select an 
option from the drop-down list. The options on the drop-down list are defined by the 
application (sites cannot add values). 

Create: the Create button is active when the Notification Type is Letter or Certified 
Letter. This function requires that you have an electronic signature on file. Click the 
Create button to access the Add New TIU Note - Batch Mode dialog. See 
Section 4.24.3 for more information. 

Notification Date: This is the date for the patient notification. The drop-down list 
contains a calendar from which to select a date. 

Event State: This shows the state of the event (view only). 

Close Reason: This is the reason when the status is closed (view only). 

Comment: Use this free text field to enter any comments pertaining to the pap smear 
screenings. 

11.1.5.2 Selected Events Group Box 
The Selected Events group box contains the selected patients for batch processing 
(these are the events you selected for the process). This is read-only information. 

 
Figure 11-12: Sample Selected Events group box 
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11.2 Tracked Events Sub-Tab 
The Tracked Events sub-tab shows the events that are coming up; they will become 
CMET reminders. This sub-tab displays all events at your site that have been 
designated as “Tracked” by all CMET users. This can be a very large number of 
events, but you can limit this display by applying filters to your view. Filtering in this 
manner does not affect the routine background job. 

 
Figure 11-13: Sample Tracked Events sub-tab 

The information on this sub-tab is divided into three general areas: Tips information, 
Tracked Events data, and Filter area. 

The Tips information provides an overview of the sub-tab. You can collapse this 
information in order to have more room for viewing the Tracked Events data. 

The Filters area provides filters for applying filter criteria to the tracked events data. 
You can collapse this area in order to have more room for viewing the tracked events 
data. 

Note: You can establish the default “collapse” status for the Tips 
and Filters areas on this sub-tab. To do that, select Tools | 
User Preferences | CMET tab | Tracked Events sub-tab. The 
check boxes on this sub-tab will establish the “collapse” 
status. 
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The default filters are established on the CMET tab (Events sub-tab) of user 
preferences. These filters are: Category, State, Time Frame, and Community. See 
Section 3.2.7.5 for more information. 

You can (also) filter the columns on the Tracked Events sub-tab. See Section 4.1.5 for 
more information. This is a temporary filter and will be lost once you exit the 
application. 

11.2.1 Filters Group Box (Tracked Events) 
You can use the filter features shown under the Filters group box. This means you can 
filter the events by using one or more of the following: Category, State, Time Frame, 
Community. Then you must use the Get Events button to re-display the events. See 
Section 3.2.7.5 for more information about using the filters. 

The Get Events, Save, and Restore to User Pref buttons work like those on the Events 
sub-tab. See Section 11.1.1 for more information. 

11.2.2 Tracked Events Sub-Tab Layout 
The data on the Tracked Events sub-tab is effective as of the date/time on the toolbar. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

The following table provides information about the columns on the Tracked Events 
sub-tab. 

Column Name Meaning 
Category The name of the category for the tracked event: Breast, Cervical, 

Colon, Skeletal. 
1 - Event The name of the event. Events are procedures, exams, or tests that 

have been documented in RPMS. Events are predefined. 
Event Date The date the event was performed. 
Result The date the result was entered. Hover help will describe where the 

result came from (V-RADIOLOGY, V-LAB). 
2 - Finding(s) Icon that indicates if the event has any Findings. 
Interpretation The interpretation of the selection in the Result field. There is hover 

help for this field, e.g., CMET, that refers to where the interpretation 
was obtained. 

3 - Follow-up(s) Icon that indicates if the event has any follow-up data. 
4 - Patient 
Notification(s) 

Icon that indicates if the event has any patient notification data. 

State The state of the tracked event (open or closed). The default is OPEN. 
Patient Name Required field and will link to the Tracked Events sub-tab of the 

CMET tab on the Patient Record if you double-click on it. 
HRN Patient’s Health Record Number (required). 
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Column Name Meaning 
DOB Patient’s date of birth (required) 
Age Patient’s age today. 
Sex F (for female) or M (for male) 
Community Patient’s community of residence. 
Designated PCP Designated Primary Care Provider, if any. Not all facilities use this 

field to empanel patients. 
Active DX Tags Predefined Diagnosis definitions (“tags”) that iCare has proposed for 

this patient, based on the tagging function (Proposed or Accepted). 
Tracked By The person who tracked the event. 
Tracked When The date the event was tracked. 

 
The Finding(s) cell can contain the following: 

• the “feather”  icon indicates that entry of a Finding is overdue based on 
the tickler time frames. Hover your mouse over the icon to view the Due Date. 

• the check  icon indicates that the Finding has been entered. Hover your 
mouse over the icon to view the Finding Due date and the Finding Value. 

• an empty cell that indicates that a finding has not been entered and is not past 
due. 

The Follow-up(s) cell can contain the following: 

• the “feather”  icon indicates that entry of recommended follow-up is 
overdue based on Tickler timeframes. Hover your mouse over the icon to 
view the Due Date. 

• the check  icon indicates that follow-up has been entered. Hover your 
mouse over the icon to view the Follow-up Date and the Follow-up type. 

• an empty cell that indicates that a decision regarding the Follow-up has not 
been entered and is not past due. 

The Patient Notification(s) cell can contain one of the following: 

• the “feather”  icon indicates that the type of patient notification is overdue 
based on Tickler timeframes. Hover your mouse over the icon to view the Due 
Date. 

• the check  icon indicates that the type of Patient Notification has been 
entered. Hover your mouse over the icon to view the notification date and 
type. 

• an empty cell that indicates that the type of Patient Notification has not been 
entered but is not past due. 

Remember that Finding(s), Follow-up(s), and Patient Notification(s) are entered on 
the CMET Worksheet. 
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If a Community cell contains the Community Alert  icon, you can view the 
Community Alert text by hovering your mouse over the icon. The icon does not affect 
the sorting of the Community column. 

You can view the CMET -Visit Detail pop-up for any underlined date in the Event 
Date column by double-clicking the date. See Section 4.7 for more information about 
this type pop-up. 

Double-click the underlined date in the Result Date column to access a particular 
detail pop-up, for example, Women’s Health Detail. 

The system default template for this sub-tab is established in User Preferences, using 
the Layouts tab and the Tracked Events field. 

11.2.3 Buttons on Tracked Events Sub-Tab 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

11.2.3.1 Reopen 
Use the Reopen function to change a Closed event to Open. Select only one event 
having a State of Closed and then click the Reopen button (or select Reopen on the 
right-click menu). The application displays the RPMS iCare – Reopen Tracked Event 
dialog. 

 
Figure 11-14: RPMS iCare – Reopen Tracked Event dialog 

Type the reason for changing the state back to Open in the free text field (not 
required). When the dialog is complete, click OK (otherwise, click Cancel to not 
save). When you use OK, this changes the State for the event to Open. 

If you select more than one event and use the Reopen function, the application 
displays the warning message: Please reselect as only one event can be reopened at one 
time. Click OK to close the warning message and select only one event. 
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11.2.3.2 Close 
Use the Close function to change an Open event to Closed. Select the events with a 
State of Open and then click the Close button (or select Close on the right-click 
menu). The application displays RPMS iCare – Reason for Closing dialog. 

 
Figure 11-15: RPMS iCare – Reason for Closing dialog 

The fields with the asterisk (*) following the name are required. 

Reason: select an option from the drop-down list: Event Complete, Patient Moved, 
Lost to Follow-up, Other (this option requires a comment). 

Comment: this free text field is required when the Reason = Other. Type the text of 
the reason. 

When the dialog is complete, click OK (otherwise, click Cancel to not save). When 
you use OK, this changes the State for the selected events to Close. 

11.2.3.3 Batch Process 
The Batch Process only applies to screening mammograms and pap smears with 
normal results. This process works on Open events that have empty (no ticklers or 
check marks) in the Findings, Follow-up, and/or Patient Notifications columns. 

If you select events that are not eligible for the Batch Process, the application displays 
the message: Please select only Tracked Events without Findings, Follow-ups, or Notifications 
in order to process these as a batch. Click OK to dismiss the message. 

Select one or more eligible events and click the Batch Process button (or select Batch 
Process on the right-click menu). 

• For mammogram screenings, see Section 11.1.4 for more information. 
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• For pap smears, see Section 11.1.5 for more information. 

11.2.3.4 Open CMET Worksheet 
Select a event and then click the Open CMET Worksheet button (or select Open 
CMET Worksheet on the right-click menu) to access the CMET Worksheet (for the 
event). Here you can enter Finding(s), Follow-up(s), and Patient Notification(s) for 
the event. See Section 4.20 for more information. Note: this function can be applied 
to only one event. 

11.2.3.5 Create Panel 
Use the Create Panel function to create a panel from the selected events. The patients 
associated with the events become the patients in the new panel. Select the events and 
then click the Create Panel button (or select Create Panel on the right-click menu). 
See Section 8.3.1.1 for more information. 

11.2.3.6 Status of Background Jobs 
To check on the status of the background jobs, do one of the following: 

• Click the Background Jobs  button 

• Select File | Background Jobs 
This displays the RPMS iCare - Background Jobs window. See Section 4.10 for more 
information. 

11.3 Follow-up Events Sub-Tab 
The Follow-up Events sub-tab contains events that you determined what you want to 
do for follow-up. This sub-tab displays all of the follow-up events at your site that 
have been generated by all CMET users. This can be a very large number of events, 
but you can limit this display by applying filters to your view. Filtering in this manner 
does not affect the routine background job. 
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Figure 11-16: Sample Follow-up Events sub-tab 

The information on this sub-tab is divided into three general areas: Tips information, 
Follow-up Events data, and Filter area. 

The Tips information provides an overview of the sub-tab. You can collapse this 
information in order to have more room for viewing the Follow-up Events data. 

The Filters area provides filters for applying filter criteria to the follow-up events 
data. You can collapse this area in order to have more room for viewing the follow-up 
events data. 

Note: You can establish the default “collapse” status for the Tips 
and Filters areas on this sub-tab. To do that, select Tools | 
User Preferences | CMET tab | Follow-up Events sub-tab. 
The check boxes on this sub-tab will establish the 
“collapse” status. 

You can (also) change the filters on the columns on the Follow-up Events sub-tab. 
See Section 4.1.5 for more information. This is a temporary filter and will be lost 
once you exit the application. 
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11.3.1 Filters Group Box (Follow-up Events) 
You can use the filter features shown under the Filters group box. This means you can 
filter the events by using one or more of the following: Category, Time Frame, 
Community. Then, you must use the Get Events button to re-display the events. See 
Section 3.2.7.4 for more information about using the filters. 

The Get Events, Save, and Restore to User Pref buttons work like those on the Events 
sub-tab. See Section 11.1.1 for more information. 

11.3.2 Follow-up Events Sub-Tab Layout 
The data on the Follow-up Events sub-tab is effective as of the date/time on the 
toolbar. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

The following table provides information about the columns on the Follow-up Events 
sub-tab. 

Column Name Meaning 
Category The name of the category for the follow-up event: Breast, Cervical, 

Colon, Skeletal. 
Follow-up Event 
Name 

The name of the event. This is the recommended follow-up entered 
in CMET. 

Follow-up Event 
Date 

The date of the recommended follow-up. 

Preceding Event This is the date of the preceding event. When you double-click on the 
underlined date, the application opens to the Tracked Events of the 
CMET tab on the Patient Record. The chain of events in the same 
category is revealed. In addition, there is hover help when you move 
your mouse over the date (for example, PAP SMEAR). 

Patient Name This is the name of the patient. 
HRN Patient’s Health Record Number. 
DOB Patient’s date of birth. 
Age Patient’s age today. 
Sex F (for female) or M (for male) 
Community Patient’s community of residence. 

 
If a Community cell contains the Community Alert  icon, you can view the 
Community Alert text by hovering your mouse over the icon. The icon does not affect 
the sorting of the Community column. 

If you double-click any event (not on the Preceding Event cell), the application 
displays the CMET Worksheet for the event. See Section 4.20 for more information. 
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The system default template for this sub-tab is established in User Preferences, using 
the Layouts tab and the Follow-up Events field. 

11.3.3 Buttons on Follow-up Events Sub-Tab 
See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

The Create Panel, Open CMET Worksheet, and Status of Background Jobs buttons 
work like those on the Tracked Events sub-tab. See Section 11.2.3 for more 
information. 

11.4 Menus on the CMET Tab 
See Section 4.3 for more information about the options on the Edit, Window, and 
Help menus. 

11.4.1 File Menu 
The File menu has the following options: 

CMET: this shows various options depending on the sub-tab you are currently on. 

The remaining options are the same as those on the File menu for the Panel List 
window (except the Panel option). See Section 6.3.1 for more information. 

11.4.2 Tools Menu 
The options on the Tools menu are the same as those on the Tools menu for the Panel 
List window. See Section 6.3.2 for more information. 

11.4.3 View Menu 
The option on the View menu is: 

Split View: When this option is checked, that means that the current view is the split 
view. You can change back to the CMET tab by removing the checkmark; this is a 
temporary setting. When you exit iCare and reopen iCare, the settings established in 
User Preferences (Startup View tab) are used for the default view. 
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12.0 Notifications 
The user can receive notifications about certain actions that have taken place in iCare. 
For example, the panel creator decides to delete a panel. A deleted panel that was 
shared will no longer appear on the panel list of the shared users or the panel creator. 
All users with shared access to the panel will receive notifications that the panel was 
deleted. Another way to look at this is iCare will support notifications to users when 
panel content has been or will be significantly altered. 

When you have new notifications, you receive an information message informing you 
that you have some new notifications and asks if you want to view them now. Click 
Yes to view the notifications (on the iCare Notifications window.) (Otherwise, Click 
No). 

12.1 iCare Notifications Window 

 
Figure 12-1: Sample iCare Notifications Window 

Note: You can access the iCare Notifications window by 
selecting Tools | View iCare Notifications on the Panel List 
window. 

The New Notification  indicator in the first column shows those notifications that 
are new. 

You can sort/filter the columns and perform other functions on the columns. See 
Section 4.1 for more information. 

12.2 iCare Notifications Toolbar Buttons 
This section reviews the buttons of the Notifications toolbar. 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 
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12.2.1 Select All 
You can select all of the notifications on the iCare Notifications window by doing one 
of the following: 

• Clicking the Select All  button 

• Selecting Edit | Select All 

• Selecting the “Select All” option on the right-click menu 

12.2.2 Delete 
You can delete the selected notifications by doing one of the following: 

• Clicking the Delete  button 

• Selecting Edit | Delete 

• Selecting the “Delete” option on the right-click menu 
The “Confirm notification delete” dialog displays, asking you if you want to delete 
the selected notifications. Click Yes to remove the selected notifications from the list. 
(Otherwise, click No.) 

12.3 iCare Notifications Menus 
The options on the File Menu are: 

Page Setup: This option allows you to set Margin, Paper, Layout characteristics (like 
landscape or portrait orientation), and the Printer to use. 

Print Preview: This option displays the print preview dialog showing the selected 
rows in the grid. 

Print: This option sends the page to the printer using the settings in Page Setup. 

Close: This option closes the iCare Notifications window. 

The Edit menu contains the Delete and Select All options. They work like the action 
buttons on the iCare Notifications window. See Sections 12.2.1 and 12.2.2. 

The Tools menu contains the Reset View, Refresh, Search, Excel Export, Copy Rows 
to Clipboard. These options work like the button on the right-side of the window. See 
Section 4.10 to review the functions of the buttons on the toolbar. 
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13.0 Nat’l Measures 
The Nat’l Measures window displays IHS national clinical performance measure as 
defined and reported in the RPMS Clinical Reporting System (CRS). iCare uses CRS 
performance logic to display whether the patients in the facility are meeting annual 
performance goals. 

The Nat’l Measures window applies to the facility listed in the toolbar of this 
window. 

 
Figure 13-1: Sample Nat’l Measures window 

The data was updated on the date shown below the window’s toolbar. 

This view is the same as that of the Natl Measures tab on Panel View except that 
Nat’l Measures on the main view applies to the whole facility. 

13.1 Nat’l Measures Layout 
The Nat’l Measures window has the following data columns: 

Category: the name of the category, Developmental, National GPRA, Non-National, 
or Other National. 

Clinical Group: the name of the clinical performance group. 

Measure Name: the measure title derived from the Summary Report. There is hover 
help when you move your mouse over a cell in this column. 
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# Patients in Denominator: the total number of patients in this measure who meet 
the denominator definition. 

# Patients in Numerator: the total number of patients in this measure who meet the 
numerator definition. 

% Met: the percentage of the panel who meet the measure, derived by dividing the 
denominator total by numerator total. 

year Goal: the value will be the same as the one that displays in the “GPRA” column 
on the Summary Page from the CRS National GPRA report. The “year” is the most 
recent year with final goals recorded. 

IHS Current National Performance: the value will be the same as the one that 
displays in the “Nat’l” column on the Summary Page from the CRS National GPRA 
report. 

You can sort and/or filter any column, re-arrange the order of the columns, etc. See 
Section 4.1 for more information. 

13.2 Nat’l Measures Toolbar 

 
Figure 13-2: Toolbar of Nat’l Measures window 

The Nat’l Measures apply the name of the facility logged into. 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

The toolbar buttons and menu options determine what actions you can take on this 
window. 

13.2.1 Background Jobs 
Click the Background Jobs  button (or select File | Background Jobs) to display the 
Background Jobs pop-up. See Section 4.10 for more information. 

13.2.2 Graph It! Button 
Use the Graph It! Button (or select File | National Measures | Graph It! or Tools | 
Graph It!) to produce a graph of selected rows in the grid. 

After clicking the button, the application displays the Charting – National Measures 
window. 
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Figure 13-3: Sample Charting – National Measures window 

The x-axis is the % Met and the Current Goal. 

The y-axis shows the percentage data range. 

Most of the features of this graph are similar to graphing measurement data. See 
Section 4.17 for more information. 

13.3 Nat’l Measures Menus 
The File, Edit, and Tools menus for the Nat’l Measures window are reviewed below. 

The View Menu on Nat’l Measures has the same options as those on Panel List. See 
Section 6.3.3 for more information. 

See Section 4.3 Menus for more information about the options on the Edit, Window, 
and Help menus. 

13.3.1 File Menu 
The File menu options (except National Measures) operate like the options on the File 
menu of Panel List. See Section 6.3.1 for more information. 
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National Measures: the options on this sub-menu function the same as the buttons on 
the toolbar. 

13.3.2 Edit Menu 
The Edit menu has the following options: 

Select All: use this option to select all of the rows in the grid. 

Deselect All: use this option to deselect all of the currently selected rows in the grid. 

13.3.3 Tools Menu 
The Tools menu options (except Graph It!) operate like the options on the Tools 
menu for Panel List. See Section 6.3.2 for more information. 

Graph It!: this option operates like the Graph It! button on the toolbar. 
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14.0 Meaningful Use 
The Meaningful Use window provides information about the Meaningful Use 
objectives and measures for providers as well as hospitals/CAHs. The Meaningful 
Use team has developed logic related to Meaningful Use (MU) objectives and clinical 
quality measures. This logic is utilized to perform background jobs to obtain related 
data for display. 

 
Figure 14-1: Sample Meaningful Use window 

Meaningful Use is a new initiative to improve the health of the nation. To achieve 
meaningful use, healthcare providers and hospitals must meet criteria created by the 
Office of the National Coordinator (ONC) and the Centers for Medicare and 
Medicaid Services (CMS). 

You can find more information about Meaningful Use on the following website: 
http://www.ihs.gov/recovery/index.cfm?module=dsp_arra_meaninful_use 

14.1 Meaningful Use Layout 
The date displayed above the grid is the most recent background job. 

You can sort, filter, etc. the columns. You cannot move the columns from one 
objective to another, however. But you can move the columns within one objective. 
For example, you could move the Current and Previous columns under the 
Demographics objective. See Section 4.1 for more information. 

The layout information is provided for each tab on the Meaningful Use window. 

http://www.ihs.gov/recovery/index.cfm?module=dsp_arra_meaninful_use
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14.1.1 Providers Performance 

 
Figure 14-2: Sample Providers Performance tab 

The user types included on this tab are displayed above the grid. The Meaningful Use 
Manager defines the user classes (used in the Background Jobs process). 

Provider: the name of the provider. 

Type: the type of provider. The Meaningful Use Manager determines if the “Type” 
will display. 

Each of the remaining columns has hover help that defines the meaning of the data in 
the particular column. Each column is further divided into Current and Previous 
periods. Each Current and Previous column has hover help that displays the time 
frame for that period (for example, Jan 12, 2011 – Apr 12, 2011). 

14.1.2 Hospitals/CAHs Performance 

 
Figure 14-3: Sample Hospitals/CAHs Performance tab 
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The number of active patients is displayed above the grid. 

Objective: The meaningful use objective. 

Measure Set: Displays either Measure Set or Core. 

• Core means that every hospital or provider must be able to meet the measure. 

• Menu Set is a list of optional measures that the hospital or provider will 
choose from. 

Stage 1 Goal: The percentage of the Stage 1 goal. The target is >30%. 

Current: There is hover help for this cell that defines the date range (for example, 
Jan 12, 2011 – Apr 12, 2011). This part of the table applies to the current date range 
and is divided into the following columns: 

# Patients in Denominator: the total number of patients in this objective who 
meet the denominator definition. 

# Patients in Numerator: the total number of patients in this objective who meet 
the numerator definition. 

% Met: the percentage of the patients who meet the measure, derived by dividing 
the denominator total by numerator total. 

Previous: There is hover help for this cell that defines the date range (for example, 
Oct 13, 2010 – Jan 11, 2011). This part of the table applies to the previous date range 
and is divided into the following columns: 

# Patients in Denominator: the total number of patients in this objective who 
meet the denominator definition. 

# Patients in Numerator: the total number of patients in this objective who meet 
the numerator definition. 

% Met: the percentage of the patients who meet the measure, derived by dividing 
the denominator total by numerator total. 

14.1.3 Providers CQ (Clinical Quality) 
The Providers CQ (Clinical Quality) window displays how meaningful use and other 
initiatives have improved the care that the patients received. These measures are 
reported for each provider, shown in the Provider column. 

Providers are required to report on three core measures and three to five additional 
measures that vary depending on the provider’s specialty of care (for Stage 1). For 
Stage 1, meaningful use and providers are not required to meet any targets. 
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Figure 14-4: Sample Providers CQ tab 

The user types included on this tab are displayed above the grid. The Meaningful Use 
Manager defines the user classes (used in the Background Jobs process). 

Provider: the name of the provider. 

Each of the remaining columns define the various criteria for the providers, with each 
criteria divided into Current and Previous. There is hover help for the Current cell 
(and the Previous cell) that defines the date range for the data. 

14.1.4 Hospitals/CAHs CQ (Clinical Quality) 
The Hospitals/CAHs CQ (Clinical Quality) window displays how meaningful use and 
other initiatives have improved the care that the patients received. These measures are 
reported for each hospital. 

Hospitals are required to report on a set of 35 Medicare inpatient measures and 
potentially 8 Medicaid inpatient measures (for Stage 1). For Stage 1, meaningful use 
and hospitals are not required to meet any targets. 
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Figure 14-5: Sample Hospitals/CAHS CQ (Clinical Quality) tab 

The number of active patients is displayed above the grid. 

Objective: The meaningful use objective. 

Measure Set: Displays either Menu Set or Core. 

• Core means that every hospital or provider must be able to meet the measure. 

• Menu Set is a list of optional measures that the hospital or provider will 
choose from. 

Stage 1 Goal: The percentage of the Stage 1 goal. The target is >30%. 

Current: There is hover help for this cell that defines the date range (for example, 
Jan 12, 2011 – Apr 12, 2011). This part of the table applies to the current date range 
and is divided into the following columns: 

# Patients in Denominator: the total number of patients in this objective who 
meet the denominator definition. 

# Patients in Numerator: the total number of patients in this objective who meet 
the numerator definition. 

% Met: the percentage of the patients who meet the measure, derived by dividing 
the denominator total by numerator total. 

Previous: There is hover help for this cell that defines the date range (for example, 
Oct 13, 2010 – Jan 11, 2011). This part of the table applies to the previous date range 
and is divided into the following columns: 
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# Patients in Denominator: the total number of patients in this objective who 
meet the denominator definition. 

# Patients in Numerator: the total number of patients in this objective who meet 
the numerator definition. 

% Met: the percentage of the patients who meet the measure, derived by dividing 
the denominator total by numerator total. 

14.2 Meaningful Use Toolbar 
The following information applies to all of the tabs on the Meaningful Use window. 

 
Figure 14-6: Meaningful Use toolbar 

Time Frame: the value determines the time frame for the data in the grid. The Time 
Frame field has two options: 90 days and 1 year. The default is 90 days. If you 
change to the one year period, this will be remembered upon subsequent logins. The 
Meaningful Use Manager defines the default time frame. 

Click the Background Jobs  button (or select File | Background Jobs) to display the 
Background Jobs pop-up. See Section 4.10 for more information. 

See Section 4.5 to review how to use the buttons on the right side of the toolbar. 

14.3 Meaningful Use Menus 
The File, Edit, and Tools menus for the Meaningful Use window are reviewed below. 

The View Menu on Meaningful Use has the same options as those on Panel List. See 
Section 6.3.3 for more information. 

See Section 4.3 Menus for more information about the options on the Edit, Window, 
and Help menus. 

14.3.1 File Menu 
The File menu options (except Meaningful Use) operate like the options on the File 
menu of Panel List. See Section 6.3.1 for more information. 

Meaningful Use: the options on this sub-menu function like the buttons on the 
toolbar. 
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14.3.2 Edit Menu 
The Edit menu has the following options: 

Select All: use this option to select all of the rows in the grid. 

Deselect All: use this option to deselect all of the currently selected rows in the grid. 

14.3.3 Tools Menu 
The Tools menu options operate like the options on the Tools menu for Panel List. 
See Section 6.3.2 for more information. 
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15.0 HIV/AIDS Management Guide 
The purpose of this section is to provide you with the information you need to use the 
iCare (BQI) population management application, specifically for the care and 
management of Patients Living With HIV/AIDS (PLWH/A). In 2005, the Indian 
Health Service developed and deployed a software application related to the care of 
this population. That software, HIV Management System (HMS) has now been 
integrated in the iCare GUI. The original roll and scroll version will no longer be 
available for use. 

This section contains reference information about iCare views, examples of its 
processes, and step-by-step procedures to show you how to perform the activities 
supported by the application, specifically for HIV/AIDS patient management. 

15.1 Introduction 
AIDS (Acquired Immunodeficiency Syndrome) was first reported in the United States 
in 1981 and has since become a major worldwide epidemic. AIDS is caused by HIV. 
By killing or damaging cells of the body’s immune system, HIV progressively 
destroys the body's ability to fight infections and certain cancers. People diagnosed 
with AIDS can get life-threatening diseases called opportunistic infections, which are 
caused by microbes such as viruses or bacteria that usually do not make healthy 
people sick. 

More than 1 million cases of AIDS have been reported in the United States since 
1981. Reports show that 21 percent of those infected with HIV are unaware of their 
infection. The epidemic is growing most rapidly among minority populations. 

iCare provides Indian Health Service/Tribal/Urban (I/T/U) healthcare providers with 
another tool for improving the care and management of PLWH/A as well as those 
who are at risk for the disease. 

This section has been developed for physicians, mid-level practitioners, nurses, and 
case managers responsible for the care of this population. It provides descriptions of 
and instructions for the following: 

• The setup and maintenance of the site-populated taxonomies related to 
specific medications and laboratory exams. 

• The entry of HIV/AIDS-specific patient data. 

• The creation and population of panels with PLWH/A patients living with 
HIV/AIDS. 

• Report generation. 
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• Clinical decision support such as Reminders, Best Practice Prompts, and 
Performance Measures. 

15.2 Key Functional Features 
iCare does not duplicate the data from any other RPMS component. All data 
displayed in or entered will pass to and reside in the appropriate underlying RPMS 
component (e.g., PCC, HMS). 

Key functional features of iCare include the following: 

• The ability to identify a group of patients based on the HIV/AIDS Diagnostic 
Tag definition. 

• The ability to create and manage a panel of patients living with HIV/AIDS 
and/or At Risk patients. 

• The ability to automatically repopulate the panel with new patients who meet 
the definition. 

• An HIV/AIDS Health Supplement that presents condition-specific patient 
data. 

• An HIV Quality of Care report for population and/or individual that provides 
care statistics that can be used to evaluate care at the local level and sent to the 
Area and/or Headquarters as requested. 

• The incorporation of artificial intelligence algorithms to provide reminders for 
tests, immunizations and other procedures related specifically to HIV/AIDS. 

• The provision of both population and patient management and reporting 
capabilities. 

• The identification of patients for state/CDC surveillance reporting. 
Using iCare and accessing sensitive patient data requires compliance with all 
procedures related to the security of protected health information. 

15.3 Using the HIV/AIDS Glossary 
The HIV/AIDS Glossary is a valuable reference tool that can assist you with 
managing HIV/AIDS patient data. For example, you could reference the glossary to 
determine why you might be receiving CD4 reminders or to see what the logic is 
behind the Quality of Care report. 

The HIV/AIDS Glossary describes in detail the logic and definitions pertaining to the 
following information: 

• The HIV/AIDS Diagnostic Tag definition 
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• The HIV/AIDS specific data entry 

• The panel layout options for the HIV/AIDS Care Management tab 

• Taxonomy maintenance 

• The HIV/AIDS Health Supplement logic 

• The HIV/AIDS Reminder logic 

• The HIV/AIDS Quality of Care Report logic 

The glossary will deepen your understanding of the HIV/AIDS-related data used in 
iCare; therefore, you might want to consider printing this glossary for easy reference 
when entering and interpreting data related to this population. 

To open the glossary: 

1. Open the Help menu. 

2. Select Care Management Glossaries. 

3. Select HIV/AIDS Glossary. 

4. The glossary opens. Use the Find function to navigate quickly to the topics you 
are looking for. 

15.4 Taxonomy Management 
This section describes the purpose of taxonomies, and how to view, edit, and add a 
site-populated taxonomy. 

15.4.1 What is a Taxonomy 
A taxonomy is the RPMS structure that holds the codes or terms that comprise any 
clinical definitions used by iCare and other RPMS clinical applications to calculate 
reminders and construct reports. 

iCare is similar to other clinical applications that use programmed logic (algorithms 
or artificial intelligence) to compute due and overdue HIV/AIDS-related reminders 
and other calculations related to constructing a complex report. See Appendix D for 
detailed algorithm logic used by iCare. The logic is composed of individual 
definitions of clinical elements, such as tests, immunizations, or diagnoses. 

In order to provide comparable reminders and reporting across all I/T/U facilities, as 
much logic as possible is based on standard national codes. These codes include 
ICD-9, CPT, LOINC, drug class and national IHS standard codesets (e.g., Health 
Factors, patient education codes, or exam codes). For lab test and medication 
terminology that is not standardized across each facility, iCare uses taxonomies that 
are populated by each individual facility with its own codes. 
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Therefore, there are two different types of taxonomies distributed: software-defined 
(“hard-coded”) and site-populated. 

15.4.2 Taxonomy Nomenclature 
Codes and terms contained in a taxonomy are referred to as “members” of the 
taxonomy. 

The names of the taxonomies generally describe the type of content. Each type of 
code (CPT, ICD, etc.) requires a separate taxonomy. The following terms are 
typically used in the taxonomy name: 

• CPTS: CPT codes for procedures, tests, etc. 

• CVX: standardized immunization codes maintained by the CDC and used by 
the RPMS Immunization application 

• DXS: ICD9 codes used to describe diagnoses in the RPMS Purpose of Visit 
(POV) or Problem List 

• FACTORS or HLTH FACTORS: IHS Health Factor codes 

• LOINC: standardized codes used to identify lab tests, in addition to the site-
populated lab test taxonomies 

• NDCS: NDC (National Drug Classification) codes used to identify 
medications, in addition to the site-populated medication taxonomies 

• PROC or PROCEDURES: ICD9 Procedure codes 
See Appendix C for a complete list of clinical definitions and associated taxonomies. 
Note that some of the taxonomies are new, while many have been in existence for 
quite some time and are used throughout RPMS. 

15.4.3 Software-Defined (Hard-coded) Taxonomies 
One clinical definition might be comprised of multiple code types with corresponding 
multiple taxonomies. For data elements like diagnoses, procedures, or lab tests 
identified by LOINC codes, a taxonomy is created for each code type within a 
definition that contains the standard codes that a software program should look for. 
These codes are hard-coded by the programmer into software-defined taxonomies that 
are distributed with the software. These taxonomies are defined nationally and cannot 
be modified at the local level. An example of a software-defined taxonomy is BGP 
CPT PAP that contains the list of CPT codes that define a pap smear. 

You should become familiar with the contents of the taxonomies in order to 
understand how your site can better document patient events. If you feel that an 
existing, nationally defined taxonomy requires editing, the user should contact the 
OIT Help Desk. 
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15.4.4 Site Populated Taxonomies 
Site-populated taxonomies are used to moderate the variations in terminology for 
medication and laboratory test names from one facility to another. PCC programs 
cannot deal with variations in spelling, spacing, and punctuation. Rather than 
attempting to find all potential spellings of a particular medication, the application 
looks in a specified taxonomy for the exact medication names that have been entered 
by that site. 

Site-populated taxonomies are distributed without content, that is, the taxonomies are 
“empty.” The individual facility will enter all medication or lab test names used at 
that particular facility. This means that one site’s Hepatitis B test data, called Hep B 
Surface Antigen, can be compared to another site’s test called Hbsag Hep B Surface 
Ant. Or, one site’s NRTI medication data can be compared to another site, even 
though the same names are not used for these medications (“Zidovudine 100MG 
Cap” or “Zidovudine Cap/100 MG”). 

If there is content in an existing site-populated taxonomy, it will not be 
overwritten/deleted in iCare. 

iCare uses many site-populated taxonomies and some must be populated by a user 
with Taxonomy Editor access. Any taxonomy that does not currently exist on your 
server will be created on the server when the software was loaded, but there will not 
be any members (lab or med names) in them until they have been added, i.e., these 
new taxonomies will be empty. 

Important Note: Taxonomy Editors must work with the 
pharmacist and the laboratory director at their facilities to 
identify the correct data to be added into these taxonomies. 

A separate table for the laboratory and the medication site-populated taxonomies are 
provided below to use as a checklist. 

Taxonomy names beginning with “BGP” are created and “owned” by the Clinical 
Reporting System (CRS) and should already be populated on your server. However, 
you should still plan to review the content for all site-populated taxonomies to ensure 
that they are accurate. 

Note: All taxonomies should be reviewed for completeness and 
potential updates before running any functions. 
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15.4.4.1 Lab Test Taxonomies 
The following is a list of lab taxonomies that must be populated by the site. It is 
recommended that you consult with your laboratory supervisor in order to include all 
lab tests that are being performed at your site. Each taxonomy has examples of 
common names for these lab tests, which can assist you in locating all appropriate 
tests for your site. 

Note: To provide the most accurate reporting, you should include 
all test names that have been used by your facility at least 
since 1995, even if these codes are currently inactive. Some 
measures search for tests as far back as 10 years, e.g., 
tuberculosis. 

 Many sites designate inactive lab tests by adding one of the 
following characters at the beginning of the test name: “z,” 
“Z,” “xx,” “X,” or “*.” Search for these characters in your 
lab file and include these tests in your site-populated 
taxonomies because these tests can have been in use at one 
time. 

The following table provides taxonomy names, their description, examples of 
member and associated CPT codes. Please note the column labeled “Example of 
Members” are just example; your site might or might not use this terminology. 

Taxonomy Name Description Example of 
Members 

Associated 
CPT Code 

BGP CD4 TAX All test names related 
to any element of a 
CD4 Lab Test, used to 
evaluate immune 
system status (Also 
known as: T4 count, T-
helper cells) 
This taxonomy is used 
to determine that a 
patient had the test, 
but is not used to 
determine the test 
result (see BKM CD4 
ABS TAX below). This 
taxonomy is also used 
by CRS 
NOTE: do NOT include 
HIV panels in this 
taxonomy. 

CD4 Cells 
CD4 Lymphocytes 
CD4 Absolute or ABS 
CD4 
Helper T-Lymphocyte 
Marker 
T-Lymphocyte Helper / 
Suppressor Profile 
T-Cell Activation 
Profile 

86359, 
86360, 86361 
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Taxonomy Name Description Example of 
Members 

Associated 
CPT Code 

BGP CHLAMYDIA 
TESTS TAX 

All lab tests for 
Chlamydia 
trachomatis, including 
panels 

Chlamydia Culture 
Chlamydia IgG 
Chlamydia IgM 
Chlamydia Screen 
Chlamydia, DNA 
Probe 
Chl/Gc Combo 
Chlamydia & 
Gonorrhea Probe 
Pap/HPV/Chlam/Gono
rrhea Combo 

86631; 
86632; 
87110; 
87270; 
87320; 
87490-87492; 
87810 

BGP HIV TEST TAX All lab tests to test for 
HIV 
NOTE: make sure you 
are NOT including any 
test name that is 
actually referring to an 
HIV panel (see CD4 
and/or HIV Viral Load) 

HIV Test 
HIV Screen 
HIV Proviral DNA 
HIV-1; by EIA; Abs by 
EIA 
HIV-2 by PCR; 
HIV2QUAL by PCR 

86689, 
86701-86703, 
87390, 
87391, 
87534-87539 

BGP HIV VIRAL LOAD 
TAX 

All HIV viral load tests 
(as measured by PCR 
or comparable test); 
used to assess 
prognosis of disease 
progression and to 
monitor the efficacy of 
antiretroviral therapy 
by measuring changes 
in HIV-1 RNA levels 
during the course of 
therapy. 
This taxonomy is also 
used by CRS. 
NOTE: do NOT include 
HIV panels in this 
taxonomy. 

HIV Viral Load 
HIV RNA QNT 

87536, 87539 

BGP LIPID PROFILE 
CPTS 

Lipid Profile includes: 
Cholesterol, HDL, LDL 
and Triglycerides 

Lipid Panel 80061 

BGP PAP SMEAR 
TAX 

All Pap Smear tests Pap Smear 
Pap/HPV/Chlam/Gono
rrhea Combo 

88141-88167, 
88174-88175, 
Q0091 
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Taxonomy Name Description Example of 
Members 

Associated 
CPT Code 

BKM CD4 ABS TAX Only CD4 Absolute 
tests. This taxonomy is 
used to identify the 
absolute count, or 
numeric value, of the 
result, which is a key 
identifying value for the 
health status of a 
patient. Any test 
included in this 
taxonomy should also 
be included in the BGP 
CD4 TAX (all CD4 lab 
tests). 
NOTE: do NOT include 
panels in this 
taxonomy. 

CD4 Absolute 
ABS CD4 
CD4 Lymphocytes 

86361 

BKM CMVTEST TAX All lab tests for 
Cytomegalovirus 
(CMV) 

CMV 
CMV Ab, IgG, 
Quantitative 
CMV Antibodies 
CMV by DFA, Direct 
Detection 
CMV Culture 
CMV DNA 
CMV IgG 
CMV IgM 
CMV PCR 
Rapid Viral Culture 
CMV 

86644, 
86645, 
87271, 
87496, 87497 

BKM COCCI 
ANTIBODY TAX 

All lab tests for 
Coccidioides 
Antibodies 

Coccidioides 
Coccidioides 
Antibodies 

86635 

BKM FTA-ABS TEST 
TAX 

All FTA-ABS 
(Fluorescent 
Treponemal Antibody 
Absorption) Tests to 
confirm syphilis 

FTA-Ab 
FTA-ABS 
TP-PA Antibodies 

86781 

BKM GONORRHEA 
TEST TAX 

All lab tests for 
gonorrhea (Neisseria 
gonorrhoeae) 

Gonorrhea, DNA 
Probe 
Chlamydia & 
Gonorrhea Probe 
GC Culture 
GC-PCA 

87081, 
87590-87592, 
87850 

BKM HEP A TAX Lab tests to assess 
Hepatitis A virus 
infection 

Hepatitis A antibody 
(HAAb) 
IgM antibody 

86708; 86709 
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Taxonomy Name Description Example of 
Members 

Associated 
CPT Code 

BKM HEP B TAX Lab tests to assess 
hepatitis B virus 
infection; evaluation of 
possible immunity in 
individuals who are at 
increased risks for 
exposure 
NOTE: do NOT include 
Hepatitis Panel as a 
member of this 
taxonomy 

Anti-HBe; HBeAb 
HBV DNA PCR 
Hep B Carrier Screen 
w/AFP 
Hep B Core AB, IgM 
Hep B Surface Ab 
Titer; Hbsab 
Hep B Surface 
Antibody; Hbsab 
Hep B Surface 
Antigen; Hbsag 
Hep B Tests 
Hepatitis B Core 
Antibodies 
Screen For Hep B 
Vaccination 

86704-86707; 
87340-87350, 
87515-87517 

BKM HEP C 
SCREENING TAX 

Includes any initial 
screening lab tests for 
Hepatitis C used at 
your site. Hep C 
confirmation tests 
should be included in 
the Hep C RIBA 
taxonomy below. 
NOTE: do NOT include 
Hepatitis Panel as a 
member of this 
taxonomy 

Hepatitis C Virus AB 
HCV-Ab HEP 
Anti HCV 

86803, 87520 

BKM HEP C 
CONFIRMATORY TAX 

Includes any 
confirmatory lab tests 
for Hepatitis C, 
including RIBA 
(Recombinant 
Immunoblot Assay), 
RNA Viral Load or 
Genotype. 
NOTE: do NOT include 
Hepatitis Panel as a 
member of this 
taxonomy 

Hepatitis C Virus 
Antibody 
Supplemental Testing; 
Hep C RIBA 
Recombinant 
Immunoblot Assay 
HCV RNA 
Hep C RNA 
NAT 
Hep C Genotype 

86804, 
87521, 87522 
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Taxonomy Name Description Example of 
Members 

Associated 
CPT Code 

BKM HEPATITIS 
PANEL TAX 

To include Hepatitis 
Panels only, containing 
Hepatitis A antibody, 
IgM; hepatitis B core 
antibody, IgM; hepatitis 
B surface antigen; 
hepatitis C virus 
antibody 
NOTE: do NOT include 
the individual 
component parts of the 
panel in this taxonomy 

Hepatitis Panel 
Acute Hepatitis Panel 

80074 

BKM PPD TAX Any PPD skin test for 
tuberculosis. 
NOTE: PPDs are 
generally recorded 
through the skin test 
function of the 
Immunization 
application 

 86580, 
86585, 
87555-87557 

BKM RPR TAX All lab tests for Syphilis 
(Rapid Plasma Reagin 
(RPR)) 

RPR 
RPR Quant 

86592, 
86593, 87285 

BKM 
TOXOPLASMOSIS 
TESTS TAX 

All lab tests for 
Toxoplasmosis 

Toxoplasma 
Toxoplasma IgG or 
IgM 

86777, 86778 

BKMV HIV 
GENOTYPE TESTS 
TAX 

Genotype tests for 
drug resistance 
NOTE: most sites are 
not currently using this 
test 

HIV Genotype 
Resistance Testing 
Retroviral Genotype 

87901 

BKMV HIV 
PHENOTYPE TESTS 
TAX 

Phenotype tests for 
drug resistance 
NOTE: most sites are 
not currently using this 
test 

HIV Phenotype 87903 

15.4.4.2 Medication Taxonomies 
The following medication taxonomies will need to be populated by the HMS Package 
Manager with the drug names that are included on your site’s formulary. The table 
below includes the list of drugs that should be considered. Some sites might not have 
medications for all the taxonomies. HMS Package Managers should consult with their 
site pharmacists to ensure accurate population of the medication taxonomies. 
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Abacavir (Ziagen, ABC) X           
Didanosine (Videx, Videx EC) X           
Emtricitabine (Emtriva) X           
Lamivudine (Epivir) X           
Lamivudine 
/Abacavir (Epzicom) X           
Stavudine (Zerit) X           
Tenofovir (Viread) X           
Zalcitibine (Hivid) X           
Zidovudine (Retrovir) X           
Zidovudine 
/Lamivudine (Combivir) X           
Zidovudine 
/Lamivudine 
/Abacavir (Trizivir) X           
Delaviridine (Rescriptor)  X          
Efavirenz (Sustiva)  X          
Nevirapine (Viramune)  X          
Etravirine (TMC-125) (Intelence)  X          
Tenofovir 
/Emtricitabine (Truvada)   X         
Tenofovir 
Emtricitabine/Efavirenz (Atripla)    X        
Amprenavir (Agenerase)     X       
Atazanavir (Revataz)     X       
Fosamprenavir (Lexiva)     X       
HGC Saquinavir (Invirase)     X       
Indinavir (Crixivan)     X       
Lopinavir /Ritonavir (Kaletra)     X       
Nelfinavir (Viracept)     X       
SCG Saquinavir (Fortovase)     X       
Tipranovir (Aptivus)     X       
Darunavir (Prezista)     X       
Ritonavir (Norvir)      X      
Enfurviritide (Fuzeon)       X     
Maraviroc (Selzentry)       X     
Raltegravir (Isentress)        X    
Atovaquone (Mepron)         X   
Dapsone          X   
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Pentamidine, Pentam 300, Pentacarinate 
(NebuPent)         X   
Sulfamethaxazole & 
Trimethoprim/Cotrimoxazole 
(Bactrim; Septra)         X   
Trimethoprim (Proloprim, Trimex)         X   
Trimetrexate, Glururonate &Leucovorin 
(Neutrexin)         X   
Azithromycin (Zithromax)          X  
Clarithromycin (Biaxin, Klacid)          X  
Rifabutin (Mycobutin, Ansamycin)          X  
Ethambutol (Myambutol)           X 
Isoniazid (INH)           X 
Pyrazinamide           X 
Rifamate           X 
Rifampin           X 
Rifater           X 
Streptomycin           X 
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Appendix A:  iCare Predefined Diagnosis Definitions 
Asthma (defined by CRS) 

Patients with at least 2 POVs ever (not on the same date) or 1 instance on Active 
Problem List. Asthma defined as ICD 493.00-493.92 (BGP ASTHMA DXS 
taxonomy) 

COPD (defined by CRS) 

Patients with at least 2 POVs ever (not on the same date) or 1 instance on Active 
Problem List. COPD defined as ICD 491.20-491.21; 496.*; 506.0-506.9 (BGP COPD 
DXS taxonomy) 

CVD Known (CVD Kn) (defined by Dr. Galloway and CVD Workgroup) 

The patient is categorized with Known CVD if any of the following criteria are met: 

1. One instance ever of specific cerebrovascular or peripheral vascular disease 
diagnoses or CABG or PCI/PTCA. Defined as ICD 431.*, 433.*1, 434.*1, 435.3, 
440.3*, 557.1 (BQI KNOWN CVD-1 DXS taxonomy); ICD Procedures 36.1*, 36.2 
(BGP CABG PROCS taxonomy); CPT 33510 -33519; 33521 -33523; 33533 -33536; 
35600, 33572 (BGP CABG CPTS taxonomy); ICD Procedures 36.01, 36.02, 36.05, 
36.06, 36.09 (BGP CMS PCI-PTCA PROCEDURES taxonomy); CPT 33140, 92980-
92982, 92984, 92995, 92996 (BGP CMS PCI-PTCA CPTS taxonomy). 

OR 

2. Two instances ever (not on the same date) of Acute Myocardial Infarction (AMI) 
(1 instance can be an Active Problem List) at least 90 days apart but no more than 2 
years between first (most recent) and last diagnosis. AMI defined as ICD 410.*0; 
410.*1 (BGP AMI DXS (HEDIS) taxonomy). 

OR 

3. Three different instances of Ischemic Heart Disease (IHD) on same day (1 
instance can be an Active Problem List); defined as ICD 411.*, 413.*, 414.* (BQI 
IHD DXS taxonomy). 

OR 
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4. Three instances of any Ischemic Heart Disease (IHD) or other specific 
cerebrovascular or peripheral vascular disease at least 90 days apart but no more than 
5 years between first and last diagnosis (1 instance can be an Active Problem List). 
Defined as ICD 411.*, 413.*, 414.* (BQI IHD DXS taxonomy); ICD 430.*; 432.*; 
433.*; 434.*; 435.*; 436.*; 437.*; 440.*; 441.* (BQI KNOWN CVD-MULT DXS 
taxonomy); ICD Procedures 38.34, 38.44, 38.64, 39.71 (BQI KNOWN CVD-MULT 
PROCEDURES taxonomy); CPT 0001T, 0002T, 0033T, 0034T, 0035T, 0036T, 
0037T, 33877, 34800, 34802, 34804, 34830, 34831, 34832 (BQI KNOWN CVD-
MULT CPTS taxonomy) 

CVD At Highest Risk (CVD AHR) (defined by Dr. Galloway and CVD Workgroup) 

The patient is categorized as CVD At Highest Risk if he/she is not categorized with 
Known CVD and meets either of the following criteria: 

1. Known Diabetes: the patient has 2 POVs ever (not on the same day) or 1 instance 
on Active Problem List. Defined as ICD 250.00-250.93 (Surveillance Diabetes 
taxonomy) 

OR 

2. End stage renal disease (ESRD) OR with dialysis: the patient has at least 2 
instances ever (not on the same day) or 1 instance on Active Problem List. Defined as 
ICD 585.6, V45.1 (BGP ESRD DXS taxonomy) or CPT 90918-90925 (BGP ESRD 
CPTS taxonomy) 

CVD At Significant Risk (CVD ASR) (defined by Dr. Galloway and CVD 
Workgroup) 

The patient is categorized as At Significant Risk if he/she is not categorized with 
either Known CVD or At Highest Risk and meets either of the following criteria. 

1. greater than (>) age 18 and at least 2 CVD Risk Factors 

OR 

2. Male equal to or greater than (≥) age 45 OR Female equal to or greater than (≥) 
age 55; and at least 1 CVD Risk Factor 

A risk factor is defined as any one of the following: 

A. Current Smoker: the patient has at least 2 POVs ever (not on the same date) or 1 
instance on the Active Problem List or most recent tobacco Health Factor or Dental 
(ADA) code 1320. Smoking defined as ICD 305.1; 301.10; 305.13; V15.82 (BGP 
GPRA SMOKING DXS taxonomy) or health factors Current Smoker, Current 
Smoker & Smokeless, Cessation Smoker, Cessation Smoker and Smokeless (BGP 
SMOKING HLTH FACTORS taxonomy) 
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B. Prediabetes Metabolic Syndrome: the patient has at least 2 POVs ever (not on the 
same date) or on 1 instance on the Active Problem List. Defined as ICD 277.7 (BGP 
PRE DM MET SYN DX taxonomy) 

C. Hypertension: the patient has at least 3 POVs separated by 90 days or 1 instance 
on the Active problem list. Defined as ICD 401.0 -401.9 (BGP HYPERTENSION 
DXS taxonomy) 

D. Obese: The patient’s most recent BMI is equal to or greater than (≥) 30 

E. High Blood Pressure: 2 of last 3 non-ER blood pressures are Systolic equal to or 
greater than (≥) 140 or Diastolic equal to or greater than (≥) 90 

F. Most recent HDL lab test is less than (<) 40 for men or less than (<) 45 for 
women. HDL defined by the site in DM AUDIT HDL TAX taxonomy or pre-defined 
LOINC codes (BGP HDL LOINC CODES) 

G. Evidence of High Cholesterol: defined as any one of the following: 

1. Prescription for Statin medication in the past year, defined by the site in the DM 
AUDIT STATIN DRUGS taxonomy or pre-defined NDC or class codes (BQI 
STATIN MEDS CLASS or BQI STATIN NDC taxonomies). 

2. Hyperlipidemia: at least 2 POVs ever (not on the same date) or 1 instance on the 
Active Problem List. Defined as ICD 272.0-272.9 (BQI HYPERLIPIDEMIA DXS 
taxonomy). 

3. LDL lab test value equal to or greater than (≥) 160 in past five years. Test is 
defined by the site in DM AUDIT LDL CHOLESTEROL TAX taxonomy or pre-
defined LOINC codes (BGP LDL LOINC CODES taxonomy). 

4. Total cholesterol value equal to or greater than (≥) 240 in past five years. Test is 
defined by the site in DM AUDIT CHOLESTEROL TAX taxonomy or pre-defined 
LOINC codes (BGP TOTAL CHOLESTEROL LOINC taxonomy). 

5. Non HDL equal to or greater than (≥) 190 in past five years, defined as value of 
Total Cholesterol minus value of HDL, both results documented on the same date. 

H. Evidence of Nephropathy: defined as any one of the following: 
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1. Patients with at least 2 instances (POV, Procedure or CPT) or 1 instance on 
Active Problem List in past 5 years. Defined as ICD 250.40-250.43; 403.0-405.01; 
405.11; 405.91; 581.81; 582.9; 583.81; 584.5-586.; 588.0-588.9; 753.0-753.19; 791.0; 
V42.0; V45.1; V56.0-V56.8 (BGP NEPHROPATHY DXS taxonomy) or ICD 
Procedures 39.27; 39.42-39.43; 39.53; 39.93-39.95; 54.98; 55.4-55.69 (BGP 
NEPHROPATHY PROCEDURES taxonomy) or CPTs 36800-36815; 36818-36821; 
50300; 50320; 50340; 50360; 50370-50380; 90920-90921; 90924-90937; 90945-
90947; 90989; 90993; 90997; 90999; 99512 (BGP NEPHROPATHY CPTS 
taxonomy) 

2. Creatinine test results equal to or greater than (≥) 2.0 over past year, separated by 
at least 90 days. Creatinine test defined by the site in DM AUDIT CREATININE 
TAX taxonomy or pre-defined LOINC codes (BGP CREATININE LOINC CODES). 

3. Estimated GFR values less than or equal to (<=) 30 over past year, separated by at 
least 90 days. Estimated GFR test defined by the site in BGP GPRA ESTIMATED 
GFR TAX taxonomy or by LOINC code 33914-3. 

CVD At Risk (CVD AR) 

Patients NOT in CVD Known, Highest or Significant Risk categories who are Male 
equal to or greater than (≥) age 45 OR Female equal to or greater than (≥) age 55. 

Diabetes (DM) 

Patients with at least 2 POVs ever (not on the same date) or 1 instance on Active 
Problem List. Diabetes defined as ICD 250.00-250.93 (SURVEILLANCE 
DIABETES taxonomy) 

HIV/AIDS (HIV) 

Patients with at least 2 POVs ever (not on the same date) or 1 instance on Active 
Problem List. HIV/AIDS defined as ICD 042.-44.9; 795.71; V08 (BGP HIV/AIDS 
DXS). 

Hypertension (HTN) 

Patients with at least 2 POVs ever (not on the same date) or 1 instance on Active 
Problem List. Hypertension defined as ICD 401.0-401.9 (BGP HYPERTENSION 
DXS taxonomy). 

Obese 
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Adult patients (ages 19 and older) with most recent adult BMI equal to or greater than 
(≥) 30. Values for patients ages 18 and under are based on standard tables. BMI is not 
a stored value but is calculated at the time the logic is run, based on the most recent 
height and weight data in the Measurement file. For ages 18 and under, a height and 
weight must be taken on the same day in the past year. For ages 19 through 50, height 
and weight must be recorded within last 5 years, not required to be on the same day. 
For ages over 50, height and weight within last 2 years but not required to be 
recorded on same day. 

Prediabetes Metabolic Syndrome w/o DM (PreDM) 

Patients with no documented diabetes 

AND 

2 POVs ever (not on the same date) or 1 instance on Active Problem List, defined as 
277.7 (BGP PRE DM MET SYN DX taxonomy) 

OR 

One each of at least three of the following in the past year: 

A. Adult BMI equal to or greater than (≥) 30 OR measurement type Waist 
Circumference: Male greater than (>) 40 inches or Female greater than (>) 35 inches. 

B Triglyceride test value equal to or greater than (≥) 150. Triglyceride test defined 
by the site in DM AUDIT TRIGLYCERIDE TAX taxonomy or pre-defined LOINC 
codes (BGP TRIGLYCERIDE LOINC CODES). 

C. HDL test value is less than (<) 40 for men or less than (<) 50 for women. HDL 
defined by the site in DM AUDIT HDL TAX taxonomy or pre-defined LOINC codes 
(BGP HDL LOINC CODES) 

D. Hypertension: patients with at least 2 POVs ever (not on the same date) or 1 
instance on Active Problem List. Hypertension defined as ICD 401.0 -401.9 (BGP 
HYPERTENSION DXS taxonomy) OR mean Blood Pressure value is equal to or 
greater than (≥) 130/85 where systolic is equal to or greater than (≥) 130 OR diastolic 
is equal to or greater than (≥) 85 

Mean value of last 3 Blood Pressures in the past year documented on non-ER 
visits. If 3 BPs are not available, uses mean of last 2 non-ER BPs. If a visit 
contains more than 1 BP, the lowest BP will be used, defined as having the lowest 
systolic value. The mean Systolic value is calculated by adding the last 3 (or 2) 
systolic values and dividing by 3 (or 2). The mean Diastolic is derived the same 
way with diastolic values. 
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E. Fasting Glucose value is equal to or greater than (≥) 100 AND less than (<) 126. 
Test is defined by the site in DM AUDIT CHOLESTEROL TAX taxonomy or pre-
defined LOINC codes (BGP TOTAL CHOLESTEROL LOINC taxonomy). 

Smokers, Current (Smoker) 

Patients with 1 instance (POV, Problem, Health Factor, ADA code) of any Smokers 
Tobacco user definition in the past year. Smoking defined as ICD 305.1; 301.10; 
305.13; V15.82 (BGP GPRA SMOKING DXS taxonomy); health factors Current 
Smoker, Current Smoker & Smokeless, Cessation Smoker, Cessation Smoker and 
Smokeless (BGP SMOKING HLTH FACTORS taxonomy); Dental (ADA) code 
1320. 
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Appendix B:  Performance Measure Logic Example 
Cancer Screening: Pap Smear Rates: Maintain the proportion of female patients ages 
21 through 64 without a documented history of hysterectomy who have had a Pap 
screen within the previous three years at the previous level. 

For CRS, the GPRA measure definition becomes: 

• Denominator (total number of patients evaluated): Active Clinical female 
patients ages 21 through 64, excluding those with documented history of 
hysterectomy. (The clinical owner of the measure has determined based on 
current medical guidelines that “eligible” women are defined as ages 21-64.) 

• Numerator (those from the denominator who meet the criteria for the 
measure): patients with documented Pap smear in past three years or refusal in 
past year. 

For the programmer, the Pap Smear measure is described in terms of the following 
logic: 

1. Begin with the Active Clinical population definition (see the User Manual for 
Clinical Reporting System for definitions of User Population and Active Clinical). 

• Exclude any patients with the name of “DEMO,PATIENT.” 

• Exclude any patients with a date of death in the Patient Registration file. 

• Exclude any patients who do NOT have value 01 (American 
Indian/Alaska Native) in the Beneficiary field in Patient Registration file. 

• Exclude any patients whose Community of Residence is not included in 
the site’s defined GPRA Community Taxonomy for this report. 

• For the remaining patients, search visit files for the three years prior to the 
selected Report end date. Exclude any patients whose visits do not meet 
the “2 medical clinics” definition OR for facilities with the CHS-Only site 
parameter set to “Yes”, exclude any patients who do not have 2 CHS visits 
in the past 3 years. 

2. From these patients, identify the subset that are female and that are ages 21 
through 64 on the first day of the Current Report period. 

3. Exclude patients with documented hysterectomy by searching the V Procedure 
file for procedure codes 68.4-68.9 or V CPT for CPT codes 51925, 56308, 58150, 
58152, 58200-58294, 58550-54, 58951, 58953-58954, or 59135 any time before 
the end of the Report period. 

4. For these patients (the denominator), check for a Pap smear in the past three years 
in the following order: 
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• V Lab is checked for a lab test called PAP SMEAR and for any site-
populated pap smear lab test documented in the BGP PAP SMEAR TAX 
taxonomy, OR 

• V Lab is checked for any LOINC code listed in the pre-defined BGP PAP 
LOINC CODES taxonomy (see the CRS Technical Manual for specific 
codes), OR 

• Purpose of Visit file (V POV) is checked for: a diagnosis of: V76.2-Screen 
Mal Neop-Cervix, V72.31 Routine Gynecological Examination, V72.32 
Encounter for Pap Cervical Smear to Confirm Findings of Recent Normal 
Smear Following Initial Abnormal Smear, V72.3 Gynecological 
Examination, Pap Cervical Smear as Part of General Gynecological Exam, 
Pelvic Exam (annual) (periodic) (old code, to be counted for visits prior to 
10/1/04 only), V76.47 Vaginal Pap Smear for Post-Hysterectomy Patients, 
or V76.49 Pap Smear for Women w/o a Cervix, OR 

• V Procedures is checked for a procedure of 91.46, OR 

• V CPT is checked for the following CPT codes: a) 88141-88167; b) 
88174-88175 or HCPCS code Q0091 Screening Pap Smear, OR 

• The Women’s Health Tracking package is checked for documentation of a 
procedure called Pap Smear, OR 

• Refusals file is checked for Lab Test Pap Smear in the past year. 
If a visit with any of the codes above is found, the patient is considered to have met 
the measure, and the program checks the next patient. 

For a detailed description of the logic for each performance measure included in CRS, 
see the Administrator Manual, section 2.0 Performance Measure Logic. 
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Appendix C:  Definitions and Taxonomies Content 
Below is information about the diagnosis and ICD-9 codes for Opportunistic 
Infections and AIDS Defining Illnesses. 

C.1 Opportunistic Infections 
DIAGNOSIS ICD 9 CODE(S) 
Aspergillosis 117.3 
Bartonellosis 088.0 
Campylobacter Enteric Disease 008.43 
Candidiasis, Oral 112.0 
Coccidioidomycosis 114.1-3 
Cryptococcosis 117.5 
Cryptosporidiosis 007.4 
Cytomegalovirus disease 078.5 
Hemophilus Influenza Respiratory Disease 041.5; 519.9 
Hepatitis B Virus 070.20-23; 070.30-33 
Hepatitis C Virus 070.41; 070.44; 070.51; 070.54; 

070.70-71 
Herpex Simplex virus 054* 
Histoplasmosis 115* 
Human Papillomavirus 079.4 
Microsporidiosis 136.8 
Mycobacterium Avium Complex 031.0; 031.1; 031.2; 013.9 
Mycobacterium Tuberculosis 010-018 
Pneumocystitis carinii Pneumonia 136.3 
Progressive Multifocal Leukoencephalopathy  046.3 
Pseudomonas respiratory Disease 519.9; 041.7 
Salmonella Enteric Disease 003.0; 003.8; 003.9 
Shigella Enteric Disease 004.0-3; 004.8-9 
Staphylococcus Respiratory Disease 041.10; 041.11; 041.19; 519.9 
Streptococcal Respiratory Disease 041.0* 519.9 
Syphilis 090* - 097* 
Toxoplasmosis 130.0-9 
Varicella Zoster Virus 053* 

C.2 AIDS Defining Illnesses 
DIAGNOSIS ICD 9 CODE(S) 
Candidiasis, Bronchi 112.89; 112.9 
Candidiasis, Esophageal 112.84 
Candidiasis, Lung 112.4 
Candidiasis, Trachea 112.89; 112.9 
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DIAGNOSIS ICD 9 CODE(S) 
Carcinoma, invasive cervical 180* 
Coccidioidomycosis 114.1; 114.2; 114.3 
Cryptococcosis 117.5 
Cryptosporidiosis 007.4 
Cytomegalovirus disease 078.5 
Herpes simplex  054* 
Histoplasmosis 115* 
HIV Encephalopathy 042; 348.3* 
Isosporiasis 007.2 
Kaposi’s Sarcoma 176* 
Lymphoma Burkitt’s 200.20-200.28 
Lymphoma Immunoblastic 200.80-200.88 
Lymphoma, primary in brain 202.8; 191*; 196* 
Mycobacterium avium Complex (MAC) 031.0; 031.1; 031.2; 031.9 
Mycobacterium Tuberculosis 010 - 018 
Pneumocystis carinii Pneumonia (PCP) 136.3 
Pneumonia 480*- 486; 487.0 
Progressive Multifocal Leukoencephalopathy 046.3 
Salmonella Septicemia 003.1 
Toxoplasmosis 130.0-9 
Wasting syndrome 261; 799.4 

 

C.3 HIV/AIDS Definitions, Codes, Taxonomies, Attributes 
The code definitions listed in the table should be located within RPMS PCC “V” 
files, as identified below: 

CPT: 1) V CPT, CPT field; 2) if a procedure related to any radiology, also V 
Radiology, CPT Code field. 

ICD Diagnoses: 1) V POV, POV field; 2) also Problem List but only if specified in 
the individual definition below, (PROBLEM file, file number 9000011. The .01 field 
is a pointer to ICD Diagnosis. 

ICD Procedures: 1) V Procedure, Procedure field. 

LOINC: 1) V Lab, LOINC Code field. 

NDC: The NDC is not stored in the V MEDICATION file, you would get at it by 
using the .01 field which points to the DRUG file (file #50). There is a field in the 
drug file called NDC. 

Site-Defined Lab Tests: 1) V Lab, Lab Test field. 
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Site-Defined Medications: 1) V Medication, Medication field. 

Health Factors: 1) V Health Factors, Health Factor field. 

Dental (ADA) Code: V Dental, Service Code field, the .01 field called service code 
that points to the ADA code table. 

Patient Education: 1) V Patient Ed, Topic field. 

Clinic Codes: 1) V Visit, Clinic field - .08 field in VISIT file is a pointer to the 
CLINIC STOP file, file 40.7 that has the name of the clinic and the code 
Immunization Codes: 1) V Immunization, the .01 field called immunization points to 
the standard immunization table. 

Exam Codes: 1) V Exam, Exam Code field. 

Provider Codes: 1) Visit Providers are entered into the V PROVIDER file. The .01 
field (PROVIDER) points to file 200, the NEW PERSON file. The provider’s 
discipline and codes can be found in file 200. 
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The information in the following table was updated September 10, 2009. 

ID Definition CPT ICD LOINC Site-Defined 
Taxonomy (Labs or 
Meds) 

Other 

DX.1 AIDS Defining 
Illnesses 

 BKMV AIDS DEF ILL 
DXS 
003.1; 007.2; 007.4; 
010.00-018.96; 
031.0;031.1; 031.2; 
031.9; 046.3; 054*; 
078.5; 112.4; 112.84; 
112.89; 112.9; 114.1; 
114.2; 114.3; 115*; 
117.5; 130.0-9; 136.3; 
176*; 180*;191*; 196*; 
200.20-200.28; 200.80-
200.88;202.80-202.88; 
261; 348.3*; 480*; 482*; 
483*; 484*; 485*; 486*; 
487*; 799.4 

   

DX.2 Chlamydia DX  BKM CHLAMYDIA DXS 
078.8*, 079.88, 079.98, 
099.41, 099.5* 

   

DX.18 Colorectal Cancer BGP COLORECTAL 
CANCER CPTS 
G0213-G0215; G0231 

BGP COLORECTAL 
CANCER DXS 
153.*, 154.0, 154.1; 
197.5; V10.05 

   

DX.4 Gonorrhea  BKM GONORRHEA 
DXS 
098.0 – 098.89 

   

DX.5 Hepatitis A  BKM HEP A DXS 
POV: 070.0; 070.1 

   

DX.15 Hepatitis B  BKM HEP B DXS 
POV or Problem List: 
070.20-.23; 070.30-.33 
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ID Definition CPT ICD LOINC Site-Defined 
Taxonomy (Labs or 
Meds) 

Other 

DX.16 Hepatitis C  BKM HEP C DXS 
POV or Problem List: 
070.41; 070.44; 070.51; 
070.54; 070.70-.71 

   

DX.6 HIV/AIDS DX  BGPHIV/AIDS DXS 
POV or Problem List 
042.-044.9; V08; 
795.71; 079.53 

   

DX.7 Non Tobacco 
Users 

    BGP NON 
TOBACCO 
USER 
FACTORS 
Health Factors: 
Non Tobacco 
User; Previous 
Smokeless; 
Previous 
Smoker 
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ID Definition CPT ICD LOINC Site-Defined 
Taxonomy (Labs or 
Meds) 

Other 

DX.8 Opportunistic 
Infections 

 BKMV HIV OPP INF 
DXS 
003.0; 003.8; 003.9; 
004.0-3; 004.8-9; 
007.4; 008.43; 010-
018.96;031.0; 031.1; 
031.2;031.9; 041.0*; 
041.10; 041.11; 041.19; 
041.5; 041.7; 046.3; 
053*; 054*; 070.20-23; 
070.30-33; 070.41; 
070.44; 070.51; 070.54; 
070.70; 070.71; 078.5; 
079.4; 088.0; 090*; 
091*; 092*; 093*; 094*; 
095*; 096*; 097*; 112.0; 
114.1-3; 115*; 117.3; 
117.5; 130.0-9; 136.3; 
136.8; 519.9 

   

DX.9 Other STD  BKM OTHER STD DXS 
099.1-099.3; 099.40; 
099.49; 099.8; 099.9 
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ID Definition CPT ICD LOINC Site-Defined 
Taxonomy (Labs or 
Meds) 

Other 

DX. 17 State Reportable 
Diagnoses 

 BKM STATE 
REPORTABLE DXS 
003.1; 007.2; 007.4; 
011*; 031.2; 031.9; 
042; 046.3; 054*; 
078.5; 112.4; 112.84; 
112.89; 112.9; 114.1; 
114.2; 114.3; 115*; 
117.5; 130*; 136.3; 
176*; 180.-180.9; 
200.20-200.28; 200.80-
200.88; 202.80-202.88; 
261; 348.3-348.39*; 
363.15; 363.20; 480*; 
482.89; 483.8; 486.0; 
487.0; 799.4 

   

DX.11 Syphilis  BKM SYPHILIS DXS 
090.0-093.9; 094.1-
097.9 

   

DX.12 Tobacco Users BGP TOBACCO USER 
CPTS 
1034F; 1035F 

BGP SMOKER ONLY 
DXS POV or Current 
Problem List 
305.1; 305.10-305.12; 
649.00-649.04; 

  BGP TOBACCO 
USER HLTH 
FACTORS 
Health Factors: 
Current 
Smokeless, 
Current Smoker, 
Current Smoker 
& Smokeless, 
Cessation 
Smoker, 
Cessation-
Smokeless, 
Cessation 
Smoker and 
Smokeless  
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ID Definition CPT ICD LOINC Site-Defined 
Taxonomy (Labs or 
Meds) 

Other 

DX.13 Trichomoniasis  BKM 
TRICHOMONIASIS 
DXS 
131.0-.9 

   

DX.14 Tuberculosis (TB)  DM AUDIT PROBLEM 
TB DXS 
010.00-018.96; 137.0-
137.4; 795.5; V12.01 

   

ED.1 Family Planning 
Education 

 BKM FAMILY 
PLANNING POV 
V25.0-.9,V26.4 

  Patient 
education (V 
PED) codes 
containing “FP-” 

ED.2 HIV Counseling/ 
Education 

 BKMV HIV ED DXS 
V65.44 

  Patient 
education codes 
containing “HIV-
”, “-HIV” or any 
HIV ICD codes 
(e.g., 042.-
044.9, 795.71, 
V08 

ED.3 Safe Sex 
Education 

    BKM SAFE SEX 
ED CODES 
Patient 
education codes 
containing: STD-
P, HIV-P, FP-
FC, MH-RS, 
WL-SX, WH-RS, 
ATO-LA, HEP-P, 
HEP-LA 
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ID Definition CPT ICD LOINC Site-Defined 
Taxonomy (Labs or 
Meds) 

Other 

ED.4 STD Education   BKMV STD ED DXS 
V65.45 sexually 
transmitted disease 
counseling 

  BKM STD ED 
CODES Patient 
education codes 
containing “STD-
”, “-STD”, “STI-” 
,“-STI” or “HEP-” 
or 
MH-RS, WL-SX, 
WH-RS, WH-
STD, WH-STI, 
CD-C 

ED.5 Tobacco 
Cessation 
Counseling 

BGP TOBACCO CESS 
CPTS 
99406, 99407, G0375, 
G0376, 4000F 

   Clinic code 94 
Patient Ed 
codes: 
containing “TO-”, 
“-TO” or “-SHS” 
(NOTE: update 
to current CRS 
logic) 
BGP TOBACCO 
CESS DENTAL 
CODE 
Dental code 
1320 

IZ.1 BCG Tuberculosis 
Vaccine 

BKM BCG IZ CPTS 
90585, 90586, 90728 

BKM BCG IZ 
PROCEDURE 
V03.2 Tuberculosis 
(BCG) 

  BKM BCG IZ 
CVX CODES 
Immunization 
Codes (CVX): 
19 BCG vaccine 

IZ.2 CMV (IgG) BKM CMV IZ CPTS 
90291 

    BKM CMV IZ 
CVX CODES 
Immunization 
Codes (CVX): 
29 CMV-IGIV 
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ID Definition CPT ICD LOINC Site-Defined 
Taxonomy (Labs or 
Meds) 

Other 

IZ.3 Hep A vaccine 
(defined as 2 
occurences of any 
of the codes at 
least 5 months 
apart – NOTE to 
programmers, 
start with most 
recent and work 
backwards) 

BKM HEP A IZ CPTS 
90632-34, 90636, 
90730 

   BKM HEP A IZ 
CVX CODES 
Immunization 
Codes (CVX): 
85 Hep A NOS; 
:52 HEP A Adult; 
83 HEP A PED 
2; 84 HEP A 
PED 3; 31 HEP 
A PED NOS; 
104 HepA & B 

IZ.4 Hep B vaccine 
(defined as at 
least 3 
occurrences of 
any of the codes 
where 1st and last 
are separated by 
at least 6 months) 

BKM HEP B IZ CPTS 
90636, 90723, 90731,, 
90740, 90743- 90748 

   BKM HEP B IZ 
CVX CODES 
Immunization 
Codes (CVX): 
30 HBIG; 08 
HEP B PED; 43 
HEP B ADLT; 45 
HEP B NOS; 42 
HEP B 
Adol/High Risk 
Inf dosage; 44 
dialysis/ 
immunosup 
patient dosage; 
51 HepB-HIB; 
102 DTP/Hep B; 
104 HEP A&B; 
110 DTaP-
HepB-IPV 
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ID Definition CPT ICD LOINC Site-Defined 
Taxonomy (Labs or 
Meds) 

Other 

IZ.5 Influenza IZ BGP CPT FLU 
90655-90662; 90724; 
G0008; G8108 

BGP FLU IZ DXS 
POV: V04.8, V04.81, 
V06.6 
 BGP FLU IZ 
PROCEDURES 
V Procedure: 99.52 

  BGP FLU IZ 
CVX CODES 
Immunization 
Code (CVX): 88 
INFL NOS; 111 
INFL intranasal; 
15 INFL Split; 16 
INFL Whole 

IZ.6 Pneumococcal IZ BGP PNEUMO IZ 
CPTS 
90669, 90732, G0009, 
G8115 

BGP PNEUMO IZ DXS 
POV: V06.6; V03.82 
BGP PNEUMO IZ 
PROCEDURES 
V Procedure: 99.55  

  BKM PNEUMO 
IZ CVX CODES 
Immunization 
Code (CVX): 33 
PNEUMO-PS; 
100 PNEUM 
CONJ; 109 
PNEUMO NOS 

IZ.7 Tetanus IZ BKM TETANUS IZ 
CPTS 
90698, 90700-90703, 
90711, 90718, 90720-
21, 90723, 90839  

BKM TETANUS IZ DXS 
V03.7 Tetanus Vac; 
V06.1 DTP; V06.2 
DTP+TAB; V06.3 
DTP+polio; V06.5 DT 
BKM TETANUS IZ 
PROCEDURES 
V Procedure 99.38; 
99.39 (DPT) 

  BKM TETANUS 
IZ CVX CODES 
Immunization 
Code (CVX): 01 
DTP; 20 DTaP; 
28 DT-PEDS; 09 
Td-Adult; 35 
Tetanus Toxoid; 
13 TIG; 106 
DTaP 5; 107 
DTaP NOS; 22 
DTP 

M.09 Entry Inhibitors 
(EI) Medications 

   BKMV EI MEDS BKMV EI MED 
NDCS 

M.10 Integrase 
Inhibitors 

   BKMV II MEDS BKMV II MED 
NDCS 

M.01 MAC Prophylaxis 
Medications 

   BKMV MAC PROPH 
MEDS 

BKMV MAC 
PROPH MED 
NDCS 
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ID Definition CPT ICD LOINC Site-Defined 
Taxonomy (Labs or 
Meds) 

Other 

M.02 NNRTIs (Non-
Nucleoside 
Reverse 
Transcriptase 
Inhibitors 
M.1 

   BKMV NNRTI MEDS BKMV NNRTI 
MED NDCS 

M.03 NRTIs 
(Nucleoside / 
Nucleotide 
Reverse 
Transcriptase 
Inhibitors) 
M.1 

   BKMV NRTI MEDS BKMV NRTI 
MED NDCS 

M.12 NRTI Combo 
(Nucleoside / 
Nucleotide 
Reverse 
Transcriptase 
Inhibitors 
Combinations) 

   BKMV NRTI COMBO 
MEDS 

BKMV NRTI 
COMBO MED 
NDCS 

M.11 NRTI/NNRTI    BKMV NRTI/NNRTI 
MEDS 

BKMV 
NRTI/NNRTI 
MED NDCS 

M.04 PCP Prophylaxis 
Medications 

   BKMV PCP PROPH 
MEDS 

BKMV PCP 
PROPH MED 
NDCS 

M. 13 PI Booster    BKMV PI BOOSTER 
MEDS 
 

BKMV PI 
BOOSTER MED 
NDCS 

M.05 PIs (Protease 
Inhibitors) 
M.1 

   BKMV PI MEDS BKMV PI MED 
NDCS 

M.08 Tuberculosis (TB) 
Treatment 

   BKM TB MEDS BKM TB MED 
NDCS 
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Taxonomy (Labs or 
Meds) 

Other 

P.01 Mastectomy, 
Bilateral 

BGP BILATERAL 
MASTECTOMY CPTS 
19300-19307, 19180, 
19200, 19220, 19240 
(all codes to include 
modifier .50 or 09950 
to indicate bilateral 
procedure) 

BGP MASTECTOMY 
PROCEDURES 
85.42, 85.44, 85.46, 
85.48 

   

P.07 Mastectomy, 
Unilateral 

BGP UNI 
MASTECTOMY CPTS 
19300-19307, 19180, 
19200, 19220, 19240  

BGP UNI 
MASTECTOMY 
PROCEDURES 
85.41, 85.43, 85.45, 
85.47 

   

P.02 Dental Exam  BKM DENTAL 
EXAMINATION 
V72.2 Dental 
Examination 

  BGP DENTAL 
EXAM DENTAL 
CODE 
ADA code 0000; 
0190 
V Exam 30 

P.03 Dilated Eye Exam  BGP DM EYE EXAM 
CPTS 
92002-92014, 67028, 
67038, 67039, 67040 
BGP RETINAL EXAM 
CPTS 
2022F, 2024F, 2026F, 
S0620, S3000 

POV V72.0   Provider codes 
79. 24. 08 
Clinic codes 17, 
18, 64, A2 
V Exam code: 
03 
Procedure: 
95.02 
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P.04 Hysterectomy BGP 
HYSTERECTOMY 
CPTS 
51925; 56308; 58150-
58152; 58200-58294; 
58548- 58554; 58951; 
58953-58954; 58956; 
59135  

BGP 
HYSTERECTOMY 
PROCEDURES 
V Procedure: 68.4-68.8 

  V POV 618.5 

P.05 Mammogram BGP CPT 
MAMMOGRAM 
VRad or VCPT 
76090-76092; G0202; 
G0204; G0206; 76083; 
77051-77059 

BGP MAMMOGRAM 
ICDS 
POV: V76.11, V76.12; 
793.80, 793.81, 793.89 
BGP MAMMOGRAM 
PROCEDURES 
V Procedure: 87.36 – 
87.37 

  Women’s 
Health: 
Screening 
Mammogram, 
Mammogram Dx 
Bilat, 
Mammogram Dx 
Unilat 

P.06 Total Colectomy BGP TOTAL 
CHOLECTOMY CPTS 
44150-44151,44152, 
44153, 44155-44158, 
44210-44212  

BGP TOTAL 
CHOLECTOMY 
PROCS 
45.8 
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S.1 Alcohol Screen BGP ALCOHOL 
SCREENING CPTS 
99408, 99409, G0396, 
G0397, H0049 

BGP ALCOHOL 
SCREEN ICDS 
V POV: V79.1, V11.3 
 
BGP ALCOHOL DXS 
291.0-291.9. 303.00-
303.93, 305.00-305.03, 
357.5 
 
BGP ALCOHOL 
PROCEDURES 
94.46; 94.53; 94.61-
94.63; 94.67-94.69 

  BGP ALCOHOL 
HLTH FACTOR 
Any Alcohol 
Category Health 
Factor 
Any Patient Ed 
codes containing 
“CD-”, “-CD”, 
“AOD-” or “-
AOD” OR any 
alcohol 
diagnosis 
Exam Code 35 
V Measurement 
AUDT, AUDC or 
CRFT 
BHS Problem 
codes: 29.1 
BHS POV 
10,27,29  

S.05 Colorectal Cancer 
Screen 

BGP COLO CPTS 
44388-44394, 44397, 
45355, 45378-45387, 
45391, 45392, G0105; 
G0121 
BGP FOBT CPTS 
82270; 82274; 89205; 
G0107; G0328; G0394 
BGP SIG CPTS 
45330-45345; G0104 
BGP BE CPTS 
74280, G0106, G0120 

BGP SIG PROCS 
45.24; 45.42 
BGP COLO PROCS 
45.22; 45.23; 45.25; 
45.43 
Colonoscopy 
VPOV V76.51 

BGP FOBT LOINC 
CODES 

BGP GPRA FOB 
TESTS 
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S.2 Depression 
Screen 

 BGP MOOD 
DISORDERS 
291.89; 292.84; 293.83; 
296.*; 300.4; 301.13; 
311. 

  Exam Code 36 
BHS Problem 
Code 14.1 
POV V79.0 

S.6 IPV/ DV Screen  BGP DV DXS 
995.80-83; 995.85; 
V15.41- V15.49 
BGP IPV/DV 
COUNSELING ICDS 
V61.11 

  Exam Code 34 
Any Patient 
Education codes 
containing "DV-" 
or "-DV" 

S.3 Substance Use 
(not including 
Alcohol or 
Tobacco) Screen 

 BKM OTHER 
SUBSTANCE ABUSE 
DXS 
304.00-.93, 305.20-
305.93, 292.0-.9, 
648.30-.34, 357.6 
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Taxonomy (Labs or 
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S.4 Tobacco Use 
Screen 

BGP SMOKING CPTS 
99406; 99407; G0375; 
G0376; 1034F; 1035F; 
1036F 

BGP GPRA SMOKING 
DXS 
POV or Current 
Problem List: 305.1-
305.13; 649.00-649.04, 
V15.82 

  BGP TOBACCO 
SCREEN HLTH 
FACTOR 
Any health factor 
for category 
Tobacco 
Any Patient Ed 
codes containing 
“TO-”, “-TO” or “-
SHS” or any 
containing 
diagnosis codes 
BGP TOBACCO 
CESS DENTAL 
CODE 
Dental code 
1320 
Clinic code 94 

T.2 CD4 Tests 
 

BGP CD4 CPTS 
86359-86361 

 BGP CD4 LOINC 
CODES 

BGP CD4 TAX  

T.1 CD4 Absolute 
Tests 

BKMV CD4 ABS CPTS 
86361 

 BKMV CD4 ABS 
LOINC CODES 
5472-6; 20605-2; 8127-
3; 20606-0; 8128-1; 
17822-8; 16274-3 

BKM CD4 ABS TESTS 
TAX 

 

T.3 Chlamydia Test BGP CHLAMYDIA 
CPTS 
86631; 86632; 87110; 
87270; 87320; 87490-
87492; 87810 

BGP CHLAMYDIA 
TEST PROCEDURES 
V73.88, V73.98 

BGP CHLAMYDIA 
LOINC CODES 

BGP CHLAMYDIA 
TESTS TAX 

 

T.6 CMV Test BKM CMV TEST CPTS 
86644, 86645; 87271; 
87496; 87497 

 BKM CMV LOINC 
CODES 

BKM CMV TEST TAX  
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T.7 Cocci Antibody 
Screen  

BKM COCCI 
ANTIBODY CPTS 
86635 

 BKM COCCI 
ANTIBODY LOINC 
CODES 

BKM COCCI 
ANTIBODY TAX 

 

T.9 FTA-ABS 
(Syphilis) 

BKM FTA-ABS CPTS 
86781; 

 BKM FTA-ABS LOINC 
CODES 

BKM FTA-ABS TEST 
TAX 
FTA-ABS 

 

T.10 Gonorrhea Test BKM GONORRHEA 
TESTS CPTS 
87590-87592, 87850 

 BKM GONORRHEA 
LOINC CODES 

BKM GONORRHEA 
TEST TAX 
 

 

T.29 Hepatitis Panel BKM HEPATITIS 
PANEL CPTS 
80074 

 BKM HEP PANEL 
LOINC CODES 

BKM HEPATITIS 
PANEL TAX 

 

T.31 Hepatitis A Tests BKM HEP A TESTS 
CPTS 
86708, 86709 

 BKM HEP A LOINC 
CODES 

BKM HEP A TAX  

T.27 Hepatitis B BKM HEP B TESTS 
CPTS 
86704-86707; 87340-
87350; 87515-87517 

 BKM HEP B LOINC 
CODES 

BKM HEP B TAX  

T.13 Hepatitis C test 
(EIA) 

BKM HEP C SCREEN 
TESTS CPTS 
86803, 87520  

 BKM HEP C SCREEN 
LOINC CODES 

BKM HEP C 
SCREENING TAX 

 

T.14 Hepatitis C test 
(RIBA) 

BKM HEP CONFIRM 
TESTS CPTS 
86804, 87521, 87522 

 BKM HEP C CONFIRM 
LOINC CODES 

BKM HEP C 
CONFIRMATORY TAX 

 

T.15 HIV Genotype BKMV HIV 
GENOTYPE CPTS 
87901 

  BKMV HIV 
GENOTYPE TESTS 
TAX 

 

T.16 HIV Phenotype BKMV HIV 
PHENOTYPE CPTS 
87903 

  BKMV HIV 
PHENOTYPE TESTS 
TAX 
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T.17 HIV Tests BGP CPT HIV TESTS 
86689; 86701-86703; 
87390; 87391; 87534-
87539 

 BGP HIV TEST LOINC 
CODES 

BGP HIV TEST TAX  

T.30 Lipid Profile BGP LIPID PROFILE 
CPTS 
80061 

 BGP LIPID PROFILE 
LOINC CODES 

DM AUDIT LIPID 
PROFILE TAX 

 

T.20 Pap Smear BGP CPT PAP 
88141-88167; 88174-
88175; Q0091; G0101; 
G0123; G0124; G0141; 
G0143-G0145; G0147; 
G0148; P3000; P3001 

BGP PAP SMEAR DXS 
POV: V72.3-V72.31; 
V72.32; V76.2; V76.47; 
795.0-795.09; V67.01; 
BGP PAP 
PROCEDURES 
V Procedure: 91.46 

BGP PAP LOINC 
CODES 

BGP PAP SMEAR TAX Women’s 
Health: 
procedure called 
Pap Smear 
Refusals: Lab 
Test Value Pap 
Smear 

T.21 PPD 
(Tuberculosis 
Test) 

BKM PPD CPTS 
86580, 86585, 87555-
87557 

BKM PPD ICDS 
V74.1 Special 
Screening Pulmonary 
Tuberculosis (PPD) 

In addition to V Lab, 
look in V Skin Test 
BKM PPD LOINC 
CODES 

In addition to V Lab, 
look in V Skin Test 
BKM PPD TAX 

BKM PPD CVX 
CODES 
Immunization 
Codes (CVX): 
95, 96, 97, 98 
tuberculin skin 
tests 

T.22 RPR (Syphilis) 
 

BKM RPR CPTS 
86592, 86593; 87285 

 BKM RPR LOINC 
CODES 

BKM RPR TAX  

T.28 Toxoplasmosis BKM 
TOXOPLASMOSIS 
CPTS 
86777, 86778 

 BKM 
TOXOPLASMOSIS 
LOINC CODES 

BKM 
TOXOPLASMOSIS 
TESTS TAX 

 

T.24 Trichomoniasis  Same as DX.13 BKM TRICH LOINC 
CODES 

BKM TRICH TESTS 
TAX 

 

T.26 HIV RNA Viral 
Load Tests 

BGP HIV VIRAL LOAD 
CPTS 
87536, 87539 

 BGP VIRAL LOAD 
LOINC CODES 

BGP HIV VIRAL LOAD 
TAX 
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Appendix D:  HIV/AIDS-Related Reminders - Logic and 
Tooltip Text 

The information is the following table was updated March 3, 2009. 

 

Reminder Name Description Field Text Tooltip Text 
CD4 Test Category: Care Management 

Clinical Group: HIV 
Reminder Name: CD4 Test 
Default Status: On 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS. 
Definition (Frequency): Every 4 months 
 
LOGIC DETAIL: 
CD4 Test Definition: 
• Procedures (CPT Codes): VCPT 86359-86361 

[BGP CD4 CPTS] 
• LOINC Codes: V Lab as predefined in [BGP 

CD4 LOINC CODES] 
• Site Defined Lab Tests: V Lab site-defined tests 

in [BGP CD4 TAX] 
 
Site Configurable? No 

A CD4 lab test is due 
every 4 months. 
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Reminder Name Description Field Text Tooltip Text 
Chlamydia Test Category: Care Management 

Clinical Group: HIV 
Reminder Name: Chlamydia Test 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
With a history of POV diagnosis of Gonorrhea, Syphilis, 
Trichomoniasis or other STD WITHOUT a negative 
Chlamydia test since the diagnosis 
OR 
With a history of positive test results for Gonorrhea or 
Syphilis since date of last Chlamydia test 
OR 
Most recent Chlamydia test was positive 
OR 
Greater than or equal to 18 years of age 
Definition (Frequency): Variable 
• Now if there has been a diagnosis for either 

Gonorrhea, Syphilis, Trichomoniasis or other 
STD since the most recent Chlamydia test 

OR 
• Now if there has been a positive test result for 

Gonorrhea or Syphilis since the date of the last 
Chlamydia test 

OR 
• 8 weeks after most recent positive Chlamydia 

test to check for cure 
OR 
• Annually if greater than or equal to 18 years of 

age 
Chlamydia Test Definition: 
• Procedures (CPT Codes): V CPT 86631, 86632, 

87110, 87270, 87320,87490-87492, 87810 
[BGP CHLAMYDIA CPTS] 

• LOINC Codes: V Lab as predefined in [BGP 
CHLAMYDIA LOINC CODES] 

• Site Defined Lab Tests: V Lab site-defined tests 
in [BGP CHLAMYDIA TESTS TAX] 

A Chlamydia Test is 
due: 1) immediately 
after infection with 
Gonorrhea, Syphilis, 
Trichomoniasis or other 
sexually transmitted 
infection; 2) 8 weeks 
after a positive 
Chlamydia test to check 
for cure; 3) annually for 
all patients. 
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Chlamydia Test 
(cont.) 

LOGIC DETAIL: 
Gonorrhea Test Definition: 
• Procedures (CPT Codes): 87590-87592, 87850 

[BKM GONORRHEA TESTS CPTS] 
• LOINC Codes: V Lab as predefined in [BKM 

GONORRHEA LOINC CODES 
• Site Defined Lab Tests: V Lab site-defined in 

[BKM GONORRHEA TEST TAX] 
 
RPR Lab (Syphilis) Test Definition: 
• Procedures (CPT Codes): V CPT 86592, 86593, 

87285 [BKM RPR CPTS] 
• LOINC Codes: V Lab as predefined in [BKM 

RPR LOINC CODES] 
• Site Defined Lab Tests: V Lab site-defined tests 

in [BKM RPR TAX] 
 
FTA-ABS (Syphilis) Test Definition: 
• Procedures (CPT Codes): V CPT 86781 [BKM 

FTA-ABS CPTS] 
• LOINC Codes: V Lab as predefined in [BKM 

FTA-ABS LOINC CODES ] 
• Site Defined Lab Tests: V Lab site-defined tests 

in [BKM FTA-ABS TEST TAX] 
 
Chlamydia Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

078.8*, 079.88, 079.98, 099.41, 099.5*[BKM 
CHLAMYDIA DXS] 

Gonorrhea Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

098.0-.89 [BKM GONORRHEA DXS]Syphilis 
Diagnosis Definition: 

• Diagnosis (ICD Codes): POV or Problem List 
090-093.9, 094.1-097.9 [BKM SYPHILIS 
DXS] 

 
Trichomoniasis Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

131.0-.9 [BKM TRICHOMONIASIS 
DXS]Other STD Diagnoses Definition: 

• Diagnosis (ICD Codes): POV or Problem List 
099.1-099.3, 099.40, 099.49,099.8, 099.9 
[BKM OTHER STD DXS] 

 
Site Configurable? No 
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HMS Dental Exam  Type: Care Management 

Category: HIV 
Reminder Name: HMS Dental Exam 
Default Status: On 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
Definition (Frequency): Annually 
 
LOGIC DETAIL: 
Dental Exam Definition: 
• Procedure Code: V72.2 [BKM DENTAL 

EXAMINATION] 
• Dental Code: ADA code 0000; 0190 [BGP 

DENTAL EXAM DENTAL CODE] 
• V Exam Code: 30 
 
Site Configurable? No 

A Dental Exam is due 
annually for all patients. 
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HMS Eye Exam  Type: Care Management 

Category: HIV 
Reminder Name: HMS Eye Exam 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
 
Definition (Frequency): Variable 
• Every 6 months if most recent CD4 Absolute 

Count is less than 50 
• Annually if most recent CD4 Absolute Count is 

greater than or equal to 50 
 
LOGIC DETAIL: 
Eye Exam Definition: 
• Procedures (CPT Codes): V CPT 67028, 67038, 

67039, 67040, 92002, 92004, 92012, 92014, 
[BGP EYE EXAM CPTS] 

• Procedures (ICD Codes): POV 72.0 
• Procedure Code 95.02 
• Provider Codes: 79; 24; 08 
• Clinic Codes: 17; 18; 64; A2 
• V Exam Code: 03 
 
CD4 Absolute Count Test Definition: 
• Procedures (CPT Codes): 86361 [BKMV CD4 

ABS CPTS] 
• LOINC Codes: V Lab as predefined in [BKMV 

CD4 ABS LOINC CODES] 
• Site Defined Lab Tests: V Lab site-defined in 

[BKM CD4 ABS TESTS TAX] 
 
Site Configurable? No 

An Eye Exam is due: 1) 
every 6 months for 
patients whose most 
recent CD4 Absolute 
Count is less than 50; 
2) annually for all 
patients whose most 
recent CD4 Absolute 
Count is greater than or 
equal to 50. 
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Family Planning 
Education  

Type: Care Management 
Category: HIV 
Reminder Name: Family Planning Education 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
Females starting at age 13 years through age 44 years. 
OR 
Males greater than or equal to age 13 years. 
 
Definition (Frequency): Every 6 months 
 
LOGIC DETAIL: 
Family Planning Definition: 
ICD Codes: V25.0-.9; V26.4 [BKM FAMILY PLANNING 
POV] 
Patient Education Codes: V PED Visits containing “FP” 
 
Site Configurable? No 

Family Planning 
Education is due every 
6 months for: 1) all 
females ages 13 – 44; 
2) all males starting at 
age 13. 
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Syphilis (FTA-
ABS) Test 

Type: Care Management 
Category: HIV 
Reminder Name: Syphilis (FTA-ABS) Test 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
With positive results on most recent RPR lab and no 
FTA-ABS test documented after the date of the positive 
RPR test 
 
Definition (Frequency): Due 14 days after the positive 
RPR test 
 
LOGIC DETAIL: 
 
FTA-ABS Test Definition: 
• Procedures (CPT Codes): V CPT 86781 [BKM 

FTA-ABS CPTS] 
• LOINC Codes: V Lab as predefined in [BKM 

FTA-ABS LOINC CODES ] 
• Site Defined Lab Tests: V Lab site-defined tests 

in [BKM FTA-ABS TEST TAX] 
 
RPR Test Definition: 
Procedures (CPT Codes): V CPT 86592, 86593, 87285 
[BKM RPR CPTS] 
LOINC Codes: V Lab as predefined in [BKM RPR 
LOINC CODES] 
Site Defined Lab Tests: V Lab site-defined tests in [BKM 
RPR TAX] 
Site Configurable? No 

An FTA-ABS (Syphilis) 
Test is due 14 days 
after the date of positive 
test results on their 
most recent RPR 
(Syphilis) Test. 
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Gonorrhea Test Type: Care Management 

Category: HIV 
Reminder Name: Gonorrhea Test 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
With a history of POV diagnosis of Chlamydia, Syphilis, 
Trichomoniasis or other STDs WITHOUT a negative 
Gonorrhea test since the diagnosis 
OR 
With a history of positive test results for Chlamydia or 
Syphilis since date of last Gonorrhea test 
OR 
Greater than or equal to age 18 years 
 
Definition (Frequency): Variable 
- Now if there has been a diagnosis for either 
Chlamydia, Syphilis Trichomoniasis or other STD since 
the most recent Gonorrhea test 
- Now if there has been a positive test result for either 
Chlamydia, Syphilis, Trichomoniasis or other STDs 
since the most recent Gonorrhea test 
OR 
- Annually if greater than or equal to age 18 years. 
 
LOGIC DETAIL: 
Gonorrhea Test Definition: 
- Procedures (CPT Codes): 87590-87592, 87850 [BKM 
GONORRHEA TESTS CPTS] 
- LOINC Codes: V Lab as predefined in [BKM 
GONORRHEA LOINC CODES 
- Site Defined Lab Tests: V Lab site-defined in [BKM 
GONORRHEA TEST TAX] 
 
Chlamydia Test Definition: 
- Procedures (CPT Codes): V CPT 86631, 86632, 
87110, 87270, 87320,87490-87492, 87810 [BGP 
CHLAMYDIA CPTS] 
- LOINC Codes: V Lab as predefined in [BGP 
CHLAMYDIA LOINC CODES] 
- Site Defined Lab Tests: V Lab site-defined tests in 
[BGP CHLAMYDIA TESTS TAX] 

A Gonorrhea Test is 
due: 1) immediately 
after infection with 
Chlamydia, Syphilis, 
Trichomoniasis or other 
sexually transmitted 
infection; 2) annually for 
all patients. 
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Gonorrhea Test 
(cont.) 

RPR Lab (Syphilis) Test Definition: 
• Procedures (CPT Codes): V CPT 86592, 86593, 

87285 [BKM RPR CPTS] 
• LOINC Codes: V Lab as predefined in [BKM 

RPR LOINC CODES] 
• Site Defined Lab Tests: V Lab site-defined tests 

in [BKM RPR TAX] 
 
FTA-ABS (Syphilis) Test Definition: 
• Procedures (CPT Codes): V CPT 86781 [BKM 

FTA-ABS CPTS] 
• LOINC Codes: V Lab as predefined in [BKM 

FTA-ABS LOINC CODES ] 
• Site Defined Lab Tests: V Lab site-defined tests 

in [BKM FTA-ABS TEST TAX] 
 
Gonorrhea Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

098.0-.89 [BKM GONORRHEA DXS] 
 
Chlamydia Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

077.98, 078.88, 079.88, 079.98, 099.41, 099.50-
59 [BKM CHLAMYDIA DXS] 

 
Syphilis Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

090-093.9, 094.1-097.9 [BKM SYPHILIS 
DXS] 

 
Trichomonas Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

131.0-.9 [BKM TRICHOMONIASIS DXS] 
 
Other STD Diagnoses Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

099.1-099.3, 099.40, 099.49,099.8, 099.9 
[BKM OTHER STD DXS] 

 
Site Configurable? No 

 



iCare Population Management GUI (BQI) Version 2.2 

User Manual HIV/AIDS-Related Reminders - Logic and Tooltip Text 
August 2011 

410 

Reminder Name Description Field Text Tooltip Text 
Hepatitis A IZ Type: Care Management 

Category: HIV 
Reminder Name: Hepatitis A IZ 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
With NO documented history of Hepatitis A diagnosis. 
 
Definition (Frequency): Series is given once in a lifetime. 
Series consists of 2 doses at least 5 months apart. 
 
LOGIC DETAIL: 
Hepatitis A Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

070.0, 070.1 [BKM HEP A DXS] 
 
Hepatitis A Immunization Definition: 
• Procedures (CPT Codes): V CPT 90632-34, 

90636, 90730 [BKM HEP A IZ CPTS] 
• Immunization (CVX Codes): 85 Hep A NOS; 

52 HEP A Adult; 83 HEP A PED 2; 84 HEP A 
PED 3; 31 HEP A PED NOS; 104 HepA & B 
[BKM HEP A IZ CVX CODES] 

 
Site Configurable? No 

The Hepatitis A 
Immunization (series of 
2) is due for all patients 
with NO documented 
history of Hepatitis A. 
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Hepatitis B IZ Type: Care Management 

Category: HIV 
Reminder Name: Hepatitis B IZ 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
With NO documented history of Hepatitis B diagnosis 
 
Definition (Frequency): Series is given once in a lifetime. 
Series consist of 3 doses where the first and last doses 
are at least 6 months apart. 
 
LOGIC DETAIL: 
Hepatitis B Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

070.20-.23, 070.30-.33 [BKM HEP B DXS] 
 
Hepatitis B Immunization Definition: 
• Procedures (CPT Codes): V CPT 90636, 90723, 

90731,90740, 90743-90748 [BKM HEP B IZ 
CPTS] 

• Immunization (CVX Codes): 30 HBIG; 08 HEP 
B PED; 43 HEP B ADLT; HEP B NOS; HEP B 
Adol/High Risk Inf dosage; 44 dialysis/ 
immunosup patient dosage; 51 HepB-HIB; 102 
DTP/Hep B; 104 HEP A&B; 110 DTaP-HepB-
IPV [BKM HEP B IZ CVX CODES] 

 
Site Configurable? No 

A Hepatitis B 
Immunization (series of 
3 doses where the first 
and last doses are at 
least 6 months apart) is 
due for all patients with 
NO documented history 
of Hepatitis B. 
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Hepatitis B Retest  Type: Care Management 

Category: HIV 
Reminder Name: Hepatitis B Retest 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
With 3 Hepatitis B immunization doses and no Hepatitis 
B test documented after the final dose 
 
Definition (Frequency): Once, after final dose in the 
Hepatitis B series 
 
LOGIC DETAIL: 
Hepatitis B Test Definition: 
• Procedures (CPT Codes): V CPT 86704-86707; 

87340-87350; 87515-87517 [BKM HEP B 
TESTS CPTS] 

• LOINC Codes: V Lab as predefined in [BKM 
HEP B LOINC CODES] 

• Site Defined Lab Tests: V Lab site-defined in 
[BKM HEP B TAX] 

 
Hepatitis B Immunization Definition: 
• Procedures (CPT Codes): V CPT 90636, 90723, 

90731, 90740, 90743-90748 [BKM HEP B IZ 
CPTS] 

• Immunizations (CVX Codes): 30 HBIG; 08 
HEP B PED; 43 HEP B ADLT; 45 HEP B 
NOS; 42 HEP B Adol/High Risk Inf dosage; 44 
dialysis/ immunosup patient dosage; 51 HepB-
HIB; 102 DTP/Hep B; 104 HEP A&B; 110 
DTaP-HepB-IPV [BKM HEP B IZ CVX 
CODES] 

 
Site Configurable? No 

A Hepatitis B Retest is 
due for all patients after 
they have received all 3 
doses of the Hepatitis B 
Immunization. 
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Hepatitis B Test Type: Care Management 

Category: HIV 
Reminder Name: Hepatitis B Test 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
Patients with NO documented history of Hepatitis B 
Diagnosis ever AND NO documented Hepatitis B test 
results ever. 
 
Definition (Frequency): Once 
 
LOGIC DETAIL: 
Hepatitis B Test Definition: 
• Procedures (CPT Codes): V CPT 86704-86707; 

87340-87350; 87515-87517 [BKM HEP B 
TESTS CPTS] 

• LOINC Codes: V Lab as predefined in [BKM 
HEP B LOINC CODES] 

• Site Defined Lab Tests: V Lab site-defined in 
[BKM HEP B TAX] 

 
Hepatitis B Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

070.20-.23, 070.30-.33 [BKM HEP B DXS] 
 
Site Configurable? No 

A Hepatitis B Test is 
due for all patients who 
have never had a test 
for or been diagnosed 
with Hepatitis B. 

Hepatitis C 
Confirmatory Test 

Type: Care Management 
Category: HIV 
Reminder Name: Hepatitis C Confirmatory Test 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
With a history of positive Hepatitis C Screening test and 
NO documentation of a positive Hepatitis C 
Confirmatory test after AND NO documented history of 
Hepatitis C diagnosis. 

A Hepatitis C 
Confirmatory Test is 
due for all patients who 
have a positive 
Hepatitis C Screening 
Test. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual HIV/AIDS-Related Reminders - Logic and Tooltip Text 
August 2011 

414 

Reminder Name Description Field Text Tooltip Text 
Hepatitis C 
Confirmatory Test 
(cont.) 

Definition (Frequency): Immediately following a positive 
result on a Hepatitis C Screening Test 
 
LOGIC DETAIL: 
Hepatitis C Confirmatory Test Definition: 
• Procedures (CPT Codes): 86804, 87521, 87522 

[BKM HEP C CONFIRM TESTS CPTS] 
• LOINC Codes: V Lab as predefined in [BKM 

HEP C CONFIRM LOINC CODES] 
• Site Defined Lab Tests: V Lab site-defined in 

[BKM HEP C CONFIRMATORY TAX 
 
Hepatitis C Screening Test Definition: 
• Procedures (CPT Codes): V CPT 86803, 87520 

[BKM HEP C SCREEN TESTS CPTS] 
• LOINC Codes: V Lab predefined tests in [BKM 

HEP C SCREEN LOINC CODES] 
• Site Defined Lab Tests: V Lab site-defined in 

[BKM HEP C SCREENING TAX] 
 
Hepatitis C Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

070.41, 070.44, 070.51, 070.54, 070.70-.71 
[BKM HEP C DXS] 

 
Site Configurable? No 
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Hepatitis C 
Screening Test 

Type: Care Management 
Category: HIV 
Reminder Name: Hepatitis C Screening Test 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
With NO documented history of Hepatitis C diagnosis 
ever 
 
Definition (Frequency): Annually 
 
LOGIC DETAIL: 
Hepatitis C Screening Test Definition: 
• Procedures (CPT Codes): V CPT 86803, 87520 

[BKM HEP C SCREEN TESTS CPTS] 
• LOINC Codes: V Lab predefined tests in [BKM 

HEP C SCREEN LOINC CODES] 
• Site Defined Lab Tests: V Lab site-defined tests 

in [BKM HEP C SCREENING TAX] 
 
Hepatitis C Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

070.41, 070.44, 070.51, 070.54, 070.70-.71 
[BKM HEP C DXS] 

 
Site Configurable? No 

A Hepatitis C Screening 
Test is due annually for 
all patients who have 
never been diagnosed 
with Hepatitis C. 
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HMS Influenza IZ Type: Care Management 

Category: HIV 
Reminder Name: HMS Influenza IZ 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
 
Definition (Frequency): Annually 
 
LOGIC DETAIL: 
Influenza Immunization Definition: 
• Procedures (CPT Codes): V CPT 90655-90662; 

90724, G0008, G8108 [BGP CPT FLU] 
• Procedures (ICD Codes): POV: V04.8, V04.81, 

V06.6 [BGP FLU IZ DXS] 
• Procedures: V Proc 99.52 [BGP FLU IX 

PROCEDURES] 
• Immunization (CVX Codes): 88 INFL NOS; 

111 INFL intranasal; 15 INFL Split; 16 INFL 
Whole [BGP FLU IZ CVX CODES] 

 
Site Configurable? No 

An Influenza 
Immunization is due 
annually for all high-risk 
patients. 

HMS Mammogram Type: Care Management 
Category: HIV 
Reminder Name: HMS Mammogram 
Default Status: On 
 
Denominator: Female patients with a proposed or 
accepted tag for HIV OR Active on HMS Register with 
Diagnosis Category of HIV or AIDS 
starting at age 50 years through 69 years WITHOUT 
documented bilateral mastectomy or 2 unilateral 
mastectomies. 
 
Definition (Frequency): Annually 

A Mammogram is due 
annually for all females 
ages 50-69 without a 
history of bilateral 
mastectomy or 2 
unilateral 
mastectomies. 
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HMS Mammogram 
(cont.) 

LOGIC DETAIL: 
Mammogram Definition: 
• Procedures (CPT Codes): VRad or VCPT 

76090-76092, G0202, G0204, G0206, 76083; 
77051-77059 [BGP CPT MAMMOGRAM] 

• Procedures (ICD Codes): POV: V76.11, 
V76.12, 793.80, 793.81, 793.89 [BGP 
MAMMOGRAM ICDS] 

• Procedure Codes: V Proc: 87.36-87.37 [BGP 
MAMMOGRAM PROCEDURES] 

• Women’s Health: Screening Mammogram, 
Mammogram Dx Bilat; Mammogram Dx Unilat 

 
Bilateral Mastectomy Definition: 
• Procedures (CPT Codes): V CPT 19300-19307; 

19180; 19200; 19220; 19240 (all codes to 
include modifier .50 or 09950 to indicate 
bilateral procedure) [BGP BILATERAL 
MASTECTOMY CPTS] 

• Procedures Codes (ICD Codes): V Procedure 
85.42, 85.44, 85.46, 85.48 [BGP 
MASTECTOMY PROCEDURES] 

 
Unilateral Mastectomy Definition: 
• Procedures (CPT Codes): V CPT 19300-19307; 

19180; 19200; 19220; 19240 [BGP UNI 
MASTECTOMY CPTS] 

• Procedure Codes (ICD Codes): 85.41; 85.43; 
85.45; 85.47 [BGP UNI MASTECTOMY 
PROC] 

 
Site Configurable? No 

 

HMS Pap Smear Type: Care Management 
Category: HIV 
Reminder Name: HMS Pap Smear 
Default Status: On 
 
Denominator: Female patients with a proposed or 
accepted tag for HIV OR Active on HMS Register with 
Diagnosis Category of HIV or AIDS 
starting at age 18 years through 64 years WITHOUT a 
documented hysterectomy 

A Pap Smear is due: 1) 
every 6 months for 
females ages 18-64 if 
most recent CD4 
Absolute Count is less 
that 200; 2) annually for 
females ages 18-64 if 
most recent CD4 count 
is greater than or equal 
to 200. 
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HMS Pap Smear 
(cont.) 

Definition (Frequency): Variable 
• Every 6 months if most recent CD4 Absolute 

Count is less than 200 
• Annually if most recent CD4 Absolute Count is 

greater than or equal to 200 
 
LOGIC DETAIL: 
Pap Smear Definition: 
• Procedures (CPT Codes): V CPT 88141-88167, 

88174-88175, Q0091 G0101; G0123; G0124; 
G0141; G0143-G0145; G0147; G0148; P3000; 
P3001 [BGP CPT PAP] 

• Procedures (ICD Codes): POV V67.01, V72.3-
V72.31, V72.32, V76.2, V76.47, 795.0-795.09 
[BGP PAP SMEAR DXS] 

• Procedure Codes: V Procedure 91.46 [BGP 
PAP PROCEDURES] 

• LOINC Codes: V Lab as predefined in [BGP 
PAP LOINC CODES] 

• Site Defined Lab Tests: V Lab site-defined in 
[BGP PAP SMEAR TAX] 

• Women's Health: Any procedure called Pap 
Smear 

 
Hysterectomy Definition: 
• Procedures (CPT Codes): V CPT 51925, 56308, 

58150-58152, 58200-58294, 58548-58554, 
58951, 58953-58954, 58956, 59135 [BGP 
HYSTERECTOMY CPTS] 

• Procedures (ICD Codes): V Procedure: 68.4-
68.9 [BGP HYSTERECTOMY 
PROCEDURES ] 

• Visit Codes: V POV 618.5 
 
CD4 Absolute Count Definition: 
• Procedures (CPT Codes): V CPT 86361 

[BKMV CD4 ABS CPTs] 
• LOINC Codes: V Lab as predefined in [BKMV 

CD4 ABS LOINC CODES] 
• Site Defined Lab Tests: V Lab site-defined in 

[BKMV CD4 ABS TESTS TAX] 
 
Site Configurable? No 
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HMS Pneumovax 
Immunization 

Type: Care Management 
Category: HIV 
Reminder Name: Pneumovax Immunization 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
 
Definition (Frequency): Every 5 years 
 
LOGIC DETAIL: \ 
Pneumococcal Immunization Definition: 
• Procedures (CPT Codes): V CPT 90669; 90732, 

G0009, G8115 [BGP PNEUMO IZ CPTS] 
• Procedures (ICD Codes): POV V06.6; V03.82 

[BGP PNEUMO IZ DXS] 
• Procedures: V Proc 99.55 [BGP PNEUMO IZ 

PROCEDURES] 
• Immunization (CVX Codes): 33 PNEUMO-PS; 

100 PNEUM CONJ; 109 PNEUMO NOS 
[BKM PNEUMO IZ CVX CODES] 

 
Site Configurable? No 

A Pneumovax 
Immunization is due 
every 5 years for all 
patients. 
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Reminder Name Description Field Text Tooltip Text 
PPD Test (TB) Type: Care Management 

Category: HIV 
Reminder Name: PPD Test (TB) 
Default Status: On 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
Without documentation of: 
• history of Tuberculosis diagnosis ever 
• history of treatment for Tuberculosis ever 
• history of positive PPD results (Positive defined 

as: Positive in the Results field or greater than 5 
in the Reading field 

 
Definition (Frequency): Annually 
 
LOGIC DETAIL: 
PPD Test Definition: 
• Procedures (CPT Codes): V CPT 86580, 86585, 

87555-87557 [BKM PPD CPTS] 
• Procedures (ICD Codes): V74.1 [BKM PPD 

ICDS ] 
• LOINC Codes: V Lab as predefined in [BKM 

PPD LOINC CODES] 
• Site Defined: Site-defined tests in [BKM PPD 

TAX] 
 
Tuberculosis Diagnosis Definition 
• Diagnosis (ICD Codes): POV or Problem List 

010.00-018.96, 137.0-137.4, 795.5, V12.01 
[DM AUDIT PROBLEM TB DXS] 

 
Tuberculosis Treatment Definition: 
• Medications (NDC Codes): V Medication as 

predefined in [BKM TB MED NDCS] 
• Site Defined Medications: V Medication site-

defined tests in [BKM TB MEDS] 
Site Configurable? No 

A PPD Skin Test is due 
annually for all patients 
WITHOUT a history of: 
1) treatment for TB; 2) 
previous positive PPD 
results. 
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Reminder Name Description Field Text Tooltip Text 
Syphilis (RPR) 
Test 

Type: Care Management 
Category: HIV 
Reminder Name: Syphilis (RPR) Test 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND/OR 
With a history of POV diagnosis of Chlamydia, 
Gonorrhea, Trichomoniasis or other STDs WITHOUT a 
negative Syphilis test since the diagnosis 
OR 
With a history of positive test results for Chlamydia or 
Gonorrhea since date of last Syphilis test 
 
Definition (Frequency): Variable 
- Now if there has been a diagnosis of either Gonorrhea, 
Chlamydia, Trichomoniasis or other STD since the most 
recent Syphilis test 
- Now if there has been a positive test result for either 
Chlamydia or Gonorrhea since the most recent Syphilis 
test 
OR 
- Annually 
LOGIC DETAIL: 
RPR (Syphilis) Test Definition: 
• Procedures (CPT Codes): V CPT 86592, 86593, 

87285 [BKM RPR CPTS] 
• LOINC Codes: V Lab as predefined in [BKM 

RPR LOINC CODES] 
• Site Defined Lab Tests: V Lab site-defined tests 

in [BKM RPR TAX] 
 
Gonorrhea Test: 
• Procedures (CPT Codes): 87590-87592, 87850 

[BKM GONORRHEA TESTS CPTS] 
• LOINC Codes: V Lab as predefined in [BKM 

GONORRHEA LOINC CODES 
• Site Defined Lab Tests: V Lab site-defined in 

[BKM GONORRHEA TEST TAX] 

An RPR Syphilis Test is 
due: 1) immediately 
after infection with 
Gonorrhea, Chlamydia, 
Trichomoniasis or other 
sexually transmitted 
infection; 2) annually for 
all patients. 
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Reminder Name Description Field Text Tooltip Text 
Syphilis (RPR) 
Test (cont.) 

Chlamydia Test Definition: 
• Procedures (CPT Codes): V CPT 86631, 86632, 

87110, 87270, 87320,87490-87492, 87810 
[BGP CHLAMYDIA CPTS] 

• LOINC Codes: V Lab as predefined in [BGP 
CHLAMYDIA LOINC CODES] 

• Site Defined Lab Tests: V Lab site-defined tests 
in [BGP CHLAMYDIA TESTS TAX] 

 
Gonorrhea Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

098.0-.89 [BKM GONORRHEA DXS] 
 
Chlamydia Diagnosis Definition: 
• Diagnosis (ICD Codes): POV or Problem List 

077.98, 078.88, 079.88, 079.98, 099.41, 099.50-
59 [BKM CHLAMYDIA DXS] 

 
Trichomoniasis Diagnosis Definition 
• Diagnosis (ICD Codes): POV or Problem list 

131.0-.9 [BKM TRICHOMONIASIS DXS] 
 
Other STD Diagnosis Definition 
• Diagnosis (ICD Codes): POV or Problem list 

099.1-099.3, 099.40, 099.49, 099.8, 099.9 
[BKM OTHER STD DXS] 

 
Site Configurable? No 

 

Safe Sex 
Education 

Type: Care Management 
Category: HIV 
Reminder Name: Safe Sex Education 
Default Status: On 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS starting at age 13 years 
Definition (Frequency): Every 6 months 
 
LOGIC DETAIL: 
Safe Sex Education Definition: 
• Patient Education Codes: V PED STD-P, STI-

P, HIV-P, FP-FC, MH-RS, WL-SX,WH-RS, 
ATO-LA, HEP-P, HEP-LA [BKM SAFE SEX 
ED CODES] 

 
Site Configurable? No 

Safe Sex Education is 
due every 6 months for 
all patients starting at 
age 13 years. 
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Reminder Name Description Field Text Tooltip Text 
Tetanus 
Immunization 

Type: Care Management 
Category: HIV 
Reminder Name: Tetanus Immunization 
Default Status: On 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
Definition (Frequency): Every 10 years 
 
LOGIC DETAIL: 
Tetanus Immunization Definition: 
• Procedures (CPT Codes): V CPT 90698, 

90700-90703, 90711, 90718, 90720-21, 90723, 
90839 [BKM TETANUS IZ CPTS] 

• Procedures (ICD Codes): V03.7 Tetanus Vac, 
V06.1 DTP, V06.2 DTP+TAB;,; V06.3 
DTP+polio, V06.5 DT [BKM TETANUS IZ 
DXS] 

• Procedure Codes: V Proc 99.38, 99.39 [BKM 
TETANUS IZ PROCEDURES] 

• Immunization (CVX Codes): 01 DTP; 20 
DTaP; 28 DT-PEDS; 09 Td-Adult; 35 Tetanus 
Toxoid; 13 TIG; 106 DTaP 5; 107 DTaP NOS; 
22 DTP [BKM TETANUS IZ CVX CODES] 

 
Site Configurable? No 

A Tetanus 
Immunization is due 
every 10 years for all 
patients. 
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Reminder Name Description Field Text Tooltip Text 
Toxoplasmosis Type: Care Management 

Category: HIV 
Reminder Name: Toxoplasmosis Test 
Default Status: On 
 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
AND 
Without a history of positive Toxoplasmosis test 
 
Definition (Frequency): Annually 
 
LOGIC DETAIL: 
Toxoplasmosis Test Definition: 
• Procedures (CPT Codes): V CPT 86777, 86778 

[BKM TOXOPLASMOSIS CPTS] 
• LOINC Codes: V Lab as predefined in [BKM 

TOXOPLASMOSIS LOINC CODES] 
• Site Defined: V Lab site-defined in [BKM 

TOXOPLASMOSIS TESTS TAX] 
Site Configurability: No 

A Toxoplasmosis test is 
due annually for all 
patients WITHOUT a 
history of positive 
Toxoplasmosis test. 

HIV Viral Load 
Test 

Type: Care Management 
Category: HMS 
Reminder Name: HIV Viral Load Test 
Status: On 
Denominator: Patients with a proposed or accepted tag 
for HIV OR Active on HMS Register with Diagnosis 
Category of HIV or AIDS 
Definition (Frequency): Every 4 months 
 
LOGIC DETAIL: 
HIV Viral Load Test Definition: 
• Procedures (CPT Codes): V CPT 87536, 87539 

[BGP HIV VIRAL LOAD CPTS] 
• LOINC Codes: V Lab as predefined in [BGP 

VIRAL LOAD LOINC CODES] 
• Site Defined Lab Tests: V Lab site-defined tests 

in [BGP HIV VIRAL LOAD TAX] 
Site Configurable? No. 

An HIV Viral Load Test 
is due every 4 months 
for all patients. 
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Appendix E:  CDC Clinical Classification 
Classification of HIV disease can be undertaken for several purposes and should be 
distinguished from disease staging. Staging is disease classification that aims 
primarily to make groupings that have different prognosis and can be used in guiding 
treatment decisions. A number of classification and staging systems have been 
proposed for HIV disease, but the classification scheme constructed by the Centers 
for Disease Control and Prevention (CDC) has gained the widest acceptance. 

The current CDC classification system, from the revision in 1993, combines three 
categories of the CD4 count with three symptom categories. It was first put forth as a 
categorization of HIV-related signs and symptoms and was explicitly for “public 
health purposes” and not intended as a staging system, although it is frequently 
treated as such. The CDC proposed that it be used to “guide clinical and therapeutic 
actions in the management of HIV-infected adolescents and adults.” 

The three categories relating to the CD4+ cell count: 

• Category 1 includes counts of 500 or more cells per microliter 

• Category 2 includes counts from 200 to 499 

• Category 3 includes counts below 200 cells 
The three clinical categories for people who test HIV-positive: 

• Category A includes individuals who have been asymptomatic except for 
persistent generalized lymphadenopathy and/or seroconversion syndrome. 

• Category B comprises those who have never had an AIDS-defining illness but 
have had some of the less serious complications of HIV infection, including 
oral or vaginal candidiasis, constitutional symptoms such as fever or persistent 
diarrhea, oral hairy leukoplakia, herpes zoster, idiopathic thrombocytopenic 
purpura, listeriosis, peripheral neuropathy, cervical dysplasia, bacillary 
angiomatosis, or pelvic inflammatory disease. 

• Category C is used to describe those who have had one or more of the AIDS-
defining illnesses. 

The use of both the CD4+ cell count and clinical categories provides shorthand for 
where the patient stands in the course of the HIV/AIDS continuum. A person placed 
in Category A1 has the least immune damage and fewest clinical complications; 
someone scoring C3 is seriously ill. Anyone placed in Category 3 and/or Category C 
has an AIDS diagnosis under the 1993 CDC case definition. A somewhat different 
classification scheme is used for pediatric cases: three classes using the letter P for 
pediatric matched with the numeral 0, 1, or 2 to indicate the stage, along with 
subclasses and categories of specific types of diseases. 
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While there are guidelines in place, assignation of this classification is made only 
after clinical evaluation. The decision of which category to assign is always made by 
a clinical person. 

The table below provides a summary of the CDC clinical classification. The sections 
following describe these classifications in more detail. 

Classification Meaning 
A1 Asymptomatic HIV infection + CD4 count > or = 500 
A2 Asymptomatic HIV infection + CD4 count between 200 and 499 
A3 Asymptomatic HIV infection + CD4 count less than 200 
B1 Symptoms attributable to HIV infection + CD4 count >= 500 
B2 Symptoms attributable to HIV infection + CD4 count between 200-499 
B3 Symptoms attributable to HIV infection + CD4 count less than 200 
C1 AIDS defining condition(s) + CD4 count > or = 500 
C2 AIDS defining condition(s) + CD4 count between 200 and 499 
C3 AIDS defining condition(s) + CD4 count less than 200 

 
The definitions of the three CD4 count categories are as follows: 

• Category 1: > 500 cells/mm3 (or CD4% > 28%) 

• Category 2: 200-499 cells/mm3 (or CD4% 14% - 28%) 

• Category 3: < 200 cells/mm3 (or CD4% < 14%) 

The lowest, most accurate CD4 count should be used for classification purposes. This 
will not necessarily be the most recent count but the most representative for the time 
frame being evaluated. This is a modifiable field and the user should expect to re-
evaluate and change this frequently. 

The definitions of the three clinical condition categories are as follows: 

• Category A: Asymptomatic HIV infection; persistent generalized 
lymphadenopathy; acute, primary HIV infection with accompanying illness or 
history of acute HIV infection. 

• Category B: Symptomatic conditions in an HIV-infected adolescent or adult 
that are not included among conditions listed in clinical Category C and that 
meet at least one of the following criteria: (a) the conditions are attributed to 
HIV infection or are indicative of a defect in cell-mediated immunity; or (b) 
the conditions are considered by physicians to have a clinical course or to 
require management that is complicated by HIV infection. Examples of 
conditions in clinical category B include but are not limited to are: 

• Bacillary angiomatosis 

• Candidiasis, oropharyngeal (thrush) 
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• Candidiasis, vulvovaginal; persistent, frequent, or poorly responsive to 
therapy 

• Cervical dysplasia (moderate or severe)/cervical carcinoma in situ 

• Constitutional symptoms, such as fever (38.5 degrees centigrade) or 
diarrhea lasting greater than 1 month 

• Hairy leukoplakia, oral 

• Herpes zoster (shingles), involving at least two distinct episodes or more 
than one dermatome 

• Idiopathic thrombocytopenic purpura 

• Listeriosis 

• Pelvic inflammatory disease, particularly if complicated by tubo-ovarian 
abscess 

• Peripheral neuropathy 

• Category C: Any incidence of one or more of the clinical conditions listed in 
the 1993 AIDS surveillance case definition, i.e., AIDS Defining Illnesses. For 
classification purposes, once a Category C condition has occurred, the person 
will remain in Category C. 

A patient’s clinical classification is dynamic. You can see from the definitions above 
that the numeric portion of the classification (1, 2, or 3) could change at each visit 
depending on the CD4 count. The alpha portion of the classification can change or 
progress from A to B to C but it cannot go back from C to B to A. In other words, 
once a patient has been assigned to the C classification which indicates AIDS, the 
clinical classification will never revert to an HIV classification even if the condition 
improves. 
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Appendix F:  Medications 
This section describes the ARV/HAART definitions and the medication 
categorization for taxonomy setup. 

15.5 ARV/HAART Definitions 
ARV (Antiretroviral Therapy)/HAART (Highly Active Antiretroviral Therapy) is a 
specific treatment regimen defined as: 

• 2 or more NRTI (M.03) together with at least one NNRTI (M.02) or PI (M.05) 
OR 

• 2 or more PIs (M.05) with at least 1 NRTI (M.03) 
OR 

• at least 3 NRTIs (M.03) 

15.6 Medication Categorization for Taxonomy Setup 
Use the following medication list to assist you in setting up the medication 
taxonomies that are used by the HIV Management System. (See Section 15.4 for 
detailed information about setting up medication taxonomies.) The following lists the 
medications that are commonly prescribed for each of the categories. 

You should work with a pharmacist to determine which medications are available and 
how they are categorized at your facility. 
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Abacavir (Ziagen, ABC) X           

Didanosine (Videx, Videx EC) X           

Emtricitabine (Emtriva) X           

Lamivudine (Epivir) X           

Lamivudine/Abacavir (Epzicom) X           

Stavudine (Zerit) X           

Tenofovir (Viread) X           
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Zalcitibine (Hivid) X           

Zidovudine (Retrovir) X           

Zidovudine/Lamivudine 
(Combivir) 

X           

Zidovudine/Lamivudine/Abacavir 
(Trizivir) 

X           

Delaviridine (Rescriptor)  X          

Efavirenz (Sustiva)  X          

Nevirapine (Viramune)  X          

Etravirine (TMC-125) (Intelence)  X          

Tenofovir/Emtricitabine 
(Truvada) 

  X         

Tenofovir/Emtricitabine/Efavirenz 
(Atripla) 

   X        

Amprenavir (Agenerase)     X       

Atazanavir (Revataz)     X       

Fosamprenavir (Lexiva)     X       

HGC Saquinavir (Invirase)     X       

Indinavir (Crixivan)     X       

Lopinavir/Ritonavir (Kaletra)     X       

Nelfinavir (Viracept)     X       

SCG Saquinavir (Fortovase)     X       

Tipranovir (Aptivus)     X       

Darunavir (Prezista)     X       

Ritonavir (Norvir)      X      

Enfurviritide (Fuzeon)       X     

Maraviroc (Selzentry)       X     

Raltegravir (Isentress)        X    

Atovaquone (Mepron)         X   

Dapsone         X   

Pentamidine, Pentam 300, 
Pentacarinate  
(NebuPent) 

        X   

Sulfamethaxazole & 
Trimethoprim/Cotrimoxazole 
(Bactrim; Septra) 

        X   

Trimethoprim (Proloprim, 
Trimex) 

        X   
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Trimetrexate, Glururonate 
&Leucovorin (Neutrexin) 

        X   

Azithromycin (Zithromax)         X   

Clarithromycin (Biaxin, Klacid)          X  

Rifabutin (Mycobutin, 
Ansamycin) 

         X  

Ethambutol (Myambutol)          X  

Isoniazid (INH)           X 
Pyrazinamide           X 
Rifamate           X 
Rifampin           X 
Rifater           X 
Streptomycin           X 
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Appendix G:  Quality of Care Report Logic 
The Quality of Care report provides a snapshot of the status of key care indicators for 
HIV/AIDS patients in the past 12 months. The general format is based on HIVQual, a 
HRSA-sponsored program built upon a model of quality improvement consultation 
that was developed in New York State. The goal of the HIVQual Continuous Quality 
Project is to improve the quality of care delivered to persons with HIV. 

Users select an end date for the report, usually “today,” and the report will display the 
status and categorization of the various elements listed above for the patients you 
have chosen to include in the report. The patients are selected from an iCare panel, 
either created by or shared with the user. iCare users will then select one of three 
ways to further define the denominator for this report. 

G.1 Denominator 
Use one of the following: 

• Patients on this panel who have an Active HMS Register Status with HMS Dx 
Category values empty, HIV or AIDS (i.e., no “At Risk” patients) 

• Patient on this panel who have a Proposed or Accepted Dx tag of HIV/AIDS 
(user selects either or both Tag Status) 

• Specified (by highlighting) patients on this particular panel 
Any denominator is filtered automatically by the following logic: patients must have 
at least one HIV/AIDS POV or Active Problem List or HMS Initial HIV Dx Date or 
HMS Initial AIDS Dx Date 6 months or more prior to report end date. Patient names 
selected by the user that do not meet these criteria will be identified on the report. 

G.2 Numerators 

G.2.1 Gender breakdowns: 
• Male patients 

• Female patients. 

G.2.2 Age breakdowns: 
• Younger than (<) 15) 

• Ages 15 through 44 

• Ages 45 through 64 
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• Older than 64. 
Age of patient is determined as of Report End date. 

G.2.3 Most recent CD4 count in 4 months prior to end of Report period 
Total number of patients reviewed with any completed CD4 test (either CD4 All (T.2) 
or CD4 Absolute (T.1)): 

• CD4 Absolute (T.1) results less than (<) 50. 

• CD4 Absolute (T.1) results equal to or greater than (=>) 50 and less than (<) 200. 

• CD4 Absolute (T.1) results => 200. 

• Number with undetermined results. 
If there is more than one test in the timeframe for the patient, use most recent result. 

If most recent test result is undetermined (no appropriate value), look for next test in 
the timeframe (past 4 months) with results. If no tests are found with appropriate 
results within past 4 months, count as “Undetermined.” 

G.2.4 Most recent Viral Load (T.26) 
Total number of patients with Viral Load test in 4 months prior to end of Report 
period. 

• Test results less than (<) 100,000 copies/ml. 

• Test results equal to or greater than (=>) 100,000 copies/ml. 

• Tests with undetermined results. 
If there is more than one test in the timeframe for the patient, use most recent result. 

If most recent test result is undetermined (no appropriate value), look for next test in 
the timeframe (past 4 months) with results. If no tests are found with appropriate 
results, count as “Undetermined.” 

G.2.5 RPR (Rapid plasma reagin) (Syphilis screening): 
Number with RPR or FTA-ABS (T.22 & T.09) completed or refused in year prior to 
end of report period. Use most recent results or refusal, if more than one test in the 
timeframe, to categorize as follows: 

• Number reactive (positive) tests r or R or Reactive; wr or WR or Weakly 
Reactive. 

• Number Non-reactive tests. n or N or Nonreactive. 

• Undetermined values. 
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• Refused (Refusal type REF). 

• NMI (Not Medically Indicated) (Refusal type NMI). 

G.2.6 Chlamydia 
Number with Chlamydia test (T.3) completed or refused in year prior to end of report 
period. Use most recent results or refusal, if more than one test in the timeframe, to 
categorize as follows: 

• Number of Females. 

• Number of Males. 

• Number of positive tests p or P or Positive or POS. 

• Number of negative tests n or N or Negative or NEG. 

• Undetermined values. 

• Refused (Refusal type REF). 

• NMI (Not Medically Indicated) (Refusal type NMI). 

G.2.7 Gonorrhea: 
Number with gonorrhea test (T.10) completed or refused in year prior to end of report 
period. Break the total number in the Numerator into number of Males and number of 
Females. Use most recent results or refusal, if more than one test in the timeframe, to 
categorize as follows: 

• Number of Females. 

• Number of Males. 

•  Number of positive tests p or P or Positive or POS. 

• Number of negative tests n or N or Negative or NEG. 

• Undetermined values. 

• Refused. 

• NMI (Not Medically Indicated) 

G.2.8 Tuberculosis Status: 
Total number of patients who needed PPD during Report Year, i.e., year previous to 
the end of the Report Period. Defined as including patients with any of the following: 

• No TB diagnosis ever (DX.14);  

• No PPD ever;  
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• No positive PPD results (T.21) on test performed more than one year previous to 
the end of the Report period, i.e. before the Report Year (see below for definition 
of “positive”; 

• No history of TB treatment (M.08) before the Report Year. 
Use most recent results or refusal, if more than one test in the timeframe, to 
categorize as follows: 

• Number of PPD received or refused (T.21) in previous year, regardless of result, 
with percentage of denominator Need PPD. 

• Number with positive PPD results in Report year, with percentage of denominator 
number PPD received. “Positive” result is defined as either: 

− Result field containing “p” or “P” or “POS” or “positive” or “+”; 
− No value in Result field but Reading field ≥ 5. 

• Number from previous list who had treatment given (M.08) or refused treatment 
or treatment contraindicated ON or AFTER date of positive PPD result, with 
percentage of denominator Pos PPD. 

• Number with negative PPD results in previous year, with percentage of 
denominator number PPD received. “Negative” result defined as either: 

− Result field containing “n” or “-” or “N” or “NEG” or “negative” or “0”; 
− No value in Result field but Reading field < 5. 

• Number with documented PPD refusals, with percentage of denominator number 
PPD received. If the most recent test is a refusal, look for a previous test within 
the time frame and categorize as above. If only the refusal exists, categorize here 
as a refusal. (NOTE: this logic was not provided on the original document, but 
was included on the format layout.) 

• Number with undetermined results in previous year, with percentage of 
denominator number PPD received. 

G.2.9 Lipids Screening 
Total number of patients with Lipid Profile (T.30) completed or refused in year prior 
to end of report period. Use most recent panel or refusal, if more than one panel in the 
timeframe. Further categorize by: 

• Number of patients who had a Lipid panel AND are receiving any ARVs (M.02; 
M.03; M.05; M.09; M.10; M.11; M12; M13); 

• Number of refusals 
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G.2.10 Colorectal Cancer Screen 
Total number of patients who needed a Colorectal Cancer (CRC) Screen (S.05) in the 
10 years prior to end date of the report. Defined as including patients: 

• Greater than or equal to 50 years of age on the date of the beginning of the report 
period. 

• No CRC diagnosis ever (DX.18); 

• No history of a total Colectomy (P.06). Use most recent screening or refusal, if 
more than one test in the timeframe, to categorize as follows: 

− Total number of patients who received or refused CRC Screens in previous 10 
years, with percentage of denominator Need CRC 

− Number of refusals. 

G.2.11 Hepatitis C Screen Baseline 
Total number of patients with a Hepatitis C Screen (T.13; T.14) baseline either: 

• Completed ever: 

• Refused in past year. 

G.2.12 Pneumovax Status 
Total number of patients with any of the following: 

• One pneumovax (IZ.6) documented in the 5 years prior to the end of the Report 
period; 

• Two pneumovax ever; 

• Pneumovax refusal in past year. 

G.2.13 Tetanus Status 
Total number of patients with any of the following: 

• Tetanus vaccine (IZ.7) in past 10 years; 

• Contraindicated; 

• Refusal in past year. 

Note: Logic for contraindications is not currently provided. 

G.2.14 Eye Exam Status 
Total number of patients with either: 

• Any completed or non-DNKA ophthalmology eye exam (P.03); 



iCare Population Management GUI (BQI) Version 2.2 

User Manual Quality of Care Report Logic 
August 2011 

436 

• Refusal documented in year prior to end of Report period. 

G.2.15 Dental Exam Status 
Total number of patients with either: 

• Any completed or non-DNKA dental exam; 

• Refusal (P.02) documented in year prior to end of Report period. 

G.2.16 Pap Smear Status 
Total number of female patients ages 19 through 64 with either: 

• No documented history of Hysterectomy (P.04) with Pap smear (T.20); 

• Refusal documented in one year period to end of Report period. 

G.2.17 ARV Therapy 
Number of patients for whom any ARV medications (M.02; M.03; M.05; M.09; 
M.10; M.11; M.12 M.13;) have been prescribed (Total of G.2.17.1, G.2.17.2, and 
G.2.17.3) as their most recent regimen in four months previous to end of Report 
Period, with percentage of Total Patients. 

G.2.17.1 HAART 
Number of patients on HAART medications in most recent regimen during past four 
months, with percentage of ARV total. A HAART regimen can be defined by an 
Active or Chronic (not Discontinued or Expired) prescription for one of the following 
nine regimens: 

• At least one PI (M.05) medication AND two NRTI (M.03) medication 

• At least one PI (M.05) medication AND one NRTI Combo (M.12) medication 

• At least 2 NRTI (M.03) medications AND one NNRTI (M.02) medication 

• At lease one NRTI Combo (M.12) medication AND one NNRTI (M.02) 
medication 

• At least one EI (M. 09) medication AND two of any NNRTI (M.02); NRTI 
(M.03); OR PI (M.05) medications 

• At least one EI (M.09) medication AND one NRTI Combo (M.12) medication 

• At least one II (M.10) medication AND two of any NNRTI (M.02); NRTI (M.03); 
OR PI (M.05) medications 

• At least one II (M.10) medication AND one NRTI Combo (M.12) medication 

• At least one NRTI/NNRTI (M.11) medication 
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G.2.17.2 17B) Mono therapy 
Number of patients who have had any one of the ARV medications prescribed for 
them one at a time in past four months. Defined as Active or Chronic (not 
Discontinued or Expired), with percentage of ARV total. 

G.2.17.3 17C) Other Combination 
Number of patients who have had any other ARV medication combination (not 
included in G.2.17.1 or G.2.17.2) prescribed for them in past four months. 
Defined as Active or Chronic (not Discontinued or Expired), with percentage of 
ARV total. 

G.2.18 PCP Prophylaxis 
Number of patients with any CD4 Absolute (T.1) results less than 200 in past 12 
months, how many received PCP Prophylaxis (M.04), with percentage of patients 
(CD4 < 200). Look at date of appropriate CD4 Absolute result (T.1) and count any 
medications prescribed on or after that date (prior to end of Report period). NOTE: 
the total number of patients in this value range can be more than the number of 
patients in the same range documented in the CD4 Lab Exam section, which 
documents most recent value rather than any value during the time period. 

G.2.19  MAC Prophylaxis 
Number of patients with any CD4 Absolute (T.1) results <50 in past 12 months, how 
many received MAC prophylaxis (M.01), with percentage of patients (CD4 <50). 
Look at date of appropriate CD4 Absolute (T.1) result and count any medications 
prescribed on or after that date (prior to end of Report period). NOTE: the total 
number of patients in this value range might be more than the number of patients in 
the same range documented in the CD4 Lab Exam section, which documents most 
recent value rather than any value during the time period. 

G.2.20 Tobacco Use 
Total number of patients screened for tobacco use (S.04) in year prior to end of 
Report Period: 

• Number of patients identified as tobacco users (DX.12) in year prior to end of 
Report Period. 

• Number counseled about tobacco use (ED.5) in past year. 

• Number identified as not current tobacco users (DX.7) in past year. 

• Number of patients with undetermined tobacco use (Total patients minus any 
patient not categorized in the previous three categories. 
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G.2.21 Substance Use 
• Total number of patients screened for substance use (S.1 and S.3) in year prior to 

end of Report Period. 

The last page of the report will provide an overview of the Report logic and a list of 
the user-selected patients who were and were not included on the report. The 
following text and data should be included: 

G.3 HMS Quality of Care Report 
This report includes all patients who meet the criteria of the selected denominator 
(any of the following): 

• HMS Register Status Active with HMS Dx Category values empty, HIV or AIDS 
(i.e., no “At Risk” patients) 

• Proposed and/or Accepted Dx tag of HIV/AIDS (user selects either or both Tag 
Status) 

• Specific patients on the grid. 
Any denominator is filtered automatically by the following logic: patients must have 
at least one HIV/AIDS POV or Active Problem List or HMS Initial HIV Dx Date or 
HMS Initial AIDS Dx Date 6 months or more prior to report end date. 

Total Patients Reviewed (All patients in denominator): [number] 

Number of Patients included on Report (filtered denominator): [number] 

Number of Patients NOT included on Report: [#] 

The following user selected patients are included on this report: 

• Name (Last Name, First Middle format) 

• HRN 

• Age 

• Gender 

• Current Register Diagnosis 

• Initial HIV Diagnosis Date 

• Initial AIDS Diagnosis Date 

• HIV/AIDS Diagnostic Tag Status 
The following user selected patients are NOT included on this report: 

• Name (Last Name, First Middle format) 
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• HRN 

• Age 

• Gender 

• Current Register Diagnosis 

• Initial HIV Diagnosis Date 

• Initial AIDS Diagnosis Date 

• HIV/AIDS Diagnostic Tag Status 

G.4 Sample Format, Quality of Care Audit 
[Initials] = initials of user who runs the report. 

[Denominator Population] is identified from Section G.1, e.g., HMS Active Patients; 
All RPMS HIV POV; Patients with Designated Provider [Name]; or Patient Panel 
[Name] 

ALA                                Oct 02, 2008 
                                DEMO HOSPITAL 
                         HMS CUMULATIVE AUDIT REPORT 
                             HIV QUALITY OF CARE 
                             Copy of HMS patients 
                         Active HMS Register Patients 
                         PERIOD ENDING: Oct 01, 2008 
               ****    CONFIDENTIAL PATIENT INFORMATION    **** 
 ----------------------------------------------------------------------------- 
 Total Patients Reviewed: 35 
12 patients are included in this report. 
  
                                                 #         % 
  
 Gender: Male                                   4      33.3% 
         Female                                 8      66.7% 
  
 Age     <15 yrs                                1       8.3% 
         15-44 yrs                              4      33.3% 
         45-64 yrs                              6      50.0% 
         >64 yrs                                1       8.3% 
  
 LABORATORY EXAMS 
# w/ CD4 count in last 4 months                 0       0.0% 
         most recent<50                         0       0.0% 
         most recent 50-199                     0       0.0% 
         most recent=>200                       0       0.0% 
         Undetermined                           0       0.0% 
  
 # w/ Viral Load in last 4 months               0       0.0% 
         <100,000 copies/ml                     0       0.0% 
         =>100,000 copies/ml                    0       0.0% 
         Undetermined                           0       0.0% 
  
 # w/ RPR (Syphilis Test) in the last 12 month  0       0.0% 
         Reactive                               0       0.0% 
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         Non-Reactive                           0       0.0% 
         Refused                                0       0.0% 
         NMI                                    0       0.0% 
         Undetermined                           0       0.0% 
  
 # w/ Chlamydia Screen in the last 12 months    1       8.3% 
         # Men                                  1     100.0% 
         # Women                                0       0.0% 
         Positive                               0       0.0% 
         Negative                               1     100.0% 
         Refused                                0       0.0% 
         NMI                                    0       0.0% 
         Undetermined                           0       0.0% 
  
 # w/ Gonorrhea Screen in the last 12 months    1       8.3% 
         # Men                                  1     100.0% 
         # Women                                0       0.0% 
         Positive                               0       0.0% 
         Negative                               1     100.0% 
         Refused                                0       0.0% 
         NMI                                    0       0.0% 
         Undetermined                           0       0.0% 
  
 # w/ Tuberculosis test needed                 12     100.0% 
         PPD Received                           1       8.3% 
         PPD+                                   1     100.0% 
           w/ Treatment Given                   0       0.0% 
         PPD-                                   0       0.0% 
         PPD Refused                            0       0.0% 
         PPD Status Unknown                     0       0.0% 
  
 # w/ Lipids Screen                             0       0.0% 
         # on ARV                               0       0.0% 
         # Refused                              0       0.0% 
  
 # Hep C Screen Baseline                        3      25.0% 
  
 VACCINATION 
 # w/ Pneumovax in last 5 years (or 2 ever)     2      16.7% 
 # w/ Tetanus in past 10 years                  4      33.3% 
  
 EXAMS - Yearly 
 # w/ Eye Exam                                  0       0.0% 
 # w/ Dental Exam                               0       0.0% 
 # w/ Pap Smear                                 1      12.5% 
  
 # Colorectal Cancer Screens Needed             4      33.3% 
        # CRC screen in past 10 yrs             1      25.0% 
        # CRC screen refused                    1      25.0% 
  
 TREATMENT (past 4 months) 
 ARV Therapy Given                              3      25.0% 
     HAART                                      2      66.7% 
     Mono Therapy                               1      33.3% 
     Other Combination                          0       0.0% 
  
 PCP Prophylaxis given if CD4 <200 in last 12 months 
                                                0       0.0% 
 MAC Prophylaxis given if ANY CD4 <50 in last 12 months 
                                                0       0.0% 
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 RISK FACTORS 
 Tobacco Use Screening                          1       8.3% 
     Current Tobacco User                       1     100.0% 
     If Yes, Counseled                          0       0.0% 
     Not a Current User                         0       0.0% 
     Not Documented                             0       0.0% 
  
 Substance Use Screening                        0       0.0% 
  
  
ALA                                Oct 02, 2008 
                                DEMO HOSPITAL 
                         HMS CUMULATIVE AUDIT REPORT 
                             HIV QUALITY OF CARE 
                             Copy of HMS patients 
                         Active HMS Register Patients 
                         PERIOD ENDING: Oct 01, 2008 
               ****    CONFIDENTIAL PATIENT INFORMATION    **** 
 ------------------------------------------------------------------------------ 
                          HMS Quality of Care Report 
  
 This report includes all patients who meet the criteria of the selected 
 denominator: 
  
 1) HMS Register Status Active with HMS Dx Category values empty, HIV or AIDS 
 (i.e., no "At Risk" patients); 
  
 OR 
  
 2) Proposed and/or Accepted Dx tag of HIV/AIDS (user selects either or both 
 Tag Status); 
  
 OR 
  
 3) Specific patients on the grid. 
  
 Any denominator is filtered automatically by the following logic: patients 
 must have at least one HIV/AIDS POV or Active Problem List or HMS Initial 
 HIV Dx Date or HMS Initial AIDS Dx Date 6 months or more prior to report 
 end date. 
  
 Total patients reviewed (All patients in denominator): 35 
  
 Number of Patients included on Report (filtered denominator): 12 
  
 Number of Patients NOT included on Report: 23 
 

Figure 15-1: Sample Report 

ALA                                Oct 02, 2008 
                                DEMO HOSPITAL 
                         HMS CUMULATIVE AUDIT REPORT 
                             HIV QUALITY OF CARE 
                             Copy of HMS patients 
                         Active HMS Register Patients 
                         PERIOD ENDING: Oct 01, 2008 
               ****    CONFIDENTIAL PATIENT INFORMATION    **** 
 ------------------------------------------------------------------------------ 
 The following user selected patients are included on this report: 
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                                           REG  INITIAL HIV INITIAL AIDS TAG 
PATIENT NAME                HRN    AGE SEX  DX     DX DATE      DX DATE  STATUS 
------------                ---    --- --- ---  ----------- ------------ ------ 
TEST,PATIENT AA             nnnnnn  nn  F  HIV  01/01/1981                 A 
TEST,PATIENT AB             nnnnnn  nn  F  AIDS 01/01/2000  01/01/2000     V 
TEST,PATIENT AC             nnnnnn  nn  F  HIV  02/01/2008                 V 
TEST,PATIENT AD             nnnnnn  nn  M  HIV  08/24/1995                 A 
TEST,PATIENT AE             nnnnnn  nn  F  AIDS 06/02/2005  06/17/2007     V 
TEST,PATIENT AF             nnnnnn  nn  F  HIV  01/01/2006                 V 
TEST,PATIENT AG             nnnnnn  nn  M  HIV  02/01/2008                 V 
TEST,PATIENT AH             nnnnnn  nn  F  HIV  02/01/2008                 V 
TEST,PATIENT AI             nnnnnn  nn  F  HIV  11/01/2001                 V 
TEST,PATIENT AJ             nnnnnn  nn  M  HIV  12/01/2003                 A 
TEST,PATIENT AK             nnnnnn  nn  M  AIDS 03/26/2007  05/06/2008     V 
TEST,PATIENT AL             nnnnnn  nn  F  HIV  04/05/1968                 V 

Figure 15-2: Sample Report 

ALA                                Oct 02, 2008 
                                DEMO HOSPITAL 
                         HMS CUMULATIVE AUDIT REPORT 
                             HIV QUALITY OF CARE 
                             Copy of HMS patients 
                         Active HMS Register Patients 
                         PERIOD ENDING: Oct 01, 2008 
               ****    CONFIDENTIAL PATIENT INFORMATION    **** 
 ------------------------------------------------------------------------------ 
 The following user selected patients are NOT included in the report: 
  
                                           REG  INITIAL HIV INITIAL AIDS TAG 
PATIENT NAME                HRN    AGE SEX  DX     DX DATE      DX DATE  STATUS 
------------                ---    --- --- ---  ----------- ------------ ------ 
TEST,PATIENT BA             nnnnnn  nn  F                                  V 
TEST,PATIENT BB             nnnnnn  nn  M                                  V 
TEST,PATIENT BC             nnnnnn  nn  F                                  V 
TEST,PATIENT BD             nnnnnn  nn  F  HIV  06/02/2008                 V 
TEST,PATIENT BE             nnnnnn  nn  M  AIDS 06/02/2008  06/05/2008     V 
TEST,PATIENT BF             nnnnnn  nn  F                                  V 
TEST,PATIENT BG             nnnnnn  nn  F  HIV  06/02/2008                 V 
TEST,PATIENT BH             nnnnnn  nn  F                                  V 
TEST,PATIENT BI             nnnnnn  nn  M                                  V 
TEST,PATIENT BJ             nnnnnn  nn  F                                  V 
TEST,PATIENT BK             nnnnnn  nn  F                                  V 
TEST,PATIENT BL             nnnnnn  nn  M                                  V 
TEST,PATIENT BM             nnnnnn  nn  F                                  V 
TEST,PATIENT BN             nnnnnn  nn  M                                  V 
TEST,PATIENT BO             nnnnnn  nn  F                                  V 
TEST,PATIENT BP             nnnnnn  nn  M                                  V 
TEST,PATIENT BQ             nnnnnn  nn  F                                  V 
TEST,PATIENT BR             nnnnnn  nn  M  HIV  06/03/2008                 V 
TEST,PATIENT BS             nnnnnn  nn  M  HIV  05/07/2008                 V 
TEST,PATIENT BT             nnnnnn  nn  F                                  V 
TEST,PATIENT BU             nnnnnn  nn  F  AIDS                            V 
TEST,PATIENT BV             nnnnnn  nn  M                                  V 
TEST,PATIENT BW             nnnnnn  nn  F                                  V 
  
  
               ****  END CONFIDENTIAL PATIENT INFORMATION  **** 
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Figure 15-3: Sample Report 
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Appendix H:  HMS Patient Care Supplement 
This section provides information about the HMS Patient Care Supplement. 

H.1 Supplement Logic 
Item Description How Data Obtained From RPMS 
Report Date Date Health Supplement 

was generated 
Date Health Supplement was 
generated 

Patient’s Name Last Name, First Name, 
Middle Initial of patient. 

Patient File 

HRN Patient’s Health Record 
Number 

Patient Registration 

Sex Gender of patient Patient Registration 
DOB Patient’s date of birth 

(mmm/dd/yyyy) 
Patient Registration 

Age Age of patient in years on 
the date the summary was 
generated 

Calculated 

Designated Primary 
Care Provider 

Name of the Primary Care 
Provider on the date the 
Health Supplement was 
generated 

Designated Specialty Provider 
Management System (DSPM) or 
Patient File 

HIV Provider Name of the HIV Provider Designated Specialty Provider 
Management System (DSPM) or 
Patient File 

HIV Case Manager Name of HIV Case 
Manager 

Designated Specialty Provider 
Management System (DSPM) or 
Patient File 

Last Height The last height in inches 
and the date of the last 
height 

PCC V Measurement. The last height 
value in inches and the date of the 
last height recorded in PCC is 
displayed 

Last Weight The last weight in pounds 
and the date of the last 
weight 

PCC V Measurement. The last weight 
value in pounds and the date of the 
last weight recorded in PCC is 
displayed 
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Item Description How Data Obtained From RPMS 
BMI The BMI is calculated 

using the last height and 
weight data for the patient 

Calculated using NHANES II. For 
ages 18 and under, the most recent 
height and weight must be taken on 
the same day. For ages 19 through 
50, both the most recent height and 
weight must be documented within 
last five years, not required to be on 
same day. For ages over 50, both the 
most recent height and weight must 
be documented within last two years, 
not required to be on same day. 
If BMI cannot be calculated, display 
“BMI cannot be calculated with 
current data.” 

Register Diagnosis Field value and date. 
Assigned by HMS user. 

HMS, field [Register Diagnosis] + 
[Diagnosis Date] 

Register Status Most recent field value 
and date assigned. 

HMS field [Register status] + [Date 
assigned] 

HIV/ AIDS 
Diagnostic Tag 
Status 

Most recent field value 
and date assigned. 

iCare field [HIV/ AIDS Diagnostic Tag 
Status] + [Date Assigned] 

HIV Clinical 
Classification 

Field value and date. The 
HIV/AIDS related clinical 
category of either: A-1; A-
2; A-3; B-1; B-2; B-3; C-1; 
C-2; or C-3; as assigned 
by the HMS user 

HMS, field [Clinical Classification] + 
[Clinical Classification Date] 

Diagnosis 
Comments 

Field value and date. 
Entered by the HMS user 

HMS, field [Diagnosis Comment] 

Initial HIV diagnosis Date assigned by HMS 
user; generally the first 
recorded date of either a 
positive HIV test or an HIV 
diagnosis  

HMS, field [Date of Initial HIV Dx] 
If no field value, use logic provided for 
field default value. Add [**] at the end 
of the date value to indicate the value 
is not in the Register. Otherwise, no 
value. 

Initial AIDS 
diagnosis 

Date assigned by HMS 
user; the first recorded 
date of an AIDS diagnosis 

HMS, field [Date of Initial AIDS Dx] 
If no field value, use logic provided for 
field default value. Add [**] at the end 
of the date value to indicate the value 
is not in the Register. 
Otherwise, no value. 
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Item Description How Data Obtained From RPMS 
Opportunistic 
infections / AIDS 
Defining Illnesses 

A list of any incidence of 
Opportunistic infections 
(OI) or AIDS Defining 
Illnesses (ADI) recorded 
on the patient's Problem 
List. 

The PCC Problem List file is scanned 
for any diagnoses contained in the 
DX.1 and DX.8 diagnosis definitions. 
If found, a list of OI or ADI will be 
displayed; [Onset date] + [Entry Date] 
+ [ICD9] + [ICD Narrative] + [Provider 
Narrative] + [Status of Problem]. 
If the Problem List entry has no onset 
date, display the Entry date. If the 
Problem List has an onset date and 
an entry date that are different, 
display both dates. Display list in 
reverse order, most recent first. 

State Notification(s) Status and date the state 
of residence was notified 
of HIV/AIDS diagnosis 

HMS, field [State Reporting Category] 
+ [State Reporting Status] + [State 
Reporting Date], if any 

Partner Notification Status whether the 
patient’s partner was 
notified 

HMS, field [Partner Notification 
Status] + [Date of Assessment] 

Last 6 CD4 The six most recent CD4 
lab tests and results, if 
available 

Look for the 6 most recent CD4 lab 
tests not on the same day defined in 
the T.1 (CD4 Absolute) and T.2 (CD4 
All Tests) definitions. For each visit 
date with any CD4 test, if there is no 
test that meets the CD4 Absolute 
definition, then use the CD4 All Tests 
definition. Only results for CD4 
Absolute tests should be displayed. 
Only display one test for any date; if 
there are 2 CD4 Absolute tests 
documented on the same day, display 
the test with a result. 
If found, the results (for CD4 Absolute 
only) and respective dates will be 
displayed, most recent value first. 

Last 6 HIV/RNA 
Viral Load 

The six most recent 
HIV/RNA Viral Load lab 
test results 

Look for the 6 most recent lab tests 
not on the same day contained in the 
T.26 (HIV Viral Load Tests) 
definitions. Only display one test for 
any date; if there are 2 tests 
documented on the same day, display 
the test with a result Once found, the 
results and respective dates will be 
displayed, most recent value first. 
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Item Description How Data Obtained From RPMS 
Lipid Profile The last Lipid Profile 

Results 
Look for the last panel contained in 
the T.30 (Lipid Profile). Once found, 
display all tests contained in the 
panel, if any, for the most recent date. 
If none found, then the refusals file is 
scanned for a patient refusal of a 
Lipid Profile. If a refusal is 
documented, indicated date and 
[refusal type] (e.g., REF, NMI) in 
result label 
NOTE: Panels will have multiple line 
values. Display ALL of the related test 
data in the panel 

RPR The last RPR result Look for the last test contained in the 
T.22 (RPR) definitions. Once found, 
the date and results are displayed. 
Only display one test for any date; if 
there are 2 tests documented on the 
same day, display the test with a 
result. If none found, then the refusals 
file is scanned for a patient refusal of 
an RPR. If a refusal is documented, 
indicate date and [refusal type] (e.g., 
REF, NMI) in Result label. 

PAP Smear The last Pap Smear result Look for the last test or procedure 
contained in the T.20 (Pap Smear) 
definitions. Once found, the date and 
results are displayed. Only display 
one test for any date; if there are 2 
tests documented on the same day, 
display the test with a result. If none 
found, then the refusals file is 
scanned for a patient refusal of a Pap 
Smear. If a refusal is documented, 
indicate date and [refusal type] (e.g., 
REF, NMI) in Result label. 
If patient is Male, display “Not 
Applicable” 

Chlamydia The last Chlamydia test 
result 

Look for the last test contained in the 
T.3 (Chlamydia Test) definitions. 
Once found, the date and results are 
displayed. Only display one test for 
any date; if there are 2 tests 
documented on the same day, display 
the test with a result. If none found, 
then the refusals file is scanned for a 
patient refusal of a Chlamydia Test. If 
a refusal is documented, indicate date 
and [refusal type] (e.g., REF, NMI) in 
Result label. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual HMS Patient Care Supplement 
August 2011 

448 

Item Description How Data Obtained From RPMS 
Gonorrhea The last Gonorrhea test 

result 
Look for the last test contained in 
theT.10 (Gonorrhea Test) definitions. 
Once found, the date and results are 
displayed. Only display one test for 
any date; if there are 2 tests 
documented on the same day, display 
the test with a result. If none found, 
then the refusals file is scanned for a 
patient refusal of a Gonorrhea Test. If 
a refusal is documented, indicate date 
and [refusal type] (e.g., REF, NMI) in 
Result label. 

Hepatitis Panel The last Hepatitis Panel 
test results. Depending on 
the site-specific definition, 
all or some of the following 
tests can be displayed. 
Hepatitis A Antibody 
(HAAb) IgM antibody; 
Hepatitis A Antibody 
(HAAb) IgG 
Hepatitis B Core Antibody 
(HbcAb) IgM antibody; 
Hepatitis C Antibody 
Hepatitis C Screen 
Hepatitis C Confirm 
Hepatitis B surface 
Antigen (HbsAg). 
Hepatitis B Surface 
Antibody (HBs Antibody) 
Hepatitis B Virus Core 
Total Antibody  

Look for the last panel contained in 
the T.29 (Hepatitis Panel) definitions. 
Once found, the dates and results for 
each element of the panel are 
displayed respectively. If none found, 
then the refusals file is scanned for a 
patient refusal of a Hepatitis Panel. If 
a refusal is documented, indicate date 
and [refusal type] (e.g., REF, NMI) in 
Result label. 
NOTE: Panels will have multiple line 
values Display ALL of the related test 
data in the panel 

Hep A The most recent Hep A 
tests not included in a 
panel 

Look for the last test contained in the 
T.31 (Hepatitis A) definitions. If there 
was a documented Hepatitis Panel 
(see above) and the Hep A test date 
is not later (more recent) than the 
Panel date, do not display. 
If found, the date and result are 
displayed respectively. If more than 
one test on the same day meets the 
Hep A definition, display ALL tests 
names and results. 
If none found, then the refusals file is 
scanned for a patient refusal of Hep 
A. If a refusal is documented, indicate 
date and [refusal type] (e.g.; REF, 
NME) in Result label 
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Item Description How Data Obtained From RPMS 
Hep B The most recent Hep B 

test not included in a 
panel. 

Look for the last test contained in the 
T.27 (Hepatitis B) definitions. If there 
was a documented Hepatitis Panel 
(see above) and the Hep B test date 
is not later (more recent) than the 
Panel date, do not display. 
If found, the date and result are 
displayed respectively. If more than 
one test on the same day meets the 
Hep B definition, display ALL test 
names and results. 
If none found, then the refusals file is 
scanned for a patient refusal of Hep 
B. If a refusal is documented, indicate 
date and [refusal type] (e.g., REF, 
NMI) in Result label 

Hep C The most recent Hep C 
test not included in a 
panel. 

Look for the last test contained in 
either the T.13 (Hepatitis C 
Screening) or T.14 (Hepatitis C 
Confirmatory) definitions. If there was 
a documented Hepatitis Panel (see 
above) and the Hep C test date is not 
later (more recent) than the Panel 
date, do not display. 
If found, the dates and results are 
displayed respectively. If more than 
one test on the same day meets the 
Hep C definition, display ALL test 
names and results. 
If none found, then the refusals file is 
scanned for a patient refusal of Hep 
C. If a refusal is documented, indicate 
date and [refusal type] (e.g., REF, 
NMI) in Result label. 
If the test meets the T.13 Hep C 
Screening definition, add text 
“[SCREENING]” to the Hep C: label. If 
the test meets the T.14 Hep C 
Confirmatory definition, add 
“[CONFIRMATORY]” to the label. 

CMV The last Cytomegolovirus 
test 

Look for the last test contained in the 
T.6 (CMV test) definitions. If found, 
the date and results are displayed. 
Only display one test for any date; if 
there are 2 tests documented on the 
same day, display the test with a 
result. If none found, then the refusals 
file is scanned for a patient refusal of 
a CMV test. If a refusal is 
documented, indicate date and 
[refusal type] (e.g., REF, NMI) in 
Result label. 

http://www.cdc.gov/node.do/id/0900f3ec80006cd2
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Item Description How Data Obtained From RPMS 
Toxoplasmosis The last Toxoplasmosis 

test 
Look for the last test contained in the 
T.28 (Toxoplasmosis) definitions. If 
found, the date and results are 
displayed. Only display one test for 
any date; if there are 2 tests 
documented on the same day, display 
the test with a result. If none found, 
then the refusals file is scanned for a 
patient refusal of a Toxoplasmosis 
test. If a refusal is documented, 
indicate date and [refusal type] (e.g., 
REF, NMI) in Result label. 

Cocci test The last Coccidiomycosis 
test 

Look for the last test contained in the 
T.7 (Cocci Antibody Screen) 
definitions. Once found, the date and 
results are displayed. Only display 
one test for any date; if there are 2 
tests documented on the same day, 
display the test with a result. If none 
found, then the refusals file is 
scanned for a patient refusal of a 
Cocci test. If a refusal is documented, 
indicate date and [refusal type] (e.g., 
REF, NMI) in Result label. 

PPD Skin Test The date of the last PPD 
applied and read  

Look for the last test contained in the 
T.21 (PPD (Tuberculosis Test)) 
definitions. Once found, the date and 
results are displayed. Only display 
one test for any date; if there are 2 
tests documented on the same day, 
display the test with a result. 
If none are found, then the PCC V 
POV are scanned for a diagnosis of 
V74.1. If one is found, the date is 
displayed along with a phrase “(by 
Diagnosis)”. If none found, then the 
refusals file is scanned for a patient 
refusal of a PPD test. If a refusal is 
documented, indicate date and 
[refusal type] (e.g., REF, NMI) in 
Result label. 

HIV Phenotype HIV Phenotype Testing  Look for the last 5 tests contained in 
the T.16 (HIV Phenotype) definitions. 
If found, display [Yes] + [Date] for 
each test. Do not display the results  

HIV Genotype HIV Genotype Testing Look for the last 5 tests contained in 
the T.15 (HIV Genotype) definitions. If 
found, display [Yes] + [Date] for each 
test. Do not display the results. 
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Item Description How Data Obtained From RPMS 
Pneumococcal 
Immunization 

The date of the last 
Pneumococcal 
Immunization given 

Look for last immunization defined in 
IZ.6 (Pneumococcal) definitions. If 
found, the date is displayed. If none is 
found, the refusals file is checked to 
see if a refusal of a pneumococcal 
immunization is documented. If so, 
indicate date and [refusal type] (e.g., 
REF, NMI) in Result label. 

Influenza Vaccine The date of the last 
Influenza Vaccine given 

Look for the last immunization 
contained in the IZ.5 (Influenza IZ) 
definitions. If found, the date is 
displayed. If none is found, the 
refusals file is checked to see if a 
refusal of an influenza immunization 
is documented. If so, indicate date 
and [refusal type] (e.g., REF, NMI) in 
Result label. 

Hepatitis A 
Diagnosis and/or 
Immunizations 

The dates of any Hep A 
diagnosis and/or the last 2 
Hepatitis A Immunizations 
given  

Look for most recent documented 
Hep A diagnosis (DX.5) in POV or 
Active Problem List and display, if 
any. Display the DX label even if no 
date is available. 
Look for the last 2 documented 
immunizations not on the same date 
contained in the IZ.3 (Hep A) 
definitions. The dates of the last 2 
immunizations are displayed, most 
recent first. If only 1 immunization is 
documented, that date will be 
displayed. If none are found, the 
refusals file is checked to see if a 
refusal of a Hepatitis A Vaccine is 
documented. If so, indicate date and 
[refusal type] (e.g., REF, NMI) in 
Result label. 
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Item Description How Data Obtained From RPMS 
Hepatitis B 
Diagnosis and/or 
Immunizations 

The dates of any Hep B 
diagnosis and/or the last 3 
Hepatitis B Vaccines given  

Look for most recent documented 
Hep B diagnosis (DX.15) in POV or 
Active Problem List and display, if 
any. Display the DX label even if no 
date is available 
Look for the last 3 documented 
immunizations not on the same date 
contained in the IZ.4 (Hep B) 
definitions. The dates of the last 3 
immunizations are displayed, most 
recent first. If only 1 or 2 
immunizations are documented, then 
those dates will be displayed. If none 
are found, the refusals file is checked 
to see if a refusal of a Hepatitis B 
Vaccine is documented. If so, indicate 
date and [refusal type] (e.g., REF, 
NMI) in Result label. 

Tetanus Vaccine The date of the last 
Tetanus vaccine given 

Look for the last immunization 
contained in IZ.7 (Tetanus) 
definitions. If found, the date is 
displayed. If none is found, the 
refusals file is checked to see if a 
refusal of a tetanus immunization is 
documented. If so, indicate date and 
[refusal type] (e.g., REF, NMI) in 
Result label. 

ARV Appropriate Display for the last 6 
months any of the 3 field 
values associated with 
whether ARV is 
appropriate for the patient 

HMS: If any value in [ARV 
Appropriate] field, display [Date] + 
[ARV Appropriate] + [ARV Not 
Appropriate Reasons] + {ARV 
Comment] – because these are visit-
related fields, there can be multiple 
values – display any values for last 6 
months, with most recent at top. 

ARV Adherence  Display for the last 6 
months any of the 2 fields 
associated with whether 
patient is adherent with 
ARV regimen. 

HMS: If any value in [ARV Adherent] 
field, display [Date] + [ARV Adherent] 
+ [ARV Adherent Comment] – 
because these are visit-related fields, 
there can be multiple values – display 
any values for last 6 months, with 
most recent at top. 
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Item Description How Data Obtained From RPMS 
Current ARV 
Medications 

A list of ARV medications 
filled in past 6 months 

Look for any (non discontinued) 
prescriptions filled in the prior 6 
months for medications defined in 
M.02 (NNRTIs), M.03 (NRTIs), M.05 
(PIs) and M.09 (EIs); M.10 (IIs); M.11 
(NRTI/NNRTIs); M.12 (NRTI Combo) 
and M.13(PI Booster). The names of 
each individual medication, date last 
filled, SIG and quantity will be 
displayed. List by date filled, with 
most current at top. If none are found, 
the refusal file is scanned for any 
refusal of any ARV medications. If 
found, indicate date and [refusal type] 
(e.g., REF, NMI) in Result label. 

MAC and PCP 
Prophylaxis 

A list of medications 
prescribed in the past 6 
months for the prevention 
of MAC (Disseminated 
Mycobacterium Avium 
Complex) or PCP 
(Pneumocystis Carinii 
Pneumonia) 

Look for any prescriptions filled in the 
prior 6 months for medications 
defined in M.01 (MAC Proph) or M.04 
(PCP Prophylaxis) definitions. The 
names of each individual medication 
and the date last filled, SIG and 
quantity will be displayed. If none are 
found, the refusal file is scanned for 
any refusal of MAC pr PCP 
Prophylaxis medications. If found, 
indicate date and [refusal type] (e.g., 
REF, NMI) in Result label. 

Depression 
Screening 

Date the patient was most 
recently screened for 
Depression in the past 
year. 

Look for the last depression screening 
in the past year contained in the S.2 
(Depression Screen) definitions. 
If found, display date, code type and 
identifying code (e.g., POV, Patient 
Education code, etc.) 

IPV/DV Screening Date the patient was most 
recently screened for 
Intimate Partner/ Domestic 
Violence in the past year. 

Look for the most recent IPV/DV 
screening in the past year contained 
in the S.6 (IPV/DV Screen) 
definitions. 
If found, display date, code type and 
identifying code (e.g., POV, Patient 
Education code, etc.) 
If patient is Male, display “Not 
Applicable” 

Alcohol Screening Date the patient was most 
recently screened for 
alcohol use in the past 
year. 

Look for the last alcohol screening in 
the past year contained in the S.1 
(Alcohol Screen) definitions. 
If found, display date, code type and 
identifying code (e.g., POV, Patient 
Education code, etc.) 
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Item Description How Data Obtained From RPMS 
Dilated eye exam The date of the most 

recent Dilated eye exam in 
the past year. 

Look for the most recent dilated eye 
exam performed in the past year, 
defined as P.03 (Eye Exam) in 
definitions table. If found, display 
date. If none is found, the refusal file 
is checked to see if a refusal of the 
dilated eye exam is documented. If 
so, indicate date and [refusal type] 
(e.g., REF, NMI) in Result label. 

Dental exam Date of most recent 
documented dental exam. 

Look for the most recent dental exam 
performed in the past year, defined as 
P.02 (Dental Exam) in definitions 
table. If found, display date. If none is 
found, the refusal file is checked to 
see if a refusal of the dilated eye 
exam is documented. If so, indicate 
date and [refusal type] (e.g., REF, 
NMI) in Result label. 

Mammogram: Date of most recent 
documented Mammogram 
in the past year. 

Look for the most recent 
mammogram performed in the past 
year, defined as P.05 (Mammogram) 
in definitions table. If none is found, 
the refusal file is checked to see if a 
refusal of the dilated eye exam is 
documented. If so, indicate date and 
[refusal type] (e.g., REF, NMI) in 
Result label. 
If patient is Male, display “Not 
Applicable” 

HIV-related 
education 

 List any patient education 
provided in the past year 
that is related to HIV 

Look for any patient education 
documented in the past year defined 
in ED.1 (Family Planning), ED.2 
(HIV), ED.3 (Safe Sex), or ED.4 
(STD) definitions. If found, display 
date, + POV and Provider Narrative – 
OR Patient Education topic and 
provider initials. 

HIV-related 
Reminders 

List any reminders here in 
due date order, beginning 
with overdue 

Look at all HMS related reminders 
and display all in order of most 
overdue first. Display [Name of 
Reminder] + [Date Last Done] + [Date 
Due]. Dates are displayed in 
mm/dd/yyyy format. If there is no 
'Date last done' leave a blank space 
NOTE: For PPD reminder, if patient 
has a history of Tuberculosis 
diagnosis (DX14) or history of positive 
PPD test (T.21), display [Name of 
Reminder (PPD)] + [the phrase 
"Diagnosis"] + [Date (if known)]. 
Positive PPD test results are defined 
in the reminder logic 
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H.2 Flow Sheet Logic 
Look for the 6 most recent HIV Viral Load lab tests WITH RESULTS contained in 
the T.26 (HIV Viral Load Tests) definitions. 

Look for the 6 most recent CD4 lab tests WITH RESULTS defined in the T.1 (CD4 
Absolute Tests) and T.2 (CD4 Tests) definitions. 

Display the results in columns associated with the date of the lab test. If both tests are 
within 7 days of each other, they can counted in the same column. Some columns 
might only have one test. Only 6 columns can be displayed, so not all of the “found” 
lab values can be used. 

List all ARV medications for this patient active on each of the column dates. ARV 
medications are defined in M.02 (NNRTIs), M.03 (NRTIs), M.05 (PIs) and M.09 
(EIs); M.10 (IIs); M.11 (NRTI/NNRTI); M.12 (NRTI Combo); M.13 (PI Booster) 

“Active” medication is defined as: 

• Has not been discontinued as of column date (NOTE: a single prescription can 
be “active” for one date and discontinued by the second date) 

• [Date filled] + [Days] equals or is greater than column date 

H.3 Example 
******* CONFIDENTIAL PATIENT INFORMATION -- 03/13/2008   1:37 PM  [CG] ******* 
                   ****** HMS PATIENT CARE SUPPLEMENT ****** 
 
 Report Date: 03/13/2008                                             Page: 1 
 
 Patient's Name: MOUSE, MICKEY           HRN: 111111 
 Sex: M            DOB: 12/06/1969            Age: 38Y 
 Designated Primary Care Provider: CPROVIDER 
 HIV Provider: APROVIDER 
 HIV Case Manager: BPROVIDER 
 Last Height: 70  11/10/2005   Last Weight: 212  07/20/2007 
 BMI: 30.4 
 
 Register Diagnosis: AIDS  03/06/2008 
 Register Status:  Active 03/01/2008 
 HIV/ AIDS Diagnostic Tag Status:  Accepted 03/01/2008  
 HIV Clinical Classification (A1-C3): C1  03/13/2008 
 Diagnosis Comments:  
 Initial HIV Diagnosis: 11/16/2005 
 Initial AIDS Diagnosis: 04/17/2006 
 
 Opportunistic infections and AIDS Defining Illnesses  
     Onset     Entry     ICD       ICD                Provider       Status of 
     Date      Date      Code     Narrative          Narrative       Problem 
   06/23/2006            112.0   CANDIDI-            Candidiasis       Inactive 
                                 ASIS OF              Oral 
                                 MOUTH       
 04/17/2006  05/01/2006  117.5   CRYPTO              Cryptococcal  
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                                                     Meningitis        Inactive 
 04/07/2006              486.    PNEUM               Pneumonia         Active 
                                 ONIA,  
                                 ORGANISM  
                                 UNSPE  PNEUMONIA 
      
 State Notification(s):  
 Partner Notification:  
 
 RECENT LABORATORY RESULTS: 
 Last 6 CD4:  
 
 Last 6 HIV/RNA Viral Load:  
                         Date: 04/08/2006 Result: >100000 
 
Lipid Profile  Date:  01/01/2006 
 RPR:                Date: 04/07/2006 Result: NR 
 PAP:    Not Applicable        
 Chlamydia:  
 Gonorrhea:  
 Hepatitis:  
     Hepatitis Panel:    Date: 11/10/2005     
     HEPATITIS A,B,C PANEL 
       HBsAg HEP B SURFACE ANTIGEN        Result:  
       HBcAb HEP B CORE ANTIBODY            Result:  
       HCV-Ab HEPATITIS C ANTIBODY         Result:  
       HEPATITIS A ANTIBODY TOTAL          Result:  
       HAVAb IgG         Result: 
     Hep A: 
     Hep B:  
     Hep C: 
 CMV:                    Date: 04/08/2006 Result: 2.70 
 Toxoplasmosis:          Date: 04/08/2006 Result: 0.05 
 Cocci:  
 PPD:                    Date: 02/22/2008 Result: POSITIVE 8 
 
HIV Phenotype:  
HIV Genotype:  
 
 LAST DOCUMENTED IMMUNIZATIONS:  
 
 Pneumococcal:           Date: 09/05/2006 
 Influenza:              Date: 11/16/2005 
 Hepatitis A (last 2): Dx Date:  
 Hepatitis B (last 3):  Dx Date: 
 Tetanus:                Date: 11/16/2005 
 
 RECENT MEDICATIONS (past 6 months):  
 
 ARV Status:  
     ARV Appropriate: 
     ARV Adherence: 
 
 Current ARV Medications (past 6 months):  
 
 Prophylaxis Medications for MAC and/or PCP (past 6 months):  
 
 IN THE PAST 12 MONTHS: 
 Depression Screening:   Date: 08/14/2007  311. 
 IPV/DV Screening:       Date:          
 Alcohol Screening:      Date:              
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 Dilated eye exam:       Date: 
 Dental exam:            Date: 08/03/2007 
 
 Last HIV-related education given (past 12 months):  
 
 
 Calculating HIV-RELATED REMINDERS - Please wait. 
 
 HIV-RELATED REMINDERS: 
Reminder                  Last             Due 
 Lipid Profile  01/01/2006           01/01/2007) 
 CD4                                         [today's date] 
 Viral Load                04/08/2006            08/08/2006) 
 PPD           02/22/2008            Positive Test Result 
 RPR Syphilis Test          04/07/2006            04/07/2007) 
 Hep C EIA Test             11/10/2005       
 Hep B Test                11/10/2005       
 Toxoplasmosis Test         04/08/2006            04/08/2007) 
 Chlamydia Test                        [today's date] 
 Gonorrhea Test                          [today's date] 
 Hep B IZ                                   [today's date] 
 Hep A IZ                                    [today's date] 
 Pneumovax IZ               09/05/2006              09/05/2011 
 Influenza IZ               11/16/2005            11/16/2006) 
 Tetanus IZ                11/16/2005            11/16/2015 
 
 Dilated Eye Exam           10/15/1996            10/15/1997) 
 Dental Exam               08/03/2007            08/03/2008 
 
 Safe Sex Educ                         [today's date] 
 Family Planning Educ                     [today's date] 
 
HIV FLOW SHEET 
 
             mm/dd/yy  mm/dd/yy  mm/dd/yy  mm/dd/yy  mm/dd/yy  mm/dd/yy   
 
 
Viral Load    ###.#     ###.#               ###.#     ###.#                
 
CD4 Count     ###.#      ##.#      ##.#               ###.#     ###.# 
 
 
 
[Rx Name #1]   x        x                              x 
[Rx #2]                 x          x         x 
[Rx #3]                                                x         x          
[Rx #4]                                                          x  

Figure 15-4: Example of HMS PATIENT CARE SUPPLEMENT 
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Appendix I:  Keyboard Navigation 
You can use various combinations of keys to navigate with the iCare application. In 
addition, there are short-cut keys for various functions. 

I.1 General Instructions 
Desired Action Use These Keys 
To move to different areas on a screen Tab and Shift-Tab 
To activate drop-down list box and view the text Alt-Up or Alt-Down 
To move one row/record at a time Up or Down arrows 
To move a page worth Page Up or Page Down 
To make a selection of a highlighted choice from a drop-
down box 

Tab 

To select or de-select a radio button or check box Space Bar 

I.2 iCare Main Window 
Use the following keys while in the iCare Main window. 

I.2.1 Split Window 
Desired Action Use These Keys 
Switch between Panel List tab and Flag List 
tab (Show drop-down box is active) 

Ctrl-Tab 

To see list in box Alt-up or Alt-down arrow keys 
To select highlighted choice Tab 
Shift-Tab in active window Up and down arrows to move from row 

to row (e.g., panel name rows, or flag 
rows) 

After the first arrow movement, to move 
Up or down rows 

Tab key to go a row down 
Shift-Tab to go a row up 

I.2.2 Panel View 
Desired Action Use These Keys 
Move the focus to the first row Tab 
Move from row to row 
After first arrow movement 

Up and Down arrows 
Tab moves you a row down and Shift-Tab moves 
you a row up 

To change the tab focus when a tab 
that has the focus 

Left or Right arrow keys (e.g., Panel List, Flag, 
GPRA, Aggregate) 

To open a patient record Enter 
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I.2.3 Flag View 
Desired Action Use These Keys 
Change the focus from the tab to the Show box 
and then to the first flag row 

Tab 

Move from row to row 
After first arrow movement 

Up and Down arrows 
Tab moves you a row down and Shift-
Tab moves you a row up 

To change the tab focus when a tab has the focus Left or Right arrow keys (e.g., Panel 
List, Flag, GPRA, Aggregate) 

To open a patient record Enter 

I.2.4 Patient Record View 
The Tab key moves the focus to the first row in Providers, then Last drop down box 
under Recent Visits. Next the focus moves to the first row in Recent Visits. 
Continuing to tab moves the user through each group. 

Once the focus moves to the first row in a grouping: 

• The up and down arrow keys move the focus between rows. 

• Shift-Tab reverses the order of the focus. 

I.2.5 Panel Definition Dialog Box 
Use the following on the main control areas on the Definitions tab. 

Initial focus is in the Panel Name field. 

Desired Action Use These Keys 
Move the focus between the controls on the 
Definition tab (e.g., Definition tab, Panel Name, Panel 
Description, Population Options, Ok, and Cancel) 

Tab and Shift-Tab 

 
Once an option other than No search logic is selected, Additional Filters is an 
additional control that is displayed. 

To select a Population Option, move the focus to the first option (No search logic), 
then use the up and down arrows to select other options. 

Desired Action Use These Keys 
To move to the different fields/options if 
the options has other selection 

Tab and Shift-Tab (e.g., Patients Assigned 
radio button is active, tab to the Provider 
field) 

To activate drop-down boxes Alt-up or Alt-down arrows 
To make a selection Tab 
To select/de-select the check boxes Space bar 
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Desired Action Use These Keys 
To move among the grouped check boxes Up and Down arrow keys 

 
The order of the tab is: Add list, Add button, Remove button, Remove List, OK, and 
Cancel on the Add/Remove dialog boxes (Community, Diagnosis). 

To move up and down on the Add/Remove lists, use up or down arrow, Page Up and 
Page Down. 

I.3 Short-Cut Keys 
When a menu has a letter underlined, use that letter and Alt to activate the function 
(e.g., for File, use Alt-F to view the File menu). 

I.3.1 Main View 
Desired Action Use These Keys 
New Panel Ctrl-N 
Open Panel Ctrl-O 
Delete Panel Delete 
Refresh F5 
Quick Patient Search F8 
Help F1 

I.3.2 Panel View 
Desired Action Use These Keys 
New Panel Ctrl-N 
Save Panel Ctrl-S 
Print Ctrl-P 
Open Patient Record Ctrl-O 
Remove Patient Record Delete 
Copy selected rows Ctrl-C 
Cut selected rows Ctrl-X 
Paste selected rows Ctrl-V 
Select all rows Ctrl-A 
Quick Patient Search F8 
Search This Screen Ctrl-F 
Excel Export Ctrl-E 
Copy Rows to Windows Window Ctrl-Shift-C 

I.3.3 Patient Record 
Desired Action Use These Keys 
New Panel Ctrl-N 
Quick Patient Search F8 
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Depending upon the selected tab, other keys will be available.  
Print Ctrl-P 
Hide Flags F3 
Show Flags F4 
Refresh Flags F5 
Search This Screen Ctrl-F 
Excel Export Ctrl-E 
Copy Rows to Windows Window Ctrl-Shift-C 
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Appendix J:  CMET Events 
 
Category 

 
Event 

 
Findings 

 
Interpretation 

Data Mining 
Timeframe 

Ce Chlamydia 
Screen 

Negative Normal 1 Year 

  Positive Abnormal  
  Unsatisfactory for 

Diagnosis 
NA  

  Error/Disregard NA  

Ce Colposcopy 
Impression 

WNL/Normal Normal 2 Years 

  Pregnant WNL Normal  

  Inflammation Abnormal  
  Pregnant Inflammation Normal  

  HPV Abnormal  
  Pregnant HPV Abnormal  
  CIN I Abnormal  

  Pregnant CIN I Abnormal  
  CIN II Abnormal  

  Pregnant CIN II Abnormal  
  CIN III Abnormal  
  Pregnant CIN III Abnormal  

  VAIN I Abnormal  
  VAIN II Abnormal  

  VAIN III Abnormal  
  VIN I Abnormal  
  VIN II Abnormal  

  VIN III Abnormal  
  Invasive CA Abnormal  

  Pregnant Invasive Abnormal  
  Unsatisfactory for 

Diagnosis 
NA  

  Results Not Available NA  

  Error/Disregard NA  

Ce Colposcopy 
w/ Biopsy 

WNL/Normal Normal 2 Years 

  Benign Changes Normal  
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Category 

 
Event 

 
Findings 

 
Interpretation 

Data Mining 
Timeframe 

  Inflammation Abnormal  
  HPV Abnormal  

  CIN I Abnormal  
  CIN II Abnormal  

  CIN III Abnormal  
  VAIN I Abnormal  
  VAIN II Abnormal  

  VAIN III Abnormal  
  VIN I Abnormal  

  VIN II Abnormal  
  VIN III Abnormal  
  Invasive Squamous 

Cell Carcinoma 
Abnormal  

  Adenocarcinoma in 
Situ 

Abnormal  

  Invasive 
Adenocarcinoma 

Abnormal  

  Invasive CA: Other Abnormal  

  Insufficient Tissue NA  
  Unsatisfactory for 

Diagnosis 
NA  

  Results Not Available NA  
  Error/Disregard NA  

Ce Cone 
Biopsy 

WNL/Normal Normal 2 Years 

  Benign Changes Normal  
  Inflammation Abnormal  

  HPV Abnormal  
  CIN I Abnormal  
  CIN II Abnormal  

  CIN III Abnormal  
  Invasive Squamous 

Cell Carcinoma  
Abnormal  

  Adenocarcinoma in 
Situ 

Abnormal  

  Invasive 
Adenocarcinoma 

Abnormal  

  Invasive CA: Other Abnormal  
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Category 

 
Event 

 
Findings 

 
Interpretation 

Data Mining 
Timeframe 

  Insufficient Tissue NA  
  Unsatisfactory for 

Diagnosis 
NA  

  Results Not Available NA  
  Error/Disregard NA  
     

Ce Cryotherapy Done NA 2 Years 
  Results Not Available NA  

  Error/Disregard NA  
     

Ce Dilation and 
Curretage 

See Patient Chart NA 2 Years 

  WNL/Normal Normal  
  Benign Changes Normal  

  Simple Endometrial 
Hyperplasia without 
Atypia 

Abnormal  

  Simple Endometrial 
Hyperplasia with Atypia 

Abnormal  

  Complex Endometrial 
Hyperplasia without 
Atypia 

Abnormal  

  Complex Endometrial 
Hyperplasia with Atypia 

Abnormal  

  Endometritis Abnormal  
  Invasive CA: 

Squamous Cell 
Carcinoma 

Abnormal  

  Invasive CA: 
Endometrial Grade 1 

Abnormal  

  Invasive CA: 
Endometrial Grade 2 

Abnormal  

  Invasive CA: 
Endometrial Grade 3 

Abnormal  

  Invasive CA: Other Abnormal  

  Insufficient Tissue NA  
  Unsatisfactory for 

Diagnosis 
NA  

  Results Not Available NA  
  Error/Disregard NA  
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Category 

 
Event 

 
Findings 

 
Interpretation 

Data Mining 
Timeframe 

Ce Endocervica
l Currettage 

WNL/Normal Normal 2 Years 

  Benign Changes Normal  

  Inflammation Abnormal  
  HPV Abnormal  
  CIN I Abnormal  

  CIN II Abnormal  
  CIN III Abnormal  

  Invasive Squamous 
Cell Carcinoma  

Abnormal  

  Adenocarcinoma in 
Situ 

Abnormal  

  Invasive 
Adenocarcinoma 

Abnormal  

  Invasive CA: Other Abnormal  
  Insufficient Tissue NA  

  Unsatisfactory for 
Diagnosis 

NA  

  Results Not Available NA  
  Error/Disregard NA  

Ce Endometrial 
Biopsy 

WNL/Normal Normal 2 Years 

  Benign Changes Normal  
  Simple Endometrial 

Hyperplasia without 
Atypia 

Abnormal  

  Simple Endometrial 
Hyperplasia with Atypia 

Abnormal  

  Complex Endometrial 
Hyperplasia without 
Atypia 

Abnormal  

  Complex Endometrial 
Hyperplasia with Atypia 

Abnormal  

  Endometritis Abnormal  
  Invasive CA: 

Squamous Cell 
Carcinoma 

Abnormal  

  Invasive CA: 
Endometrial Grade 1 

Abnormal  
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Category 

 
Event 

 
Findings 

 
Interpretation 

Data Mining 
Timeframe 

  Invasive CA: 
Endometrial Grade 2 

Abnormal  

  Invasive CA: 
Endometrial Grade 3 

Abnormal  

  Invasive CA: Other Abnormal  
  Insufficient Tissue NA  
  Unsatisfactory for 

Diagnosis 
NA  

  Results Not Available NA  
  Error/Disregard NA  

Ce Gonorrhea 
Screen 

Negative Normal 1 Year 

  Positive Abnormal  
  Unsatisfactory for 

Diagnosis 
NA  

  Results Not Available NA  
  Error/Disregard NA  

Ce HPV-DNA 
Screen 

Low Risk HPV Positive Abnormal 1 Year 

  Low Risk HPV 
Negative 

Normal  

  High Risk HPV Positive Abnormal  
  High Risk HPV 

Negative 
Normal  

  Insufficient Sample NA  
  Unsatisfactory for 

Diagnosis 
NA  

  Results Not Available NA  
  Error/disregard NA  

Ce Hysterecto
my 

WNL/Normal Normal 2 Years 

  Benign Changes Normal  
  Inflammation Abnormal  

  HPV Abnormal  
  CIN I Abnormal  
  CIN II Abnormal  

  CIN III Abnormal  
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Category 

 
Event 

 
Findings 

 
Interpretation 

Data Mining 
Timeframe 

  Invasive CA: 
Squamous Cell 
Carcinoma 

Abnormal  

  Invasive CA: 
Endometrial Carcinoma 

Abnormal  

  Other Malignant 
Neoplasms 

Abnormal  

  Unsatisfactory for 
Diagnosis 

NA  

  Results Not Available NA  

  Error/Disregard NA  

Ce Laser 
Ablation 

Done NA 2 Years 

  Results Not Available NA  

  Error/Disregard NA  
     

Ce Laser Cone WNL/Normal Normal 2 Years 
  Benign Changes Normal  
  Inflammation Abnormal  

  HPV Abnormal  
  CIN I Abnormal  

  CIN II Abnormal  
  CIN III Abnormal  
  Invasive Squamous 

Cell Carcinoma  
Abnormal  

  Adenocarcinoma in 
Situ 

Abnormal  

  Invasive 
Adenocarcinoma 

Abnormal  

  Invasive CA: Other  Abnormal  

  Margins Positive Abnormal  
  Margins Negative  Nomal  

  Unsatisfactory for 
Diagnosis 

NA  

  Results Not Available NA  
  Error/Disregard NA  

Ce LEEP WNL/Normal Normal 2 Years 
  Benign Changes Normal  
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Category 

 
Event 

 
Findings 

 
Interpretation 

Data Mining 
Timeframe 

  Inflammation Abnormal  
  HPV Abnormal  

  CIN I Abnormal  
  CIN II Abnormal  

  CIN III Abnormal  
  Invasive Squamous 

Cell Carcinoma  
Abnormal  

  Adenocarcinoma in 
Situ 

Abnormal  

  Invasive 
Adenocarcinoma 

Abnormal  

  Invasive CA: Other  Abnormal  
  Margins Positive Normal  

  Margins Negative  Abnormal  
  Unsatisfactory for 

Diagnosis 
NA  

  Results Not Available NA  
  Error/Disregard NA  

Ce OB/GYN 
Consult 

WNL/Normal Normal 1 Year 

  See Patient Chart NA  
  Results Not Available NA  
  Error/Disregard NA  

Ce Pap Smear Negative Normal 5 Years 
  Neg-Trichomonas Abnormal  

  Neg-Candida Species Abnormal  
  Non-Bacterial 

Vaginosis 
Abnormal  

  Neg-Actinomyces Abnormal  

  Neg-Other non-
neoplastic 

Abnormal  

  ASC-US Abnormal  

  ASC-H Abnormal  
  LSIL Abnormal  
  HSIL Abnormal  

  Carcinoma Abnormal  
  AGC Abnormal  
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Category 

 
Event 

 
Findings 

 
Interpretation 

Data Mining 
Timeframe 

  AGC-Favor Neoplastic Abnormal  
  AIS Abnormal  

  Adenocarcinoma Abnormal  
  Other Abnormal  

  Unsatisfactory for 
Diagnosis 

NA  

  Results Not Available NA  
  Error/Disregard NA  

Ce Pelvic Exam Done Normal 5 Years 
  Infection Abnormal  

  Other Finding Abnormal  
  Results Not Available NA  
  Error/Disregard NA  

Ce Pelvic 
Ultrasound 

Done Normal 2 Years 

  Abnormal Abnormal  

  Unsatisfactory for 
Diagnosis 

NA  

  Results Not Available NA  
  Error/Disregard NA  

Ce Perianal 
Biopsy 

WNL/Normal Normal 2 Years 

  Abnormal Abnormal  
  Unsatisfactory for 

Diagnosis 
NA  

  Results Not Available NA  
  Error/Disregard NA  

Ce Vaginal 
Ultrasound 

Done NA 2 Years 

  See Pt Chart NA  
  Unsatisfactory for 

Diagnosis 
NA  

  Results Not Available NA  
  Error/Disregard NA  



iCare Population Management GUI (BQI) Version 2.2 

User Manual RPMS Rules of Behavior 
August 2011 

470 

Appendix K:  RPMS Rules of Behavior 
The Resource and Patient Management (RPMS) system is a United States 
Department of Health and Human Services (HHS), Indian Health Service (IHS) 
information system that is FOR OFFICIAL USE ONLY. The RPMS system is 
subject to monitoring; therefore, no expectation of privacy shall be assumed. 
Individuals found performing unauthorized activities are subject to disciplinary action 
including criminal prosecution. 

All users (Contractors and IHS Employees) of RPMS will be provided a copy of the 
Rules of Behavior (RoB) and must acknowledge that they have received and read 
them prior to being granted access to a RPMS system, in accordance IHS policy. 

• For a listing of general Rules of Behavior for all users, see the most recent edition 
of IHS General User Security Handbook (SOP 06-11a).  

• For a listing of system administrators/managers rules, see the most recent edition 
of the IHS Technical and Managerial Handbook (SOP 06-11b). 

Both documents are available at this IHS web site: http://security.ihs.gov/ 

The Rules of Behavior listed in the following sections are specific to RPMS.  

K.1 All RPMS Users 
In addition to these rules, each application may include additional RoBs that may be 
defined within the documentation of that application (e.g., PCC, Dental, Pharmacy). 

K.1.1 Access 
RPMS users shall 

• Only use data for which you have been granted authorization. 

• Only give information to personnel who have access authority and have a need to 
know.  

• Always verify a caller’s identification and job purpose with your supervisor or the 
entity provided as employer before providing any type of information system 
access, sensitive information, or nonpublic agency information. 

• Be aware that personal use of information resources is authorized on a limited 
basis within the provisions Indian Health Manual Part 8, “Information Resources 
Management,” Chapter 6, “Limited Personal Use of Information Technology 
Resources.” 

http://security.ihs.gov/
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RPMS users shall not 

• Retrieve information for someone who does not have authority to access the 
information. 

• Access, research, or change any user account, file, directory, table, or record not 
required to perform their official duties. 

• Store sensitive files on a PC hard drive, or portable devices or media, if access to 
the PC or files cannot be physically or technically limited. 

• Exceed their authorized access limits in RPMS by changing information or 
searching databases beyond the responsibilities of their jobs or by divulging 
information to anyone not authorized to know that information. 

K.1.2 Information Accessibility 
RPMS shall restrict access to information based on the type and identity of the user. 
However, regardless of the type of user, access shall be restricted to the minimum 
level necessary to perform the job. 

RPMS users shall 

• Access only those documents they created and those other documents to which 
they have a valid need-to-know and to which they have specifically granted 
access through an RPMS application based on their menus (job roles), keys, and 
FileMan access codes. Some users may be afforded additional privileges based on 
the functions they perform, such as system administrator or application 
administrator. 

• Acquire a written preauthorization in accordance with IHS policies and 
procedures prior to interconnection to or transferring data from RPMS. 

K.1.3 Accountability 
RPMS users shall 

• Behave in an ethical, technically proficient, informed, and trustworthy manner. 

• Log out of the system whenever they leave the vicinity of their personal 
computers (PCs). 

• Be alert to threats and vulnerabilities in the security of the system. 

• Report all security incidents to their local Information System Security Officer 
(ISSO)  

• Differentiate tasks and functions to ensure that no one person has sole access to or 
control over important resources. 

• Protect all sensitive data entrusted to them as part of their government 
employment. 
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• Abide by all Department and Agency policies and procedures and guidelines 
related to ethics, conduct, behavior, and information technology (IT) information 
processes. 

K.1.4 Confidentiality 
RPMS users shall 

• Be aware of the sensitivity of electronic and hard copy information, and protect it 
accordingly. 

• Store hard copy reports/storage media containing confidential information in a 
locked room or cabinet. 

• Erase sensitive data on storage media prior to reusing or disposing of the media. 

• Protect all RPMS terminals from public viewing at all times. 

• Abide by all Health Insurance Portability and Accountability Act (HIPAA) 
regulations to ensure patient confidentiality. 

RPMS users shall not 

• Allow confidential information to remain on the PC screen when someone who is 
not authorized to that data is in the vicinity. 

• Store sensitive files on a portable device or media without encrypting. 

K.1.5 Integrity 
RPMS users shall 

• Be aware of the sensitivity of electronic and hard copy information, and protect it 
accordingly. 

• Store hard copy reports/storage media containing confidential information in a 
locked room or cabinet. 

• Erase sensitive data on storage media prior to reusing or disposing of the media. 

• Protect all RPMS terminals from public viewing at all times. 

• Abide by all Health Insurance Portability and Accountability Act (HIPAA) 
regulations to ensure patient confidentiality. 

RPMS users shall not 

• Allow confidential information to remain on the PC screen when someone who is 
not authorized to that data is in the vicinity. 

• Store sensitive files on a portable device or media without encrypting. 
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K.1.6 System Logon 
RPMS users shall 

• Have a unique User Identification/Account name and password. 

• Be granted access based on authenticating the account name and password 
entered. 

• Be locked out of an account after 5 successive failed login attempts within a 
specified time period (e.g., one hour). 

K.1.7 Passwords 
RPMS users shall 

• Change passwords a minimum of every 90 days. 

• Create passwords with a minimum of eight characters. 

• If the system allows, use a combination of alpha-numeric characters for 
passwords, with at least one uppercase letter, one lower case letter, and one 
number. It is recommended, if possible, that a special character also be used in the 
password. 

• Change vendor-supplied passwords immediately. 

• Protect passwords by committing them to memory or store them in a safe place 
(do not store passwords in login scripts or batch files).  

• Change passwords immediately if password has been seen, guessed, or otherwise 
compromised, and report the compromise or suspected compromise to their ISSO. 

• Keep user identifications (IDs) and passwords confidential. 
RPMS users shall not 

• Use common words found in any dictionary as a password. 

• Use obvious readable passwords or passwords that incorporate personal data 
elements (e.g., user’s name, date of birth, address, telephone number, or social 
security number; names of children or spouses; favorite band, sports team, or 
automobile; or other personal attributes). 

• Share passwords/IDs with anyone or accept the use of another’s password/ID, 
even if offered. 

• Reuse passwords. A new password must contain no more than five characters per 
eight characters from the previous password. 

• Post passwords. 

• Keep a password list in an obvious place, such as under keyboards, in desk 
drawers, or in any other location where it might be disclosed. 
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• Give a password out over the phone. 

K.1.8 Backups 
RPMS users shall 

• Plan for contingencies such as physical disasters, loss of processing, and 
disclosure of information by preparing alternate work strategies and system 
recovery mechanisms. 

• Make backups of systems and files on a regular, defined basis.  

• If possible, store backups away from the system in a secure environment. 

K.1.9 Reporting 
RPMS users shall 

• Contact and inform their ISSO that they have identified an IT security incident 
and begin the reporting process by providing an IT Incident Reporting Form 
regarding this incident. 

• Report security incidents as detailed in the IHS Incident Handling Guide (SOP 
05-03). 

RPMS users shall not 

• Assume that someone else has already reported an incident. The risk of an 
incident going unreported far outweighs the possibility that an incident gets 
reported more than once. 

K.1.10 Session Timeouts 
RPMS system implements system-based timeouts that back users out of a prompt 
after no more than 5 minutes of inactivity. 

RPMS users shall 

• Utilize a screen saver with password protection set to suspend operations at no 
greater than 10-minutes of inactivity. This will prevent inappropriate access and 
viewing of any material displayed on your screen after some period of inactivity. 

K.1.11 Hardware 
RPMS users shall 

• Avoid placing system equipment near obvious environmental hazards (e.g., water 
pipes). 

• Keep an inventory of all system equipment. 
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• Keep records of maintenance/repairs performed on system equipment. 
RPMS users shall not 

• Eat or drink near system equipment 

K.1.12 Awareness 
RPMS users shall 

• Participate in organization-wide security training as required. 

• Read and adhere to security information pertaining to system hardware and 
software. 

• Take the annual information security awareness. 

• Read all applicable RPMS Manuals for the applications used in their jobs. 

K.1.13 Remote Access 
Each subscriber organization establishes its own policies for determining which 
employees may work at home or in other remote workplace locations. Any remote 
work arrangement should include policies that 

• Are in writing. 

• Provide authentication of the remote user through the use of ID and password or 
other acceptable technical means. 

• Outline the work requirements and the security safeguards and procedures the 
employee is expected to follow. 

• Ensure adequate storage of files, removal, and nonrecovery of temporary files 
created in processing sensitive data, virus protection, and intrusion detection, and 
provide physical security for government equipment and sensitive data. 

• Establish mechanisms to back up data created and/or stored at alternate work 
locations. 

Remote RPMS users shall 

• Remotely access RPMS through a virtual private network (VPN) whenever 
possible. Use of direct dial in access must be justified and approved in writing and 
its use secured in accordance with industry best practices or government 
procedures. 

Remote RPMS users shall not 

• Disable any encryption established for network, internet, and Web browser 
communications. 



iCare Population Management GUI (BQI) Version 2.2 

User Manual RPMS Rules of Behavior 
August 2011 

476 

K.2 RPMS Developers 
RPMS developers shall 

• Always be mindful of protecting the confidentiality, availability, and integrity of 
RPMS when writing or revising code. 

• Always follow the IHS RPMS Programming Standards and Conventions (SAC) 
when developing for RPMS. 

• Only access information or code within the namespaces for which they have been 
assigned as part of their duties. 

• Remember that all RPMS code is the property of the U.S. Government, not the 
developer. 

• Not access live production systems without obtaining appropriate written access, 
and shall only retain that access for the shortest period possible to accomplish the 
task that requires the access. 

• Observe separation of duties policies and procedures to the fullest extent possible. 

• Document or comment all changes to any RPMS software at the time the change 
or update is made. Documentation shall include the programmer’s initials, date of 
change, and reason for the change. 

• Use checksums or other integrity mechanism when releasing their certified 
applications to assure the integrity of the routines within their RPMS applications. 

• Follow industry best standards for systems they are assigned to develop or 
maintain, and abide by all Department and Agency policies and procedures. 

• Document and implement security processes whenever available. 
RPMS developers shall not 

• Write any code that adversely impacts RPMS, such as backdoor access, “Easter 
eggs,” time bombs, or any other malicious code or make inappropriate comments 
within the code, manuals, or help frames. 

• Grant any user or system administrator access to RPMS unless proper 
documentation is provided. 

• Release any sensitive agency or patient information. 

K.3 Privileged Users 
Personnel who have significant access to processes and data in RPMS, such as, 
system security administrators, systems administrators, and database administrators, 
have added responsibilities to ensure the secure operation of RPMS. 
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Privileged RPMS users shall 

• Verify that any user requesting access to any RPMS system has completed the 
appropriate access request forms. 

• Ensure that government personnel and contractor personnel understand and 
comply with license requirements. End users, supervisors, and functional 
managers are ultimately responsible for this compliance. 

• Advise the system owner on matters concerning information technology security. 

• Assist the system owner in developing security plans, risk assessments, and 
supporting documentation for the certification and accreditation process. 

• Ensure that any changes to RPMS that affect contingency and disaster recovery 
plans are conveyed to the person responsible for maintaining continuity of 
operations plans. 

• Ensure that adequate physical and administrative safeguards are operational 
within their areas of responsibility and that access to information and data is 
restricted to authorized personnel on a need-to-know basis. 

• Verify that users have received appropriate security training before allowing 
access to RPMS. 

• Implement applicable security access procedures and mechanisms, incorporate 
appropriate levels of system auditing, and review audit logs.  

• Document and investigate known or suspected security incidents or violations and 
report them to the ISSO, Chief Information Security Officer (CISO), and systems 
owner. 

• Protect the supervisor, superuser, or system administrator passwords. 

• Avoid instances where the same individual has responsibility for several functions 
(i.e., transaction entry and transaction approval). 

• Watch for unscheduled, unusual, and unauthorized programs. 

• Help train system users on the appropriate use and security of the system. 

• Establish protective controls to ensure the accountability, integrity, 
confidentiality, and availability of the system. 

• Replace passwords when a compromise is suspected. Delete user accounts as 
quickly as possible from the time that the user is no longer authorized system. 
Passwords forgotten by their owner should be replaced, not reissued. 

• Terminate user accounts when a user transfers or has been terminated. If the user 
has authority to grant authorizations to others, review these other authorizations. 
Retrieve any devices used to gain access to the system or equipment. Cancel 
logon IDs and passwords, and delete or reassign related active and backup files. 
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• Use a suspend program to prevent an unauthorized user from logging on with the 
current user's ID if the system is left on and unattended. 

• Verify the identity of the user when resetting passwords. This can be done either 
in person or having the user answer a question that can be compared to one in the 
administrator’s database. 

• Shall follow industry best standards for systems they are assigned to, and abide by 
all Department and Agency policies and procedures. 

Privileged RPMS users shall not 

• Access any files, records, systems, etc., that are not explicitly needed to perform 
their duties 

• Grant any user or system administrator access to RPMS unless proper 
documentation is provided. 

• Release any sensitive agency or patient information. 
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Glossary 

There are many terms used in the User Manual that might be new to you or might 
have slightly different meanings in other program environments. To clarify, a 
glossary of terms commonly used in this User Manual is included. 

Case File Manager(s) 
The system owner(s) of an individual CM application. The Case File 
Manager(s) have full security access to the application to perform various 
setup functions and to assign access roles to other users. 

Case Management 
Most often synonymous with “disease” management, where groups of patients 
with like disease conditions are evaluated and managed to a specific set of 
clinical guidelines, e.g. diabetes management. In the context of iCare, case 
management also refers to the evaluation and treatment of a patient within the 
context of ALL factors related to the patient’s health, not just a single disease 
condition. This might include multiple disease conditions, gender or age 
specific factors, environmental, and/or family factors, etc. 

Case Manager(s) 
A term used to describe a particular type of clinical role within a clinic. Case 
Managers are typically, but not always, nurses who perform clinical 
management tasks for specified groups of patients, e.g. diabetics. 

Designated Primary Care Provider (DPCP) 
In RPMS, the provider name that is assigned as the primary care physician for 
a patient or group of patients at a specific facility. This is not a required 
function. 

Editor 
Access level to an application that allows a user to read and write data, but not 
to perform manager-level set up functions. 

Flags 
Flags are critical, usually time-sensitive, information points related to a patient 
that might affect diagnosis or care. Flags are defined specifically for each 
RPMS application and might include formal clinical or administrative alerts as 
defined in RPMS Kernel Alerts application, and other definitions. 

Patient Panel 
A list of patients defined in iCare by the user. 
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PCC (or PCC+) form 
The paper form used in most I/T/U clinics on which the provider(s) document 
all data from the patient’s visit. Used by data entry staff to enter patient data 
into RPMS PCC. 

Providers 
Any staff member in an I/T/U facility who provides direct healthcare to 
patients, e.g. general practice or specialty physicians, registered nurses, social 
workers, physician assistants, etc. 

Within RPMS, the term “provider” has different specific meanings. See 
definitions for Designated Primary Care Provider (DPCP); Primary Provider; 
Visit Providers. 

Reader 
Access level to an application that allows a user to read but not write data. 

Register 
A software application that provides the ability to maintain a permanent list of 
patients and associated clinical data that is not located within other RPMS 
applications. Register applications are often disease-condition specific and 
contain specific clinical care guidelines that do not apply to the overall patient 
population. Examples of RPMS register management systems are Diabetes 
Management System and Asthma Register System. 

Reminders 
Health Maintenance Reminders review patient data and alert the provider to 
procedures that might be overdue for the patient. Reminders can be based on 
age and gender and include typical clinical prevention measures, such as pap 
smears. 

Site Manager 
The staff member at an I/T/U site who is responsible for managing all IT 
functions, including loading RPMS software on the site’s server. The Site 
Manager assigns the initial security keys of any new software to a designated 
user. 

“Tagging” 
A process to review the patient’s data and categorize (“tag”) the patient with 
one or more clinical diagnoses, such as Known CVD or Diabetes. Tags will be 
used to provide more accurate reminders that are prioritized more 
appropriately for a patient’s multiple conditions. 
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Taxonomy 
In RPMS, a grouping of functionally related data elements, such as ICD 
codes, that are created and maintained within the RPMS Taxonomy Setup 
application. Taxonomies will be used as definitions for diagnoses, procedures, 
lab tests, medications, and other clinical data types. 

If you need a change or addition to an existing taxonomy, please see your 
CRS coordinator. 

Visit Provider 
In RPMS, the provider(s) who cared for a patient on a specific visit. Each 
patient visit must have at least a primary provider entered. Visits can also have 
one or more secondary providers. The primary visit provider might or might 
not be the same provider as the patient’s DPCP, and can change on each visit, 
depending on the visit type or the clinic staffing. 
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Acronym List 

ACM Namespace for Case Management 
System 

BDM Namespace for Diabetes Management 
System 

BKM Namespace for HIV Management 
System 

CMET Care Management Event Tracking 

CQ Clinical Quality 

DPCP Acronym for Designated Primary Care 
Provider 

DSPM Acronym for Designated Specialty 
Provider Management 

IHS Indian Health Service 

MU Meaningful Use 

RPMS Resource and Patient Management 
System 

SRF Suicide Reporting Form 
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Contact Information 

If you have any questions or comments regarding this distribution, please contact the 
OIT Help Desk (IHS). 

Phone: (505) 248-4371 or (888) 830-7280 (toll free) 

Fax: (505) 248-4363 

Web: http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm 

Email: support@ihs.gov 

http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm
mailto:support@ihs.gov
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